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O K U M A  R E H B E R İ

Bu kılavuzu nasıl okumalısınız

Kılavuzdaki her girdi aynı şemayı izler. Sol tarafta kullanım yolları ve teknik detaylar yer 
alır; sağda, sıcak tonlu bir kenar sütununda her zaman sade bir açıklama bulursun. Her 
satırın başındaki küçük simgeler, hemen bir bakışta hangi tür bilginin geleceğini söyler.

D Ö R T  S İ M G E

Bunu nerede bulurum? Uygulamadaki somut tıklama yolu — menü çubuğu, Ins
pector bölümü veya Başlangıç modu adımı. İlgili klavye kısayolları da burada yer 
alır. Simge bir harita raptiyesidir ve işlevin arayüzde nerede olduğunu gösterir.

Detaylar. Varsayılan değerler, değer aralıkları ve kod yolları. Bunlara özellikle 
menü girdisi olmayan, sayısal parametre olan eğitim ayarlarında rastlarsın. Simge 
küçük bir teknik kart gösterir.

Teknik. İşlevin içeride ne yaptığı, hangi parametrelerin etki ettiği, neye tepki 
verdiği ve hangi yan etkileri olduğu. Sahne arkasında ne olup bittiğini anlamak is
teyen okurlar için. Simge bir sürgü bloğudur ve sembolik olarak kaputun altındaki 
ayar düğmelerini temsil eder.

Kısaca. Ana fikir açık sözcüklerle — jargonsuz, kodsuz. Bir işlevin ne işe yaradı
ğını ve ne zaman ihtiyacın olacağını sadece hızlıca öğrenmek istiyorsan önce bu 
bölümü oku. Simge bir konuşma balonudur ve „özetle“ anlamına gelir. Bu sütun 
her zaman sıcak bir kum tonlu zemin üzerindedir, böylece göz onu hemen bulur.

B Ö L Ü M  R E N K L E R İ

Her bölümün kendine ait bir vurgu rengi vardır; bu rengi her girdi başlığının solundaki ID 

etiketinden (ör. M1 ) ve önündeki küçük simgelerden tanırsın. Sayfalar arasında gezer
ken hangi bölümde olduğunu bir bakışta görürsün.

1 Menüler 2 Inspector 3 Ayarlar 4 Yardımcı pencereler 6 Eğitim

7 Önayarlar 8 Dışa aktarmalar 9 SfM 10 Başlangıç modu

N AV İ G A S YO N  İ P U Ç L A R I



Hızlı başlangıç. Yalnızca uygulamanın nasıl kullanılacağıyla ilgileniyorsan doğru
dan Bölüm 10 — Başlangıç modu’na atla. Dört adımlı rehberli sürümdür ve hiçbir 
ön bilgi gerektirmez.

Daha derin bir giriş. Bölüm 2 — Inspector ve Bölüm 7 — Önayarlar Uzman 
modunda kullanabileceğin kontrolleri ve hazır kalite profillerini açıklar.

Başvuru. İçindekiler ve PDF tam metin araması belirli bir işlevi bulmana yardımcı 
olur. Kılavuzu baştan sona okumak zorunda değilsin.



R A D I A N C E K I T

B Ö L Ü M

Giriş — Bilmeniz gerekenler

RadianceKit nedir?

RadianceKit, sıradan bir dizi fotoğraftan ya da bir videodan içinde gezilebilen bir 3D 
yeniden yapılandırma üreten yerel bir macOS uygulamasıdır. Girdi, örneğin bir nesnenin 
etrafında, bir mekânda ya da bir manzara boyunca çektiğin 50 ile 500 arası kareden 
oluşur. Çıktı, Gaussian Splatting sahnesi denen şeydir — Mac’inde gerçek zamanlı olarak 
her açıdan inceleyebildiğin, dışa aktarıp web sitelerine gömebildiğin ve ana yönleriyle 
fotorealistik görünen bir 3D modeldir.

Uygulama tamamen Mac’inde yerel olarak çalışır — hiçbir görüntü buluta yüklenmez, 
oturum açma istenmez, abonelik yoktur. Apple Silicon Mac’inin (M serisi) GPU’sunu 
yoğun biçimde kullanır: bir tam eğitim, sahneye ve önayara bağlı olarak iki dakikadan 
birkaç saate kadar sürebilir. Hesaplama sürerken Mac’inde normal şekilde çalışmaya 
devam edebilirsin; RadianceKit arka planda çalışır ve sonuç hazır olduğunda seni bilgi
lendirir.

İki kullanım modu vardır: Başlangıç modu (Simple Mode) seni dört adımda İçe aktar → 
Önayar seç → Eğit → Dışa aktar akışında yönlendirir. Uzman modu (Expert Mode) tüm 
ayar düğmeleri, canlı önizleme penceresi ve tanı grafikleri olan büyük bir Inspector açar. 
İstediğin zaman modlar arasında geçiş yapabilirsin; sahnedeki veriler korunur.

Gaussian Splatting nedir?

Gaussian Splatting (genellikle kısaca 3DGS ya da yalnızca Splatting), fotorealistik 3D 
temsil için görece yeni bir yöntemdir; 2023′te Graz ve INRIA’dan bir makalede sunuldu. 
Fikir şudur: bir sahneyi klasik bir poligon ağı (üçgenler) ya da bir voksel ızgarası olarak 
modellemek yerine, sahne milyonlarca küçük, yumuşak 3D “bulutçuk”tan oluşturulur — 
her tekil bulutçuk kendi konumu, boyutu, şekli, rengi ve saydamlığı olan bir 3B Gauss 
dağılımıdır (adı buradan gelir). Bu bulutçuklar, girdi fotoğraflarının her bakış açısından 
birlikte doğru görüntüyü üretecek şekilde eğitilir.

Pratikte bu, Gaussian Splatting’in yansımaları, parlaklıkları, yumuşak yaprakları, saçları 
ya da perdeleri klasik 3D modellemenin yapamayacağı — ya da yalnızca devasa bir 
maliyetle yapabileceği — biçimde temsil edebileceği anlamına gelir. Karşılığında sonuç, 

3 / 231



R A D I A N C E K I T Giriş — Bilmeniz gerekenler

klasik anlamda düzenlenebilir bir 3D model değildir — tek bir duvarı kaydırıp bir vazoyu 
yeniden yerleştiremezsin. Daha çok, içinde özgürce hareket edebildiğin dondurulmuş bir 
uzay yakalaması gibidir. Mimari görselleştirme, ürün sunumu, sanal turlar, adli inceleme, 
kültürel miras gibi pek çok uygulama için tam da bu doğru güç noktasıdır.

Girdi görüntülerinin 3D sahneye dönüşmesi için iki adım gereklidir. Önce uygulama, St­
ructure-from-Motion (SfM) adlı bir süreçle kameranın her fotoğrafta nerede durduğunu 
hesaplar. Yan ürün olarak bu işlemden sahnenin kabaca bir nokta bulutu çıkar. Ardından 
asıl Gaussian Splatting eğitimi başlar: bu kaba buluttan yola çıkarak milyonlarca 3D bu
lutçuk kademeli olarak dağıtılır, büyütülür, ince ayarlanır ve tüm girdi açılarından eşleşen 
görüntüyü üretene dek konum ve renkte yeniden ayarlanır.

RadianceKit’i kullanmak için bunların hiçbirini bilmen gerekmez. Başlangıç modu bu 
adımları tamamen gizler. Ama Uzman modundaki tanı sayılarının (iterasyon, kayıp, gaus
sianlar, SSIM …) ne anlama geldiğini ya da neden bazı sahnelerin diğerlerinden daha 
güzel çıktığını anlamak istersen, kılavuzun sonraki bölümlerinde yanıtları bulursun.
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B Ö L Ü M

Bölüm 1 — Menü Çubuğu

RadianceKit’in menü çubuğu, doğrudan ana pencerede veya Inspector’da yer almayan 
tüm işlevleri toplar. Bunlar her şeyden önce tüm sahneyi etkileyen eylemler (Aç, Kaydet, 
Yeni Proje), eğitimi kontrol eden eylemler (Başlat, Duraklat, Sürdür), görüntüleyiciyi kul
lanan eylemler (Otomatik döndürme, ekran görüntüsü, arka plan rengi) ve çeşitli 3D ve 
medya biçimlerinde dışa aktarmalardır. Buna ek olarak tüm yardımcı pencerelere (User 
Guide, Pareto Dashboard, Holdout Analysis, BayesOpt Console) atlama noktaları gelir.

Klavye kısayolları her menü girdisinin sağında yer alır. Kurallar: ⌘  Command tuşu (elma 
tuşu), ⇧  Shift, ⌥  Option (Alt) ve ⌃  Control anlamına gelir. Örnek: ⇧⌘T , Shift+Com
mand+T’dir. Burada belgelenen tüm kısayollar Help → Keyboard Shortcuts (⌘/​) ile ayrıca 
kendi genel görünüm penceresinde listelenir.

Aşağıdaki 42 girdi envanter sırasında (M1–M42) belgelenmiştir, ilgili üst düzey menüye 
göre gruplanmıştır. Tüm girdiler güncel kod durumuna karşı (175–477 satırlar) doğrulan
mıştır. Hiçbir girdi envantere göre kaldırılmamış veya geçersiz kılınmamıştır; yeni bir Edit 
menüsü girdisi („Remove Image“ için Cmd-Z) sistem NSUndoManager çatısı tarafından 
sağlanır ve bu nedenle RadianceKitApp kodunda görünmez (bölüm sonundaki nota bak).

File menüsü

Şekil 1:  Dosya menüsü açık — M1′den M6′ya girdiler
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R A D I A N C E K I T Bölüm 1 — Menü Çubuğu

File menüsü, Apple’ın standart „New Window“ girdisini proje özel eylemlerle değiştirir. 
Sahne yükleme/kaydetme, dinamik bir son açılanlar listesi, Workspace içe aktarma ve 
boş duruma sert sıfırlamayı kapsar.

M1 File > Open Scene…

N E R E D E

Menü çubuğu → File → Open Scene… (⌘O).

T E K N İ K

RadianceScene  paketi, .ply , .splat  ve .spz  
biçimleri için bir dosya diyaloğu açar. Tek seçim, 
hem dosyaları hem de dizinleri gösterebilir (pa
ket biçimi için). Başarılı bir seçimden sonra yol 
son açılanlar listesine eklenir ve sahne eşzamansız 
olarak yüklenir — öncekinin yerini alır ve eğitim 
pipeline’ı yüklenen durumla başlatılır. PLY/SPZ/Splat 
dosyaları ilgili biçim yükleyiciler aracılığıyla okunur; 
.radiancescene  paketi manifest, bulut anlık görün

tüsü ve SfM sonuçlarını içeren bir dizindir.

K I S ACA

Önceden eğitilmiş bir sahneyi 
uygulamaya nasıl yeniden yük­
lersin. RadianceKit’in kendi biçi­
mi ile ve diğer splatting program­
larının ürettiği PLY, SPLAT ve SPZ 
standart biçimleriyle çalışır. Ör­
neğin bir sahneyi gece eğitip er­
tesi gün devam etmek veya dışa 
aktarmak istiyorsan kullan. Açma 
sırasında ana penceredeki mev­
cut durum değiştirilir — mevcut 
sahne hâlâ senin için önemliyse 
önce kaydet. Yol otomatik olarak 
„Open Recent“ (M3) listesine gi­
rer, böylece bir sonraki sefer da­
ha hızlı erişirsin.

M2 File > Save Scene…

N E R E D E

Menü çubuğu → File → Save Scene… (⌘S).

T E K N İ K

İçerik türü RadianceScene  paketi ve önceden dol
durulmuş scene.radiancescene dosya adıyla bir 
kaydet diyaloğu açar. manifest.json , serileştirilmiş 
Gaussian bulutu (PLY anlık görüntüsü) ve SfM sonu
cunun bir dökümünü içeren bir dizin paketi yazar; 
böylece yeniden açıldıktan sonra Continue Training 
de çalışır. Henüz Gaussian yoksa girdi devre dışı
dır. Eğitim günlüklerinin yoluna değil, kaydet diyalo
ğunun gösterdiği yere kaydeder — tipik olarak ~/​
Documents/​ altında.

K I S ACA

Mevcut sahneni bir dosya olarak 
(daha doğrusu: dosya gibi gö­
rünen bir paket klasörü olarak) 
kaydeder. Ancak ondan sonra 
bu sahneyi „Open Scene…“ (M1) 
ile sonradan açabilirsin. Paket­
te hem Gaussian bulutu hem 
de SfM sonucu yer alır, böylece 
Continue Training (M12–M14) ek­
lemeyi sonradan da yapabilirsin. 
Henüz bir eğitim tamamlamadıy­
san girdi griye alınır. Varsayılan 
ad scene.radiancescene’tir 
— ama Save diyaloğunda kendi 
adını verebilirsin.
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R A D I A N C E K I T Bölüm 1 — Menü Çubuğu

M3 File > Open Recent > [Sahne adları]

N E R E D E

Menü çubuğu → File → Open Recent → (Liste).

T E K N İ K

Son açılan yollar listesinden (Ayarlar’da saklanır) 
oluşturulan dinamik alt menü. Her liste girdisi dos
ya adıyla adlandırılır ve tıklandığında yüklenir. Liste 
boşsa, devre dışı „No Recent Scenes“ etiketi görü
nür. Apple tarzında liste son N açılmış sahneyi tutar 
— sınırlama, Ayarlara yazarken yapılır, menü oluştu
rucunun kendisinde değil.

K I S ACA

Burada son açılan sahneleri gö­
rür ve dosya diyaloğundan geç­
mek zorunda kalmadan tek bir 
tıklamayla yeniden atlayabilirsin. 
Daha yeni başladıysan, liste boş­
tur ve menüde gri görünür. „Open 
Scene…“ (M1) üzerinden açtığın 
her sahne otomatik olarak bu 
listeye girer. Liste bir noktada 
çok dolarsa veya gizlilik için 
temizlemek istersen, „Clear Re­
cent” (M4) kullan.

M4 File > Open Recent > Clear Recent

N E R E D E

Menü çubuğu → File → Open Recent → Clear Re
cent.

T E K N İ K

Ayarlardaki son açılanlar listesini temizler. Onay di
yaloğu olmadan hemen etki eder. Girdi yalnızca son 
açılanlar listesinde gerçekten girdi varsa alt menüde 
görünür (yollardan sonra bir ayırıcının altında bulu
nur).

K I S ACA

Son açılan sahnelerin listesini si­
ler. Bir test veri setiyle oynamış 
ve artık yolları görmek istemedi­
ğinde pratiktir. Sahne dosyaları­
nın kendisi silinmez — yalnızca 
menüdeki bağlantı. Eylem soru­
suz hemen etki eder; ardından alt 
menüde „No Recent Scenes“ gö­
rünür. Girdi yalnızca listede sah­
ne varsa belirir — liste boşken 
görünmez.
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R A D I A N C E K I T Bölüm 1 — Menü Çubuğu

M5 File > Import COLMAP / Metashape Workspace…

N E R E D E

Menü çubuğu → File → Import COLMAP / Metasha
pe Workspace… (⇧⌘I).

T E K N İ K

Bir klasör seçici açar. COLMAP Workspace düzeni
ne sahip bir klasör bekler (ör. sparse/​0/​cameras.
{bin,txt} artı images/​). Seçimden sonra Works
pace ön kontrolü gerçekleştirilir — bu, üç düzeni 
(sparse/​0/​, sparse/​, kök) ve yeniden yapılandır
manın ikili ( cameras.bin ) mi yoksa ETH3D metni 
( cameras.txt ) mi olduğunu algılar. Başarılı olursa 
Workspace içe aktarılır; aksi takdirde yalnızca uygu
lama günlüğünde bir uyarı görünür. Tam pipeline 
mantığı için ayrıca Bölüm 9 „SfM Arka Uçları“nda 
Q6′ya bak.

K I S ACA

Metashape, COLMAP, RealityCap­
ture veya benzer bir yazılımı ka­
mera yeniden yapılandırması için 
kullanıyorsan ve bir dışa aktar­
man varsa klasörü buraya yük­
lersin. RadianceKit ardından SfM 
aşamasını atlar ve doğrudan eği­
time başlar — bu, büyük sah­
nelerde saatler kazandırır. Ana 
pencereye sürükle-bırak da aynı 
şekilde çalışır. COLMAP düzenli 
(yani cameras.*  artı images/​ 
klasörüyle sparse/​0/​) bir kla­
sör beklenir. Desteklenen düzen­
ler ve iş akışları hakkında daha 
fazlası Bölüm 9 „SfM Arka Uçla­
rı“nda var.

M6 File > New Project

N E R E D E

Menü çubuğu → File → New Project (⇧⌘N).

T E K N İ K

Kaydedilmemiş çalışma olup olmadığını kontrol eder. 
Varsa, bir şey kaybolmadan önce bir onay diyaloğu 
görünür. Kaydedilecek bir şey yoksa sıfırlama doğ
rudan çalışır — içe aktarılan görüntüleri, SfM sonu
cunu, Gaussian bulutunu, eğitim durumunu ve tüm 
bağımlı UI göstergelerini temizler. Dikkat: Kullanıcı 
tarafından oluşturulan önayar kütüphanesi korunur, 
çünkü proje durumunda değil uygulama ayarlarında 
bulunur.

K I S ACA

Her şeyi boş bir başlangıca sıfır­
lar — sanki uygulamayı yeni aç­
mışsın gibi. Henüz kaydedilme­
miş çalışman varsa uygulama ön­
ce sorar. Tamamen farklı bir sah­
neyle başlamak istediğinde bunu 
kullan. İçe aktarılan görüntüler, 
SfM sonucu, Gaussian bulutu ve 
eğitim durumu tamamen boşal­
tılır. Ama kendi önayarların koru­
nur, çünkü uygulama ayarlarında 
yer alırlar ve sahneye ait değil­
dirler.
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Mode menüsü

Şekil 2:  Simple ve Expert mod anahtarlı Mode menüsü

Rehberli Simple Mode (sihirbaz tarzı, 4 adım) ile tam Expert Mode (tüm kontrollerle 
klasik Inspector düzeni) arasında iki basit anahtar.

M7 Mode > Simple Mode

N E R E D E

Menü çubuğu → Mode → Simple Mode (⌘1).

T E K N İ K

Uygulama durumunu Simple Mode’a değiştirir. Uy
gulamanın ana alanı ardından Expert düzeni yerine 
rehberli iş akışını gösterir. Mod durumu Ayarlarda 
saklanır (Bölüm 3 Ayarlar’da S1 „Default Mode“ 
bkz.).

K I S ACA

Adım adım sürüme geçer; uygu­
lama seni İçe aktarma, İşleme, 
Önizleme ve Dışa aktarma boyun­
ca yönlendirir. Daha yeni başlı­
yorsan ya da hızlıca bir sonuca 
ihtiyacın varsa önerilir. Çoğu de­
tay kontrolü gizlenmiştir — an­
lamlı ön ayarlarla çalışırsın. Daha 
sonra daha derine inmek isti­
yorsan Expert Mode’a (M8) geç. 
Uygulama başlatıldığında hangi 
modun aktif olacağını Ayarlar’da 
(Bölüm 3, S1) belirleyebilirsin.
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M8 Mode > Expert Mode

N E R E D E

Menü çubuğu → Mode → Expert Mode (⌘2).

T E K N İ K

Uygulama durumunu Expert Mode’a değiştirir. Böy
lece tüm bölümlerle tam Inspector düzeni görünür 
(Presets, TrainingConfig, Enhancements, Metrics, 
LossChart, ProjectNavigator). Expert Mode’da tüm 
eğitim parametreleri, COLMAP seçici, Mid-Compact 
anahtarları ve tanı bilgileri erişilebilirdir. Canlı önizle
me de yalnızca bu modda çalışır.

K I S ACA

Tüm kontrollerle tam görünüme 
geçer. Burada kayıp grafiğini ger­
çek zamanlı görürsün, tüm pa­
rametreleri ince ayarlayabilirsin 
ve önayarlar üzerinden birden 
çok karşılaştırma yapılandırma­
sını paralel yönetebilirsin. Eğiti­
min içeride ne yaptığını anlamak 
veya hedefli deneyler yapmak is­
tiyorsan önerilir. Canlı önizleme, 
COLMAP seçici ve tanı bilgileri 
de yalnızca buradan erişilebilir. 
Bunaltırsa M7 üzerinden Simple 
Mode’a geri dön — sahnen koru­
nur.

Training menüsü

Şekil 3:  Continue alt menüsü ile Training menüsü — M9′dan M14′e girdiler

Eğitim çalıştırması etrafında dört eylem: başlat, duraklat, iptal et ve belirli bir iterasyon 
sayısı kadar uzat. Üç Continue girdisi de IAP korumalıdır (ücretsiz deneme sürümünde 
tıklanamaz).
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M9 Training > Start Training

N E R E D E

Menü çubuğu → Training → Start Training (⇧⌘T).

T E K N İ K

Eğitim pipeline’ını eşzamansız olarak başlatır. Ön
koşul: bir SfM sonucu mevcut ve şu anda baş
ka bir pipeline çalışmıyor. Karşılanmadığı takdir
de her iki koşul da girdiyi engeller. Başlatıldı
ğında mevcut yapılandırma değerleri okunur, ~/​
Documents/​RadianceKit/​Logs/​training_​YYYY-MM-DD_​

HHmmss.jsonl altında yeni bir JSONL günlüğü oluş
turulur ve strateji seçimine bağlı olarak klasik veya 
MCMC yolu çalıştırılır. Eğitim durumu „idle“dan „tra
ining”e geçer.

K I S ACA

Büyük yeşil düğmeye basar — fo­
toğrafları içe aktardığında ve ka­
mera yeniden yapılandırması bit­
tiğinde, asıl Gaussian Splatting 
eğitimi başlar. Uygulamayı çalı­
şır bırak; önayara göre 1 dakika 
(Quick) ile birkaç saat (MCMC 
Quality) arasında. SfM sonucu 
yoksa veya başka bir pipeline 
çalışıyorsa girdi gri kalır. Her ça­
lıştırma yan yana ~/​Documents/​
RadianceKit/​Logs/​ içine bir 
günlük yazar; bunu daha sonra 
Pareto Dashboard (M40) üzerin­
den değerlendirebilirsin.

M10 Training > Pause Training

N E R E D E

Menü çubuğu → Training → Pause Training.

T E K N İ K

Çalışan eğitimi duraklatır. Yalnızca eğitim durumu 
„training“ ise etkinleştirilir. Duraklatma, iterasyon 
döngüsünü bir sonraki güvenlik senkronizasyon 
noktasında durdurur, tam GPU durumunu (Gaussian 
buffer’ları, optimizer momentleri, scheduler konu
mu) korur ve „paused”a geçer. Tekrar basmak sür
dürür (girdi başlığı statiktir — ama uygulama gerçek 
mantıkta pause/resume arasında geçer). Duraklatı
lan eğitimler uygulama çıkışından sağ çıkmaz; bu 
durumda sahneyi kaydet ve daha sonra Continue 
Training girdisi (M12–M14) ile genişlet.

K I S ACA

Eğitimi ilerlemeyi kaybetmeden 
kısa süreliğine durdurur. Bilgisa­
yara kısa süreliğine daha önemli 
bir şey için ihtiyacın olduğun­
da pratiktir. Tekrar tıklamak sür­
dürür. Uygulama yeniden başlat­
malarında çalışmaz — gerçekten 
sonradan devam etmek istiyor­
san, eğitimi Cancel (M11) ile bi­
tir, sahneyi Save Scene (M2) ile 
kaydet ve ardından Continue Tra­
ining (M12–M14) kullan. Durakla­
ma sırasında GPU tamamen din­
lenir; ama bellek meşgul kalır.
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M11 Training > Cancel Training

N E R E D E

Menü çubuğu → Training → Cancel Training.

T E K N İ K

Çalışan eğitimi iptal eder. Eğitim durumu „idle“ de
ğilse aktiftir. Eğitim motorundaki cancel bayrağını 
ayarlar; bu, iterasyon döngüsünü bir sonraki sync 
noktasında temiz biçimde bitirir, son özet girdisini 
JSONL günlüğüne yazar ve durumu „idle”a sıfırlar. 
O ana kadar eğitilmiş bulut korunur (kaydedilebilir 
veya dışa aktarılabilir), ama „cancelled“ olarak işa
retlenir.

K I S ACA

Çalışan eğitimi kesin olarak ip­
tal eder. Mevcut durum korunur 
— yani birkaç bin iterasyondan 
sonra zaten gösterilebilir bir so­
nucun varsa, sonradan yine de 
dışa aktarabilirsin. Yalnızca kısa 
süreliğine durdurmak istiyorsan, 
bunun yerine Pause (M10) kul­
lan. Eğitim günlüğünde çalıştır­
ma „cancelled“ olarak işaretlenir, 
son kayıp değeri yine de yazı­
lır. İptal edilen bir sahneyi, ara­
da uygulama bitirilmediği süre­
ce, daha sonra Continue Training 
(M12–M14) ile de sürdürebilirsin.

M12 Training > Continue Training > +5 000 iterations

N E R E D E

Menü çubuğu → Training → Continue Training → 
+5,000 iterations.

T E K N İ K

Eğitimi 5 000 iterasyon kadar sürdürür. Tamamlan
mış bir eğitim sürdürülebilirse ve tam sürüm etkin
leştirilmişse aktif olur. Sürdürülebilirlik, tamamlanmış 
bir eğitim varsa ve tam optimizer durumu hâlâ 
bellekte ise geçerlidir. Continue sırasında Adam mo
mentleri ve LR scheduler sürdürülür, böylece devamı 
yeni baştan başlatma yerine kesintisiz 25K/45K/60K 
çalıştırma gibi davranır. JSONL günlüğü artımlı kuru
lumla yeni bir config girdisi alır. Yalnızca tam sürüm
de mevcuttur.

K I S ACA

5 000 ek eğitim adımı ekler. İlk 
çalıştırmadan sonra sonuç yakın 
ama henüz tam keskin değilse 
bunu kullan. Yalnızca ücretli tam 
sürümde çalışır. Tamamen yeni 
bir çalıştırmadan farklı olarak op­
timizer durumu korunur, böylece 
devamı kesintisiz bir çalıştırma 
gibi hissettirir. 5 000 adımdan 
fazlasına ihtiyacın varsa, doğru­
dan M13 (+10 000) veya M14 (+20 
000) al.
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M13 Training > Continue Training > +10 000 iterations

N E R E D E

Menü çubuğu → Training → Continue Training → 
+10,000 iterations.

T E K N İ K

M12 ile aynı, ama 10 000 ek iterasyonla. Aynı önko
şullar, aynı LR scheduler yolu. İlk eğitim orta katman 
bir önayarla yapıldıysa ve çalıştırmayı tamamen ye
niden başlatmadan önemli bir kalite artışı görmek 
istiyorsan önerilir.

K I S ACA

Eğitimi 10 000 adım uzatır — 
üç kullanılabilir Continue değeri­
nin orta olanı. İlk çalıştırma iyi 
gitti ama belirgin biçimde daha 
iyi olmak istiyorsan iyi bir seçim­
dir. M12 ve M14 gibi, öğrenme 
hızı seyri yeniden başlatma yeri­
ne kesintisiz sürdürülür. Yalnızca 
tam sürümde mevcuttur.

M14 Training > Continue Training > +20 000 iterations

N E R E D E

Menü çubuğu → Training → Continue Training → 
+20,000 iterations.

T E K N İ K

M12 / M13 ile aynı, ama 20 000 ek iterasyonla. Ön
ceden tanımlı en büyük Continue sıçraması. MCMC 
eğitimlerinde sıklıkla „yeterli“ ile „benchmark uy
gun” arasındaki farkı yaratan budur; Classic’te 35–
40K’dan sonra deneyimsel olarak az şey eklenir.

K I S ACA

20 000 ek eğitim adımı ekler, 
maksimum Continue değeri. Ger­
çekten son bir kalite damlasını 
çıkarmak istiyorsan bunu kullan. 
Klasik eğitimde 40 000 adımdan 
sonra bu çoğu kez fazla bir şey 
getirmez — MCMC’de ise yakın­
sama daha yavaş başladığı için 
sıkça zahmete değer. Sahneye 
göre belirgin ek çalışma süresi 
öngör. M12 ve M13 gibi bu girdi 
de yalnızca tam sürümde mev­
cuttur.
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Viewport menüsü

Şekil 4:  Düzenleme modu, kamera kontrolü ve arka plan alt menüsüyle Görüntüleyici menüsü

3D görüntüleyiciyi kontrol eder: Gaussian seçimi ve temizlik için Edit Mode, kamera 
kontrolü (otomatik döndürme, oynatma, kayıt), ekran görüntüsü, arka plan rengi ve sıfır
lama.

M15 Viewport > Enter/Exit Edit Mode

N E R E D E

Menü çubuğu → Viewport → Enter Edit Mode (veya 
duruma göre „Exit Edit Mode“). ⇧⌘E.

T E K N İ K

Girdi başlığı dinamiktir ve duruma göre „Exit Edit 
Mode“ veya „Enter Edit Mode” gösterir. Basıldığında 
görüntüleyici render’cısında Edit Mode değiştirilir. 
Edit Mode’dan çıkıldığında ayrıca mevcut seçim sı
fırlanır. Edit Mode, Gaussian’lar üzerinde tıklamayla 
seçimi, kutu seçimini ve işaretlenen Gaussian’ları 
silmeyi etkinleştirir (UI’nın editör alanına bak). Gö
rüntüleyici render’cısı bağlı olmadığı sürece devre 
dışıdır.

K I S ACA

Normal 3D görünüm ile tekil 
Gaussian’ları işaretleyip silebi­
leceğin (örneğin arka plandaki 
floater’lar veya aykırı değerler) 
bir düzenleme modu arasında 
geçiş yapar. Çıkışta seçim oto­
matik olarak sıfırlanır. Görüntüle­
yicide henüz bir sahne görünür 
değilken girdi gri kalır. Etiket du­
ruma göre „Enter Edit Mode“ ile 
„Exit Edit Mode” arasında değişir 
— böylece hangi modda olduğu­
nu her zaman görürsün.
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R A D I A N C E K I T Bölüm 1 — Menü Çubuğu

M16 Viewport > Toggle Auto-Rotation

N E R E D E

Menü çubuğu → Viewport → Toggle Auto-Rotation 
(⌘⌥T).

T E K N İ K

Görüntüleyici kamerasının sahne merkezinden ge
çen dikey bir eksen etrafında sürekli dönüşünü açar 
veya kapatır. Eksen ve hız kamera kontrol yapılandır
masından gelir. Otomatik döndürme yalnızca bir gö
rüntüleyici etkisidir ve ne eğitimi ne de kaydı etkiler 
— paralel olarak turntable video kaydedicisini (M18) 
kullanırsan, otomatik döndürme tam olarak kaydedi
cinin yakaladığı yolu sağlar.

K I S ACA

Kameranı sahnenin etrafında sü­
rekli yavaş döndürür, böylece fa­
reyle çekmeden onu her açıdan 
görebilirsin. Tekrar tıklamak dön­
dürmeyi durdurur. Eğitilmiş sah­
neleri değerlendirirken veya canlı 
demo için arka plan animasyo­
nu olarak pratiktir. Paralel olarak 
bir video kaydediyorsan (M18), 
otomatik döndürme tam olarak 
kaydedicinin yakaladığı hareketi 
sağlar.

M17 Viewport > Toggle Camera Playback

N E R E D E

Menü çubuğu → Viewport → Toggle Camera Play
back.

T E K N İ K

Kamera yolu oynatımını değiştirir. Kaydedilmiş bir 
kamera yolu varsa (ör. önceki bir kayıttan veya bir 
transforms.json  yüklendiği için), yol oynar — gö

rüntüleyici kamerası artık fare/trackpad girdilerine 
göre hareket etmez, yörüngeyi kare kare yeniden 
üretir. Tekrar basmak oynatmayı duraklatır.

K I S ACA

Daha önce kaydedilmiş veya içe 
aktarılmış bir kamera çekimini 
oynatır. Böylece sahnenin orijinal 
yolunu tekrar görebilir veya vi­
deo dışa aktarmadan önce plan­
lanan bir orbit hareketini kont­
rol edebilirsin. Oynatma sürerken 
fare ve trackpad girişleri devre 
dışıdır — kamera kesinlikle yolu 
takip eder. Tekrar tıklamak oy­
natmayı duraklatır. Bir kamera 
yolu yüklemediysen veya kaydet­
mediysen hiçbir şey olmaz.
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M18 Viewport > Record Turntable Video

N E R E D E

Menü çubuğu → Viewport → Record Turntable Vi
deo.

T E K N İ K

Görüntüleyici kaydını değiştirir. İlk basıldığında geçi
ci bir yola kare kaydı başlar; ikinci basıldığında kayıt 
biter, kodlanır ve bir MP4 yoluna yazılır (yol bir 
kaydet diyaloğu ile sorulur). Sabit bir 360° yolda 
ayarlanabilir süreli bir video üreten Export → Media 
→ Orbit Video’dan (M31) farklı olarak, Turntable Re
corder, görüntüleyicide gördüklerini canlı kaydeder 
— yani manuel bir kamera çekimi de kaydedebilirsin.

K I S ACA

Doğrudan görüntüleyicide bir vi­
deo kaydeder. Kameranın otoma­
tik dönmesi veya kendin fareyle 
hareket ettirmen fark etmez — 
gördüğün her şey bir MP4 dos­
yasına kaydedilir. „Orbit Video“ 
dışa aktarmasından (M31) farklı 
olarak kamera çekimini kendin 
belirlersin. İlk tıklama kaydı baş­
latır, ikinci tıklama bitirir ve kayıt 
konumunu sorar. Örneğin sabit 
orbit hareketle mümkün olmayan 
belirli bir detay panoramasını 
göstermek istediğinde pratiktir.

M19 Viewport > Save Screenshot

N E R E D E

Menü çubuğu → Viewport → Save Screenshot 
(⇧⌘S).

T E K N İ K

Tek bir görüntüleyici karesini tam render çözünürlü
ğünde (yani pencere piksel düzeni değil, tam render 
hedef içeriği) bir PNG dosyası olarak yakalar. Yol bir 
kaydet diyaloğu ile sorulur. Arka plan rengi (M21–
M23) içine yakılır. Etkinse Enhancements’tan (I27/
I28′e bak) MetalFX/MPS yukarı ölçekleme ayarları 
etkili olur — ekran görüntüsü yani yukarı ölçeklenen 
çıktıyı gösterir.

K I S ACA

Mevcut 3D görünümünün bir an­
lık görüntüsünü PNG resmi olarak 
kaydeder. Pazarlama malzemesi 
veya hızlı bir karşılaştırma için 
pratiktir. Dikkat: Arka plan görün­
tünün bir parçasıdır — saydamlı­
ğa ihtiyacın varsa, sahne dosyası 
dışa aktarman daha iyidir. Çözü­
nürlük, pencere boyutuna değil, 
dahili render hedefine karşılık 
gelir — yani görüntü genellikle 
penceredekinden daha keskindir. 
Olası yukarı ölçekleme ayarları 
(Inspector → Enhancements) de 
buna dahildir.
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R A D I A N C E K I T Bölüm 1 — Menü Çubuğu

M20 Viewport > Copy Camera Info

N E R E D E

Menü çubuğu → Viewport → Copy Camera Info.

T E K N İ K

Mevcut görüntüleyici kamera pozunu (konum, bakış 
noktası, yukarı vektörü) ve FOV değerlerini kamera 
kontrolünden okur ve panoya çok satırlı metin olarak 
yazar. Biçim insan okunabilirdir (satır başına etiket = 
değer), JSON değil. Belirli bir görünümü hata ayıkla
ma amacıyla yeniden üretmek veya destekle paylaş
mak için pratiktir.

K I S ACA

Mevcut kamera konumunu ve ba­
kış yönünü metin olarak panoya 
kopyalar. Örneğin başka bir ge­
liştiriciye sahnede bir yerin nere­
den garip göründüğünü göster­
mek istiyorsan, metni doğrudan 
bir e-postaya veya sohbet pence­
resine yapıştırırsın. Biçim insan 
okunabilirdir (değer başına bir 
satır), JSON değil. Çoğunlukla ha­
ta raporları veya destek istekleri 
için tasarlanmıştır.

M21 Viewport > Background > Dark Gray

N E R E D E

Menü çubuğu → Viewport → Background → Dark 
Gray.

T E K N İ K

Görüntüleyici arka plan rengini koyu griye 
(RGB 0.1/0.1/0.1) ayarlar. Render’cı bu rengi, 
Gaussian’ların önünde birleştirildiği arka plan olarak 
kullanır. Uygulama başlatıldığında varsayılan rengi 
S3 „Default Viewport Background“ ayar seçeneği 
kontrol eder.

K I S ACA

3D görüntüleyicinin arka planını 
koyu griye boyar. Çoğu sahne 
için standart seçim — açık ya 
da koyu Gaussian’lara, gözün saf 
siyah ya da beyaz bir yüzeye 
takılmadan iyi bir kontrast sağ­
lar. Renk, ekran görüntülerinde 
(M19) ve orbit videolarda (M31) 
da alınır. Koyu gri sana çok sıra­
dan geliyorsa, karşılaştırma için 
Black (M22) veya White (M23)‘i 
de dene. Uygulama başlatıldığın­
da hangi rengin aktif olacağını 
Ayarlar’da (S3) belirleyebilirsin.
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M22 Viewport > Background > Black

N E R E D E

Menü çubuğu → Viewport → Background → Black.

T E K N İ K

Görüntüleyici arka plan rengini saf siyaha (RGB 
0/0/0) ayarlar. Sahnede çok parlak floater varsa ve 
onları tanımlamak istiyorsan veya koyu görünümlü 
pazarlama malzemesi için yardımcı olur.

K I S ACA

Siyah arka plan. Çok parlak sah­
neler için veya Edit Mode’a bakıp 
grinin içinde kaybolan küçük par­
lak Gaussian’ları (floater) arar­
ken iyidir. Koyu, dramatik bir 
görünümle pazarlama malzemesi 
için de idealdir. Renk ekran gö­
rüntülerine ve orbit videolarına 
yakılır — daha sonraki bir bileşim 
için saydamlığa ihtiyacın varsa, 
siyah en kötü seçimdir. Koyu 
floater için ters yönde White’a 
(M23) geç.

M23 Viewport > Background > White

N E R E D E

Menü çubuğu → Viewport → Background → White.

T E K N İ K

Görüntüleyici arka plan rengini saf beyaza (RGB 
1/1/1) ayarlar. Sahne çoğunlukla koyu içerik içeriyor
sa ve karanlık floater’ları (tipik dış mekân arka plan 
gürültüsü) görmek istiyorsan yararlıdır.

K I S ACA

Beyaz arka plan. Konu açık-koyu 
üzerinde daha iyi öne çıktığında 
veya daha sonra Edit Mode’da 
(M15) kaldırabileceğin koyu aykı­
rı değerleri bulmak için pratiktir. 
Dış mekân sahnelerde beyaz, ti­
pik dış mekân floater’larının da­
ha çok koyu olması nedeniyle 
sıklıkla siyahtan daha kullanışlı­
dır. Diğer arka plan seçenekleri 
gibi renk ekran görüntülerine ve 
videolara taşınır.
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M24 Viewport > Reset Camera

N E R E D E

Menü çubuğu → Viewport → Reset Camera.

T E K N İ K

Görüntüleyici kamerasını sıfırlar, eğitim kamerası 
görünümünü terk eder ve otomatik döndürmeyi dur
durur. Böylece kamera ilk konumuna geri döner 
(tipik: sahnenin önünde, hafifçe yukarıdan bakar), 
otomatik döndürme kapalıdır ve render’cı şu anda 
eğitim kamerasını (SfM pozlarından birini) gösteri
yorsa, serbest kameraya geri döner.

K I S ACA

Görüntüleyici kamerasını başlan­
gıç konumuna geri getirir. Çev­
rilirken kaybolduysan veya sah­
neyi görüntüden kaydırdıysan — 
buraya bir kez tıkla ve görmen 
gerekeni yeniden görürsün. Aynı 
zamanda çalışmaktaysa otomatik 
döndürmeyi de kapatır ve dondu­
rulmuş bir eğitim kamerasından 
serbest görünüme döner. Böyle­
ce her durumda görünümün te­
miz bir yeniden başlangıcını elde 
edersin.

Export menüsü

Şekil 5:  Üç alt menü grubuyla Dışa Aktar menüsü — 3D Formats, Media ve Photogrammetry

Sekiz dışa aktarma hedefi artı iki Photogrammetry dışa aktarması, üç bölümde grup
lanmış (3D Formats, Media, Photogrammetry). İlk altısı ortak bir yardımcı rutinle oluştu
rulur; her biri bir kaydet diyaloğu açar ve dışa aktarmayı biçim kataloğunda kaydeder. 
Photogrammetry girdileri kendine özgü mantığa sahiptir. Tüm Photogrammetry ve bazı 
3D dışa aktarmaları yalnızca tam sürümde mevcuttur.
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M25 Export > 3D Formats > Export PLY…

N E R E D E

Menü çubuğu → Export → 3D Formats → PLY (⌘E).

T E K N İ K

Varsayılan dosya adı gaussians.ply  ile bir kaydet 
diyaloğu açar. OK’de mevcut Gaussian bulutu stan
dartlaştırılmış ASCII/Binary PLY biçimine yazılır — 
SuperSplat, PolyCam, PlayCanvas ve tüm yaygın 
3DGS görüntüleyicileri ile uyumludur. Tam SH katsa
yıları, tam hassasiyet (alan başına Float32). Dosya 
boyutu ≥ 500K Gaussian’da sıklıkla birkaç yüz MB.

K I S ACA

3D sahneni standart PLY dos­
yası olarak kaydeder. Bu en 
evrensel biçimdir — neredey­
se her yazılım bunu yükleyebi­
lir, SuperSplat’tan PolyCam’e ve 
PlayCanvas’a kadar. Ama dosya­
lar büyür, sıklıkla birkaç yüz me­
gabayt. Tam kalitede sürdürmek 
veya arşivlemek istiyorsan PLY 
kullan. Sahneyi web üzerinden 
paylaşmak istiyorsan, SPZ (M27) 
veya Compressed PLY (M26) bak 
— bunlar çok daha küçüktür.

M26 Export > 3D Formats > Export Compressed PLY…

N E R E D E

Menü çubuğu → Export → 3D Formats → Compres
sed PLY.

T E K N İ K

Gaussian bulutunu konum, ölçek, dönüş ve SH 
alanlarının özel kuantizasyonlu Compressed-PLY bi
çiminde yazar. Sıkıştırılmamış PLY’den (M25) 5–
10× daha küçük dosyalar, minimum görsel kayıpla. 
SuperSplat (Compressed-PLY standardını okur) ve 
PlayCanvas ile uyumludur. Varsayılan dosya adı 
gaussians_​compressed.ply.

K I S ACA

Normal PLY gibi, ama 5–10 kat 
daha küçük. Kalite neredeyse ay­
nı kalır. Dosyayı çevrimiçi paylaş­
mak veya e-postayla göndermek 
istiyorsan bunu kullan. SuperSp­
lat ve PlayCanvas ile doğrudan 
çalışır. Ama hedef sistem daha 
küçük dosyalara ihtiyaç duyuyor­
sa (Mobil, tarayıcı demoları), bu­
nun yerine SPZ (M27) al — bu, 
daha da agresif sıkıştırılmıştır. 
Tam düzenleme kalitesi için sı­
kıştırılmamış PLY’yi (M25) al.
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M27 Export > 3D Formats > Export SPZ…

N E R E D E

Menü çubuğu → Export → 3D Formats → SPZ.

T E K N İ K

Gaussian bulutunu SPZ biçiminde yazar — Nian
tic tarafından yayınlanan, agresif kuantizasyonlu 
(sıkıştırılmamış PLY’den ~%90 daha küçük) sıkıştırıl
mış splat biçimi. Özellikle web görüntüleyicileri ve 
mobil uygulamalar için optimize edilmiştir. Niantic 
Splatt3R, gsplat.js ve Niantic tarayıcı görüntüleyicisi 
ile uyumludur.

K I S ACA

En küçük biçimlerden biri. Nor­
mal bir PLY’den yaklaşık 10× 
daha küçük. Bunu özellikle sah­
neyi tarayıcıda göstermek veya 
bir telefon uygulamasıyla görün­
tülemek istediğinde kullan. Mak­
simum kalite için PLY daha iyi 
bir seçimdir. SPZ Niantic tarafın­
dan geliştirilmiştir ve doğrudan 
gsplat.js, Splatt3R ve Niantic web 
görüntüleyicisi ile çalışır. Güçlü 
sıkıştırma nedeniyle SPZ dosya­
larını daha fazla eğitemezsin — 
düzenleme için PLY al.

M28 Export > 3D Formats > Export glTF…

N E R E D E

Menü çubuğu → Export → 3D Formats → glTF.

T E K N İ K

KHR_gaussian_splatting uzantısıyla bir .glb  dos
yası (Binary glTF) yazar. Standart uyumlu, 
Babylon.js veya Three.js gibi glTF motorlarını kulla
nan ve KHR_gaussian_splatting uzantısını uygulayan 
pipeline’lar için uygundur.

K I S ACA

Sahneyi birçok 3D programının 
ve web motorunun anladığı glTF 
biçiminde kaydeder — Gaussi­
an Splatting uzantısını destekle­
meleri koşuluyla. Belirli bir 3D 
pipeline’ın varsa (ör. Three.js ve­
ya Babylon.js) bunu anlıyorsa, bi­
çimin budur. Dosya ikili .glb  
olarak çıkar — her şeyi içeren tek 
bir paket. Klasik splatting iş akış­
ları için genellikle PLY veya SPZ 
daha iyi bir seçimdir, çünkü daha 
çok araç bunları doğrudan anlar.
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M29 Export > 3D Formats > Export .splat…

N E R E D E

Menü çubuğu → Export → 3D Formats → .splat.

T E K N İ K

Antimatter15 .splat  biçimini yazar — Gaussian 
başına sabit boyutlu 32 bayt (konum 3× Float32 ola
rak, ölçek 3× Float32 olarak, dönüş 4× Uint8 nor
malleştirilmiş dörtlü olarak, RGB+opaklık 4× Uint8 
olarak). DC’den daha yüksek SH katsayısı yok. 
Tarayıcı doğrudan uyumluluğuyla en küçük dosya. 
gsplat.js ve antimatter15′in çevrimiçi demo görüntü
leyicisi için.

K I S ACA

En basit web görüntüleyici bi­
çimi. Küçük ve her tarayıcıda 
hemen görüntülenebilir. Ama de­
tay aydınlatmayı kaybeder (daha 
yüksek SH katsayıları kaybolur — 
splat ışığa tepki vermek yerine 
her açıdan aynı görünür). Maksi­
mum web performansı için iyi, 
foto gerçekçilik için daha çok 
SPZ veya PLY. Antimatter15 çevri­
miçi görüntüleyicisi ve gsplat.js 
ile çalışır. Her Gaussian sabit 32 
bayt kaplar, bu biçimi basit ve 
uyumlu yapar — ama derinlik pa­
hasına.

M30 Export > 3D Formats > Export SOG…

N E R E D E

Menü çubuğu → Export → 3D Formats → SOG.

T E K N İ K

Gaussian bulutunu SOG biçiminde yazar. SOG 
(„Self-Organizing Gaussian“), kuantize verilerin te
xture atlas düzeni ve WebP sıkıştırmasıyla PlayCan
vas biçimidir. PLY’den 15–20× daha iyi boyut oranıy
la ölçeklenir. Dışa aktarma dahili olarak harici bir 
araç olarak cwebp  çağırır — bu yüzden sandbox sü
rümünde (App Store) potansiyel olarak kısıtlıdır.

K I S ACA

PlayCanvas iş akışları için çok 
küçük biçim. Veriler bir texture 
atlas düzenine paketlendiği ve 
WebP sıkıştırıldığı için PLY’den 
yaklaşık 15–20 kat daha küçük. 
PlayCanvas iş akışın yoksa, SPZ 
veya Compressed PLY genellikle 
daha iyi bir seçimdir. Dışa aktar­
ma dahili olarak harici araç ola­
rak cwebp  çağırır — App Store 
sürümünde (sandbox) bu adım 
kısıtlı olabilir.
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M31 Export > Media > Export Orbit Video…

N E R E D E

Menü çubuğu → Export → Media → Orbit Video.

T E K N İ K

Sahne merkezi etrafında 360° orbit render eder ve 
bunu MP4 (H.264) veya MOV (HEVC, sistem var
sayılanına bağlı) olarak kodlar. M18′in (canlı kayıt) 
aksine yol burada sabit önceden tanımlıdır — süre 
Ayarlar’da veya Simple Mode dışa aktarma adımında 
seçilir.

K I S ACA

Sahnen etrafında otomatik ola­
rak bir dönüş videosu üretir. Ma­
nuel hareket gerekmez. Sosyal 
medya veya hızlı bir demo için 
iyi. Kamerayı kendin kontrol et­
mek istiyorsan, bunun yerine Re­
cord Turntable Video (M18) kul­
lan. Yol sabittir: sahne merkezi 
etrafında tam 360° orbit, süre­
yi Ayarlar’da veya Simple Mode 
dışa aktarma adımında seçersin. 
Video sisteme göre H.264 MP4 
veya HEVC MOV olarak verilir.

M32 Export > Media > Export Web Viewer…

N E R E D E

Menü çubuğu → Export → Media → Web Viewer.

T E K N İ K

Bağımsız bir HTML görüntüleyici (gsplat.js tabanlı) 
artı base64 kodlu Gaussian verisini tek bir .html  
dosyasına paketler. Bu dosya her modern tarayıcıda 
çevrimdışı çalışır — sunucu bağımlılığı yok, harici 
URL yok. Dosya boyutu SPZ varyantından yaklaşık 
1.3 kat daha büyüktür (Base64 ek yükü nedeniyle).

K I S ACA

Sahneni kendi kendine başla­
yan web sayfası olarak kaydeder. 
HTML dosyasına çift tıkla → ta­
rayıcı açılır → hazır etkileşimli 
3D sahne. İnternet olmadan çalı­
şır, e-postayla gönderilebilir, so­
nuçları arkadaşlar veya müşteri­
lerle paylaşmanın en kolay yolu­
dur. Dosya, tek bir belgede tam 
gsplat.js görüntüleyicisini ve Ga­
ussian verilerini içerir — web’den 
hiçbir şey yüklenmez. Dosya bo­
yutu bir SPZ dışa aktarmasından 
yaklaşık üçte bir daha büyüktür, 
ama alıcının ek bir yazılıma ihti­
yacı yoktur.
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M33 Export > Photogrammetry > Export SfM (transforms.json)…

N E R E D E

Menü çubuğu → Export → Photogrammetry → Ex
port SfM (transforms.json).

T E K N İ K

Ayrı bir dışa aktarma yolu (ortak yardımcı ru
tin üzerinden değil), çünkü Gaussian bulutu ye
rine SfM sonucu dışa aktarılır. Varsayılan olarak 
transforms.json  ve içerik türü json  ile bir kay

det diyaloğu açar. OK’de kamera intrinsikleri, pozları 
(NeRF kuralında 4×4 matris olarak) ve kare yolları 
ile nerfstudio uyumlu bir transforms.json  yazılır. 
UI’da yardım metni, eğitim görüntülerinin kardeş 
images/​ klasörü olarak birlikte kopyalanması gerek
tiğini belirtir. Yalnızca SfM sonucu mevcutsa ve tam 
sürüm etkinleştirilmişse etkindir.

K I S ACA

SfM sonucunu nerfstudio, Brush, 
gsplat veya OpenSplat gibi baş­
ka bir yazılımda yeniden kullan­
mak istiyorsan, kamera konum­
larını buradan dışa aktarırsın. 
Eğitim görüntülerini ek olarak 
transforms.json  dosyasının 

yanında bir images/​ klasörüne 
yerleştir — aksi takdirde hedef 
program görüntüleri ilişkilendi­
remez. Henüz bir SfM sonucu 
yoksa girdi griye alınır ve ücret­
siz deneme sürümünde kilitlidir. 
COLMAP Workspace iş akışı için 
bunun yerine M34′ü al.

M34 Export > Photogrammetry > Export SfM (COLMAP Workspace)…

N E R E D E

Menü çubuğu → Export → Photogrammetry → Ex
port SfM (COLMAP Workspace).

T E K N İ K

Varsayılan ad colmap-workspace  (uzantı yok, çünkü 
bir klasör) ile bir kaydet diyaloğu açar. sparse/​0/​
cameras.bin, images.bin , points3D.bin  ile stan
dart bir COLMAP Workspace yazar. RadianceKit’te 
hesaplanan veya içe aktarılan bir SfM yeniden yapı
landırmasını Postshot, Nerfstudio veya Meshroom 
gibi diğer araçlarda açmaya veya bir A/B yeniden 
çalıştırmada (M5 üzerinden) RadianceKit’te zaten 
hesaplanmış girdi olarak yeniden yüklemeye izin ve
rir — hesaplama süresinden tasarruf sağlar. Yalnızca 
SfM sonucu mevcutsa ve tam sürüm etkinleştirilmiş
se etkindir.

K I S ACA

M33 gibi, ama nerfstudio ye­
rine COLMAP biçiminde. Posts­
hot, Meshroom, Nerfstudio veya 
başka bir COLMAP iş akışlı ara­
cı kullanıyorsan, dışa aktarman 
budur. Pratik bir yan etki: Bu 
klasörü daha sonra M5 üzerin­
den RadianceKit’e geri yükleye­
bilir ve bir sonraki çalıştırmada 
SfM hesaplama süresinden ta­
sarruf edebilirsin — özellikle bü­
yük sahnelerde saatlerce zaman 
kazandırır. M33 gibi yalnızca SfM 
sonucu mevcutsa ve ücretsiz de­
neme sürümünde kilitlidir.
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Help menüsü

Şekil 6:  Belgeleme, klasör ve analiz girdileriyle Yardım menüsü

Yedi girdi: iki belgeleme penceresi (User Guide, Keyboard Shortcuts), üç klasör kısayolu 
(Training Logs, Exports, Storage) ve üç analiz penceresi (Pareto Dashboard, Holdout 
Analysis, BayesOpt Console). Apple tarzında Help menüsü en sağda görünür. Standart 
Help menüsü tamamen RadianceKit’in kendi varyantıyla değiştirilir.

M35 Help > User Guide

N E R E D E

Menü çubuğu → Help → User Guide (⌘?).

T E K N İ K

User Guide penceresini açar. Konu kenar çubuğu ve 
kaydırılan detay alanıyla 860×640 varsayılan boyut
ta bir gezinme gösterir. İçerikler statik olarak yerleş
tirilmiştir (Markdown’dan ayrıştırılmamıştır).

K I S ACA

Uygulama içi kılavuzu açar. Bu 
el kitabındaki her şeyi okumak 
istemiyorsan, en önemli adımla­
rı doğrudan programda bulursun. 
Kılavuz konu kenar çubuğuyla ay­
rı bir pencere olarak kuruludur — 
yani belirli konulara hedefli bir 
şekilde atlayabilirsin. İçerikler bu 
el kitabından daha kısadır ve en 
sık iş akışlarına odaklanır.
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M36 Help > Keyboard Shortcuts

N E R E D E

Menü çubuğu → Help → Keyboard Shortcuts (⌘/).

T E K N İ K

Keyboard Shortcuts penceresini açar — üst düzey 
menüye göre gruplanmış tüm uygulama kısayolla
rıyla basit bir kaydırma düzeni. Varsayılan boyut 
440×560. İçerikler de statik olarak yerleştirilmiştir.

K I S ACA

Tüm klavye kısayollarının tam lis­
tesiyle bir pencere açar. Örne­
ğin hangi tuşla eğitimin başla­
tıldığını hatırlayamıyorsan, oraya 
bakarsın. Bir özet bu bölümün 
sonunda da bulunur. Liste üst 
düzey menüye göre gruplandırıl­
mıştır, böylece doğru alana hız­
lıca atlayabilirsin. Fare stilinden 
klavye stiline geçiyorsan yardım­
cıdır.

M37 Help > Open Training Logs…

N E R E D E

Menü çubuğu → Help → Open Training Logs… 
(⇧⌘L).

T E K N İ K

Günlük klasörünü ~/​Documents/​RadianceKit/​Logs 
olarak hesaplar, gerekirse oluşturur ve Finder’da 
açar. Her eğitim çalıştırması oraya kendi JSONL 
dosyasını training_​YYYY-MM-DD_​HHmmss.jsonl yazar.

K I S ACA

Tüm önceki eğitim protokolleri­
nin bulunduğu klasörü Finder’da 
açar. Bir şeyler ters gittiyse ve­
ya eğitimin tam olarak ne za­
man hangi değere yakınsadığı­
nı görmek istiyorsan, bunu bu­
rada JSONL dosyalarında bulur­
sun. Eğitim çalıştırması başına 
zaman damgalı tam olarak bir 
dosya oluşturulur — bunları baş­
ka araçlara da yükleyebilir veya 
e-postayla destekle paylaşabilir­
sin. Grafik bir değerlendirme isti­
yorsan, Pareto Dashboard (M40) 
daha iyi bir başlangıçtır.
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M38 Help > Open Exports Folder…

N E R E D E

Menü çubuğu → Help → Open Exports Folder…

T E K N İ K

M37′ye benzer, ama ~/​Documents/​RadianceKit/​
Exports ile. İlk otomatik test çalıştırmasında veya 
ilk tıklamada oluşturulur; ardından tüm otomatik test 
dışa aktarmalarının (ör. autotest_​<timestamp>.ply) 
standart yolları oraya iner. Kaydet diyaloğu üzerin
den manuel olarak seçilen dışa aktarmalar burada 
ZORUNLU olarak değil, kullanıcının nereye kaydet
tiğine bağlı olarak gider — bu yüzden bu klasör 
çoğunlukla otomatik testler için ilginçtir.

K I S ACA

Uygulamanın kendi dışa aktar­
malarını (özellikle otomatik test 
çalıştırmaları) yerleştirdiği klasö­
rü açar. Bir dışa aktarmayı kaydet 
diyaloğuyla manuel olarak başka 
bir yere koyduysan, bu klasör ye­
rine oradadır. Düzenlemek veya 
önceki test dışa aktarmalarının 
ne kadar yer kapladığını görmek 
için pratiktir. Günlükler ve sahne 
paketleri dahil tam bir genel ba­
kış istiyorsan, bunun yerine Ma­
nage Storage (M39) kullan.

M39 Help > Manage Storage…

N E R E D E

Menü çubuğu → Help → Manage Storage…

T E K N İ K

Depolama tarayıcısını açar (Bölüm 4 Yardımcı 
Pencereler’e bak, ID’ler W7–W12). ~/​Documents/​
RadianceKit/​ klasöründeki tüm kalıcı sahneleri, eği
tim günlüklerini, dışa aktarmaları ve önbellekleri 
boyutuyla listeler, girdi başına Finder’da göster ve 
çöpe taşı sağlar.

K I S ACA

RadianceKit’in disk üzerinde ne 
kadar yer kapladığını — sahne, 
günlük ve dışa aktarma başına — 
sana gösteren bir pencere tarayı­
cısı açar. Finder’a gitmek zorun­
da kalmadan doğrudan tekil şey­
leri silebilirsin. Uzun kullanımdan 
sonra disk dolduğunda pratiktir 
— önceki günlükler ve otomatik 
test dışa aktarmaları birkaç giga­
bayta toplanabilir. Finder’da Gös­
ter ile istediğin zaman klasik gö­
rünüme de gelirsin.
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M40 Help > Pareto Dashboard…

N E R E D E

Menü çubuğu → Help → Pareto Dashboard… 
(⇧⌘D).

T E K N İ K

Pareto Dashboard’ı açar (Bölüm 4′e bak, ID’ler W13–
W22). Dashboard ~/​Documents/​RadianceKit/​Logs/​ 
içindeki tüm JSONL eğitim günlüklerini yükler, sah
neye ve önayara göre sıralar ve bir Pareto saçılım 
grafiği çizer (Standart: kayıp vs Gaussian, isteğe 
bağlı kayıp vs duvar saati veya PSNR vs iterasyon).

K I S ACA

Tüm önceki eğitim çalıştırmala­
rının diyagram olarak bir genel 
bakışını açar. Hangi çalıştırma­
nın kalite ve boyut arasında en 
iyi dengeyi sağladığını hemen 
görürsün. Farklı önayarları birbir­
leriyle karşılaştırmak istediğin­
de pratiktir. Diyagram varsayılan 
olarak kaybı Gaussian sayısına 
göre gösterir — ama duvar saati 
zamanına veya PSNR’ye de ge­
çebilirsin. Veriler JSONL eğitim 
günlüklerinden (M37) gelir; ne 
kadar çok çalıştırman varsa, de­
ğerlendirme o kadar anlamlı olur.

M41 Help > Holdout Analysis…

N E R E D E

Menü çubuğu → Help → Holdout Analysis… (⇧⌘H).

T E K N İ K

Holdout analiz penceresini açar (Bölüm 4′e bak, 
ID’ler W23–W29). Bir transforms.json  yükler, ka
meraları 3B küre olarak çizer ve eğitim/test fold 
bölmelerine izin verir (açısal veya doğrusal, 2–
8 fold). Çıktı, eğitimin ilgili eğitim yapılandırma
larında test seti olarak kullanabileceği bir fold-
assignment.json’dır.

K I S ACA

Kamera çekimlerini eğitim ve 
test setlerine ayırmana yardım 
eder — böylece sahnenin ne ka­
dar iyi olduğunu nesnel olarak 
ölçebilirsin (eğitimin görmediği 
görüntülerde). Daha çok bir araş­
tırma ve benchmark aracıdır. Ka­
meralar 3B küre olarak gösterilir; 
ya açıda eşit ya da sırayla doğru­
sal olarak 2 ile 8 fold arasında se­
çim yapabilirsin. Sonuç, eğitimin 
ardından test seti olarak kullan­
dığı küçük bir JSON dosyasıdır.
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M42 Help > BayesOpt Console…

N E R E D E

Menü çubuğu → Help → BayesOpt Console… 
(⇧⌘B).

T E K N İ K

BayesOpt konsolunu açar (Bölüm 4′e bak, ID’ler 
W30–W39). Önceden tanımlı arama alanlarını yükler 
(ör. „MCMC scale-reg + opacity-reg + ssim“), Bayes 
Optimizasyon denemelerini eşzamansız olarak çalış
tırır ve yakınsama eğrisini ile deneme günlüğünü 
canlı gösterir.

K I S ACA

Yerleşik bir otomatik ayarlayıcı 
konsolu. Farklı parametreleri ma­
nuel olarak denemek yerine, uy­
gulama bunu kendisi gece çalış­
tırabilir ve sonunda sahnen için 
en iyi değerleri sana önerebilir. 
Çok gelişmiş bir araç — çoğu 
iş akışı için iyi bir önayar (bkz. 
Bölüm 7) yeterlidir. Önceden ta­
nımlı bir arama alanı seçersin (ör. 
„MCMC scale-reg + opacity-reg + 
ssim“) ve canlı olarak yakınsama 
eğrisini ve deneme günlüğünü 
görürsün. Kuruluma göre birkaç 
saatten günlere kadar planla.

Not: Edit menüsünde Cmd-Z

Mayıs 2026′dan beri Expert Mode’daki Project Navigator, içe aktarılan görüntülerin eksi 
düğmesi veya Backspace tuşuyla silinmesini ve Cmd-Z  ile geri alınmasını destekler. 
Bu Cmd-Z eylemi, silinen bir görüntü hâlâ kurtarılabilir olduğu sürece macOS Edit me
nüsünde (SwiftUI tarafından sağlanır) „Undo Remove Image“ olarak görünür. Standart 
uyumlu sistem üzerinden kaydedilir; bu yüzden envanterde kendi M ID girdisi yoktur.
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Klavye kısayolları genel bakışı

Menü girdisi Kısayol

File > Open Scene… ⌘O

File > Save Scene… ⌘S

File > Import COLMAP / Metashape Workspace… ⇧⌘I

File > New Project ⇧⌘N

Mode > Simple Mode ⌘1

Mode > Expert Mode ⌘2

Training > Start Training ⇧⌘T

Viewport > Enter/Exit Edit Mode ⇧⌘E

Viewport > Toggle Auto-Rotation ⌘⌥T

Viewport > Save Screenshot ⇧⌘S

Export > 3D Formats > PLY ⌘E

Help > User Guide ⌘?

Help > Keyboard Shortcuts ⌘/

Help > Open Training Logs… ⇧⌘L

Help > Pareto Dashboard… ⇧⌘D

Help > Holdout Analysis… ⇧⌘H

Help > BayesOpt Console… ⇧⌘B

Edit menüsü (sistem tarafından sağlanır, Expert Mode’da etkin Project Navigator seçi
minde):

Eylem Kısayol

Undo Remove Image ⌘Z

Remove Selected Image Backspace / Delete

30 / 231



R A D I A N C E K I T Bölüm 1 — Menü Çubuğu

B Ö L Ü M

Bölüm 2 — Inspector (Expert View)

Şekil 7:  Boş Expert modu — solda Project Navigator (Images 0, Cameras, Log), ortada boş 
görüntüleyici, sağda Presets/Training Configuration/Enhancements/Training Metrics bölüm­

leriyle Inspector

İçe aktarmadan önce boş Inspector: Sol kenar çubuğu Images sayacını 0 ve „Drop 
images here / or tap + to import“ ipucunu gösterir. Sağdaki Inspector tam işlevseldir, 
ama önayarlar yalnızca bilgilendiricidir (aktif eğitim yok). Varsayılan „Preview” önayarı 
(5K iter) işaretli. Camera Alignment Apple Photogrammetry’de, Densification Classic, 
SSIM Weight 0.20, Render Scale %50. Training Metrics’te boş durumlar („Start training 
to see live metrics“) ve Loss History („Loss curve will appear during training”).
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Şekil 8:  60 çiçek görüntüsü yüklü Inspector — Görüntü kenar çubuğu ilk dosya adlarını 
frame_0001.jpg vd. gösterir, başlık „60 images ready“

İçe aktarmadan sonra Inspector: Başlık durumu „60 images ready“. Görüntü kenar 
çubuğu içe aktarılan 60 karenin tümünü listeler ( frame_0001.jpg  ile frame_0945.jpg  
arasında, 960 kameralı çiçek demeti veri setinden hızlı yineleme için her 16. kare 
alt küme olarak). Otomatik render ölçek mantığı görüntü çözünürlüğünü kontrol eder 
(1536×2048 = 3.1 MP) ve Render Scale’i buna göre ayarlar. Oynat düğmesi (yeşil, sol 
altta) artık etkindir ve etkin önayar ile eğitimi başlatır.

Şekil 9:  Eğitim ortasında Inspector — canlı görüntüleyici çiçek demeti yeniden yapılandırma­
sını gösterir, altta metrik çubuğu (Loss / LR / Gaussian sayısı / İterasyonlar), parametre 

ayarlanmışsa „Modified“ rozetiyle „Preview” önayar kartı

Eğitim sırasında Inspector: Başlık çubuğu küresel ilerlemeyi „RadianceKit — Training 
NN %“ gösterir. Görüntüleyici çalışan Gaussian yeniden yapılandırmasını gerçek zamanlı 
render eder (her 50 iterasyonda güncellenir — Canlı önizleme aralığı Ayarlar → General 
→ Training → Live Preview’da ayarlanabilir). Görüntüleyicinin altındaki metrik çubuğu: 
mevcut Loss, öğrenme hızı, Gaussian sayısı ve iterasyon sayacı (ör. Preview önayarında 
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1,600/5,000). Inspector’daki „Preview” önayar kartı, herhangi bir parametre yerleşik var
sayılandan saptığı anda „Modified“ rozeti taşır. Kenar çubuğunun „Log”u SfM ve eğitim 
aşaması olaylarını toplar.

Şekil 10:  Eğitim tamamlandıktan sonra Inspector — görüntüleyici tamamlanmış çiçek demeti 
yeniden yapılandırmasını gösterir (13 sn’de 5K iterasyondan sonra 2,991 Gaussian), başlık 

çubuğu „Training Complete — 2,991 Gaussians“

Eğitimden sonra Inspector: Başlık çubuğu son Gaussian sayısını gösterir (burada 2 
991 — çok kompakt, çünkü açık arka planda sentetik Blender çiçek demeti sahnesinin 
basit geometrisi vardır). Görüntüleyici tamamlanmış nokta bulutunu gösterir — yörünge
sel sürükleme navigasyonu etkindir (sahne merkezi etrafında döner). Eğitim metrikleri 
bölümü artık son değerlerle doludur, Loss History grafiği tüm 5 000 iterasyonun seyrini 
gösterir. Alttaki dışa aktarma bölümü artık etkindir (tüm biçim düğmeleri etkinleştirilmiş
tir).

Inspector, Expert Mode’daki (⌘2) sağ kenar çubuğudur. Tüm eğitim ilişkili parametre
leri yedi katlanabilir bölümde toplar. İlk başlatmada yukarıdan aşağıya varsayılan sıra 
şudur: Look, Presets, Eğitim Yapılandırması, Metrikler, Kayıp Diyagramı, Enhancements 
ve Export. „Look“ bölümü (eğitim sonrası görüntü ayarları), eski „Finishing” bölümünün 
gerçek UI yeniden adlandırılmasıdır — iç enum- rawValue ’su kalıcılık nedeniyle „Finis
hing“ olarak kalır, görüntülenen başlık „Look” diye okunur. Her bölüm başlığa tıklanarak 
kapatılabilir, sırası sürükle bırakla yeniden düzenlenebilir (InspectorView.swift:81-97). 
İlk başlatmada yedi bölümün tümü kapalıdır (inspectorCollapsedSections varsayılan 
olarak Set(InspectorSection.allCases)‘e ayarlıdır); uygulama durumu, katlanma ve sı
ralama tercihlerini sonradan uygulama başlatmaları arasında saklar.

Inspector’daki bir dizi kontrol, neredeyse aynı biçimde Ayarlar’da (Bölüm 3) da görünür 
— tipik olarak SfM arka ucu, Sky Masking ve benzer varsayılanlar. Ayrım bilinçlidir: Ayar
lar yeni oluşturulan projeler için uygulama genelinde şablonu sağlar, Inspector ise bu 
değerleri mevcut açık proje için geçersiz kılar. Bir tarafın kontrol mantığını bilen, diğerini 
gözü kapalı kullanabilir.

Expert Mode’daki sol sütun — Project Navigator — Inspector’ın parçası değildir, ama 
doğrudan komşusudur. İçe aktarılan görüntüler oradan tıklamayla seçilebilir, boşluk tu
şuyla Quick Look ile görüntülenebilir ve eksi düğmesi veya Sil tuşu üzerinden silinebilir 
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(geri almak için Cmd-Z). Inspector mevcut kenar çubuğu seçimini bağlama özel detay 
bilgileriyle takip eder, ama yedi ana bölüm her zaman kullanılabilir kalır.

Look bölümü (L1–L5)

Look bölümü (iç rawValue  hâlâ „Finishing“), en üstteki Inspector bölümüdür ve eğitim 
sonrası görüntü ayarlarını tek bir yerde toplar. Tüm kaydırıcılar tahribatsız çalışır: Her 
kaydırıcı, FinishingPass ’i değişmemiş bir Pristine anlık görüntüsüne (orijinal DC-renk, 
-opaklık, -ölçekleme) yeniden uygular — böylece ayarlama idempotenttir, kümülatif de
ğildir. Sonuç görüntüleyicide canlı belirir (WYSIWYG, tam olarak sonraki dışa aktarma 
gibi) ve her dışa aktarmaya pişirilir. Bölüm yalnızca bir eğitim çalışması tamamlan­
dıktan sonra kullanılabilir (öncesinde „Available after a training run completes.” yazar); 
değerleri her yeni eğitimde sıfırlanır. Bir dışa aktarma çalıştığı sürece tüm kaydırıcılar 
kilitlidir — „Locked while exporting — the file uses the current settings.“ kilit ipucu 
belirir ve GroupBox devre dışıdır.

L1 Saturation kaydırıcı

N E R E D E

Inspector → Look bölümü → GroupBox → Saturati
on.

T E K N İ K

0.5–1.2 arası kaydırıcı, iki haneli gösterim (ör. 
„1.00″). Her Splat’ın SH-DC kromasını luminans de
ğeri etrafında ölçeklendirir: 1.0 = değişmemiş, < 
1.0 = doygunluğu azaltılmış (renk gri tonuna çekil
miş), > 1.0 = daha canlı. Matematiksel olarak DC-
renk, Pristine anlık görüntüsünden geri hesaplanır 
( desaturateDC ), böylece tekrarlı sürükleme toplan
maz. DJI dron materyalinde doğrulandı (Pensford 
Viyadüğü), bu materyal aşırı doygun çıkma eğili
mindedir — dron varsayılanı 0.82′dir. Yalnızca renk 
tabanına etki eder (SH-Derece 0), daha yüksek SH 
katsayıları dokunulmadan kalır.

K I S ACA

Tamamlanmış Splat’ın renkleri­
nin ne kadar canlı olduğu. 1.00 
her şeyi eğitildiği gibi bırakır, al­
tındaki değerler rengi griye doğ­
ru çeker — çoğu kez aşırı doygun 
çıkan dron veya video materyali 
için iyidir. 1.0 üzeri değerler onu 
daha canlı yapar. Uygulama her 
zaman değişmemiş orijinal du­
rumdan yeniden hesapladığı için 
bir şeyin „şişmesi“ olmadan is­
tediğin kadar ileri geri sürükleye­
bilirsin. Görüntüleyicide canlı gö­
rünür ve dışa aktarmada tam ola­
rak öyle.
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L2 Splat length kaydırıcı

N E R E D E

Inspector → Look bölümü → GroupBox → Splat 
length.

T E K N İ K

0.3–1.0 arası kaydırıcı, iki haneli gösterim. Her 
Gaussian’ın üç ölçekleme eksenini Log uzayında 
ortalamalarına doğru çeker ( shortenScale , faktör 
alpha ): 1.0 = değişmemiş, daha küçük değerler 

uzunlamasına „iğne“ Splat’larını yuvarlar, 0 saf küre
ler olur. İğne benzeri, aşırı uzamış Splat’lara genel 
boyutu değiştirmeden etki eder ve böylece tipik 
„konfeti” eserlerini azaltır. Pristine anlık görüntüsün
den (orijinal Log ölçekleme) uygulanır, bu yüzden 
idempotenttir. İkisi de Log uzayında çalıştığı için Sp
lat size (L3) ile yer değiştirir.

K I S ACA

Aşırı uzun, kıymık benzeri 
Splat’ları yuvarlar. 1.00 formu 
eğitildiği gibi bırakır, daha dü­
şük değerler uzun „iğneleri“ da­
ha yuvarlak kümelere sıkıştırır — 
bu, konfeti eserleriyle dolu körlü 
yeniden yapılandırmaları sakin­
leştirir. Genel boyut aynı kalır, 
mesele yalnızca uzunlamasına­
lık. Splat size (L3) ile güvenle bir­
leştirilebilir.

L3 Splat size kaydırıcı

N E R E D E

Inspector → Look bölümü → GroupBox → Splat size.

T E K N İ K

0.5–2.0 arası kaydırıcı, iki haneli gösterim. Her 
Gaussian’ı üç eksenin tümünde tekdüze ölçeklendi
rir ( sizeScale ): 1.0 = değişmemiş, < 1.0 = daha 
küçük/daha yoğun/daha keskin, > 1.0 = daha bü
yük/„daha kabarık“ (Splat’lar arasındaki boşlukları 
doldurur). Ölçeklemeler Log uzayında olduğundan, 
çarpma toplamsal bir log(factor)  ofseti olarak 
gerçekleştirilir — bu, sabit bir ofset ortalamadan-
sapmayı dokunulmadan bıraktığı için Splat length 
(L2) ile yer değiştirir. Pristine anlık görüntüsünden, 
yani idempotent. Bu sürümde yeni.

K I S ACA

Tüm Splat’ları eşit biçimde bü­
yütür veya küçültür. 1.00 eğitil­
miş durumdur, altındaki değer­
ler nokta bulutunu daha sıkı ve 
keskin yapar, üzerindeki değerler 
Splat’lar arasındaki boşlukları ör­
ter (daha yumuşak/„daha kaba­
rık“ görünür). Körlü bir yeniden 
yapılandırmayı optik olarak ka­
patmak veya tersine daha fazla 
detay açığa çıkarmak için pratik­
tir. Splat length (L2) ile sorunsuz 
çalışır — her iki kaydırıcı birbirini 
etkilemez.
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L4 Fade far region (alt kaydırıcılarla)

N E R E D E

Inspector → Look bölümü → GroupBox → „Fade far 
region“ anahtarı artı „Fade start ×radius” ve „Fade 
floor“ alt kaydırıcıları.

T E K N İ K

Kamera ağırlık merkezinden uzaklıkla rad
yal bir opaklık düşüşünü etkinleştiren anah
tar — arka planda zayıf gözlemlenen „Far-
konfeti“ gizlenir. Yalnızca orbit çekimleri için: 
finishingContext.fadeEligible false ise (lineer 
uçuşlar, çok az veya dejenere kameralar) anahtar 
devre dışıdır; o zaman alt kaydırıcılar yerine „Far-
fade applies only to orbit captures (not this scene).” 
ipucu belirir. Uygunluk, kamera konumlarının azimut 
kapsamıyla belirlenir (bir orbit ağırlık merkezini çev
reler ve birçok pusula sektörünü doldurur, bir lineer 
uçuş yalnızca ~2′sini). İki alt kaydırıcı geometriyi 
yönetir: Fade start ×radius (1.0–3.0) iç yarıçapı or
bit yarıçapının katı olarak ayarlar, bunun içinde tam 
opaklık geçerli; Fade floor (0.0–1.0) fade yarıçapı
nın çok ötesindeki opaklık faktörüdür. Önemli: Fade 
Sky-Dome bölgesini atlar (indisleri [0, frozenCo
unt) olan frozen Gaussian’lar), böylece kasıtlı arka 
plan kubbesi birlikte karartılmaz.

K I S ACA

Dış sahne kenarındaki süngerim­
si kalıntıları gizler — tam olarak 
çepeçevre çekimlerde çok geri­
de süzülen „Far-konfeti“ kümele­
ri. Yalnızca gerçek orbit/çepeçev­
re çekimlerinde çalışır; düz dron 
uçuşlarında veya çok az kame­
rada anahtar griye alınır ve bir 
ipucu nedenini açıklar. Etkinse iki 
ince ayar gelir: „Fade start ×radi­
us” gizlemenin hangi mesafeden 
(çepeçevre yarıçapının katı ola­
rak) başlayacağını belirler, „Fade 
floor“ uzak Splat’ların sonunda 
ne kadar görünür kaldığını (0 = 
tamamen yok, 1 = değişmemiş). 
Kasıtlı olarak yeniden yapılandı­
rılmış bir Sky-Dome (I44) bu sıra­
da asla dokunulmaz — gök koru­
nur.
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L5 Reset finishing düğmesi

N E R E D E

Inspector → Look bölümü → GroupBox → „Reset fi
nishing“ (altta, küçük düğme).

T E K N İ K

Tüm Look ayarlarını varsayılanlara sıfırlar 
(FinishingPass.Settings() = Saturation 1.0, Fade 
kapalı, Splat length 1.0, Splat size 1.0) ve he
men yeniden bir finishing tetikler, böylece görün
tüleyici değişmemiş eğitilmiş duruma geri sıçrar. 
controlSize(.small). Tüm Look yığını idempotent 
olarak Pristine anlık görüntüsünden hesapladığın
dan, „varsayılana dön“ tam olarak orijinal eğitim çık
tısıdır — defalarca ileri geri yapmaktan kalite kaybı 
yok. Bölümün tüm kaydırıcıları gibi çalışan bir dışa 
aktarma sırasında kilitlidir.

K I S ACA

Tek tıklamayla tüm Look kaydı­
rıcılarını standarda sıfırlar (Sa­
turation 1.00, Fade kapalı, her 
iki Splat kaydırıcısı 1.00) — gö­
rüntüleyici sonrasında yeniden 
tam olarak taze eğitilmiş sonu­
cu gösterir. Oynayıp dağıttıysan 
ve temiz baştan başlamak isti­
yorsan pratiktir. Uygulama her 
zaman orijinal durumdan hesap­
ladığı için bunda kalite kaybı ol­
maz. Bir dışa aktarma çalışırken 
düğme (kaydırıcılar gibi) kilitlidir.

Önayarlar bölümü (I1–I11)

Önayarlar bölümü, test edilmiş bir yapılandırmayı uygulamanın en hızlı yoludur. Yerleşik 
önayarlar (Capture Class, Classic, MCMC, Hybrid) 560+ belgelenmiş deneyden yeniden 
üretilebilir başlangıç noktaları sağlar; kendi önayarların kaydedilebilir, dışa aktarılabilir, 
içe aktarılabilir ve paylaşılabilir. Liste kategoriye göre gruplanmıştır (Capture Class, 
Classic, MCMC, Hybrid, Custom) ve aynı anda birden fazla kategori açık olabilir. Bağlam 
menüsü mekanizması (bir satıra sağ tıklama) üzerinden dışa aktarma, çoğaltma ve — 
kendi önayarlarında — silmeye ulaşılabilir.
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I1 Save… düğmesi

N E R E D E

Inspector → Önayarlar bölümü → Save… düğmesi 
(alt eylem çubuğu).

T E K N İ K

Metin alanı ve Save/Cancel düğmeleri olan bir popo
ver açar. Mevcut TrainingConfig durumu yeni bir 
kullanıcı tanımlı önayar olarak kalıcı kılınır (JSON 
kodlu, uygulama çapında saklanır). Save işlemi 81 
eğitim parametresinin tümünü artı mevcut Densifi
cation stratejisini kopyalar. Önayar, hangi yerleşik 
önayardan türetildiğine bakılmaksızın otomatik ola
rak Custom kategorisine düşer. Boş adlar ve yalnız
ca boşluk girdileri reddedilir. Zaten mevcut adlar 
reddedilmez — her önayarın kendi iç ID’si vardır, çift 
adlar teknik olarak izinlidir ama pratik olarak kafa 
karıştırıcıdır.

K I S ACA

Mevcut yapılandırmanı yeniden 
kullanılabilir bir önayar ola­
rak kaydeder. Düğmeye bas, 
popover’da bir ad gir ve Save’e 
tıkla — Densification stratejisi 
dahil 81 parametrenin tümü seçi­
len adla Custom kategorisine dü­
şer. Üzerinde uğraştığında ve bir 
sonraki projede yeniden sıfırdan 
uğraşmak istemediğinde gerekir. 
Özellikle „Drone 4K“ veya „Indoor 
hızlı” gibi tekrar eden kurulum­
lar için pratiktir. Çift adlar teknik 
olarak izinlidir, ama pratik olarak 
kafa karıştırıcıdır — daha çok ko­
nuşan bir şey al.

I2 Önayar Adı TextField

N E R E D E

Save popover → „Preset Name“ metin alanı.

T E K N İ K

Yuvarlatılmış çerçeve ve geniş biçimle basit metin 
alanı. Değer Save düğmesine tıklandığında önayar 
adı olarak alınır. UI’da uzunluk sınırı yoktur, ama 
kaydedilen ad JSON kodlanabilir ve UI listelerinde 
temsil edilebilir olmalıdır — emoji ve umlaut çalışır. 
Popover açıldığında içerik otomatik olarak boş bir 
dize ile sıfırlanır. Alan trim sonrası boş kaldığı sürece 
Save düğmesi devre dışı kalır. Otomatik öneri ve şu 
anda etkin önayarın adıyla ön doldurma yoktur.

K I S ACA

Önayarın için adı buraya yazar­
sın. „Drone 4K 30fps“ veya „In­
door hızlı” gibi konuşan bir şey 
seç — daha sonra Custom kate­
gorisinde bulmana yardımcı olur. 
Emoji ve umlaut’lara izin veri­
lir, sert bir uzunluk sınırı yok­
tur. Alan boş olduğu veya yalnız­
ca boşluklardan oluştuğu sürece 
Save düğmesi gri kalır. Popover’ı 
tekrar açtığında alan yeniden 
boştur — etkin önayar adıyla ön 
doldurma yoktur.
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I3 Cancel düğmesi (Save diyaloğu)

N E R E D E

Save popover → Cancel düğmesi (sol).

T E K N İ K

Popover’ı kaydetmeden kapatır. Metin alanı içeriğini 
atar — bir sonraki açılışta Save… düğmesi mantığıyla 
(I1) tekrar boşa sıfırlanır. Standart düğme stili, onay 
diyaloğu yok, kısayol yok. Save yolu hiç çalıştırılma
dığı için mevcut TrainingConfig değişmeden kalır.

K I S ACA

Save popover’ını hiçbir şey kay­
detmeden kapatır. Fikrini değiş­
tirmişsen, yanlış yazmışsan veya 
diyaloğu yanlışlıkla açmışsan — 
sadece Cancel’a tıkla. Henüz hiç­
bir şey yazılmadığı için mevcut 
eğitim yapılandırman değişmez. 
Popover’ı tekrar açtığında ad ala­
nı yeniden boş başlar. Güvenlik 
sorusu yok, kısayol yok — sadece 
tıkla ve kaybol.

I4 Save düğmesi (Save diyaloğu)

N E R E D E

Save popover → Save düğmesi (sağ, belirgin stil).

T E K N İ K

Asıl kalıcılaştırmayı tetikler. Boş olmayan adı tekrar 
doğrular (savunmacı kontrol) ve ardından mevcut 
TrainingConfig’i JSON olarak uygulama deposuna 
yazar. Sonra popover’ı kapatır. Mavi vurgulanmış, 
metin alanı boş olduğu sürece gri kalır. Kayıt başarı
sız olursa (ör. uygulama deposu dolduğu için — çok 
düşük olasılık), şu anda görünür bir hata diyaloğu 
yoktur; önayar bir sonraki uygulama başlatmasında 
basitçe görünmez.

K I S ACA

Save’e tıklamayla adı kabul eder 
ve mevcut kurulumunu yeni 
önayar olarak kaydeder. Popo­
ver kapanır, önayar hemen öna­
yar listesinin Custom kategori­
sinde görünür ve bu andan iti­
baren tıklamayla etkinleştirilebi­
lir. Düğme mavi vurgulanmıştır 
( borderedProminent ) ve ad 
alanı boş olduğu sürece gri kalır. 
Kayıt başarısız olursa (ör. User­
Defaults dolu) görünür bir hata 
diyaloğu olmaz — önayar bir 
sonraki uygulama başlatmasında 
basitçe eksik olur.
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I5 Export… düğmesi

N E R E D E

Inspector → Önayarlar bölümü → Eylem çubuğu → 
Export… düğmesi.

T E K N İ K

Mevcut seçilen önayarı bir .radiancepreset  dos
yası (içeride JSON) olarak dışa aktarır. Önayar seçili 
değilse devre dışıdır. Tıklamada uygulama varsayılan 
dosya adıyla (önayar adı + .radiancepreset  uzan
tısı) bir kaydet diyaloğu açar. Kaydedilen biçim tüm 
TrainingConfig’i artı meta verileri (ad, kategori, ID, 
Built-in bayrağı) içerir. Finder’da çift tıklama uygu
lamayı açar — ama içe aktarmayı otomatik olarak 
değil; kullanıcı içe aktarma düğmesini (I6) kullanma
lıdır.

K I S ACA

Listede bir önayar seç ve 
Export’a tıkla — böylece 
onu .radiancepreset  dosya­
sı olarak kaydedebilir ve örneğin 
bir meslektaşa gönderebilir ve­
ya başka bir Mac’e aktarabilirsin. 
Alıcı karşıda Import… düğmesi 
(I6) ile yeniden yükler. Built-in’ler 
ve kendi Custom önayarların için 
aynı şekilde iyi çalışır. Listede 
hiçbir şey tıklanmadığı sürece 
düğme gri kalır. İpucu: Bağlam 
menüsü (I8) üzerinden daha da 
hızlı — önayarı önce seçmek zo­
runda değilsin.

I6 Import… düğmesi

N E R E D E

Inspector → Önayarlar bölümü → Eylem çubuğu → 
Import… düğmesi.

T E K N İ K

Yalnızca .radiancepreset  dosyalarına izin veren 
bir dosya diyaloğu açar (çoklu seçim devre dışı). 
Seçildiğinde JSON dosyası yüklenir, doğrulanır ve 
Custom kategorisine eklenir — Built-in’lerle çakışma 
olmaması için yeni bir iç ID ile. İçe aktarma, dışa 
aktarılan önayar başlangıçta örneğin bir Built-in olsa 
bile kategoriyi otomatik olarak Custom’a ayarlar. Bo
zuk veya eski şema sürümüyle uyumsuz dosyalar 
hata diyaloğu olmadan sessizce reddedilir (Console 
günlüğü bilgi verir).

K I S ACA

Diskten bir .radiancepreset  
dosyası okur. Biri sana denen­
miş bir kurulum gönderirse veya 
en sevdiğin önayarları birden çok 
Mac arasında senkronize tutmak 
istersen kullanışlıdır. İçe aktarı­
lan önayarlar her zaman Custom 
kategorisine düşer — başlangıç­
ta Built-in’lerden dışa aktarılmış 
olsalar bile. Bozuk veya eski dos­
yalar sessizce yok sayılır; konsol 
günlüğünde gerekçe bulunur. Di­
yalogda çoklu seçim devre dışı­
dır, yani tıklama başına yalnızca 
bir dosya.
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I7 Önayar satırı (tıklamayla etkinleştirme)

N E R E D E

Inspector → Önayarlar bölümü → her kategorideki 
her önayar satırı.

T E K N İ K

Bir önayar satırına tıklama, TrainingConfig’in tüm 
alanlarını önayardaki değerlerle değiştirir, etkin öna
yarın ID’sini hatırlar ve Modified durumunu sıfırlar. 
Satırın önündeki etkin onay işareti yalnızca önayar 
seçili VE değiştirilmemişse görünür. Diğer Inspector 
bölümlerindeki TrainingConfig’te bir değer değiştiril
diğinde (kaydırıcı, stepper, anahtar), adın arkasında 
turuncu bir „Modified“ rozeti görünür. Yerleşik öna
yarlar üzerine yazılamaz — değişiklikte Save düğme
si (I1) üzerinden kendi kopyan oluşturulmalıdır.

K I S ACA

Bir satıra tıklamak önayarı etkin­
leştirir ve orada saklı tüm değer­
leri mevcut eğitim ayarlarına alır. 
Adın önündeki onay işareti han­
gi önayarın şu anda etkin oldu­
ğunu gösterir. Ardından diğer bö­
lümlerden herhangi bir kaydırıcı, 
stepper veya anahtarı değiştir­
diğinde, adın arkasında turuncu 
bir „Modified“ rozeti görünür — 
çünkü kurulumun artık önayar­
dan sapıyor. Yerleşik önayarların 
üzerine yazılamaz; değişiklikleri 
tutmak istiyorsan Save… düğme­
si (I1) üzerinden kendi kopyan 
oluştur ya da önayarı çoğalt (I9).

I8 Bağlam menüsü „Export…“

N E R E D E

Her önayar satırına sağ tıklama → ilk girdi „Export…“.

T E K N İ K

I5 (Export… düğmesi) ile aynı işlevsellik, ama daha 
rahat erişilebilir — önayarın önce seçili olması gerek
mez. Doğrudan satırda tıklanan önayarı dışa aktarır. 
Tüm önayar kategorileri için aynı şekilde çalışır (Bu
ilt-in veya Custom), kısıtlama yok. Dışa aktarma 
Built-in bayrağını ve orijinal kategoriyi içerir, ama ye
niden içe aktarmada kategori I6′da açıklandığı gibi 
Custom’a eşlenir.

K I S ACA

Dışa aktarmanın hızlı yolu — 
istediğin önayara sağ tıkla ve 
„Export…“ seç. Önce tıklayıp 
sonra Export… düğmesine bas­
ma zahmetini kazandırır. Bu­
ilt-in’ler dahil tüm kategoriler 
için aynı şekilde çalışır. Üreti­
len .radiancepreset  dosyası 
I5′inkiyle aynıdır; daha sonra ye­
niden içe aktarıldığında otomatik 
olarak Custom kategorisine dü­
şer.
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I9 Bağlam menüsü „Duplicate“

N E R E D E

Her önayar satırına sağ tıklama → ikinci girdi „Dupli
cate“.

T E K N İ K

Önayarı Custom kategorisine klonlar. Yeni bir iç ID 
oluşturur, adın sonuna „ Copy“ ekler ve kopyayı kay
deder. Built-in önayarlar için de çalışır — klon o za
man düzenlenebilir olur. Orijinal dokunulmamış kalır. 
TrainingConfig değer değer kopyalanır (JSON gidip 
dönüş), böylece orijinal ile kopya arasında referans 
bağı yoktur.

K I S ACA

Custom kategorisinde bir önaya­
rın düzenlenebilir kopyasını oluş­
turur. Örneğin Built-in „Quality“ 
önayarını başlangıç noktası ola­
rak istiyorsan ve sadece SSIM 
kaydırıcısını biraz değiştirmek is­
tiyorsan pratiktir. İş akışı: çoğalt, 
yeniden adlandır (bağlam menü­
sü veya yeni Save…), uyarla, bitti. 
Orijinal dokunulmamış kalır — is­
tediğin zaman ona dönebilirsin. 
Built-in’ler için de çalışır; bu, on­
ların değerlerini temel olarak al­
manın ve aynı zamanda düzenle­
nebilir yapmanın tek yoludur.

I10 Bağlam menüsü „Delete“

N E R E D E

Kendi önayar satırlarına sağ tıklama → son girdi „De
lete“ (kırmızı, yıkıcı).

T E K N İ K

Yalnızca Custom önayarlar için görünür. Built-in’ler 
silinemez. Girdi yıkıcı olarak işaretlenmiştir, bağlam 
menüsünde kırmızı görünür ve yanlışlıkla tıklanma
ması için bir ayırıcının arkasına yerleştirilmiştir. Onay 
diyaloğu yoktur — bir tıklama önayarı hemen siler. 
Silinen önayar kurtarılamaz (Cmd-Z burada çalışmaz 
— mevcut yapıda Undo yalnızca görüntü listesi için 
vardır, önayar işlemleri için değil). Silinen önayar şu 
anda etkinse, mevcut TrainingConfig değişmez, yal
nızca etkin önayar seçimi nullenir.

K I S ACA

Kendi önayarlarını sil. Built-
in’lerde (Quick, Preview, Balan­
ced, Quality, Ultra Detail, Drone / 
Aerial, 360° Walkaround, Photo / 
Object vb.) „Delete“ zaten görün­
mez — bunları yanlışlıkla öldüre­
mezsin. Dikkat: Güvenlik sorusu 
ve geri alma yok, bir tıklama ve 
önayar gitti. Emin değilsen, önce 
Export… (I5/I8) ile diskte yedek 
al — istediğin zaman tekrar içe 
aktarabilirsin. Önayar şu anda 
etkinse, TrainingConfig’in değiş­
mez, yalnızca onay işareti kaybo­
lur.
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I11 Kategori başlığı (açma/kapama)

N E R E D E

Inspector → Önayarlar bölümü → her kategori başlığı 
(Capture Class, Classic, MCMC, Hybrid, Custom).

T E K N İ K

Kategoriye göre farklı varsayılanla katlama durumu: 
kürasyonlu Capture Class grubu açık başlar, Clas
sic, MCMC, Hybrid ve Custom kapalı başlar. Durum 
kalıcı değildir — uygulama yeniden başlatıldığında 
tüm kategoriler yine varsayılan durumda olur. Chev
ron oku animasyonlu döner. Başlığın sağındaki sayı, 
bu kategorideki önayar sayısını gösterir. Tıklama 
tepki alanı tüm başlık alanını kapsar.

K I S ACA

Önayar listesini düzenli tutmak 
için kategorileri aç ve kapat. 
Uygulama başlatıldığında Captu­
re Class grubu açıktır, Classic, 
MCMC, Hybrid ve Custom kapa­
lıdır. Başlığa tıkla (tüm alan tıkla­
nabilir) ve liste kısa bir chevron 
animasyonuyla açılır veya kapa­
nır. Sağdaki küçük sayı kategori­
de kaç önayar olduğunu gösterir. 
Uygulama yeniden başlatıldığın­
da yine varsayılan durumdadır — 
uygulama bu katlama ayarını bi­
linçli olarak saklamaz.

Eğitim yapılandırması bölümü (I12–I22)

Şekil 11:  Yalnızca Eğitim Yapılandırması bölümü kırpması — Camera Alignment (Apple Pho­
togrammetry aktif, Native (Beta) etkin değil), Densification (Classic aktif), Link sembolüyle 

Max Iterations 5,000 / Densify Until 3,500, SSIM Weight kaydırıcı 0.20, Render Scale kaydırıcı 
%100′de (1,536×2,048 = 3.1 MP)

Merkezi kaldıraçlar burada toplanır: hangi SfM arka ucunun hesaplayacağı, 
Densification’ın nasıl çalışacağı, kaç iterasyon, SSIM ağırlığının ne kadar olacağı. MCMC 
stratejisinde Classic modunda gizlenen iki ek anahtar belirir („MCMC Quality“ ve „Auto-
scale by scene”). Native SfM arka ucunda, yalnızca EXIF odak uzaklığı olmayan video 
kareleri için gerekli FOV Override alanı eklenir.
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I12 Camera Alignment seçici

N E R E D E

Inspector → Eğitim Yapılandırması → Camera Align
ment (üstte segmentli seçici).

T E K N İ K

İki seçenekli segmentli seçici: Apple Photogram
metry ve Native (Beta). Seçim, bir sonraki kamera 
yeniden yapılandırmasında kullanılacak SfM arka 
ucunu belirler. Aynı anda hangi ek Inspector ögele
rinin görünür olacağını da etkiler: Native, yalnızca 
EXIF’siz video kareleri için gerekli FOV Override’ı 
(I13) ek olarak gösterir. Not: Çok büyük dış mekân 
çekimleri için harici bir aracın (Metashape veya 
COLMAP) sonucunu Workspace içe aktarma üzerin
den yükleyebilirsin — Bölüm 1′e (M5) ve Bölüm 9′a 
(Q3, Q6) bak.

K I S ACA

Burada kamera konumlarının na­
sıl yeniden yapılandırılacağını 
seçersin — son kalite için en 
önemli anahtar. Apple Photog­
rammetry hızlı standarttır ve 
çoğu nesne taraması için ta­
mamen yeterlidir. Native (Beta), 
App Store uyumlu kendi geliştiri­
len sürümdür, orbit ve turntable 
sahneleri için iyidir ve EXIF’siz 
video kareleri için FOV Overri­
de (I13) gerektirir. Çok büyük 
dış mekân setlerinde kameraları 
alternatif olarak Metashape ve­
ya COLMAP’te hesaplayıp sonucu 
Workspace içe aktarma üzerin­
den yükleyebilirsin. Sahne türü­
ne göre detaylar ve öneriler Bö­
lüm 9′da.

I13 FOV Override alanı (Native SfM)

N E R E D E

Inspector → Eğitim Yapılandırması → FOV Override 
(yalnızca Camera Alignment = Native ise görünür).

T E K N İ K

Sayısal metin alanı (Aralık 0-170°), Varsayılan 0 = 
EXIF veya sezgisel yöntemden otomatik belirleme. 
Manuel girdi, girdi görüntüleri odak uzaklığı meta 
verisi içermeyen bir videodan çıkarıldığında gerekli
dir. Tipik değerler: iPhone Wide ≈ 73°, DJI Mavic 
Wide-Crop ≈ 70°, Tam kare sensörlü dron ≈ 84°. 
Değer [0, 170] aralığına sıkıştırılır — dışındaki değer
ler doğrudan geri itilir. Yalnızca yerel SfM pipeline’ını 
etkiler (Q4/Q5); Apple Photogrammetry bu değeri 
tamamen yok sayar.

K I S ACA

Görüntülerin EXIF’i yoksa (çıkarıl­
mış video karelerinde tipik), ka­
meranın yatay görüş açısını de­
rece cinsinden buraya girersin. 
Pratik değerler: iPhone Wide ≈ 
73°, DJI Mavic Wide-Crop ≈ 70°, 
tam kare sensörlü dron ≈ 84°. 
0, uygulamanın kendisinin tah­
min etmesine izin verir — bu 
sıklıkla iyi gider, ama nadir mer­
cekler için yanlış gidebilir. 170° 
üzeri değerler otomatik geri itilir. 
Alan yalnızca Camera Alignment 
olarak Native (I12) seçtiğinde gö­
rünür ve etkindir — Apple Pho­
togrammetry bunu tamamen yok 
sayar.
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I15 Densification seçici

N E R E D E

Inspector → Eğitim Yapılandırması → Densification 
(segmentli seçici, her zaman görünür).

T E K N İ K

İki Densification stratejisi arasında geçiş yapar: 
Classic (Clone/Split/Prune ve gradyan eşiğiyle ori
jinal 3DGS yöntemi) ve MCMC (Yeniden konum
landırmayla stokastik gradyan Langevin dinamiği, 
NeurIPS 2024). Classic’ten MCMC’ye geçişte uygu
lama, MCMC’ye özgü alanları test edilmiş varsayılan 
değerlere otomatik olarak ayarlar (Reg-Weights = 
0, MCMC-Cap-Multiplier 3.0, Sample/Noise schedu
le). Bu otomatik başlatma olmadan eski önayarlı 
oturumlar 1.4.4 MCMC çöküş hatasından (460K→5 
Gaussian, watchdog kill) etkilenirdi. Seçim ayrıca 
hangi Inspector ögelerinin görüneceğini belirler — 
MCMC’de I16/I17 belirir. Bölüm 6′da, T11–T16 (Clas
sic) ve T61–T73 (MCMC) detaylı alan etkisi.

K I S ACA

Gaussian sayısının büyümesi için 
merkezi strateji seçimi. Classic 
459 deneyden iyi ayarlanmıştır, 
hızlı ve yüksek kaliteli sonuçlar 
üretir ve MCMC alanlarını bilme­
ni gerektirmez. MCMC daha yeni 
yaklaşımdır (NeurIPS 2024), da­
ha tekrarlanabilir ve manuel eşik 
ayarlamasından kaçınır — karşı­
lığında karşılaştırılabilir kalitede 
yaklaşık 6× daha uzun hesap­
lar. MCMC’ye geçişte uygulama 
otomatik olarak güvenli varsa­
yılanlar ayarlar, böylece eğitim 
1.4.4 çöküşüne düşmez. Strateji 
alanları hakkında detaylar Bölüm 
6′da (T11–T16 Classic, T61–T73 
MCMC).

I16 MCMC Quality anahtarı

N E R E D E

Inspector → Eğitim Yapılandırması → MCMC Quality 
(yalnızca Densification = MCMC ise).

T E K N İ K

Gradyan birikimini 2 adıma (etkin) veya 1 adıma 
(etkin değil) çevirir. Optimizer adımı yürütülmeden 
önce iki ardışık kamera görünümünden gradyanları 
biriktirir. Ampirik olarak (Oturum 33, V544a) son L1 
hatasını yaklaşık %6 azaltır (Horse-Full-MCMC’de 3 
deneme ortalamasında Quality ile 0.0246, Quality 
olmadan 0.0261). Bedeli: iki katı eğitim süresi. Çok 
uzun eğitimlerde (200K iterasyon) bu ek 10+ dakika 
bekleme süresi getirir — yani yalnızca son birkaç 
yüzde kalite gerçekten gerektiğinde değer. Yalnızca 
eğitimi etkiler, dışa aktarma biçimini veya görüntüle
yici görünümünü etkilemez.

K I S ACA

İki görünüm üzerinden gradyan 
birikimi olan MCMC için Quality 
modu. Sonuç ampirik olarak yak­
laşık %6 daha iyi olur (Horse tes­
tinde 0.0261 yerine L1 0.0246), 
karşılığında iki kat daha uzun sü­
rer. Zaten 200K MCMC eğitimi ya­
pıyorsan (sıklıkla 2 saat), yanına 
neredeyse bir saat daha eklenir. 
Son showcase render’larında ve­
ya bir kalite sweep oturumunun 
sonunda değer; günlük iş akışın­
da pek değil. Yalnızca Densifica­
tion MCMC’de (I15) ayarlıysa gö­
rünür.
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I17 Auto-scale by scene anahtarı

N E R E D E

Inspector → Eğitim Yapılandırması → Auto-scale by 
scene (yalnızca MCMC’de).

T E K N İ K

Etkinse, etkili Maks Gaussian üst sınırını SfM başlan
gıç nokta sayısı × MCMC üst sınır çarpanıyla (Varsa
yılan 3.0) ölçeklendirir. Örnek: SfM 250K başlangıç 
noktası sağlar, taban üst sınır = 150K, çarpan 3.0 
→ etkili üst sınır = max(150K, 750K) = 750K. Devre 
dışıyken yalnızca taban geçerlidir. v1.4.5 için tanıtıl
dı, çünkü 1000′den fazla kare ile büyük dış mekân 
çekimlerinde ve buna karşılık gelen yüksek SfM nok
ta yoğunluğunda, sabit 150K üst sınır varsayılanı 
Densification’ı aç bırakıyordu — gereksiz noktalar 
kalıyordu, yenileri oluşamıyordu. Custom önayarla
rında varsayılan KAPALI, MCMC Built-in’lerde AÇIK. 
Yalnızca eğitim sırasında etkilidir, dışa aktarmada 
değil.

K I S ACA

Maksimum Gaussian sayısının 
sahne boyutuyla (daha doğru­
su: SfM başlangıç nokta sayısıy­
la) birlikte büyümesine izin verir. 
Küçük sahnelerde neredeyse hiç 
fark hissetmezsin, büyük dış me­
kân sahnelerinde kalite için çoğu 
kez belirleyicidir — aksi takdir­
de eğitim „boğulur“, çünkü 150K 
varsayılan üst sınırı sahne için 
çok düşüktür. Çok büyük dış me­
kân setlerinin (1000′den fazla ka­
re) gözle görülür biçimde üst sı­
nıra takıldığı görüldükten sonra 
v1.4.5 için tanıtıldı. MCMC Built-
in önayarlarında zaten önceden 
açıktır; kendi önayarlarında var­
sayılan kapalı.

I18 Max Iterations stepper

N E R E D E

Inspector → Eğitim Yapılandırması → GroupBox → 
Max Iterations.

T E K N İ K

Aralık 1 000–100 000, adım 1 000 olan stepper. 
Toplam optimizer iterasyon sayısını belirler. Eğitim 
süresi ile doğrusal ilişkilidir (yarıya bölme = yaklaşık 
%50 süre). Ampirik tatlı noktalar: 20K (Classic Ba
lanced, L1≈0.028), 40K (Classic Quality, L1≈0.023), 
200K (MCMC Full, L1≈0.0246). Classic’te 40K üze
ri ortalama olarak neredeyse iyileşme getirmez — 
Diminishing Returns. Değişimde Link işlevi (I19) et
kinse, Densify Until orantılı olarak birlikte sürüklenir 
(Varsayılan oran: 0.5, yani Densify-Until = Max/2).

K I S ACA

Kaç eğitim adımı yürütüleceği 
— daha fazlası daha iyi, ama 
doğrusal olarak daha fazla süre­
ye de mal olur. Pratik kural: iyi 
kalite için 20 000, Classic stra­
tejisinde optimum için 40 000 
(üzerinde ortalama olarak nere­
deyse hiç fark etmez). MCMC çok 
daha fazlasına ihtiyaç duyar, bu­
rada 200 000 standarttır. İteras­
yonu iki katına çıkarmak eğitim 
süresini kabaca iki katına çıkarır. 
Etkin Link düğmesinde (I19) Den­
sify Until orantılı olarak birlikte 
sürüklenir — pratik olarak her 
zaman istediğin budur.
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I19 Link/Unlink düğmesi (Densify ↔ Iterations)

N E R E D E

Inspector → Eğitim Yapılandırması → GroupBox → 
Max Iterations ile Densify Until arasındaki küçük 
Link düğmesi.

T E K N İ K

Densify Until’in Max Iterations’a oranını donduran 
anahtar düğme. Etkinde (Link simgesi vurgulu) Max 
Iterations’taki her değişiklikte Densify Until orantılı 
olarak çekilir. Unlink’te (Link artı simgesi) değerler 
bağımsız kalır. Varsayılan linkedir, çünkü bu tipik 
korelasyonu yansıtır — eğitimi iki kat iterasyona çe
kersen, çoğunlukla Densification’ı da orantılı olarak 
daha uzun çalıştırmak istersin. Oran, Link düğmesi
ni ayarlarken mevcut değerden hesaplanır; tipik bir 
oran 0.5′tir (Densify-Until = iterasyon sayısının yarı
sı).

K I S ACA

Max Iterations ile Densify Un­
til arasında küçük zincir düğ­
mesi. Etkinse (Link simgesi vur­
gulu) iki değer birlikte gezer 
— iterasyonu iki katına çıka­
rırsan, Densify Until de aynı 
oranda iki katına çıkar. Değil­
se ( link.badge.plus  simge­
si) onları bağımsız ayarlayabilir­
sin. Standart linkedir, çünkü bu 
tipik korelasyonu yansıtır — da­
ha uzun eğitim çoğunlukla daha 
uzun Densification aşaması da 
ister. Vakaların %99′unda yerinde 
bırak.

I20 Densify Until stepper

N E R E D E

Inspector → Eğitim Yapılandırması → GroupBox → 
Densify Until.

T E K N İ K

Aralık 500–50 000, adım 500 olan stepper. Clo
ne/Split (Classic) veya Yeniden Konumlandırma 
(MCMC) yoluyla artık yeni Gaussian eklenmediği ite
rasyon endeksini belirler. Ulaşıldıktan sonra yalnızca 
konum ve renk ince ayar yapılır. Daha yüksek değer
ler = daha fazla Gaussian = daha büyük dosya, daha 
uzun iterasyon başına süre (adım başına +%30-60 
GPU süresi). Tipik değerler: 15K (30K Max-Iter için), 
20K (40K için), 100K (200K MCMC için). Link etkin
se (I19) otomatik olarak birlikte ölçeklenir. Classic vs 
MCMC’de farklı etki eder: Classic büyümeyi tama
men durdurur, MCMC yeniden konumlandırma man
tığını durdurur, ama örnek/gürültü uyarlaması çalış
maya devam eder.

K I S ACA

Hangi iterasyona kadar ye­
ni Gaussian’ların eklenebilece­
ği — Classic’te Clone/Split ile, 
MCMC’de yeniden konumlandır­
ma ile. Sonrasında yalnızca mev­
cut noktaların renk ve şekil ince 
ayarı yapılır. Daha yüksek = daha 
fazla detay, ama daha büyük dos­
ya ve adım başına %30-60 GPU 
süresi. Tipik değerler: 15K (30K 
Max-Iter için), 20K (40K için), 
100K (200K MCMC için). Nor­
malde Link (I19) üzerinden Max 
Iterations’a bağlıdır — bunu ma­
nuel olarak ayırmak nadiren an­
lamlıdır.
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I21 SSIM Weight kaydırıcı

N E R E D E

Inspector → Eğitim Yapılandırması → GroupBox → 
SSIM Weight.

T E K N İ K

0.0–1.0 arası, 0.05 adımda kaydırıcı, „0.20″ olarak 
gösterilir. L1 kaybını (0.0) ve SSIM kaybını (1.0) ka
rıştırır. L1 piksel başına parlaklığı sıkılaştırır, SSIM 
yapısal benzerliği (kenarlar, yerel istatistikler). Var
sayılan 0.2, orijinal 3DGS makalesinin (Kerbl 2023) 
değeridir ve çok sayıda oturumda dayanıklı uzlaşma 
olarak tersine mühendislikle bulunmuştur. Daha yük
sek değerler (0.5+) detay korumayı destekler ama 
yerel parlaklık hatalarını yok sayabilir. Daha düşük 
değerler (< 0.1) keskin kenarlarda detay kaybına 
yol açar. SSIM hesaplama shader’da 11×11 Gaussian 
pencereyle çalışır. Performans: 0.0′da (yalnızca L1) 
eğitim yaklaşık %8-12 daha hızlıdır, çünkü SSIM he
saplama shader’da atlanır.

K I S ACA

Yapısal görüntü benzerliğinin 
(kenarlar, yerel desenler) saf par­
laklık karşılaştırmasına göre ne 
kadar ağırlıklandırıldığı. 0.2, oriji­
nal 3DGS makalesinden standart 
ve neredeyse tüm sahneler için 
yeterlidir. Saç, kürk veya bitki 
örtüsü gibi ince yapılarda daha 
yüksek (0.5+) — orada daha faz­
la yapı ağırlığı yardımcı olur. Da­
ha düşük (0.0) eğitimi yaklaşık 
%8-12 daha hızlı yapar, çünkü 
SSIM hesaplama shader’da atla­
nır, ama keskin kenarlarda detaya 
mal olur. Değişiklik için iyi bir ne­
deni olmayan, 0.2′yi bırakır.

I22 Render Scale kaydırıcı

N E R E D E

Inspector → Eğitim Yapılandırması → GroupBox → 
Render Scale.

T E K N İ K

0.25–1.0 arası, 0.25 adımda kaydırıcı, „100%“ olarak 
gösterilir. Eğitim render çözünürlüğünü kaynak gö
rüntü boyutuna göre ölçeklendirir. Performans üze
rinde en büyük kaldıraç: %50 GPU süresini yaklaşık 
%75 azaltır (çünkü 4× daha az piksel), %25 yaklaşık 
%94. Gradyan eşiği otomatik olarak birlikte ölçekle
nir. Kaydırıcının altında MP cinsinden canlı çözünür
lük gösterimi belirir (ör. „2304×1296 (3.0 MP)”). 
Mevcut değer önerilenden farklıysa turuncu yazıyla 
„— recommended: 50%“ gösterilir. Öneri ~3 MP et
kin çözünürlüğü hedefler — Apple Silicon GPU’ları 
tarafından en verimli işlenen aralık. 4K kaynak 
görüntüleri örneğin otomatik olarak %25 önerilir, 
FullHD görüntüleri %100. Değişiklik ek olarak buffer 
yeniden tahsisini de tetikler.

K I S ACA

Eğitimin hangi çözünürlükte ren­
der edeceği — en büyük perfor­
mans kaldıraçlarından biri. Tam 
(%100) en iyi kaliteyi verir ama 
büyük görüntülerde çok GPU sü­
resine mal olur. Yarı (%50) GPU 
süresinin yaklaşık %75′ini kazan­
dırır, çünkü dört kat daha az 
piksel hesaplanır — 4K kaynak­
lar için mükemmel. Kaydırıcının 
altında etkin çözünürlüğü mega­
piksel cinsinden görürsün; uygu­
lama yaklaşık 3 MP’yi hedefler, 
çünkü bu Apple Silicon’da en 
verimli çalışır. Değerin bundan 
farklıysa, uygulama turuncu „re­
commended“ uyarısı görüntüler 
— çoğunlukla buna uymaya de­
ğer.
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Enhancements bölümü (I26–I29, I42–I44)

Şekil 12:  Yalnızca Enhancements bölümü kırpması — üç satır: Post-Training Compactification 
(anahtar açık), Viewport Scaling (segmentli seçici Off/MetalFX/Lanczos), Perceptual Loss 

(kaydırıcı „Off“‘ta). Her satır alt başlıkla işlevi açıklar

Enhancements bölümü, çekirdek eğitim döngüsünün kendisini değiştirmeden görüntü 
kalitesini artıran üç özelliği gruplar. İlk ikisi (I26-I27) eğitim sonrası veya görüntüleyici 
aşamalarıdır: Compactification eğitim bittikten sonra temizlik yapar, Viewport Scaling 
çalışan eğitimi etkilemeyen saf bir görüntüleyici render’cısıdır. Bölüm üyeliğine rağmen 
Perceptual Loss (I29) bir eğitim bileşenidir — eğitim sırasında ek bir kayıp terimi olarak 
etkinleştirilir; bu yüzden görüntüleyici anahtarlarından bir ayırıcı ile ayrılmıştır.

v1.6 itibarıyla bölümde ayrıca bir Outdoor grubu bulunur (I42–I44: Sky Masking, Mid-
Training Floater Cleanup, Reconstruct Sky Dome) — eskiden Ayarlar penceresinde yer 
alan ve artık burada proje başına duran, gökteki floater’lara karşı eğitim seçenekleri.
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I26 Post-Training Compactification anahtarı

N E R E D E

Inspector → Enhancements → Post-Training Com
pactification.

T E K N İ K

V443 son işlemeyi etkinleştirir: Eğitim iterasyonları 
tamamlandıktan sonra opaklığı 0.01′in (görünürlük 
%1) altındaki Gaussian’lar silinir. Ampirik olarak gör
sel kalite kaybı sıfır olarak dosya boyutunu ~%55-58 
azaltır — çünkü bu Gaussian’lar görsel olarak zaten 
katkıda bulunmuyor. Compactification GPU compact 
geçişi olarak çalışır ve Gaussian sayısına göre sani
yenin parçası ile birkaç saniye arasında sürer. Eğitim 
performansını etkilemez. Bu anahtar kapalıysa gö
rünmez Gaussian’lar da dışa aktarılır — yalnızca bi
çimi başka bir eğitim aşaması için kullanmak istiyor
san ilgilidir (Continue Training), aksi takdirde bellek 
israfıdır.

K I S ACA

Eğitimden sonra zaten göreme­
diğin Gaussian’ları (opaklığı %1 
altında) temizler. Dışa aktarma 
dosyalarını yaklaşık yarıya kadar 
küçültür ( %55-58 boyut azaltma) 
görünür kalite kaybı olmadan. 
Son iterasyondan sonra kısa bir 
GPU geçişi olarak çalışır, yalnızca 
saniyenin parçası ile birkaç sani­
ye sürer. Pratikte her zaman açık 
olmalı — bunu kapatmanın tek 
nedeni eğitimi daha sonra Con­
tinue Training ile sürdürmek iste­
men ve görünmez Gaussian’ları 
da tutmak zorunda olmandır. 
Normal dışa aktarma iş akışların­
da basitçe açık bırak.
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R A D I A N C E K I T Bölüm 2 — Inspector (Expert View)

I27 Viewport Scaling-Seçici

N E R E D E

Inspector → Enhancements → Viewport Scaling (üç 
seçenekli segmentli seçici: Off, MetalFX, Lanczos).

T E K N İ K

Görüntüleyici yukarı ölçekleyicisini seçen tek bir 
segmentli seçici — üç seçenek birbirini dışlar. Eği
tim çözünürlüğü (I22 Render Scale ile) görüntüleyici 
boyutundan düşükse, seçilen mod render edilen ka
reyi görüntüleme boyutuna yukarı ölçekler. Off = 
basit bilineer germe. MetalFX = Apple’ın ML tabanlı 
uzaysal yukarı ölçekleyicisi, en keskin seçenek (ML 
modeli keskin kenarlar için optimize edilmiştir), M3 
GPU’larda kare başına yaklaşık 1-2ms ek yük. Lanc­
zos = Apple’ın Metal Performance Shaders’ı, 8-tap 
sinc yeniden örneklemeyle, ML olmadan klasik, mi
nimal ek yük (< 0.5ms), kalite MetalFX’in altında 
ama ince çizgi yapılarının ML tipik „yumuşaması“ 
olmadan. Render’cı pipeline’ı değiştirildiğinde canlı 
yeniden yapılandırılır — yeniden başlatmadan hemen 
görünür. Arka plan: Eskiden bunlar aynı anda açık 
olabilen iki ayrı anahtardı (MetalFX + Lanczos) — 
MetalFX’in sessizce Lanczos’u geçtiği çelişkili bir 
durum. Seçici bu durumu kaldırır; eski oturumlardan 
miras alınmış olası bir „ikisi-de-açık” durumu, bir 
sonraki geçişte kendini MetalFX’e iyileştirir. Yalnızca 
canlı görüntüleyiciye etki eder, render edilmiş dışa 
aktarmalara değil (orbit video, ekran görüntüleri) — 
bunlar tam kaynak çözünürlüğünde render edilir.

K I S ACA

Görüntüleyicideki canlı görün­
tüyü keskinleştirir — özellikle 
azaltılmış eğitim çözünürlüğün­
de (Render Scale %50, bkz. I22) 
çalışıyorsan yararlıdır. Her za­
man yalnızca birinin etkin olduğu 
üç kademe: „Off“ pikselleri ba­
sitçe gerer, „MetalFX” en keskin 
kenarlar için Apple’ın Machine-
Learning’ini kullanır (pratikte he­
men her zaman en iyi seçim), 
„Lanczos“ ise ML’siz klasik filt­
redir — MetalFX bir sahnede 
sana çizgileri düzleştiriyor veya 
eserler gösteriyorsa onu geri dö­
nüş olarak al. Canlı, yani yeni­
den başlatmadan etkilidir. Yalnız­
ca canlı görüntüleyicide etkili, dı­
şa aktarılmış orbit videolarında 
veya ekran görüntülerinde değil 
— bunlar tam kaynak çözünürlü­
ğünde render edilir. Eskinin aksi­
ne artık yanlışlıkla iki modu aynı 
anda seçemezsin.
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I29 Perceptual Loss kaydırıcı

N E R E D E

Inspector → Enhancements → Perceptual Loss.

T E K N İ K

0.0–0.2 arası, 0.01 adımda kaydırıcı, 0.0′da „Off“ 
olarak, aksi takdirde „0.05” vb. olarak gösterilir. 
Render’ın çoklu ölçekli Gaussian bulanıklığını gro
und truth görüntüyle karşılaştıran ek bir kayıp teri
mini etkinleştirir (3 bulanıklık ölçeği). L1+SSIM tek 
başına algılamayan yapısal farkları yakalar. V460 uy
gulaması. Ampirik olarak 0.05-0.1 arası bir değer 
oturumlarda L1 puanını birkaç yüzde iyileştirir ama 
~%5 eğitim süresine mal olur (bulanıklık çekirdekleri 
üzerinden ek forward geçişi). 0.15 üzerinde eğitim 
istikrarsızlaşır ve L1 yine kötüleşir (kayıp terimi opti
mizasyona egemen olur). Eğitim sırasında etkilidir, 
son işlemede değil — yani „Enhancements“ bölü
mündeki konumuna rağmen bu, sonradan saf bir 
iyileştirme değildir.

K I S ACA

Üç farklı bulanıklık seviyesin­
de yapısal görüntü benzerliğini 
kontrol eden ek bir kayıp payı. 
Özellikle saç, kumaş veya bitki 
örtüsü gibi ince yapılı sahnelerde 
yardımcı olur, çünkü L1+SSIM tek 
başına görmediği desenleri yaka­
lar. Daha küçük değerler daha 
güvenlidir — 0.05 ile 0.1 arası 
tatlı nokta, 0.15 üstünde eğitim 
istikrarsızlaşır ve kayıp yeniden 
kötüleşir. 0′da (Off) işlev tama­
men kapalı ve hiçbir maliyeti yok; 
etkinken bulanıklık çekirdekleri 
üzerinden ekstra forward geçişi 
için yaklaşık %5 eğitim süresi yu­
tar. „Enhancements“ bölümüne 
rağmen doğrudan eğitim sırasın­
da etkilidir, yalnızca son işleme­
de değil.
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I42 Sky Masking

N E R E D E

Inspector → Enhancements (Outdoor gru
bu) → „Sky Masking“ anahtarı. Bağlı: 
AppState.trainingConfig.skyMaskingEnabled (proje 
başına, @DefaultFalse ). Varsayılan: false .

T E K N İ K

Eğitim öncesi Apple Vision tabanlı gök piksel seg
mentasyonunu etkinleştirir. Eğitim başlangıcından 
önce her girdi kamerası için gök bölgesi Apple 
Vision foreground maskesiyle çıkarılır (Gök = Arka 
plan) ve ilgili kameraya piksel başına maske olarak 
atanır. Eğitim sırasında piksel başına kayıp katkısı 
gök maskesinin tümleyeniyle çarpılır — gök pikselleri 
gradyana 0 katkı sağlar; böylece göğe projekte olan 
Gaussian’lar optimizasyon sinyali almaz ve „daha 
yoğun“ ya da „daha parlak” olmaz. Dış mekân/dron 
sahnelerinde floater’ları (gökte koyu yumakçıklar) 
önemli ölçüde azaltır. Klasik 40K eğitiminde ~%3 
L1 gerilemesine mal olur (bkz. memory/​dev_​outdoor-
floater-reduction.md). Yalnızca açıkça tanınabilen 
gökle dış mekân sahnelerinde anlamlıdır; iç mekân 
sahnelerinde veya beyaz arka planda gök segmen
tasyonu yanlış alanları tanımlar ve geçerli kayıp sin
yallerini engeller. Değer artık proje başına saklanır 
(artık uygulama genelinde değil) ve önayarı / sahne 
dosyasını izler.

K I S ACA

Gök içeren dış mekân çekim­
lerinde sıklıkla gökte siyah ya 
da renkli yumakçıklar oluşur — 
bunlara „floater“ denir. Bu se­
çenek göğün nerede olduğunu 
otomatik algılar ve eğitime „gö­
ğü rahat bırak” der. Dron uçuş­
ları ve manzara sahnelerinde 
çok iyi çalışır. İç mekânlarda ya 
da koyu arka planlarda görün­
tüyü bozabilir — yani sadece 
gerçek gök görünüyorsa aç. De­
taylar: memory/​dev_​outdoor-
floater-reduction.md.
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I43 Eğitim Ortası Floater Temizliği

N E R E D E

Inspector → Enhancements (Outdoor grubu) → 
„Mid-Training Floater Cleanup“ anahtarı. Bağlı: 
AppState.trainingConfig.floaterCleanupEnabled 
(proje başına, @DefaultFalse ). Varsayılan: false .

T E K N İ K

Classic-40K eğitimde („P4 Quality“ önayarı) iki ek 
yoğunluk kontrol geçişi açar: iterasyon 20,000′de 
ve iterasyon 30,000′de. Her iki geçiş de tüm 
Gaussian’ları üç kriter için tarar: (a) çok düşük 
opaklık (standart 0.005), (b) küçücük ekran uzayı 
boyutu, (c) son 1000 iterasyonda kayıp katkısının ol
maması. Üç koşulun tamamını sağlayan Gaussian’lar 
budanır. Etki: eğitim sonunda ~%5–15 daha az Ga
ussian, dron/dış mekân sahnelerinde gökte gözle 
görülür biçimde daha az koyu yumakçık. Yakın çe
kim iç mekân sahnelerinde ~%1–3 L1 gerilemesine 
mal olur, bu yüzden varsayılan olarak etkin değildir. 
İki temizlik iterasyonu (20K, 30K) sabit tanımlıdır 
ve şu anda UI üzerinden değiştirilemez; daha kısa 
eğitimlerde (ör. P2 Preview 5K) anahtarın etkisi 
yoktur, çünkü iterasyon işaretlerine asla ulaşmaz. 
Yeni: Anahtar yalnızca aktif önayar Classic densifi
er kullandığında işletilebilir (densificationStrategy 
== .classic). MCMC veya Hybrid için devre dışı 
kalır ve satır içi bir not belirir, çünkü bu stratejiler ölü 
Gaussian’ları zaten kendileri ele alır (MCMC yeniden 
konumlandırma yoluyla, Hybrid birleşik reloc/noise 
mantığı yoluyla) — manuel temizlik geçişleri orada 
etkisiz veya kontraproduktif olurdu. Kod referansı: 
RadianceKitApp.swift, General sekmesi. Detaylar: 
memory/​dev_​outdoor-floater-reduction.md.

K I S ACA

Eğitim sırasında bazen artık gö­
rüntü kalitesine katkı sağlama­
yan ama bellek kaplayan „ölü“ 
Gauss noktaları oluşur. Bu seçe­
nek uzun bir eğitim sırasında iki 
kez (20K ve 30K iterasyonlarda) 
temizlik yapar ve bu cesetleri 
kaldırır. Gökle dış mekân sahne­
lerinde özellikle anlamlıdır, çünkü 
floater’ların çoğu orada birikir. 
Küçük eğitimlerde veya mobilya 
yakın çekimlerinde pek gerekli 
değildir. Anahtar yalnızca önaya­
rın Classic densifier kullandığın­
da açılabilir — MCMC veya Hyb­
rid önayarlarında griye alınır (kı­
sa bir açıklamayla), çünkü bunlar 
ölü noktalarını kendileri temizler.
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I44 Sky Dome’u Yeniden Yapılandır

N E R E D E

Inspector → Enhancements (Outdoor grubu) 
→ „Reconstruct Sky Dome“ anahtarı. Bağ
lı: AppState.trainingConfig.skyDomeEnabled (proje 
başına, @DefaultFalse ). Varsayılan: false .

T E K N İ K

Eğitim öncesi Sky-Dome projeksiyonunu etkinleştirir 
(V549e MVP). SfM’den sonra ve eğitim başlangıcın
dan önce her girdi kamerası için I42 ile paylaşılan 
Apple Vision gök maskesi görüntüden çıkarılır, gök 
pikselleri kamera intrinsikleriyle sanal bir küre yüze
yine ters projeksiyonlanır (standart yarıçap 8× sah
ne yarıçapı). Bu küre üzerinde projekte edilen gök 
piksellerinden gelen renk ortalamaları, çok büyük 
ölçeklendirme (sahne birimlerinde 1.0) ve başlangıç 
opaklığı 0.95 ile ~5000 yeni Gaussian başlatılır. 
Bu 5000 Gaussian klasik anlamda bir gök maske
si değildir — diğerleri gibi eğitilirler, ama yüksek 
başlangıç opaklığıyla ince bir kabukta bırakılırlar. 
Sonuç: dış mekân/dron sahnelerinde 360° novel gö
rünümlerde koyu konfeti yumakçıkları yerine gerçek 
gök rengi ve bulut yapıları görünür. Değer yeniden 
başlatmalar arasında hatırlanır. Yalnızca en azından 
360° kamera kapsamı olan dış mekân sahnelerinde 
anlamlıdır; gök görünümü olmayan saf nesne yaka
lamalarında etkisi yoktur. Durum: deneysel, daha 
geniş A/B doğrulaması ek dış mekân setlerinde bek
liyor.

K I S ACA

Eğitim, görünen birkaç piksel­
den göğü „tahmin“ etmeye çalış­
mak yerine (bu floater’lara yol 
açar), RadianceKit eğitim başla­
madan önce gök piksellerini doğ­
rudan sahne etrafındaki sanal bir 
küreye projeksiyonlar. Bittiğinde 
sahneyi 360° döndürdüğünde si­
yah yumakçıklar yerine gerçek 
gök görürsün. Yalnızca gerçekten 
gökte gök olan dış mekân çekim­
lerinde çalışır. Oturma odası ta­
ramalarında veya stüdyo çekim­
lerinde bir şey katmaz.
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Metrikler bölümü (I30–I38)

Şekil 13:  Bouquet üzerinde tamamlanmış eğitim sonrası yalnızca Training Metrics bölümü 
kırpması (5K iterasyon, sonunda 2 991 Gaussian) — eğitim metrikleriyle tablo (Iteration, Loss, 

SSIM Loss, Combined Loss, Gaussian Count, Learning Rate, Elapsed, ETA)

Bir eğitim çalışırken Metrikler bölümü eğitim döngüsünden dokuz canlı değer gösterir. 
Eğitim başlamadan önce bölüm boştur („Start training to see live metrics“). Tüm değer
ler her ~30 iterasyonda güncellenir ( akış güncelleme sıklığı). Bölüm salt okunur — hiçbir 
öge tıklanamaz veya değiştirilemez. Daha derin analiz için ~/​Documents/​RadianceKit/​
Logs/​ altındaki JSONL eğitim günlüklerini kullan (script python3 scripts/​analyze_​
logs.py best 5).
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I30 Iteration

N E R E D E

Inspector → Metrikler → Iteration. Salt okunur.

T E K N İ K

„4523 / 40000″ biçiminde gösterim — toplam plan
lanan iterasyonlar üzerinde mevcut iterasyon. De
ğerleri her ~30 iter’de gönderen eğitim döngüsüyle 
senkron sayar. İkinci sayı, başlangıç anındaki Max 
Iterations değerine karşılık gelir; kullanıcı stepper’ı 
daha sonra değiştirirse bile değişmez — çalışan 
çalıştırma kendi anlık görüntü kopyasını kullanır. Uy
gulama Training menüsünden iterasyon eklediğinde 
(Continue Training +5K/+10K/+20K) payda artar.

K I S ACA

Eğitimin şu anda nerede olduğu. 
„4523 / 40000″ demek: 40 000 
adımdan 4523′ü tamamlandı, ya­
ni yaklaşık %11 bitti. Sol sayı 
saniye saniye sayar; dakikalarca 
yerinde duruyorsa, eğitim takılı­
dır — çoğunlukla GPU throttling 
veya yarışan uygulama belirtisi. 
Sağ sayı, eğitim başlangıcındaki 
Max Iterations değerine (I18) kar­
şılık gelir ve stepper’ı sonradan 
değiştirsen bile değişmez. Conti­
nue Training’de (+5K/+10K/+20K) 
ek adımlarla birlikte büyür.

I31 Loss

N E R E D E

Inspector → Metrikler → Loss. Salt okunur.

T E K N İ K

Altı ondalık basamaklı float değeri (ör. „0.024385″). 
Birleştirilmiş L1+SSIM kaybını (karışım I21 SSIM We
ight üzerinden kontrol edilir) artı isteğe bağlı Per
ceptual Loss (I29) ve diğer düzenleyicileri ölçer. 
Ölçek mutlak değildir, sahneye bağlıdır — çoğu kar
şılaştırma için aynı veri setini gerektirir. İyi yapılan
dırmalarda tipik son değerler: - Classic Quality 40K 
iter: 0.022–0.025 (Horse, Truck, Garden) - MCMC 
Full 200K iter: 0.024–0.028 - Dış mekân dronu 30K: 
0.030–0.060 (geometriye bağlı olarak daha kötü) - 
İç mekân daireler: 0.018–0.025

5K iterasyondan sonra 0.10 üzerindeki değerler SfM 
sorunlarına (kötü kamera pozları) işaret eder — iptal 
et ve SfM’yi yeniden hesapla.

K I S ACA

Render edilen görüntünün oriji­
nalden ne kadar saptığı — L1, 
SSIM ve gerektiğinde Perceptual 
Loss’tan birleştirilmiş. Daha kü­
çük daha iyi. 0.03′ün altı çoğu 
kez gerçekten iyidir, 0.05′in altı 
hâlâ tamamdır, dış mekân sah­
neleri geometriye bağlı olarak 
daha çok 0.03-0.06′dadır. Birkaç 
bin iterasyondan sonra 0.10 üstü 
uyarı sinyalidir — çoğunlukla ka­
mera yeniden yapılandırmasın­
dandır (SfM temiz çalışmamıştır). 
Ölçek mutlak değildir, sahneye 
bağlıdır; yalnızca aynı veri se­
ti içinde karşılaştırma yap. Sayı 
aniden yukarı sıçrarsa, çoğunluk­
la bir gradyan patlaması olayı ol­
muştur.
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I32 Learning Rate

N E R E D E

Inspector → Metrikler → Learning Rate. Salt okunur.

T E K N İ K

Bilimsel notasyon gösterimi (ör. „1.60e-04″). Konum 
parametreleri için mevcut öğrenme hızı (3DGS’in ko
num, SH-DC, SH-Rest, opaklık, ölçek, dönüş için altı 
bağımsız LR’si vardır — burada temsili büyüklük ola
rak konum LR’si gösterilir). Varsayılan başlangıç de
ğeri 1.6e-4, üstel azalma üzerinden eğitim sonunda 
~1.6e-6′ya iner. Azalma, Eğitim Yapılandırması’ndaki 
LR Schedule alanı üzerinden (Bölüm 6′da T alanı) 
ayarlanabilir. LR olağandışı şekilde yüksek kalırsa 
(ör. 10K iterasyondan sonra 1e-3 veya daha fazla), 
bu yanlış yüklenmiş bir yapılandırmaya işaret edebi
lir.

K I S ACA

Optimizasyon adımlarının şu an­
da ne kadar büyük olduğu — 
somut olarak Gaussian konumla­
rı için öğrenme hızı. 1.60e-04′te 
başlar ve eğitim sonunda yakla­
şık 1.60e-06′ya üstel olarak dü­
şer („1.60e-06″ = 0.0000016). 
Seyir otomatiktir, burada bir şey 
ayarlaman gerekmez. Değer 10 
000+ iterasyondan sonra hâlâ 
1e-3′ten büyükse, muhtemelen 
hatalı bir config yüklenmiştir — 
eğitimi iptal et ve önayarı yeni­
den seç. İçeride 3DGS’in altı ba­
ğımsız öğrenme hızı vardır (Ko­
num, SH-DC, SH-Rest, Opaklık, 
Ölçek, Dönüş); burada yalnızca 
temsilci olarak konum LR’sini gö­
rürsün.

I33 SH Degree

N E R E D E

Inspector → Metrikler → SH Degree. Salt okunur.

T E K N İ K

0-3 tam sayı. Renk temsili için küresel harmonik 
derecesi. 0′da başlar (yalnızca DC bileşeni, yani Ga
ussian başına yön bağımsız renk — yani yalnızca bir 
RGB sabiti) ve eğitim seyrinde aşamalı olarak 3′e 
yükselir. Standart schedule, 1000/2000/3000 iteras
yonlarda dereceyi 1′er yükseltir. SH-3, Gaussian ba
şına 48 renk katsayısına karşılık gelir (3 RGB kanalı 
× 16 SH taban fonksiyonu). Daha yüksek SH derece
si = daha yön bağımlı yansıma (parlak yüzeyler farklı 
bakış açılarından doğru biçimde farklı görünür), ama 
daha fazla bellek ve daha yavaş eğitim.

K I S ACA

Gaussian başına renk temsilinin 
şu anda ne kadar karmaşık ol­
duğu. 0′da başlar (nokta başına 
yalnızca yön bağımsız renk) ve 
kademeli olarak 3′e çekilir — ti­
pik olarak iterasyon 1000, 2000 
ve 3000′de. Aşama 3 Gaussian 
başına 48 renk katsayısı demek 
ve yön bağımlı yansımalara izin 
verir, yani parlak yüzeyler farklı 
bakış açılarından doğru biçimde 
farklı görünür. Aktif olarak elle­
men gerekmez, schedule otoma­
tik çalışır. Daha yüksek derece 
daha fazla belleğe mal olur ve 
eğitimi hafifçe yavaşlatır — ama 
bu, gerçekçi parıltıların bedelidir.
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I34 Gaussians

N E R E D E

Inspector → Metrikler → Gaussians. Salt okunur.

T E K N İ K

Modeldeki mevcut Gaussian sayısı, yerel ayrım 
sembolüyle biçimlendirilir (ör. „524.318″). Büyü
me: - Classic: SfM başlangıç noktalarında (tipik 
50K-300K) başlar, Densify Until’in hemen öncesine 
kadar Clone/Split ile büyür, sonra eğitim sonuna ka
dar statik (budama hariç) - MCMC: Örnek noktaları 
MCMC üst sınırına kadar eklenir, sonra yalnızca ye
niden konumlandırma

Sağlıklı son değerler: - Classic Quality: 400K-700K 
(Horse 524K, Garden 800K) - MCMC Full: tam ola
rak üst sınırda (Varsayılan 150K, Auto-Scale çarpanı 
× SfM sayısına göre sahneye bağlı 500K-1.5M)

MCMC’de sayı üst sınırın < %60′ına düşerse → ano
mali (çöküş göstergesi, çok agresif düzenleyicilere 
işaret eder).

K I S ACA

3D modelin şu anda kaç Gaussian 
noktası olduğu. Eğitim sırasında 
Densify Until’e (I20) ulaşılana ka­
dar büyür; sonra sayı pratikte 
sabit kalır. Daha fazla nokta = da­
ha fazla detay, ama daha büyük 
dosya ve görüntüleyicide daha 
yavaş render. 500.000 Gaussian 
orta bir sahnede Classic Quality 
için tipik bir orta değerdir; MCMC 
Full Auto-Scale’e (I17) bağlı ola­
rak 500K ile 1.5M arasına düşer. 
MCMC’de sayı aniden üst sınırın 
%60′ının altına düşerse, bu bir 
çöküş göstergesidir — çoğunluk­
la çok agresif düzenleyiciler.

I35 GPU Memory

N E R E D E

Inspector → Metrikler → GPU Memory. Salt okunur.

T E K N İ K

Gaussian buffer bellek tüketiminin tahmini, Gaussian 
sayısı × 616 bayt olarak (bellek stilinde biçimlen
dirilmiş). 616 bayt, tam donanımlı bir Gaussian’ın 
(konum, ölçek, dönüş, opaklık, SH katsayıları dere
cesi 3, gradyan biriktiricisi) ampirik boyutudur. Gös
terim render’cı ek yükünü (tile buffer, sort buffer, 
backward buffer) içermez — gerçek GPU bellek ih
tiyacı tipik olarak bu değerin 2-3× üzerindedir. 500K 
Gaussian’da: gösterilen ~290 MB, gerçek ~700 MB. 
1.5M Gaussian’da: gösterilen ~880 MB, gerçek ~2.5 
GB. 64+ GB Unified Memory’li M3 Max’ta kritik de
ğildir, 18 GB’lı M3 Pro’da zaten bir limit.

K I S ACA

Gaussian’ların kendisinin ne ka­
dar GPU belleği kapladığının bir 
tahmini — nokta başına yaklaşık 
616 bayt. Gerçek GPU tüketimi 
gösterilenden 2-3× daha yüksek­
tir, çünkü render’cı kendi tile, 
sort ve backward buffer’larını da 
ekler. 16-18 GB Unified Memory’li 
bir MacBook’ta 500K Gaussian’ın 
altında kalman gerekir; M3 Max 
veya Studio (64+ GB) ile 1.5M 
ve fazlasını rahatlıkla sürdürebi­
lirsin. Eğitim aniden çökerse ve­
ya sistem swap yaparsa, sınır 
çoğunlukla buraya ulaşılmıştır — 
Render Scale’i (I22) düşür veya 
Densify Until’i (I20) azalt.
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I36 Speed

N E R E D E

Inspector → Metrikler → Speed. Salt okunur.

T E K N İ K

Bir ondalık basamakla saniyede iterasyon („24.3 it/
s“). Eğitici tarafından son ~100 iterasyon üzerinden 
kayan ortalama olarak hesaplanır. Tipik değerler: - 
Quick önayar (1K iter): 80-120 it/s (kısa, steady sta
te yok) - Classic 20K @ 1.0 Render Scale (Truck 
sahnesi, M3 Max): 25-35 it/s - Classic 20K @ 0.5 
Render Scale: 80-120 it/s - MCMC 200K @ 0.5 
Render Scale: 25-50 it/s (yeniden konumlandırma 
nedeniyle daha yavaş) - 1M+ Gaussian ve tam çözü
nürlükte: < 10 it/s

Eğitim seyrinde hızın azalması normaldir — daha 
fazla Gaussian = iterasyon başına daha fazla com
pute. Ani düşüşler (ör. 30 → 5 it/s) GPU termal 
throttling’e veya yarışan uygulamalara işaret eder.

K I S ACA

Eğitimin saniyede kaç iterasyon­
la çalıştığı. Tipik olarak 20-50 
it/s’de durur, azaltılmış Render 
Scale’de (%50) ve küçük sahne­
lerde 80-120 it/s’ye kadar olur. 
Eğitim seyrinde tamamen doğal 
olarak azalır, çünkü daha fazla 
Gaussian = iterasyon başına da­
ha fazla iş. Ani düşüşler (ör. 30 
→ 5 it/s) GPU termal throttling’e 
veya yarışan uygulamalara işaret 
eder — video tarayıcı sekmeleri, 
Time Machine yedeklemesi, Pho­
tos indeksleme. Uygulamayı ön­
de tutmak ve arka plan program­
larını kapatmak çoğu kez yardım­
cı olur. 1M+ Gaussian ve tam çö­
zünürlükte 10 it/s altı normaldir.

I37 Elapsed

N E R E D E

Inspector → Metrikler → Elapsed. Salt okunur.

T E K N İ K

Geçmiş süre olarak „4:23″ (m:ss) veya „1:23:45″ 
(h:mm:ss). Biçim 1 saatten itibaren geçer. Yalnızca 
saf eğitim süresini ölçer, öncesinde gelen aşamaları 
(SfM hesaplama, görüntü içe aktarma) ölçmez. Du
raklat/Sürdür’de saat çalışmaya devam eder — yani 
wall clock, CPU süresi değil.

K I S ACA

Eğitimin ne kadar süredir çalıştı­
ğı, saf bir kronometre olarak (wall 
clock süresi). Biçim bir saate 
kadar „m:ss“, sonra „h:mm:ss”. 
„CPU süresi“ değil, „ne kadar sü­
redir bekliyoruz” — yani durakla­
ma süreleri de sayılır. Yalnızca 
saf eğitim aşamasını ölçer, ön­
cesinde gelen SfM hesaplama ve­
ya görüntü içe aktarmayı değil. 
ETA (I38) ile karşılaştırma için 
yardımcıdır — Elapsed orijinal 
ETA’nın belirgin biçimde üstüne 
çıkarsa, eğitim bir yerde planla­
nandan yavaşlamıştır.
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I38 ETA

N E R E D E

Inspector → Metrikler → ETA. Salt okunur.

T E K N İ K

Kalan süre tahmini olarak „17:42″ veya „1:12:35″. 
Hesaplama: (Max Iterations − mevcut iterasyon) / 
saniyedeki iterasyon. Hız şu an sıfırsa „–“ gösterir 
(en başta veya duraklatmada). Tahmin, eğitim sonu
na doğru tipik yavaşlamaya uyarlanmaz — özellikle 
MCMC ve büyük Densify-Until değerli Classic’te 
eğitim, daha fazla Gaussian görüntüye girdiği için 
yavaşlamaya eğilimlidir. Gerçek, tipik olarak başlan
gıç ETA’sının %10-20 üzerinde kalır.

K I S ACA

Daha ne kadar beklenmesi gerek­
tiği — kalan iterasyonlar ve mev­
cut hızdan (I36) hesaplanır. Ka­
baca bir tahmin: Mac aniden ya­
vaşlarsa (Densify aşamasından 
itibaren daha fazla Gaussian, ter­
mal throttling, diğer uygulama­
lar), gösterildiğinden daha uzun 
sürebilir. Uygulama eğitim sonu­
na doğru tipik yavaşlamayı hesa­
ba katmaz, bu yüzden gerçek son 
çoğunlukla başlangıç ETA’sının 
%10-20 üzerinde çıkar. %15 ekle, 
sonra çoğunlukla uyar. Hız şu an 
0 ise (eğitim başlangıcı veya du­
raklatma) „–“ gösterir.

61 / 231



R A D I A N C E K I T Bölüm 2 — Inspector (Expert View)

Kayıp Diyagramı bölümü (I39–I41)

Şekil 14:  Tamamlanmış eğitimden sonra yalnızca Loss History bölümü kırpması — Current 
0.0064, Min 0.0035 (yeşil), 0.027′den (İterasyon 1) 0.0035′e (İterasyon 5K) mavi seyir, İter 

200 civarında karakteristik kırılma ile, altında turuncu Gaussian Count grafiği

Kayıp Diyagramı bölümü, eğitim seyrini zaman içinde görselleştirir. İki grafikten oluşur: 
bir Loss Curve grafiği (büyük, üstte, mavi) ve bir Gaussian Count grafiği (daha küçük, 
altta, turuncu). Her ikisi de eğitim sırasında canlı oluşturulur ve bir sonraki eğitim 
başlangıcına kadar kalıcı kalır. İlk eğitimden önce alan boştur („Loss curve will appear 
during training“). Grafikler saf SwiftUI Path çizimleridir (Swift Charts çerçevesi yok), 
böylece 100K+ noktada da akıcı render ederler.
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I39 Current Loss (gösterim)

N E R E D E

Inspector → Kayıp Diyagramı → sol etiket alanı „Cur
rent: 0.0287″. Salt okunur.

T E K N İ K

Son Loss örnek noktasının float değeri, dört onda
lık basamakla biçimlendirilir. Metrik bölümündeki I31 
(Loss) ile aynı, sadece burada daha kompakt biçim
lendirilmiştir. Kaynak Loss History — her ~30 iteras
yonda bir girdi alan bir liste. Yalnızca sonlu değerler 
listeye alınır — NaN/Infinity (çok nadir, gradyan pat
laması hatası durumunda) filtrelenir.

K I S ACA

Metrik bölümündekinden daha 
kısa yazımda (dört ondalık basa­
mak) mevcut Loss değeri. İçerik 
olarak I31 ile aynı, ama burada 
gösterim doğrudan Loss grafiği­
nin yanındadır ve eğriyi gözlem­
lerken sana tam sayısal değeri 
verir. Tüm canlı metrikler gibi her 
~30 iterasyonda güncellenir. NaN 
veya Infinity değerleri (gradyan 
patlaması hatalarında son derece 
nadir) uygulama otomatik olarak 
filtreler. Diyagrama bakarken di­
ğer bölüme atlamak zorunda kal­
mamak için kullanışlıdır.

I40 Min Loss (gösterim)

N E R E D E

Inspector → Kayıp Diyagramı → sağ etiket alanı 
„Min: 0.0245″ (yeşil). Salt okunur.

T E K N İ K

Mevcut eğitim çalıştırmasının şimdiye kadar gö
rülmüş tüm Loss değerlerinin minimumu. Loss 
History’den canlı yeniden hesaplanır — ayrı kalıcı
lık yok. Yeşil yazıyla gösterilir, çünkü „Min“ = „Şu 
ana kadar en iyi”. Grafik alt kenarındaki kesik yeşil 
çizgi bu Y konumunu görsel olarak işaretler. Conti
nue Training oturumlarında minimum izleme yeniden 
başlar — eski history UI’da yenisi tarafından değiş
tirilir (eklenmez). Mevcut eğitim öncekinden daha 
kötü çalışıyorsa, Min gösterimi önceki son sonuçtan 
daha büyük olabilir.

K I S ACA

Bu eğitimin şimdiye kadar gördü­
ğü en düşük Loss değeri — „şu 
ana kadar en iyi“ olduğu için 
yeşil gösterilir. Grafik alt kenarın­
daki kesik yeşil çizgi bu konumu 
görsel olarak da işaretler. Mev­
cut eğri şu an belirgin biçimde 
üstünde duruyorsa, biraz şansla 
hâlâ bir iyileşme olur; çoğunluk­
la ama Min, daha sonra ilgilen­
diğin son sonuç işaretidir. Conti­
nue Training oturumlarında Min 
izleme yeniden başlar, çünkü es­
ki history UI’da yenisi tarafından 
değiştirilir — Min değeri bu yüz­
den önceki son sonuçtan kötü 
görünebilir.
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I41 Gaussian Count grafiği

N E R E D E

Inspector → Kayıp Diyagramı → altındaki ikinci grafik 
(turuncu). Salt okunur.

T E K N İ K

Gaussian sayısının eğitim iterasyonları üzerindeki 
çizgi diyagramı. Kaynak: Gaussian Count history 
(eğitici tarafından her ~30 iter doldurulan (Iter, Co
unt) çiftlerinin listesi). Y ölçeği history’nin minimum 
ile maksimumu arasında dinamik. Classic stratejisin
de eğri tipik olarak şöyle görünür: Densify Until’e 
kadar sürekli yükselir, sonra düz (küçük budama 
dalgalanmaları ile). MCMC’de: üst sınıra kadar dik 
yükseliş, sonra yatay çizgi (yeniden konumlandırma 
sayıyı sabit tutar). Eğri etkin eğitime rağmen düşer­
se, Densification çok agresif budar — yanlış varsayı
lanlara veya bilinen MCMC çöküş hatasına (v1.4.4 
hotfix konusu) işaret eder.

K I S ACA

Gaussian sayısının eğitim süresi 
boyunca nasıl değiştiği — Loss 
eğrisinin altındaki daha küçük 
turuncu grafik. Classic strateji­
sinde çizgi sürekli yükselir ta ki 
Densify Until’e (I20) ulaşana ka­
dar, sonra küçük budama dalga­
lanmalarıyla düz kalır. MCMC’de 
üst sınıra dik bir şekilde fırlar 
ve sonra yatay kalır, çünkü yeni­
den konumlandırma sayıyı sabit 
tutar. Eğri etkin eğitime rağmen 
aniden aşağı kırılırsa, Densifica­
tion budarken çok agresiftir — 
v1.4.4′ten MCMC çöküş hatasının 
klasik belirtisi. Sonra uygulama 
güncellemesi veya Classic’e geri 
dönüş yardımcı olur.

Loss eğrisi nasıl okunur?

Loss grafiği Inspector’daki en önemli tanı aracıdır — başka hiçbir gösterge eğitimin 
faydalı ilerleyip ilerlemediğini veya takılıp takılmadığını bu kadar doğrudan göstermez. 
Tipik sağlıklı biçim, ilk 1000-3000 iterasyonda hızlı bir düşüş (~0.15′ten ~0.05′e), ardın
dan eğitim sonuna kadar yavaş, eşit bir düşüştür (0.020-0.030′a). Logaritmik olarak eğri 
böylece düzgün bir çapraz gibi görünür.

Loss’taki bir plato ne anlama gelir? Eğri birkaç bin iterasyon boyunca düz kalırsa, 
iki olası okuma vardır: (a) Eğitim „yakınsamıştır“ — Loss artık önemli ölçüde düşemez, 
çünkü model verilen veriler ve ayarlarla olabileceği kadar iyidir. Bu istenir; bu „bitti”dir. 
(b) Eğitim „takılır“ — Loss aslında hâlâ düşebilir, ama optimizasyon duraklamıştır (yerel 
minimum, öğrenme hızı çok küçük, Densification kapalı). Ayırt et: Loss değeri tipik iyi 
bir aralıkta (İç mekân/Nesnede 0.020-0.030, Dış mekânda 0.040-0.060) ve eğri 5K ite
rasyondan beri düz ise, yakınsamıştır. Değer karşılaştırılan sahnelerden belirgin biçimde 
yüksekse (ör. 0.08), takılıdır.

Dikkat: Gaussian platosu ≠ Loss platosu. Gaussian sayısındaki bir plato „Eğitim bitti“ 
anlamına gelmez. Yalnızca Densification’ın yeni nokta eklemeyi bıraktığı anlamına gelir 
— ya ulaşıldığı (Classic) ya da MCMC üst sınırı dolu olduğu için. Eğitim sonrasında çalış
maya devam eder ve yalnızca mevcut noktaları ince ayar yapar. Asıl „bitti” sinyalini Loss 
eğrisinde ve İterasyon gösteriminde (I30) okursun, burada değil.

İptal etmek için pratik kural: Loss eğrisi 5000+ iterasyondan sonra 0.08′in üstündeyse 
ve neredeyse hiç düşmüyorsa, yüksek olasılıkla SfM yeniden yapılandırması bozuktur. 
Eğitimi iptal et, Bölüm 9′da seçtiğin SfM arka ucunun sahneye uyup uymadığını kontrol 
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et, gerektiğinde COLMAP/Native’e geç, sonra yeniden başlat. Kötü kamera hizalamasıyla 
2 saat eğitim yerine daha iyi SfM için 10 dakika yatırım yapmak daha iyi.

Ne zaman Inspector’a el atmalı?

Hızlı referans: Hangi tipik kullanım durumu için hangi bölüm + hangi kontroller?
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Yaygın görev Bölüm Kontrol ID’leri

Tamamlanmış Splat’ın renkleri
nin doygunluğunu azaltma

Look L1 (Saturation)

İğne/konfeti Splat’larını yuvar
lama

Look L2 (Splat length)

Körlü bulutu doldurma / 
Splat’ları büyütme

Look L3 (Splat size)

Orbitlerde uzak „Far-konfeti“yi 
gizleme

Look L4 (Fade far region)

Look ayarlarını atma Look L5 (Reset finishing)

Hazır kurulum yükleme Önayarlar I7 (satıra tıklama)

Kendi kurulumunu kaydetme Önayarlar I1 → I2 → I4

Kurulumu meslektaşlarla pay
laşma

Önayarlar I5 (Export) veya I6 (Import)

SfM arka ucunu değiştirme (ör. 
Apple PG çok istikrarsız)

Eğitim Yapılandırma
sı

I12 (bkz. Bölüm 9)

EXIF odak uzaklığı olmayan vi
deo karelerini işleme

Eğitim Yapılandırma
sı

I13 (FOV Override)

COLMAP performansı: klasik 
yerine GLOMAP

Eğitim Yapılandırma
sı

I14

Classic’ten MCMC’ye geçiş Eğitim Yapılandırma
sı

I15

Eğitimi daha uzun çalıştırma Eğitim Yapılandırma
sı

I18 (Max Iter) + I20 (Densify 
Until) — I19 üzerinden bağlı

GPU süresini yarıya bölme Eğitim Yapılandırma
sı

I22 (Render Scale %50)

Eğitim kalitesi +%6 (MCMC) Eğitim Yapılandırma
sı

I16 (MCMC Quality)

Çok SfM noktalı dış mekân sah
nesi

Eğitim Yapılandırma
sı

I17 (Auto-scale by scene)

COLMAP yolu ayarlama / değiş
tirme

Eğitim Yapılandırma
sı

I23 / I24 / I25

Dışa aktarma dosyalarını kü
çültme

Enhancements I26 (her zaman açık bırak)

Görüntüleyiciyi daha keskin, ek 
eğitim süresi olmadan

Enhancements I27 (Viewport Scaling → Metal
FX)

MetalFX çok düzleştiriyor → al
ternatif

Enhancements I27 (Viewport Scaling → Lanc
zos)

İnce yapılarda son detay dam
lası

Enhancements I29 (Perceptual Loss 0.05-0.1)

Eğitimi izleme Metrikler I30 (İlerleme), I36 (Hız), I38 
(Kalan süre)

Kaliteyi erken değerlendirme Metrikler I31 (5K sonrası Loss < 0.05 = 
iyi)

SfM sorunu şüphesi Metrikler + Loss 
grafiği

I31 + I39 (5K sonrası Loss > 
0.08 → SfM’yi yeniden)

Convergence ile takılmayı ayırt 
etme

Kayıp Diyagramı I39 + I40 (Loss platosunu oku
ma)

Densification sorununu tanıma Kayıp Diyagramı I41 (Gaussian eğrisi düşer → 
hata)66 / 231
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B Ö L Ü M

Bölüm 3 — Ayarlar

Ayarlar penceresi RadianceKit → Ayarlar… veya standart kısayol ⌘,  ile açılır. İki 
sekme içerir: General ve AI Helpers. Bölüm 2′deki Inspector değerlerinden farklı olarak 
bu penceredeki ayarlar uygulama genelinde (tüm projeler boyunca) etkilidir — kalıcı 
olarak saklanır ve uygulama yeniden başlatmalarında korunur. General sekmesi içerik 
olarak üç bölüm gruplandırır: Arayüz, Görüntüleyici ve Eğitim. (Eskiden burada yer alan 
üç Outdoor-Floater anahtarı — Sky Masking, Mid-Training Floater Cleanup, Reconstruct 
Sky Dome — v1.6 itibarıyla Expert Inspector’ının Enhancements bölümüne taşındı ve 
artık orada proje başına saklanıyor; bkz. Bölüm 2, I42–I44.) AI Helpers sekmesi, SfM ve 
eğitim ön işleme için cihaz üzerinde Machine Learning yardımcılarını (Vision, CoreML) 
açar.

Tüm AI Helpers’ı topluca etkinleştiren ya da devre dışı bırakan daha önceki kontroller 
mevcut sürümde artık yoktur — bu yüzden burada belgelenmemiştir. Henüz gönderilme
miş yardımcılar için önceki „Coming Soon“ alanı da kaldırılmıştır ve burada referans 
verilmez.
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General sekmesi

Şekil 15:  Ayarlar → Arayüz, Görüntüleyici, Eğitim ve deneysel bölümlü General sekmesi
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S1 Default Mode

N E R E D E

Ayarlar → General → Arayüz → Default Mode seçici. 
Bağlı:. Varsayılan: .simple .

T E K N İ K

Uygulamanın bir sonraki başlatmada iki UI modun
dan hangisinde açılacağını kontrol eder. „Simple 
Mode“, 4 adımdaki rehberli sihirbaz iş akışıdır (İçe 
aktarma → İşleme → Önizleme → Dışa aktarma, 
Bölüm 10′da Z1–Z4 olarak belgelenmiştir), „Expert 
Mode” ise Bölüm 2′deki Navigator, 3D görüntüleyici 
ve Expert Inspector ile klasik üç panel düzenidir. De
ğer yeniden başlatmalar arasında hatırlanır. Mode →
Simple Mode (⌘1) / Mode → Expert Mode (⌘2) 
menüsüyle aynı etkiyi yapar; sadece menü çalışan 
oturumu değiştirirken bu seçici gelecekteki oturum
lar için varsayılanı belirler. Her iki mod da aynı proje 
durumuna erişir — projeler, kameralar ve eğitim ya
pılandırması mod değişiminde korunur. Moda özel 
araç çubuğu düğmeleri hemen yeniden çizilir.

K I S ACA

Burada RadianceKit’in bir son­
raki başlatmada hangi arayüzle 
açılacağını seçersin. „Simple Mo­
de“ başlangıç modudur: dört net 
adım, hazır ön ayarlar, neredeyse 
hiç seçenek. „Expert Mode” ise 
Bölüm 2′de gördüğün tüm kont­
rollerle tam alet çantası düzeni­
dir. „Mode“ menüsü üzerinden 
istediğin zaman ileri geri geçe­
bilirsin; görüntüler ya da eğitim 
ilerlemesi kaybolmaz.

S2 Dil

N E R E D E

Ayarlar → General → Arayüz → Dil seçici. Bağlı:. Var
sayılan: .system  (macOS dilini izler).

T E K N İ K

Uygulama UI’ının tamamının görüntü dilini, macOS 
sistem dilinden bağımsız olarak seçer. RadianceKit 
17 dile yerelleştirilmiştir ( de , en , pl , en-AU , 
ar-SA , artı 12 dil daha). „System“ seçildiğinde 

uygulama macOS dilini izler. Açıkça bir seçim yapıl
dığında dil ayarı yeniden başlatmalar arasında hatır
lanır; tam etki genellikle uygulamanın yeniden başla
tılmasını gerektirir, çünkü yerelleştirme paketleri yal
nızca başlangıçta yüklenir. Projede belgelenen 298 
yerelleştirme anahtarının tümü, alt görünümlerdeki 
ve yardım ipuçlarındaki tüm metinler dahil olmak 
üzere dikkate alınır.

K I S ACA

Mac’in İngilizce çalışıyor ama 
Türkçe RadianceKit arayüzünü 
tercih ediyorsan (ya da tersi), bu­
radan ayarlarsın. Çoğu metin he­
men değişir. Bazı diyaloglar yeni 
dilde ancak uygulamayı yeniden 
başlattıktan sonra görünür.
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S3 Görüntüleyici Arka Planı

N E R E D E

Ayarlar → General → Görüntüleyici → Arka plan seçi
ci. Bağlı:. Varsayılan: .darkGray  (RGB 0.1, 0.1, 0.1).

T E K N İ K

3D görüntüleyici için standart arka plan rengini ayar
lar. Üç seçenek: „Dark Gray“ (RGB 0.1, 0.1, 0.1 — 
varsayılan), „Black” (0, 0, 0) ve „White“ (1, 1, 1). 
Ayar, yeni projeler ve oturumlar için varsayılanı yeni
den başlatmalar arasında kalıcı kılar ve aynı zaman
da çalışan Metal render’cısını hemen günceller. Aynı 
seçenekler Viewport
→ Background menüsünde de bulunur (M21, M22, 
M23), ancak Ayarlar seçicisi varsayılanı belirlerken 
menü çalışan görüntüyü değiştirir. Ekran görüntüleri 
ve demo videoları için önemli: beyaz arka planlar 
yeşil/mavi floater’ları daha güçlü vurgular, koyu arka 
planlar temiz render çekimleri için daha iyidir.

K I S ACA

Önizleme penceresindeki 3D mo­
dellerinin arkasındaki renk. Koyu 
gri varsayılandır ve çoğu sahne­
ye uygundur. Beyaz ekran görün­
tüleri için iyidir, siyah render çe­
kimlerinde daha şık görünür. „Vi­
ewport → Background“ menüsü 
üzerinden çalışan sahne için ren­
gi istediğin zaman değiştirebilir­
sin — bu ayar yalnızca bir sonra­
ki açılışta hangi rengin aktif ola­
cağını belirler.

S4 Eğitimden Sonra Otomatik Döndür

N E R E D E

Ayarlar → General → Görüntüleyici → „Auto-Rotate 
After Training“ anahtarı. Bağlı:. Varsayılan: false .

T E K N İ K

Eğitim biter bitmez görüntüleyici kamerasının sah
ne ağırlık merkezi etrafında sürekli bir turntable 
dönüşünü başlatır (standart dönüş hızı ~0.3 rad/
sn). Demo oturumları, A/B karşılaştırmaları ve 360° 
görünümden „floater“ların sahne kenarında oluşup 
oluşmadığını doğrudan değerlendirmek için pratiktir. 
Görsel olarak Viewport →
Toggle Auto-Rotation menüsüyle (M16, ⌘⌥T) aynı 
etkidir, sadece buradaki anahtar davranışı manuel 
olarak değil, eğitim bittiğinde otomatik olarak tetik
ler. Daha sonra istediğin zaman menü üzerinden ve
ya görüntüleyiciye tıklayarak (bu dönüşü duraklatır) 
durdurabilirsin. Eğitim performansına etkisi yoktur — 
döndürme yalnızca eğitim bittiğinde başlar.

K I S ACA

Etkinleştirildiğinde 3D sahne, 
eğitim biter bitmez bir atlıkarın­
ca gibi otomatik olarak döner. 
Gece eğitimlerinde sabah sonucu 
kendin tıklamadan harekette gör­
mek hoştur. Eğitimi yalnızca izle­
diğin uzun oturumlarda kapalı bı­
rak.
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S5 Canlı Önizleme Aralığı

N E R E D E

Ayarlar → General → Eği
tim → Live Preview seçici. Bağ
lı: AppState.trainingConfig.livePreviewInterval. 
Varsayılan: 0  (Kapalı).

T E K N İ K

Çalışan eğitim anlık görüntüsünün hangi iterasyon 
aralığında 3D görüntüleyiciye render edileceğini be
lirler. Dört ayrık değer: 0 („Off“), 50, 250, 1000 
iterasyon. Canlı Önizleme etkinken eğitici, Gaussian 
buffer’ını GPU’dan ayrı bir render buffer’a kopyalar 
ve bir görüntüleyici yeniden çizimini tetikler. „Off”ta 
görüntüleyici yalnızca eğitim bittikten sonra güncel
lenir. Performans maliyeti: her 50 iterasyonda M3 
Ultra’da ~%5–10 daha yavaş, her 250 iterasyonda 
~%1–2 daha yavaş, her 1000 iterasyonda ölçülemez. 
Anlık görüntü buffer’ı için bellek ek yükü sabit ~2 
GB, aralıktan bağımsız. Değer yeni eğitimler için var
sayılan görevi görür; eğitim başladıktan sonra Eğitim 
Inspector’ı bu eğitimin gerçek canlı değerini göste
rir. Aralık 50′de görsel izlenim nokta bulutunun akıcı 
bir „büyümesi“dir, 1000′de takılır.

K I S ACA

Eğitim çalışırken 3D görünümün 
ne sıklıkta güncelleneceğini se­
çebilirsin. „Off“ demek: eğitim 
sırasında güncelleme yok (en 
hızlısı). „Every 50 Iterations”, 
sahnenin nasıl oluştuğunu nere­
deyse gerçek zamanlı gösterir 
(biraz daha yavaş). Küçük eğitim­
lerde rahat izlemek için „Every 
250″ iyi bir uzlaşmadır.
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S6 Throttle Gecikmesi

N E R E D E

Ayarlar → General → Eğitim → Throttle seçici. Bağlı: 
AppState.trainingConfig.throttleDelayMs. Varsa
yılan: 0  (Kapalı).

T E K N İ K

Eğitim iterasyonları arasına milisaniye cinsinden ya
pay bir gecikme ekler. Dört ayrık değer: 0 („Off“), 
2 („Light”), 5 („Moderate“), 10 („Eco”). Anlam: uzun 
eğitimlerde (birkaç saat) GPU aksi takdirde %100 
kullanılır; bu da fark edilir derecede yavaş sistem 
UI’sına neden olur (fare imleci takılır, diğer uygu
lamalar ağırlaşır). Throttle gecikmesi GPU’ya diğer 
görevlerin çalıştırılabileceği duraklar verir. Perfor
mans maliyetleri ciddidir: 5 ms throttle’da tipik bir 
40K eğitim, throttle olmadan göre yaklaşık %50–
80 daha uzun sürer. „Eco“ performans modunda 
(10 ms) iterasyon başına gecikme iterasyondan daha 
uzundur — 2–3× daha yavaş faktör. Throttle etkin
ken seçicinin altında bir uyarı görünür: „Throttle is 
on. Training will be slower than usual.” Uygulamanın 
kendisi fark edilir biçimde daha iyi tepki vermez — 
yalnızca diğer uygulamalar yararlanır.

K I S ACA

Mac’in uzun bir eğitim sırasında 
çok ısınıyor veya diğer program­
lar fazla ağırlaşıyorsa, buradan 
bir fren aç. „Off“ GPU’ya tam gaz 
verir (en hızlısı). „Light” her adım 
arasında küçük bir mola yapar 
(biraz daha yavaş, ama sistem 
daha iyi tepki verir). „Eco“ en 
güçlü frendir — çok ısınmaması 
istenen MacBook’ta gece eğitim­
leri için iyidir.
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AI Helpers sekmesi

Şekil 16:  Ayarlar → Ana anahtarlı ve alt anahtarlı AI Helpers sekmesi
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S11 AI Helpers etkin (Ana)

N E R E D E

Ayarlar → AI Helpers → ilk bölüm → „AI Helpers 
enabled“ anahtarı. Bağlı:. Varsayılan: true .

T E K N İ K

Pipeline’daki tüm AI Helpers özelliklerinin üzerin
de ana anahtar. Kapalıyken içe aktarma ve SfM 
pipeline’ı tüm ML tabanlı ön işleme aşamalarını ta
mamen atlar — Apple Vision çağrısı yok, CoreML 
model yüklemesi yok, NPU uyandırması yok. Açıkken 
bireysel alt anahtarlar (S12–S13) danışılır. Değer ye
niden başlatmalar arasında hatırlanır. Şu aşamaları 
etkiler: (a) SfM’den önce kare kalitesi ön kontrolü 
(S12), (b) loop closure tespiti (S13). Önemli: kapa
lıyken iki alt anahtar devre dışıdır ve görsel olarak 
griye alınır. Alt bilgi notu, tüm AI Helpers’ın kesinlikle 
cihaz üzerinde çalıştığını vurgular — görüntü yükle
mesi yok, bulut işleme yok. Veri gizliliği garantisi, 
yalnızca Apple Vision çatısının (Neural Engine üze
rinde yerel olarak) ve doğrudan uygulama paketinde 
bulunan CoreML modellerinin kullanılmasından gelir.

K I S ACA

İçeride yapay zeka/Machine Lear­
ning kullanan tüm işlevler için 
ana anahtar. Yardımcılar görün­
tülerin Mac’ten ayrılmadan çok 
zaman kazandırdığı için varsa­
yılan „açık“tır. Tamamen kapa­
lı olmasını istiyorsan (ör. ener­
ji tasarrufu için ya da Mac’inin 
NPU’su yok diye) buradan kapat 
— o zaman aşağıdaki iki alt seçe­
nek otomatik gri olur ve bir şey 
yapmaz.

74 / 231



R A D I A N C E K I T Bölüm 3 — Ayarlar

S12 Kare Kalitesi Kontrolü

N E R E D E

Ayarlar → AI Helpers → Mevcut bölüm → „Frame 
quality check“ anahtarı. Bağlı:. Varsayılan: true .

T E K N İ K

SfM çağrısından önce her içe aktarılan kareyi analiz 
eden Kare Kalitesi Tarayıcısını etkinleştirir (Faz 3.11). 
Kare başına pipeline adımları: (a) Apple Vision’dan 
Laplacian Variance filtresi (bulanıklık tespiti — eşik 
~150), (b) histogram tabanlı aşırı/yetersiz pozlama 
kontrolü (eşik: 0 veya 255′te >%5 piksel), (c) Boş 
kare algılaması (tüm piksellerde standart sapma < 
5). Üç kontrolden de geçen kareler doğrudan geçer. 
En az bir kontrolde başarısız olan kareler, her so
runlu kareyi küçük resim ve gerekçeyle listeleyen 
ve silinip silinmemesi gerektiğini soran modal bir 
onay diyaloğunu tetikler. Önemli: otomatik silme yok 
— diyalog her zaman gereklidir, son kararı kullanı
cı verir. Performans: M3 Ultra’da kare başına ~50 
ms, paralel çalışır. Kapalıyken tüm kareler kontrol 
edilmeden SfM’ye iletilir. Ana (S11) devre dışıyken 
bu anahtar görsel olarak griye alınır ve etkisizdir. 
Bellek durumuna göre gönderim durumu: SHIPPED 
2026-05-23.

K I S ACA

Asıl eğitim öncesi uygulama her 
fotoğrafa bakar: sallanmış mı? 
tamamen koyu ya da beyaz mı? 
boş mu? Eğer öyleyse görüntü­
yü atıp atmak istemediğini sorar 
— asla otomatik bir şey silmez. 
Bu sonradan çok saat kazandırır, 
çünkü tek bir tamamen sallanmış 
görüntü bazen tüm eğitimi boza­
bilir. Çaba neredeyse sıfır ve fay­
dası büyük olduğu için varsayılan 
„açık“tır.

75 / 231



R A D I A N C E K I T Bölüm 3 — Ayarlar

S13 Loop Closure Algılama

N E R E D E

Ayarlar → AI Helpers → Mevcut bölüm → „Loop clo
sure detection“ anahtarı. Bağlı:. Varsayılan: true .

T E K N İ K

Apple Vision Feature-Print tabanlı loop closure al
gılamasını etkinleştirir. İçe aktarılan her kare için, 
görüntü içeriğinin nöral bir embedding’ini temsil 
eden ~768 boyutlu bir özellik vektörü hesaplanır. 
Ardından tüm Feature-Print’ler çiftler halinde cosine 
benzerliğiyle karşılaştırılır. Benzerliği > 0.85 ve kare 
endeksinde mesafesi > 50 (yani komşu olmayan ka
reler) çiftler „loop closure adayları“ olarak tanımlanır 
ve proje klasöründeki bir sidecar JSONL dosyasına 
yazılır. Yalnızca bilgilendirici — içe aktarılan görüntü 
dizisi değiştirilmez. Anlam: SfM çözücüsüne (özel
likle COLMAP) bu karelerin 3D uzayda birlikte grup
landığı ipucunu verir. Yerel SfM için sidecar bilgisi 
şu anda yalnızca belgeleyicidir; COLMAP ipuçlarını 
özel matches dosyası üzerinden dahili olarak kullanır 
(manuel entegrasyon mümkün, otomatik bağlı değil
dir). Performans: M3 Ultra’da kare başına ~200 ms, 
paralel çalışır. Kapalıyken Feature-Print üretilmez. 
Ana (S11) devre dışıyken görsel olarak griye alınır.

K I S ACA

Bir nesne etrafında fotoğraf çe­
kerken sonunda yeniden başlan­
gıç noktasına geldiğinde, bunu 
bilmek bilgisayara çok yardım 
eder. Bu seçenek fotoğrafları­
nın hangilerinin „neredeyse ay­
nı noktadan“ çekildiğini otomatik 
algılar ve bunu küçük bir yar­
dımcı dosyaya yazar. SfM araç­
ları (özellikle COLMAP) bu bilgi­
yi daha temiz bir 3D yeniden 
yapılandırma sağlamak için kul­
lanabilir. Senin müdahalen olma­
dan çalıştığı ve görüntülerinde 
bir şey değiştirmediği için varsa­
yılan „açık”tır.

Inspector Ayna Ayarları

Envanter tablosundan kalan Ayarlar girdileri (S17–S33) Expert Inspector’dan yansımalar
dır ve Bölüm 2′de (Inspector kontrolleri I12–I29) belgelenmiştir. Fiziksel olarak Ayarlar 
penceresinde görünmezler, sadece ile kalıcı kılınan ve dolayısıyla resmi olarak Ayarlar 
karakterine sahip TrainingConfig  özellikleri üzerinden çalıştıkları için envanterde liste
lendiler. İçerik açıklamaları için oraya bak.
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Ne zaman ne?

Ayar Geçerlilik alanı Kalıcılık

S1 Default Mode Uygulama Geneli Uygulama yeniden başlat
ma

S2 Dil Uygulama Geneli Uygulama yeniden başlat
ma

S3 Görüntüleyici 
Arka Planı

Uygulama Geneli (Varsayılan) + Ça
lışma zamanı

Uygulama yeniden başlat
ma

S4 Eğitimden Son
ra Otomatik Dön

dür

Uygulama Geneli Uygulama yeniden başlat
ma

S5 Canlı Önizleme 
Aralığı

Yeni eğitimler için varsayılan Uygulama yeniden başlat
ma

S6 Throttle Gecik
mesi

Yeni eğitimler için varsayılan Uygulama yeniden başlat
ma

S11 AI Helpers Ana Uygulama Geneli Uygulama yeniden başlat
ma

S12 Kare Kalitesi 
Kontrolü

Uygulama Geneli Uygulama yeniden başlat
ma

S13 Loop Closure 
Algılama

Uygulama Geneli Uygulama yeniden başlat
ma

Uygulama Geneli = tüm projeleri etkiler. Yeni eğitimler için varsayılan = yalnızca bir 
sonraki oluşturulan eğitimi etkiler, çalışan oturumlar değişmeden kalır. Mevcut eğitim 
= mevcut eğitim yapılandırmasında hemen etkilidir, ama açık bir yeniden içe aktarma 
olmadan kalıcı olmaz.
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B Ö L Ü M

Bölüm 4 — Yardımcı Pencereler

Ana pencerenin (3D görüntüleyici artı Inspector) yanı sıra RadianceKit, hepsi Help me
nüsünden açılan yedi pencere daha yönetir. Liste yukarıdan aşağıya: User Guide (⌘?), 
Keyboard Shortcuts (⌘/), Open Training Logs… (bir uygulama penceresi değil Finder’ı 
açar; bu yüzden burada ele alınmaz), Manage Storage…, Pareto Dashboard… (⇧⌘D), 
Holdout Analysis… (⇧⌘H), BayesOpt Console… (⇧⌘B). Bunlardan üçü — Dashboard, 
Holdout, BayesOpt — bağımsız analiz araçlarıdır. Her birinin kendi View-Model yığını 
vardır, diskte JSON dosyaları okur veya yazar; ve her biri için pencereyi uygulama baş
langıcında belirli bir dosyaya yönlendirebilen bir CLI argümanı vardır ( --dashboard-dir , 
--holdout-file , --bayesopt-autorun ).

Dört basit pencere (User Guide, Keyboard Shortcuts, Manage Storage ve alt menü öge
leri Open Training Logs / Open Exports Folder) kontrol başına kısa bir girdi alır. Üç analiz 
penceresi daha ayrıntılı olarak belgelenmiştir — her biri ne göreceğini, ne zaman açmanı, 
gösterilen görüntüyü nasıl yorumlamanı açıklayan bir girişle.

Bölüm sonunda ana pencerenin Inspector’ına bir çapraz başvuru bölümü vardır: çalışan 
bir eğitim sırasında canlı Loss grafiğinden ve Gaussian Count gösteriminden anlamlı 
olarak ne okuyabileceğin.
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User Guide (W1–W4)

Şekil 17:  Solda kenar çubuğu ve sağda render edilmiş Markdown içeriği olan User Guide 
penceresi

Nedir: Uygulamayla birlikte gelen guide_<dil>.md ’yi render eden yerleşik bir yardım 
penceresi. Dil Ayarlardan (Sekme General → Dil) veya orada „Sistem“ ayarlıysa macOS 
dil tercihlerinden türetilir. Düzen klasik: solda tüm başlıklarla kenar çubuğu, sağda akan 
metin.

NE ZAMAN AÇ  Tek bir noktaya hızlı bir hatırlatmaya ihtiyacın olduğunda — yani anahtar 
kelime yerine. Ayrıntılı referans bu kılavuzdur; yerleşik yardım penceresi daha çok komut 
satırındaki bir --help  olurdu. Her uygulama yayınında güncellenir, ancak içerik olarak 
daha yüzeyseldir.
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W1 NavigationSplitView (Kenar Çubuğu + Detay)

N E R E D E

Help → User Guide (⌘?).

T E K N İ K

İçerik ağacı için dar bir kenar çubuğu (en az 180 pt 
genişlik) ve asıl Markdown içeriği için kaydırılabilir 
bir detay alanı olan iki sütunlu düzen. Pencerenin 
minimum boyutu 700 × 500 pt’dir. İlk açılışta pence
re uygun guide_<lang>.md ’yi uygulama paketinden 
yükler (geri dönüş guide_en.md ), blok kayıtlarına 
(H1–H4 başlıkları, paragraflar, listeler, tablolar, ayırı
cı çizgiler) ayrıştırır ve kenar çubuğu için başlık 
yapısını ayrı olarak çıkarır. Satır içi biçimlendirme 
(Bold, Italic, Code span) yerleşik Markdown motoru 
üzerinden render edilir. Dil uygulama ayarlarından 
okunur, Çince ( zh-Hans ) ve Brezilya Portekizcesi 
( pt-BR ) özel durumlarıyla birlikte; bu varyantlar zh 
veya pt’den farklı olduğu için tam yerel ayar etiketle
ri olarak tutulurlar.

K I S ACA

Yerleşik yardım metni, solda ko­
nu listesi, sağda içerik. Dil sistem 
ayarlarına göre otomatik olarak 
ayarlanır. Çevrimdışı çalışır ama 
bilinçli olarak yalnızca kısa bir 
sürümdür — tam referans bu kı­
lavuzdur.

W2 List (Başlık kenar çubuğu)

N E R E D E

User Guide penceresindeki sol sütun.

T E K N İ K

Mevcut Markdown belgesinin tüm H2 ve H3 başlık
ları üzerinde liste. H2 girdileri girinti olmadan, orta 
yazı tipi ağırlığıyla görünür, H3 girdileri solda 16 
pt girinti ve azaltılmış ön plan stiliyle. H4 ve daha 
derin olanlar yok sayılır, çünkü derinlik aksi takdir
de kenar çubuğunu karışık yapar. Bağlantı ID’leri 
başlık metninden slugifikasyonla üretilir (küçük harf 
+ boşluklar tirelere + harf/rakam/tirelere filtreleme 
— GitHub’ın Markdown bağlantıları için kullandığı 
aynı algoritma, böylece dokümana harici URL’ler de 
potansiyel olarak aynı bağlantıya düşer). Liste yerel 
macOS stilini kullanır.

K I S ACA

Sol taraftaki gezinme çubuğu. Bir 
girdiye tıkla, bölüme atla.
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W3 Button (Başlık → Bağlantı sıçraması)

N E R E D E

Kenar çubuğu satırı başına bir düğme.

T E K N İ K

Her kenar çubuğu girdisi, mevcut bağlantıyı ayarla
yan ama görsel olarak liste girdisi gibi görünen bir 
düğmedir. Bir gözlemci değişkeni daha sonra 0,3 
sn boyunca yumuşak bir animasyonla karşılık gelen 
bağlantıya kaydırma sıçramasını tetikler. Sıçramadan 
sonra bağlantı değeri sıfırlanır, böylece aynı bağ
lantıya bir sonraki tıklama yeniden ateşlenir (aksi 
takdirde gözlemci yeniden tetiklenmez, çünkü değer 
değişmemiştir).

K I S ACA

Tıklamak seni sağdaki metinde 
uygun yere götürür.

W4 ScrollView (Detay içerik)

N E R E D E

Sağ sütun.

T E K N İ K

Tembel render’lı kaydırılabilir, dikey yığınlı içerik 
alanı, çünkü uzun kılavuzlar kolayca 200′den fazla 
Markdown bloğu olabilir — tembel olmayan bir var
yant hepsini aynı anda örneklendirir. Her blok kendi 
ID’sini alır, ya başlık bağlantısı (sıçranabilir H1–H3 
için) ya da bir indeks yer tutucusu. Maksimum ge
nişlik 720 pt, dolgu 32 yatay / 24 dikey, böylece 
uzun satırlar iyi okunan bir düzen korur. Tablolar 
yatay yığınlar ve ayırıcı çizgilerle hücre hücre render 
edilir; satır içi kod yerleşik Markdown motoru tara
fından. Gerçek kod blokları şu anda paragraf olarak 
ele alınır — yardım penceresinin bilinen bir kısıtlama
sı.

K I S ACA

Asıl yardım metni. Kaydırılabilir, 
iyi okunan genişlik, net tipografi.
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Keyboard Shortcuts (W5–W6)

Şekil 18:  Keyboard Shortcuts penceresi — solda hotkey sütunu ve sağda açıklama ile beş 
grup Navigation/Views/Capture/Editor/Training

RESIMDE NE GÖRÜNDÜĞÜ  Beş bölümde statik referans listesi. Navigation: Mouse Drag 
(Orbit/Fly), Shift+Drag/Right-Drag (Pan), Scroll (Zoom), WASD (Fly-Through hareket), 
Q/E (Yukarı/Aşağı), F (Orbit/Fly arasında geçiş), Double-click (Yeniden merkezle), 
Cmd+Scroll (FoV ayarı). Views: R (Kamerayı sıfırla), T (Otomatik döndürme), P (Kamera 
oynatma), B (Arka plan döngüsü), 0–9 (Eğitim kamerasına atla 1=%10/5=%50/0=son), 
Sol/Sağ Ok (Önceki/Sonraki Cam). Capture: S (Masaüstüne ekran görüntüsü), V (Turn
table Video), C (Kamera bilgisini kopyala). Editor: Tab (Düzenleme modu), Click/Drag 
(Paint-Select), Option+Click (Seçimi kaldır), X / Delete (Seçimi sil), Cmd-Z (Son silmeyi 
geri al), [ / ] (Fırça boyutu küçük/büyük), Esc (Seçimi kaldır). Training: Start, Pause/
Resume, Cancel, Continue +5K/+10K/+20K, M9–M14′teki menü kısayolları üzerinden.

Nedir: Tüm klavye kısayollarının basit statik bir genel görünümü — Navigation, Views, 
Capture, Editor, Training. İçerik sert kodlanmıştır, Markdown yüklemesi yok.
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NE ZAMAN AÇ  Görüntüleyicide bir şey yapmanın en hızlı yolunu ararken. WASD Fly-Thro
ugh, kamera sıfırlamak için R, arka plan döngüsü için B — hepsi burada.

W5 ScrollView (İçerik alanı)

N E R E D E

Help → Keyboard Shortcuts (⌘/).

T E K N İ K

İçinde dikey liste olan basit bir kaydırma alanı. Etra
fında 20 dolgu, kenar çubuğu gezinme ağacı yok 
(liste yeterince kısa). İçerikler beş bölümde gruplan
dırılmıştır (Navigation, Views, Capture, Editor, Tra
ining). Tuş kombinasyonu başına her iki sütunda 
çevrilebilir metin içeren bir satır. Sol sütun (tuş 
kodu) 180 pt genişliğine sabitlenmiş, böylece sağ
daki açıklamalar dikey olarak hizalı kalır. Kaydırma 
dışında etkileşim yok — bir satıra tıklamak bir şey te
tiklemez; tuş kısayolları menüde ve görüntüleyicide 
gerçek klavye değiştiricileridir.

K I S ACA

Tüm kısayol tuşlarının tablosu. 
Kısa kontrol için statik bir kopya 
kağıdı.

W6 VStack (Kısayol bölümleri)

N E R E D E

ScrollView içinde.

T E K N İ K

16 pt aralıkla sola dayalı yığınlı bölümler. Beş bölü
mün içinde Başlık + satır dizisi. Başlıklar ikincil bir 
Subheadline stili kullanır — bilinçli olarak Title biçimi 
yok, çünkü bölümlerin gezinilebilir olması gerekmez. 
İçerik bilinçli olarak düzdür (disclosure yok, search 
yok, filter yok), böylece bileşen her macOS sürü
münde değişmeden çalışır ve dosya okunabilir kalır.

K I S ACA

Tuşların işleve göre gruplandırıl­
ması (Navigation, Views, Editor 
vb.).
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Manage Storage (W7–W12)

Şekil 19:  Manage Storage penceresi — başlık „693 öge · 16.74 GB toplam“ gösterir, tarihe 
göre sıralanmış Export PLY dosyalı tablo, her birinde biçim hapı + dosya adı + boyut + tarih

RESIMDE NE GÖRÜNDÜĞÜ  RadianceKit tarafından yönetilen tüm dosyaların tablo görünü
mü. Başlık 693 öge, 16.74 GB toplam boyut sayar. Üst araç çubuğu: „Show in Finder“ + 
„Refresh”. Her satır: PLY simgesi, dosya adı (ör. training_​20260527T211321Z.ply), dışa 
aktarma tarihi, boyut (7 KB ile 218 MB arasında değişir), büyüteç simgesi (Reveal) ve 
çöp kutusu simgesi (Move to Trash). Dosyalar tarihe göre sıralanmıştır, en yenisi üstte. 
Bu demo çekiminde PLY dışa aktarmaları baskındır, çünkü çok --benchmark  ile çalışıldı.

Nedir: RadianceKit’in ~/​Documents/​RadianceKit/​ altında yerleştirdiği her şey için bir 
disk kullanım genel bakışı — günlükler, dışa aktarmalar, sahneler, capture paketleri (iOS 
arkadaşından), içe aktarmalar (girdi görüntülerinin staging kopyaları). Girdi başına bayt 
cinsinden bir boyut ve iki düğme: „Finder’da göster“ ve „Çöpe taşı”. Otomatik temizlik 
DEĞİLDİR — uygulama kendisi bir şey silmez; sen girdi başına karar verirsin.

NE ZAMAN AÇ  Disk dolduğunda. Özellikle günlükler birikir (eğitim denemesi başına bir 
JSONL artı _​qualityMetrics.json); dışa aktarmalar da doğal olarak (PLY %100 ham 
veri, dışa aktarma başına bir). Bir çökme sonrası, içe aktarma staging dizininde hâlâ giriş 
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görüntülerinin eski kopyaları varsa da yararlıdır (dev_​v549f-needle-reduction.md’deki 
„Disk-pressure incident“e bak).

W7 „Show in Finder“ düğmesi

N E R E D E

Storage tarayıcı penceresinin sağ üstünde başlık.

T E K N İ K

Tüm RadianceKit dizinini (~/​Documents/​RadianceKit/​
) Finder’da açar, böylece klasör yapısını doğrudan 
görebilir ve Finder ile kendisinin manipüle edebilir
sin. Eylem yeni bir Finder penceresi açar ve uygula
ma sandbox kapsayıcısına geçmez — ~/​Documents/​
RadianceKit/​ uygulamalar için normal erişilebilir Do
cuments alanıdır, sandbox kapsayıcı yolu değildir.

K I S ACA

Dizini Finder’da açar, böylece 
dosyalarla kendin çalışabilirsin.

W8 „Refresh“ düğmesi

N E R E D E

Başlık, Finder düğmesinin yanında.

T E K N İ K

Büyük dizin ağaçlarını taramanın UI’yi engelleme
mesi için kullanıcı başlatmalı eşzamansız görevde 
çalışan bir arka plan taramasını tetikler. Asıl gezinti 
bilinen her alt klasörü (Logs, Exports, Scenes, Cap
tures, Imports) gezer ve doğrudan çocuk başına bir 
depolama girdisi oluşturur. Girdi başına özyineleme
li boyut belirlenir — tercihen gerçek disk tüketimi 
(APFS hardlink paylaşımı dahil) mantıksal dosya bo
yutuna geri dönüşle.

K I S ACA

Bu arada Finder’da bir şey sildi 
ya da eklediysen listeyi yeniden 
okur.
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W9 List (Depolama girdileri)

N E R E D E

Başlığın altında ana içerik.

T E K N İ K

Satır başına bu düzenle liste: kategoriye özgü SF 
Symbol simgesi (Günlükler için belge, Dışa aktar
malar için yükleme oku, Sahneler için küp, İçe aktar
malar için tepsi), ad + alt başlık (çocuk etiketi + 
biçimlendirilmiş değiştirme tarihi), sağda bayt sayacı 
(sağa hizalı, monospace), Reveal düğmesi (büyüteç 
simgesi), Trash düğmesi (çöp kutusu). Sıralama: bi
rincil olarak çocuğa göre (Sahneler önce, sonra Dışa 
aktarmalar, Günlükler, Captures, İçe aktarmalar, Di
ğer), ikincil olarak değiştirme tarihine göre azalan 
(en yenisi üstte). Tarama hâlâ çalışıyorsa, yer yerine 
bir „Scanning…“ ilerlemesi gösterir. Hiçbir şey bulu
namazsa tepsi simgesi olan boş durum göstergesi.

K I S ACA

Türe ve güncelliğe göre sıralan­
mış tüm RadianceKit verilerinin 
listesi. Girdi başına boyutu gö­
rürsün ve doğrudan silebilirsin.

W10 Satır düğmesi „Reveal in Finder“

N E R E D E

Satır başına, sağda büyüteç simgesi.

T E K N İ K

Finder’ı açar ve belirli ögeyi (dosya veya klasör) 
seçer. W7′den fark: W7 kök dizini açar; W10 tam 
olarak bu girdiyi işaretler. Pratik iş akışı: büyük bir 
girdiyi tanımla, büyüteç tıkla, sonra örneğin harici bir 
hacme kopyala.

K I S ACA

Finder’da bu girdiye doğrudan 
atlar, böylece onu hızlıca bulur­
sun.

W11 Satır düğmesi „Move to Trash“

N E R E D E

Satır başına, büyütecin sağında çöp kutusu simgesi.

T E K N İ K

Onay diyalog kutusunu (W12) tetikler. Yalnızca 
onaydan sonra macOS standart işlemi „çöpe taşı“ 
çalışır (yani geri döndürülebilir, doğrudan silme de
ğil). Başarılı çöpe taşıdan sonra girdi listeden kaldı
rılır ve toplam bayt sayacı güncellenir. Hatalarda 
modal bir hata diyaloğu gösterilir.

K I S ACA

Girdiyi çöp kutusuna taşır. Diya­
log önce sorar.
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W12 ConfirmationDialog (Silme onayı)

N E R E D E

W11 tarafından tetiklenir, macOS sheet olarak gös
terilir.

T E K N İ K

Dinamik başlık „Delete <name>?“ ile standart onay 
diyaloğu ve girdinin çöp kutusuna düşeceğini ve 
oradan geri döndürülebileceğini (çöp kutusu boşal
tılana kadar) açıkça belirten bir Message satırı. İki 
düğme: yıkıcı eylem olarak „Move to Trash” (kırmızı 
gösterilir) ve otomatik Esc bağlamayla „Cancel“. Di
yalog, yalnızca bu pencereyi engelleme anlamında 
modal değildir, tüm uygulamayı engellemez — bu, 
geri döndürülebilir silmeler için macOS standardıdır.

K I S ACA

Silmeden önce güvenlik sorusu. 
„Move to Trash“ geri döndürüle­
bilir — çöp kutusu boşaltılmadığı 
sürece.

Pareto Dashboard (W13–W22)

Şekil 20:  Pareto Dashboard — rapor içe aktarmadan önce boş durum

Boş durum (ilk açılıştan sonra) — „Open Reports Folder…“ çağrısıyla boş durum. Veri 
noktaları eğitim raporları yüklendiğinde görünür, bir sonraki çekime bak.
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Şekil 21:  129 yüklü benchmark raporlu Pareto Dashboard — Pareto-Front ile Gaussians vs 
PSNR, Scene/Strategy/Mip filtre

RESIMDE NE GÖRÜNDÜĞÜ  Başlık araç çubuğu „129 reports of 129″ gösterir (seçilen klasör
deki tüm raporlar başarıyla ayrıştırıldı — sağdaki uyarı listesine bak, eski biçim nedeniyle 
21 ek dosya ayrıştırılamadı). Eksenler: X ekseni seçici Gaussians ’ta, Y ekseni seçici 
PSNR (dB) ’de. Saçılım grafiği: yeşil noktalar = Classic stratejisi, mavi noktalar = MCMC. 

Kesik Pareto-Front çizgisi en iyi elde edilen PSNR değerleri boyunca uzanır ve yaklaşık 
500K Gaussian’dan itibaren PSNR≈30 dB’de platolaşır. Sağdaki filtre hapları: 7 sahne 
(bicycle, bonsai, family, flowers, kitchen, stump, truck), 2 strateji (classic, mcmc), 3 
Mip-Splatting seçeneği (All, On, Off). Şu anda tüm filtreler açık, bu yüzden yoğun nokta 
kümesi.

Nedir: Çoklu çalıştırma karşılaştırma aracı. Geçmişte birden çok sahne veya aynı sahne
yi farklı önayarlarla eğittin — bu eğitim çalıştırmalarının her biri (eğer --benchmark  ile 
çalıştırdıysan veya benchmark işlevi üzerinden çağırdıysan) diğer şeylerin yanı sıra final 
PSNR, SSIM, LPIPS, Gaussian sayısı ve wall clock süresini içeren bir JSON rapor dosyası 
üretir. Dashboard, bu raporların tüm bir klasörünü aynı anda okur ve onları seçilebilir ek
senli 2D saçılım olarak çizer. Ek olarak Pareto-Front (dominasyon edilmemiş noktaların 
kümesi) kesik çizgi olarak çizilir.

NE ZAMAN AÇ  En az üç veya dört eğitim raporu oluşturduktan sonra. Daha az noktada 
Frontier çizgisi anlamlı değildir. Tipik kullanım durumu: bir dış mekân sahnesini yeniden 
yapılandırmaya çalıştın ve P3 Balanced (Classic), P4 Quality (Classic), P7 MCMC Quality 
ve P9 Outdoor (tuned)‘u sırayla denedin — şimdi hangi yapılandırmanın saniye eğitim 
süresi başına en iyi PSNR sağladığını veya belirli PSNR için en az Gaussian’a ihtiyaç 
duyduğunu bilmek istersin.

NASIL YORUMLANIR  Her iki eksen de serbestçe seçilebilir (X ekseni: psnr , ssim , 
lpips , …; Y ekseni aynı). Pareto-Front mantığı ParetoFront2D.indices, her metrik için 

„daha küçük = daha iyi“ (ör. LPIPS, Loss, Time) veya „daha büyük = daha iyi” (PSNR, 
SSIM) olduğunu bilir — yani çizgi eksen seçimine göre sol alttan sağ üste veya sol üstten 
sağ alta gider, her zaman elde edilen en iyi kombinasyon boyunca. Bir nokta Pareto-
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optimaldir, eğer HİÇBİR başka nokta HER İKİ boyutta en az aynı derecede iyi DEĞİLSE 
(yani başkası tarafından domine edilmez). Pareto-optimal noktalar çizgi üzerindedir, 
diğer noktalar (eksen yönelimine göre) sağında/üstünde veya sağında/altındadır. Çizgi 
ÜZERİNDEKİ noktalar „en iyi önayar“ için gerçek adaylardır; çizgiden UZAK noktalar 
boşa harcanan eğitim süresidir.

FILTRE HAPLARI  Seçimi belirli bir sahneye (örneğin yalnızca dış mekân çalıştırmaları kar
şılaştırmak istiyorsan), belirli bir stratejiye (Classic veya MCMC) veya Mip-Splatting açık/
kapalı (Mip’in opt-in gelişmiş bayrak olarak kaldığı Faz Q1.5 sonrası ilgili) kısıtlayabilirsin.

ÖRNEK IŞ AKIŞI  ~/​Documents/​RadianceKit/​Reports/​ altında „truck“ sahnesi için üç rapo
run var: Çalıştırma A (P4 Quality, 40K iter, 524K Gs, 105 sn, PSNR 23.4), Çalıştırma 
B (P7 MCMC, 200K iter, 150K Gs, 693 sn, PSNR 24.6), Çalıştırma C (P9 Outdoor, 
100K iter, 1.25M Gs, 312 sn, PSNR 25.8). X eksenini trainingTime’a, Y eksenini PSNR’ye 
ayarla. Çalıştırma B sağ üstte, Çalıştırma C daha sağ üstte, Çalıştırma A sol altta. Pare
to-Front A ve C’yi bağlar — ikisi de domine edilmemiş. Çalıştırma B „kayıp” (C zamanda 
VE PSNR’de daha iyidir). Bilgi: „truck“ için MCMC varsayılanı değmez; ya hızlı+tamam 
(A) ya da uzun+çok iyi (C). C’den yapılandırmayı kendi önayar olarak kaydet (Inspector 
→ I1 Save Preset).

Sonraki eylem: En iyi yapılandırmayı önayar olarak kaydet. Somut olarak: Pareto 
noktalarına bak (Hover ipucu tooltip’inde PSNR/SSIM/LPIPS/Gs/Time gösterir), Time-vs-
Quality dengesinden hangisinin sana en iyi uyduğuna karar ver, ilgili raporu aç (dosya 
adı çalıştırma zaman damgasını içerir), eğitim yapılandırmasını yeni bir çalıştırmada 
kopyala veya bir sonraki eğitim oturumundan sonra Inspector üzerinden önayar olarak 
kaydet.

W13 „Open Reports Folder…“ düğmesi

N E R E D E

Sol üstte araç çubuğu.

T E K N İ K

„Select a folder containing benchmark .json reports“ 
istemiyle bir klasör seçim diyaloğu açar. Onaydan 
sonra arka plan görevi klasördeki tüm .json  dos
yalarını sıralı olarak ayrıştırır. Bozuk raporlar (bozuk 
JSON, yanlış şema) toplanır ve kenar çubuğunun al
tında „N file failed to parse” olarak gösterilir — çök
me yok. İlk yükleme hâlâ çalışırken ikinci bir tıklama 
yapılırsa, önceki görev iptal edilir, böylece duruma 
aynı anda iki sonuç yazılmaz.

Ayrıca CLI üzerinden: --dashboard-dir /​path/​to/​
reports klasörü uygulama başlangıcında yükler.

K I S ACA

Benchmark raporlarının bulun­
duğu klasörü seçer. Standart yol 
~/​Documents/​RadianceKit/​

Reports/​. Sonra tüm JSON’ları 
aynı anda yükler.
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W14 „X-Axis“ seçici

N E R E D E

Grafiğin üstünde, solda.

T E K N İ K

Dashboard modülünün tüm kullanılabilir metrik ek
senleriyle (PSNR, SSIM, LPIPS, Gaussian sayısı, eği
tim süresi vb.) menü seçici. Varsayılan Gaussian 
sayısıdır. Değişimde üzerine gelinen nokta sıfırlanır, 
çünkü daha önce vurgulanan konum yeni eksen ko
ordinat sisteminde eksen değişiminden sonra anlam 
ifade etmez. Seçici tüm genişlik boyunca uzatmasın 
diye içerik genişliğiyle sınırlıdır.

K I S ACA

Yatay eksende hangi metri­
ğin durması gerektiği. Genellikle 
„Eğitim süresi“ veya „Gaussian 
sayısı”, çünkü karşılaştırmak is­
tediğin „maliyetler“ bunlardır.

W15 „Y-Axis“ seçici

N E R E D E

Grafiğin üstünde, X eksenin yanında.

T E K N İ K

W14 ile aynı, sadece varsayılan PSNR. Eksen seçimi 
bağımsız olarak kaydedilir, böylece kullanıcı saçma 
kombinasyonlar da seçebilir (X=PSNR, Y=PSNR — 
tüm noktaları bir köşegene atar). Ancak bu tür kom
binasyonlar yakalanmaz; bilinçli karar, çünkü metrik
lerin nasıl tutarlı davrandığını görmek için „SSIM vs 
PSNR“ karşılaştırması oldukça ilginçtir.

K I S ACA

Dikey eksende ne durduğu. 
Normalde kalite ölçütü olarak 
„PSNR“ veya „SSIM”.

W16 „Show Pareto Front“ anahtarı

N E R E D E

Eksen seçicilerin sağında.

T E K N İ K

Standart macOS anahtarı. Etkinse, Pareto grafiğinde 
nokta bulutuna ek olarak hesaplanan 2D Pareto-
Front’la bir çizgi çizilir. Stil: kesik (çizgi deseni 4–4), 
gri yarı saydam, çizgi kalınlığı 1,5 pt. Pareto hesapla
ma ana iş parçacığında çalışır — tipik rapor sayısın
da (≤ ~50) sorunsuz hızlıdır. Anahtar kapalıysa çizgi 
atlanır, böylece yalnızca çıplak noktalar kalır.

K I S ACA

„Şu ana kadar en iyi“ noktalar­
dan geçen çizgiyi gösterir. Çizgi 
yolda ise (ör. yalnızca tekil takas­
ları karşılaştırmak istediğin için) 
kapat.

90 / 231



R A D I A N C E K I T Bölüm 4 — Yardımcı Pencereler

W17 „Scene“ filtre hapları

N E R E D E

Dashboard penceresinin sağ kenar çubuğu.

T E K N İ K

Yüklenen raporlarda görünen her sahne için filtre 
hapları. Kendi akış düzeni, hapları genişlik tükendi
ğinde otomatik olarak birden çok satıra paketler. 
Aktif haplar vurgu arka planını alır, aktif olmayanlar 
nötr standart materyal arka planını. Çoklu seçim 
mümkündür (set anlambilim); hiçbir hap seçili değil
se tüm sahneler „geçer“ sayılır — yani set mantığı 
„boş seçim = her şey”, „boş seçim = hiçbir şey“ 
değil.

K I S ACA

Bir sahne adına tıklamak nokta­
ları yalnızca o sahneye filtreler. 
Çoklu seçim mümkündür. Boş = 
tüm sahneler.

W18 „Strategy“ filtre hapları

N E R E D E

Kenar çubuğunda Scene filtresinin altında.

T E K N İ K

W17 gibi tam olarak ama eğitim stratejileri için — 
benchmark rapor JSON’larının Strategy alanından 
türetilen tipik iki değer „classic“ ve „mcmc”. Her iki 
strateji raporlarını karıştırdıysan ve yalnızca bir türü 
görmek istiyorsan yardımcıdır (ör. „yalnızca MCMC 
çalıştırmalarını göster, çünkü Classic’i zaten dışla
dım“).

K I S ACA

Classic veya MCMC’ye göre filtre. 
Varsayılan olarak her ikisi de et­
kindir.
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W19 „Mip-Splatting“ filtre hapları

N E R E D E

Kenar çubuğunda Strategy filtresinin altında.

T E K N İ K

Üç değerli filtre (W17/W18 gibi set değil): „All“ / 
„On” / „Off“. Arka plan: Mip-Splatting Faz Q1.5′te 
deneysel çok ölçekli iyileştirme olarak değerlendiril
di ve son verdik „baştan başa hoş bir kazanç yok; 
opt-in bayrak olarak tutuldu” idi. Mip on/off karşılaş
tırmaları yapıyorsan, sıklıkla çok keskin ayırabilmek 
istersin. Bu yüzden „her şeyi geçir“, „yalnızca Mip 
açık”, „yalnızca Mip kapalı“ durumlarıyla özel üçlü 
filtre. Kenar çubuğu bölümü yalnızca veri kümesinde 
en az bir Mip raporu VE en az bir Mip olmayan rapor 
varsa görünür (aksi takdirde filtreleme anlamsızdır).

K I S ACA

Mip-Splatting açık/kapalıyı karşı­
laştırmak istiyorsan, burada üç 
bölümlü filtre. Aksi takdirde yok 
say.

W20 ChipButton (Filtre anahtarı, all/on/off)

N E R E D E

Yardımcı bileşen, W17/W18/W19′da kullanılır.

T E K N İ K

Minimalist düğme sarmalayıcı. İçerik: Caption yazı 
tipi boyutu ve 10 yatay / 5 dikey dolgu ile etiket 
metni. Koşullu arka plan: etkinse → beyaz metinle 
uygulama vurgu rengi; aksi takdirde siyah metinli 
nötr standart materyal arka planı. Şekil bir kapsüldür 
(hap benzeri). Plain düğme stili, böylece kapsül ma
teryali sistem kenarlığıyla örtülmez.

K I S ACA

Yuvarlak filtre düğmelerinin ken­
disi. Görsel olarak iOS etiketi gi­
bidir.
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W21 Chart (Pareto saçılımı)

N E R E D E

Dashboard’un orta alanı.

T E K N İ K

İki katmanlı Swift Charts diyagramı: 1. rapor başına 
bir nokta — seçilen X ve Y metriklerinden konum, st
ratejiye göre renk, Mip durumuna göre simge. Sem
bol boyutu normal 80, vurgulanan 200 (ID mevcut 
üzerine gelinen rapora karşılık geliyorsa). 2. Yalnızca 
anahtar açıkken Pareto-Front için bir çizgi.

Chart bindirme: şeffaf bir dikdörtgen fare hareketini 
kaydeder; kare başına grafik çerçevesindeki Öklid 
olarak en yakın nokta konumu belirlenir ve mesafe 
24 px’in altındaysa üzerine gelinen rapor güncellenir 
(aksi takdirde sıfırlanır). Böylece tooltip’i tıklamadan 
alırsın — üzerine gelme yeterli.

K I S ACA

Asıl saçılım diyagramı. Her nokta 
bir eğitim çalıştırmasıdır. Detay 
tooltip için üzerine gel.

W22 Tooltip (Üzerine gelme detayı)

N E R E D E

Grafiğin altında, üzerine gelmede görünür.

T E K N İ K

Yatay yığın: Sahne adı (Headline), Strateji etiketi 
(Caption), ayırıcı çizgi, ardından PSNR/SSIM/LPIPS/
Gs/Time metrikleri her biri küçük dikey grupta (Eti
ket + monospace değer). Mip etkinleştirilmişse, ek 
olarak vurgu renginde bir „Mip“ kapsül etiketi. Arka 
plan yarı saydam blur, 8 pt yarıçaplı yuvarlatılmış 
dikdörtgen. Yalnızca fare gerçekten bir noktanın 
üzerindeyse görünür. Ayrıldığında otomatik olarak 
kaybolur.

K I S ACA

Fareyle bir noktanın üzerine gel­
diğinde alttaki detay kartı. Tüm 
kalite metriklerini ve çalıştırma 
yapılandırmasını aynı anda gös­
terir.
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Holdout Analysis (W23–W29)

Şekil 22:  Holdout Analysis — transforms.json yüklemeden önce boş durum

„Open transforms.json…“ çağrısı ile boş durum. NeRF-Studio ve Instant-NGP biçimini 
kabul eder.

Boş durum (ilk açılıştan sonra) — bir transforms.json  yüklendiğinde kamera işaretleri 
görünür, bir sonraki çekime bak.

Şekil 23:  100 NeRF-Blender Mic kamerasıyla Holdout küresi, fold başına 20 kamera ile 5 fold, 
Angular stratejisi aktif

RESIMDE NE GÖRÜNDÜĞÜ  Başlık yüklenen dosyayı (transforms_​train.json) ve cam sayısı
nı („100 cameras“) gösterir. Sol kenar çubuğu: iki seçenekli Strategy seçici — aktif 
Angular (longitudinal) (folları kürenin üzerinde boylam/genişlik sektörlerine göre hi
zalar, böylece her test fold geometrik olarak yoğun olur) vs Linear (round-robin) (sıra 
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tabanlı, her k’inci kare test seti olarak). k-Folds kaydırıcı 5′te, test fold seçici Fold 1′de. 
Dışa aktarma düğmesi Nerfstudio/Instant-NGP için bir fold-assignment.json üretir. Or
ta panel: 100 kameranın 3D küre projeksiyonu — yeşil noktalar = Train, kırmızı noktalar 
= mevcut test fold (20 kameralı Fold 1). Sağ kenar çubuğu (Angular Correlation): fold 
başına 20 cam + Mean Nearest Angle (Fold 1: 7.9°, Fold 2: 7.8°, Fold 3: 7.7°, Fold 4: 7.0°, 
Fold 5: 6.3°) — daha küçük değer, bu fold içindeki kameraların birbirine yakın durduğu, 
yani Holdout bölmesinin uzaysal olarak tutarlı olduğu anlamına gelir.

Nedir: Çapraz doğrulama mantığıyla kamera düzenleminin 3D görselleştiricisi. Bir 
transforms.json  (Nerfstudio / Instant-NGP’nin kamera pozları için standart biçimi) 

yüklersin, uygulama tüm kameraları okur, bakış yönlerini birim küreye projeksiyonlar ve 
onları sanal bir küre üzerinde küçük küre işaretleri olarak gösterir. Sonra kameraları 
k  folda böler (seçilen stratejiye göre: angular veya linear), eğitim oranını yeşil, test 

oranını (Holdout) kırmızı işaretler ve fold başına test fold’un bakış açısı uzayında eğitim 
fold’undan ne kadar uzakta olduğunu söyleyen bir açısal korelasyon puanı hesaplar.

NE ZAMAN AÇ  Holdout değerlendirmesi yapmak istediğinde — yani: modelin görülmemiş 
bakış açılarına ne kadar iyi genelleşir? Eğitimde standart „her 8. görünüm holdout 
olarak“tır (Mip-NeRF360 kuralı), ama bu çok doğrusal bir bölmedir. Görüntülerin örneğin 
zamansal olarak kümelenmişse (önce nesnenin bir tarafı, sonra diğeri), o zaman „her 8.” 
temsili değildir — rastgele bir dizi konumu teste düşer, ama tüm komşuları eğitimde, bu 
çok kolaydır. „Angular“ ile bunun yerine bakış açısı uzayında katmanlandırılır: her fold 
tüm orbit bölgelerinden kameralar içerir, böylece test gerçekten genelleme boşluklarını 
test eder.

NASIL YORUMLANIR  Angular vs Linear: - Angular (standart): Kameraları boylam açısına 
(Y eksenine göre φ koordinatı) göre k  eşit sektöre böler. Fold 0 φ ∈ [0°, 360/k°) ile 
kameralardır, Fold 1 bir sonrakiler vb. Avantaj: her fold orbitin bir kesimini kapsar; test 
fold uzaysal olarak kompakttır ama dünya veri seti üzerinde geniş dağılır. Klasik orbit 
çekimleri için iyidir. - Linear (Round-Robin): Fold indeksi = (image_index modulo k). Bu 
basit „her k’inci“ bölmesidir. Görüntü sırasının uzaysal önyargısı OLMADIĞINDA çalışır 
(ör. rastgele sıralanmış dron çekimleri). Görüntüler zamansal olarak kümelendiğinde 
kötü çalışır.

3D küresinde hemen görürsün: yeşil noktalar (Eğitim) ve kırmızı noktalar (Test). Kırmızı 
noktaların hepsi bir köşede kümelendiyse, Holdout kötüdür (iyi bir genelleme testi 
değil). Yeşillerin arasında eşit duruyorlarsa iyidir. Fold başına Açısal Korelasyon puanı 
(sağ kenar çubuğu, derece cinsinden) ek olarak söyler: daha küçük değer = test eğitime 
yakın (her test kamerasının yakın bir eğitim kamerası var, kolay test); daha büyük değer 
= test eğitimden uzak (daha sert genelleme).

ÖRNEK IŞ AKIŞI  Truck sahneni 251 görüntüyle çektin, menü ögesi M33 (Export SfM 
transforms.json) üzerinden bir nerfstudio dosyası dışa aktarırsın. Holdout penceresini 
(⇧⌘H) aç, „Open transforms.json…“ ile JSON’u yükle, küreye bak. k=5 (varsayılan) 
sana 5 fold verir. „Fold 3” üzerine tıkla — kırmızı işaretlerin makul derecede eşit olup 
olmadığını gör. Evet ise: „Export fold-assignment.json“, dışa aktarılan dosyayı Reports 
klasörüne koy ve bir sonraki eğitim çalıştırmasında --benchmark  ile (veya karşılık gelen 
Inspector ayarlarıyla) tam olarak bu fold bölmesi test Holdout olarak kullanılır — „her 8.” 
standardının yerine.
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W23 „Open transforms.json…“ düğmesi

N E R E D E

Sol üstte araç çubuğu.

T E K N İ K

JSON dosyalarıyla sınırlı bir dosya seçim diyaloğu 
açar. Onaydan sonra Holdout modülü dosyayı yükler. 
Yükleyici hem nerfstudio biçimini (kamera intrinsik
leri artı görüntü yolu ve dönüştürme matrisi olan 
kare listesi) hem de instant-ngp biçimini (aynı yapı) 
ayrıştırır. Kare başına bakış yönü dönüştürme matri
sinden (kamera yerel tabanının z ekseni) çıkarılır ve 
kaydedilir. Ayrıştırma başarısız olursa durum alanın
da bir hata mesajı gösterilir.

Ayrıca CLI üzerinden: --holdout-file /​path/​to/​
transforms.json pencereyi yüklü dosyayla doğru
dan başlatır.

K I S ACA

Kamera pozları JSON’ını yükler. 
Standart Nerfstudio ve Instant-
NGP dışa aktarmalarıdır. Radi­
anceKit kendisi transforms.json’ı 
Menü → Export → SfM üzerinden 
dışa aktarabilir.

W24 „Strategy“ seçici (angular/linear)

N E R E D E

Sol kenar çubuğunda üst.

T E K N İ K

İki seçenekli radyo seçici: Angular ve Linear. Strateji 
değişikliği fold’ların yeniden hesaplanmasını otoma
tik olarak tetikler. Bakış yönleri küre üzerindeki 3D 
birim vektörlerinin listesidir; Angular stratejisi onları 
boylam açısı φ’ye projeksiyonlar ve sıralar, Linear 
stratejisi kare indeksi üzerinde basit bir modulo böl
mesi yapar.

K I S ACA

Eşit orbit çekimleri için Angular 
(standart, güvenli), yalnızca gö­
rüntülerin uzaysal olarak küme­
lenmediğinde Linear.
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W25 „k Folds“ kaydırıcı

N E R E D E

Sol kenar çubuğunda ortada.

T E K N İ K

3′ten 10′a, adım 1 olan kaydırıcı. Değişimde fold he
sabı otomatik olarak yeniden başlatılır, böylece fold 
listesi, eğitim/test indeksleri ve fold başına puan he
men yeniden hesaplanır. Seçilen değer monospace 
rakam metni olarak etiketin sağında gösterilir.

Pratik kural: k=5 standarttır (sana fold başına %20 
test verir, çapraz doğrulama için yaygındır). Çok 
verin varsa ve istatistiksel anlamlılık için daha fazla 
fold istiyorsan k=10. Az verin varsa k=3.

K I S ACA

Bölmede kaç fold. 5 standarttır 
ve neredeyse her zaman uyar.

W26 „Test Fold“ seçici

N E R E D E

Sol kenar çubuğunda k kaydırıcının altında.

T E K N İ K

Menü seçici. Seçenekler dinamik 0..<k, etiket „Fold 
1″den „Fold N“e (yani UI’da 1 indeksli, içeride 0 
indeksli). Önceden seçilen indeks ≥ k ise (ör. k’yi 
10′dan 5′e azalttığın için) otomatik olarak 0′a sıfır
lanır. Seçilen test fold küresinde kırmızı gösterilir, 
diğerleri yeşil.

K I S ACA

Şu anda hangi fold’un test fold 
olduğu. Tıklayabilir ve her tekil 
fold’un küresinde nasıl göründü­
ğünü görebilirsin.

W27 „Export fold-assignment.json“ düğmesi

N E R E D E

Sol kenar çubuğunda altta.

T E K N İ K

Varsayılan dosya adı fold-assignment.json olan 
bir kaydet diyaloğu açar. Onaydan sonra Holdout 
modülü mevcut bölmeyi bir JSON şemasına kod
lar (kare başına fold ataması artı strateji meta 
bloğu). Bu dosya daha sonra bir sonraki eğitim
de --benchmark  ile birlikte verilebilir, böylece son 
metrik değerlendirmesi için aynı Holdout kullanılır. 
Yazma hataları hata metni olarak gösterilir; başarı 
yeşil metinle „Saved to (filename)“ olarak.

K I S ACA

Mevcut eğitim/test bölmesini 
JSON olarak kaydeder. Bu dosya­
yı eğitime doğrudan ekleyebilir 
ve aynı test seti yeniden kullanı­
lır.
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W28 SCNView (3D kamera küresi)

N E R E D E

Holdout penceresinin orta paneli.

T E K N İ K

SceneKit küre görünümü. Sahne şunlardan oluşur: 
bir tel örgü küre (yarıçap 1.0, 36 segment, koyu 
gri), üç renkli eksen çıkıntısı (X/Y/Z için kırmızı/yeşil/
mavi, her biri 1.2 uzunluğunda) ve kamera başına 
birim küresinin karşılık gelen bakış yönü konumunda 
küçük bir işaretçi küre (yarıçap 0.03) (tel örgü küre
sinin İÇİNDE kaybolmaması için hafifçe dışarda). İşa
retçiler her fold değişikliğinde yeniden oluşturulMAZ 
— yeniden oluşturma yalnızca kare listesi değişirse 
(yani yeni bir JSON yüklenirse) gerekir. Bunun yerine 
güncelleme başına materyal renklerinin yerinde bir 
güncellemesi çalışır: test indeksleri için kırmızı, eği
tim için yeşil, ne biri ne diğeri ise açık gri. Böylece 
N > 1000 kamerada da kaydırıcı tıklamaları perfor
manslı kalır.

Kamera kontrolü etkindir — fareyle küreyi döndüre
bilir, yakınlaştırabilir, kaydırabilirsin. Aydınlatma işa
retçilerin düz görünmemesini sağlar. Arka plan koyu 
gri.

K I S ACA

Kamera konumlarıyla 3D küresi. 
Yeşil = Eğitim, Kırmızı = Test, Açık 
gri = atanmamış (oluşmaz, tüm 
kameralar bir yere ait). Fareyle 
küreyi döndürüp yakınlaştırabi­
lirsin.

W29 FoldCard (Fold seçmek için dokun)

N E R E D E

Sağ kenar çubuğunda „Angular Correlation“ bölümü.

T E K N İ K

Fold başına bir kart görünümü — yarıçapı 6 pt olan 
yuvarlatılmış dikdörtgen, dolgu 10, iki satırlı dikey 
düzen (üstte „Fold N“ + kamera sayısı, altta „Mean 
nearest angle:” + derece cinsinden değer). Koşullu 
arka plan rengi: aktif fold = yarı saydam vurgu rengi, 
aktif olmayan = nötr standart materyal. Dokunma 
fold’u seçer ve küre canlı yeniden renklenir.

„Mean nearest angle“ puanı test kamerası başına en 
yakın eğitim kamerasına ortalama en küçük açıdır 
(içeride radyan cinsinden hesaplanır, UI’da derece 
olarak gösterilir).

K I S ACA

Fold başına sağda kamera sayısı 
ve en yakın eğitim kamerasına 
ortalama mesafe ile küçük bir 
kart. Üzerine tıklamak bu fold’u 
test olarak seçer.
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BayesOpt Console (W30–W39)

Şekil 24:  BayesOpt konsolu — Trial başlangıcından önce boş durum

Search Space seçici (RadianceKit defaults (6-dim)), Trial Budget kaydırıcı (varsayılan 
40), Random Seed (42) ve Convergence grafiği, Trial Log ve Search Space parametre 
listesi için üç boş panelle boş durum.

Boş durum (ilk açılıştan sonra) — bir çalıştırma başlatıldığında Convergence grafiği ve 
Trial tablosu dolar, bir sonraki çekime bak.

Şekil 25:  40 deneme sonrası BayesOpt konsolu — Trial 15′e kadar dik yükselen Convergence 
grafiği, 40 denemeden sonra Best Value 0.9943, init/bo/restart etiketleriyle Trial Log

RESIMDE NE GÖRÜNDÜĞÜ  Sağ üstte durum „Finished — best 0.9943 after 40 trials“. Sol 
kenar çubuğu: Search Space seçici RadianceKit defaults (6-dim)‘de, Trial Budget 
40, Random Seed 42. Parametre listesi değer aralıklarıyla ayarlanacak altı hiperpa
rametreyi gösterir: mipSmoothing3DScale [0.05, 0.5], mipFilter2DVariance [0.1, 
0.6], densifyGradThreshold [5e-07, 5e-06], ssimWeight [0.05, 0.5], mcmcNoiseScale 
[1e-05, 0.0001], mcmcRelocationInterval [50, 200]. Orta: Convergence grafiği (X = 
Trial indeksi 1–40, Y = Objective Value 0–1) — gri noktalar
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B Ö L Ü M

ilk örnekler (LHS), mavi noktalar = 
BayesOpt akquisition, turuncu

noktalar = Restart denemeleri (#22 ve #31). En iyi değer çizgisi Trial ~7′ye kadar dik 
yükselir, sonra yalnızca Trial 15′e kadar marjinal iyileşme, oradan 0.99+‘da düz plato. 
Sağ kenar çubuğu: Trial Log #1–#34 puan + etiketle (init/bo/restart). Sağ üstteki Save 
Best Config düğmesi bayesopt-best.json  yazar.

Nedir: Hiperparametre arama için bir Bayes optimizasyon konsolu. Bayes-Opt, mümkün 
olduğunca az deneyle bilinmeyen bir fonksiyonun en uygun noktasını bulmaya çalışan 
otomatik bir yöntemdir — tipik olarak: „mcmcMaxGaussians, capMultiplier, ssimWeight 
ve gradThreshold’un hangi kombinasyonu sahne sınıfım için en iyi PSNR’yi sağlar?“ 6^4 
= 1296 denemenin bir ızgarası yerine Bayes-Opt yaklaşık 40–100 bilgili deneme dener 
ve böylece optimuma yaklaşır.

Önemli: Uygulamada şu anda gönderilen sürüm optimizasyonu gerçek eğitim çalıştır
malarına karşı yürütmez (bu günler sürerdi), sentetik bir demo objektifine karşı yürütür 
— hafif gürültü artı Hill-Climbing karakterli çok modlu bir manzara. Bu kasıtlıdır: pencere 
sana optimizatörün davranışını (yakınsama seyri, örnek noktaları, şu ana kadar en iyi) 
göstermeli ve arama alanı tanımlarını anlamana izin vermelidir. Gerçek eğitim güdümlü 
BayesOpt çalıştırmaları için (Faz Q7′de Scene-Class önayarları için yapıldığı gibi) ayrı bir 
çevrimdışı CLI iş akışı kullanılır; pencere canlı UI varyantıdır.

NE ZAMAN AÇ  Üç kullanım durumu: 1. BayesOpt’un nasıl çalıştığını anlamak istiyorsun 
— o zaman bir demo çalıştırma başlat ve Convergence grafiğini izle. 2. Yerleşik 10 
önayarın tam olarak uymadığı yeni bir sahne sınıfı (örneğin „Akvaryumlar“ veya „Antika 
Mobilyalar”) planlıyorsun. Zihinsel olarak bir arama alanı tanımla, burada „Bowl demo“ 
veya „Densify” önayarıyla kontrol et, sonra en iyi yapılandırmayı JSON olarak dışa aktar 
ve gerçek bir eğitim çalıştırması için başlangıç noktası olarak kullan. 3. RKBayesOpt 
paketinde tanımlanan varsayılan arama alanlarını (Mip-Subset, RadianceKit Defaults) in
celemek istiyorsun — bunlar sol kenar çubuğunun Parametre panelinde listelenir.

NASIL YORUMLANIR  - Convergence grafiği (orta sütun): Y = şimdiye kadar elde edilen 
en iyi objektif fonksiyon değeri. X = Trial indeksi. Başlangıçta dik yükselir (BayesOpt ilk 
örnekleri rastgele dener, bazıları şanslıdır), sonra giderek düz hale gelir, çünkü yakın op
timum bölgesi tükenmiştir. Çizgi 20+ deneme için düz kalırsa, çalıştırmayı durdurabilirsin 
— daha fazla deneme bir şey getirmez. Grafikteki tekil noktalar tekil deneme değerleridir 
(yani „şu ana kadar en iyi“ değil), faza göre renklidir: gri = ilk örnek, mavi = bayesopt 
acquisition, turuncu = restart. - Trial tablosu (sağ sütun): #1, #2, #3, … her biri değer ve 
faz etiketiyle. Şu ana kadar en iyi deneme sarı yıldızla işaretlenmiştir. Tablodan en iyi de
nemeyi tanımlayabilir ve daha sonra dışa aktarmada parametre değerlerine bakabilirsin. 
- Search Space denetleyicisi (sol kenar çubuğu): seçilen önayar için tüm parametre 
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adlarını ve arama aralıklarını [lo, hi]  gösterir. „RadianceKit defaults (6-dim)” önaya
rındaysan, örneğin „densifyGradThreshold [5e-7, 5e-6]“ görürsün — yani bu iki değer 
arasında log-uniform.

ÖRNEK IŞ AKIŞI  „RadianceKit defaults (6-dim)“ önayarını, Trial Budget 40, Seed 42′yi 
seç. „Start”a tıkla. Gözlemle: ilk 8 deneme gridir (ilk örnekler, LHS-Latin-Hypercube), 
sonrakiler mavidir (BayesOpt edinilmiş). Convergence grafiği Trial ~15′e kadar dik 
olur, sonra düzleşir. Trial ~30–40′ta en iyi değer dengelenir. „Save Best Config“e 
tıkla — önayar adı, deneme indeksi, değer ve çözülmüş parametre değerleriyle bir 
bayesopt-best.json  kaydedilir. Bu JSON’ı sonra manuel olarak önayar tanımına alabi

lirsin.

W30 „Start“ düğmesi

N E R E D E

Sol araç çubuğu, idle/finished durumunda.

T E K N İ K

Trial listesini sıfırlar, running durumuna geçer, yeni 
bir çalıştırma ID’si üretir (çoklu Start tıklamalarında 
bayat algılama için) ve taze bir duraklatma kapısı 
oluşturur. Sonra optimizatörü eşzamansız akış ola
rak çalıştıran bir arka plan görevi başlatır. İlk örnek
lerin boyutu min(8, budget /​ 4 + 1) ile sonuçlanır 
— yani ≥ 28 bütçede tipik 8 Latin-Hypercube örneği, 
küçük bütçede daha az. Trial güncellemeleri artımlı 
olarak alınır ve listeye eklenir. Bayat çalıştırma koru
ması: bu sırada ikinci bir Start tıklaması çalıştırma 
ID’sini yeniden ayarlarsa, eski çalıştırmadan güncel
lemeler atılır.

Belirgin düğme görünümü için birincil eylem stili.

K I S ACA

Mevcut arama alanı, bütçe ve se­
edle taze bir optimizasyon çalış­
tırması başlatır.
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W31 „Pause“ düğmesi

N E R E D E

Sol araç çubuğu, running durumunda.

T E K N İ K

Pause kapısını etkin ayarlar ve Paused durumuna 
geçer. Asıl etki: Runner bir sonraki objektif fonksiyo
nu değerlendirmeden önce 50 ms yoklama döngü
sünde bekler. Bu, şu anda çalışan bir denemenin so
nuna kadar yürütüleceği (sentetik ve yalnızca mikro 
saniye sürdüğü için) ama başka bir denemenin baş
latılmayacağı anlamına gelir. Resume çalışır çalışmaz 
nerede durdurulduysa oradan devam eder.

K I S ACA

Çalıştırmayı duraklatır. Mevcut 
hesaplama hâlâ sonuna kadar 
çalışır, sonra duraklatır.

W32 „Stop“ düğmesi

N E R E D E

Sol araç çubuğu, running ve Paused durumunda.

T E K N İ K

Runner görevini iptal eder, referansı nulla, pause 
kapısını çözer (hâlâ duraklatılmışsa) ve denemeler 
varsa Finished durumuna (denemeler yoksa idle 
durumuna) geçer. Önceden hesaplanan denemeler 
listede görünür kalır — Stop onları silmez. Yıkıcı 
düğme rolü, çalıştırmayı iptal ettiği için düğmeyi kır
mızıda gösterir.

K I S ACA

Çalıştırmayı kesin olarak iptal 
eder. Denemeler görünür kalır, en 
iyi yapılandırmayı yine de dışa 
aktarabilirsin.

W33 „Resume“ düğmesi

N E R E D E

Sol araç çubuğu, Paused durumunda.

T E K N İ K

Pause kapısını çözer ve Running durumuna geri 
döner. Runner görevi zaten çalışır (yoklama döngü
sünde bekler); döngü duraklamanın kaldırıldığını fark 
eder etmez devam eder ve bir sonraki denemeyi 
başlatır.

K I S ACA

Duraklatılmış bir çalıştırmayı 
sürdürür.
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W34 „Save Best Config“ düğmesi

N E R E D E

Sağdaki araç çubuğu, her zaman görünür (ama 
bestTrial yoksa devre dışı).

T E K N İ K

Varsayılan dosya adı bayesopt-best.json , JSON 
ile sınırlı bir kaydet diyaloğu açar. Onaydan sonra 
payload sözlüğü oluşturulur: Önayar adı, deneme 
indeksi, değer (objektif puan), parametreler (çözü
len parametre adları sözlüğü → değerler). Çözme 
normalize edilmiş arama alanı koordinatlarını [0,1]^d 
içinden orijinal değer aralığına (log-uniform/linear/
integer ölçekleriyle uygun olarak) projeksiyonlar. 
JSON çıktısı düzenli yazdırılır ve sıralanmış anah
tarlarla. Yazma hatasında (mevcut demo sürümde) 
sessizce yok sayılır — hata UI’si yok, çünkü bu bir 
demo yoldur.

Bir deneme çalıştırılmadığı sürece düğme gri kalır.

K I S ACA

Şimdiye kadar en iyi denemenin 
parametre değerlerini JSON ola­
rak kaydeder. Bu değerleri sonra 
manuel olarak önayar yapılandır­
mana alabilirsin.

W35 „Search Space“ önayar seçici

N E R E D E

Sol kenar çubuğunda üst.

T E K N İ K

Dört önayar seçenekli menü seçici: - „RadianceKit 
defaults (6-dim)“ — tüm Q7 hiperparametreleriyle 
tam standart arama alanı. - „Mip subset (2-dim)” 
— yalnızca mipSmoothing3DScale [0.05, 0.5] log-uni
form ve mipFilter2DVariance [0.1, 0.6] doğrusal. 
Mip-Splatting’i bir sahne sınıfı için ayarlamak is
tiyorsan yararlıdır. - „densify-until + ssim-weight 
+ grad-thresh“ — üç densify ile ilgili paramet
re (densifyGradThreshold log-uniform, ssimWeight  
doğrusal, densifyUntilIter  tamsayı). - „Bowl de
mo (1-dim)” — „BayesOpt böyle çalışır“ demoları 
için pedagojik tek parametre arama alanı.

Bir çalıştırma aktifken arama alanı değiştirilemez 
(optimizatörü karıştırır).

K I S ACA

BayesOpt’un hangi hiperpara­
metre arama alanını araştırdı­
ğı. Standart „RadianceKit defa­
ults“tır. Hedefli Mip ayar de­
nemeleri için „Mip subset”. 
BayesOpt’un nasıl çalıştığını an­
lamak için „Bowl demo“.
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W36 „Trial Budget“ kaydırıcı

N E R E D E

Sol kenar çubuğunda Search Space seçicinin altın
da.

T E K N İ K

10′dan 200′e, adım 5 olan kaydırıcı. Varsayılan 40. 
Bu, BayesOpt’un maksimum N deneme yapabilece
ği anlamına gelir. Bunlardan ilk birkaçı başlangıç 
örnekleridir (Latin-Hypercube), gerisi gerçek Baye
sOpt denemeleridir. Pratik için pratik kurallar: d 
boyutlu bir arama alanı iyi bir optimum için yaklaşık 
10d ile 20d deneme gerektirir. 6 boyutlu varsayılan
larda yani 60–120, 2 boyutlu Mip alt kümesinde 20–
40, 1 boyutlu Bowl demosunda 10–20.

Çalıştırma sırasında kaydırıcı devre dışıdır.

K I S ACA

Maksimum kaç optimizasyon de­
nemesi. Daha fazla deneme = da­
ha iyi çözüm, ama daha fazla za­
man gerektirir. 40, demo objektifi 
için iyi varsayılandır.

W37 „Random Seed“ kaydırıcı

N E R E D E

Sol kenar çubuğunda Budget kaydırıcının altında.

T E K N İ K

1′den 100′e, adım 1 olan kaydırıcı. Varsayılan 42. 
Seed hem ilk Latin-Hypercube örneklerine hem de 
demo objektifinin gürültü bileşenine iletilir. Yeniden 
üretilebilirlik: aynı seed + aynı arama alanı + aynı 
bütçe tam olarak aynı deneme dizisini verir. „Demo
yu yeniden inşa ettiklerinde tüm meslektaşların aynı 
çalıştırmayı alıyorlar mı?“ için yararlıdır. Çalıştırma 
sırasında devre dışıdır.

K I S ACA

Rastgele üreteciyi kontrol eder. 
Aynı seed = aynı çalıştırma — ye­
niden üretmek için.
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W38 Chart (Convergence)

N E R E D E

Pencerenin orta sütunu.

T E K N İ K

İki katmanlı Swift Charts diyagramı: 1. Deneme başı
na „best-value-so-far“ için bir çizgi — vurgu rengin
de monoton yükselen veya sabit kalan eğri. 2. Faza 
göre renklendirilmiş tekil objektif değeriyle deneme 
başına bir nokta. Sembol boyutu 40. Üç faz etiketi: 
„init” (gri), „bo“ (mavi), „restart” (turuncu).

Sol üstte küçük bir lejant faz renklerini gösterir. 
Deneme listesi boşsa (ilk başlangıçtan önce), grafik 
simgesi ve „Press Start to begin a BayesOpt run.“ 
ipucuyla bunun yerine bir boş durum gösterimi gös
terilir.

K I S ACA

Seyir grafiği. Düz çizgi „şu ana 
kadar bulunan en iyi çözüm“dür; 
noktalar tekil denemelerdir. Çizgi 
uzun süre düz kalırsa, BayesOpt 
optimumu bulmuştur.

W39 Table (Trial Log)

N E R E D E

Pencerenin sağ sütunu.

T E K N İ K

Tembel yığılmış deneme satırlarıyla kaydırma alanı. 
Satır başına yatay yığın: deneme numarası (3 basa
maklı monospace, solda), değer (monospace, sağa 
hizalı, 70 pt geniş), faz etiketi (kapsül, %25 opaklık
ta faz rengiyle doldurulmuş), bu deneme şu anda en 
iyisiyse isteğe bağlı sarı bir yıldız. Bir otomatik kay
dırma mekanizması yeni bir deneme eklendiğinde 
otomatik olarak sona atlar — böylece canlı seyri ek
ran tabanında kendin kaydırmadan takip edebilirsin.

K I S ACA

Tüm denemelerin tablosu. Değer, 
faz, en iyi için yıldız. Otomatik 
olarak birlikte kaydırılır, yeni de­
nemeler altta görünür.

Ana pencere: Kayıp seyri ve Gaussian sayısı (I39–I41, çapraz 
başvuru)

Ana penceredeki Inspector göstergelerinden üçü kendi açıklamasını hak eder, çünkü 
çalışan bir eğitim sırasında sürekli görünürler ve seyrin ne zaman sağlıklı göründüğü 
hakkında önemli pratik kurallar vardır. Göstergeler Inspector’da „Loss Chart“ bölümünde 
(bkz. Bölüm 2 — Inspector) bulunur ve yukarıdaki yardımcı pencereden Holdout analizini 
tamamlar.
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Loss eğrisi ne zaman sağlıklıdır? Sağlıklı bir Loss eğrisi üç faz gösterir: (1) Warmup 
— ilk 200–500 iterasyon Loss yüksekten (L1+SSIM birleşik için sahneye göre tipik 0.15–
0.25) yaklaşık yarıya dik düşer. Loss bu fazda DÜŞMEZSE, çoğunlukla girdi yanlıştır 
(görüntüler bozuk, SfM pozları kötü, başlangıç Gaussian sayısı çok küçük). (2) Densifi­
cation — ~500 ile densifyUntilIteration (klasik 15K, MCMC 20K veya 25K’ya kadar) 
arasında Loss düşmeye devam eder, sıklıkla Densify işlemleri yeni Gaussian’lar ekledi
ğinde ve optimizer onları kullanırken aşağı doğru küçük sıçramalarla. Gaussian sayısı bu 
fazda artar. (3) Refinement — sonra Loss düzleşen bir kuyruğa girer. Tipik son değerler: 
Tanks-&-Temples Truck P4 Quality ile L1 ≈ 0.023′e, Horse Full Classic V546 ile L1 ≈ 
0.0230′a, dış mekân Mip-NeRF360 sahneleri sıklıkla daha kötü (0.04–0.07).

Bir plato ne anlama gelir? Bir plato (Loss eğrisi birkaç bin iterasyon boyunca yatay 
gider), iki yorumu vardır: (a) model yakınsamıştır, daha fazla eğitim hiçbir şey getirmez 
— iyi durum. (b) model takılıdır (yerel minimum, kötü gradyan bilgisi, buffer limitinde 
bir üst sınır) — kötü durum. İkisi de grafikte aynı görünür. Ayırt etme: Gaussian sayısına 
bak. Bu da düzse VE MCMC üst sınırına yakınsa (ör. .fullMCMC ’de 150K’dan 150K), 
limittesin — ya üst sınırı artır ya da platoyu kabul et. Gaussian sayısı hâlâ büyüyorsa ama 
Loss düşmüyorsa, takılıdır.

Ne zaman iptal et vs eğitime devam et? Pratik kural: 10K iterasyon boyunca min 
Loss’ta iyileşme yok → iptal et, daha fazla iterasyon boşa harcanır. Bundan önce: Cmd+T 
üzerinden (Training menüsü → Continue Training → +5K iterations) sınır iyileşme görü
yorsan bir uzatma daha ekleyebilirsin. Dikkat: MCMC’de plato sıklıkla gerçektir — üst 
sınır doğal sınırdır.

Gaussian sayısı platosu BİR „bitti“ sinyali DEĞİLDİR. Yalnızca MCMC’nin üst sınıra 
ulaştığı veya Classic Densification’ın tüketildiği anlamına gelir. Gerçek „bitti” sorusunu 
ancak Holdout analizi sorar — bağımsız bir test setinde PSNR/SSIM/LPIPS, Holdout pen
ceresinde (W23–W29) veya --benchmark  bayrağı üzerinden değerlendirilir.

PSNR/Holdout gerçektir, Loss yalnızca proxy. Loss göreli bir metriktir: modelin eğitim 
görünümlerine uyumlandığı sırada düşer. Ancak düşük bir Loss otomatik olarak iyi model 
demek değildir — model eğitim görüntülerini ezberlediyse (overfitting), Loss küçük olur
du ama görülmeyen görünümlerde (Holdout) PSNR kötü olurdu. Bu yüzden: son kalite 
değerlendirmesi için her zaman Holdout metriklerine bak, yalnızca son Loss’a değil.

Pratik kural kutusu

• User Guide ve Keyboard Shortcuts statik yardımdır — anahtar kelime soruları için hızlı, 
derinlik için bu mevcut kılavuzu kullan.

• Disk %10 boş alanın altına düştüğünde Manage Storage’ı aç. Günlükler ve içe aktar
maların staging’i tipik suçlulardır.

• Pareto Dashboard ancak en az üç veya dört eğitim raporundan sonra anlamlıdır. X 
ekseni = maliyetler (Time / Gs), Y ekseni = kalite (PSNR / SSIM). Pareto-Front verimli 
kombinasyonları gösterir.

• Başkalarıyla PSNR benchmark’ları yayınlamadan önce Holdout Analysis kullan — test 
setinin gerçekten temsili olduğunu sana garanti eder.
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• BayesOpt Console öncelikle arama alanı tanımları için bir öğrenme ve denetim aracı
dır. Gerçek eğitim güdümlü hiperparametre ayarı için çevrimdışı CLI iş akışını kullan.

• Loss platosu ve Gaussian sayısı platosu ayrı yorumlanmalıdır. Üst sınır limiti bir „bitti“ 
sinyali değildir. Gerçek kaliteyi yalnızca Holdout PSNR ölçer.

• Min Loss iyileşmesi olmadan 10K iterasyon → eğitimi durdur.
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B Ö L Ü M

Bölüm 6 — Eğitim Yapılandırması

Şekil 26:  JSON olarak dışa aktarılmış ve TextEdit’te görüntülenmiş Preview önayarı — id/na­
me/category/version/createdAt/description alanları, tüm ilgili parametrelerle trainingConfig 

(maxIterations 5000, densifyUntilIteration 3500, ssimWeight 0.20, renderScale 0.50, strategy 
classic, cameraAlignment applePhotogrammetry, densifyGradThreshold 2.0e-06, opacityRe­

setInterval 3000, minOpacity 0.005, altı bool anahtar)

RESIMDE NE GÖRÜNDÜĞÜ  Tipik bir önayar JSON dışa aktarması. Üst düzey alanlar: id  
(UUID), name , (classic | mcmc | sceneClass | custom), (şema sürümü), (zaman damga
sı), (serbest metin). İç içe nesne yeniden üretilebilirlik için kritik parametreleri içerir — 
içe aktarmada tüm blok TrainingConfig  yapısına deserialize edilir ve uygulama sürü
münün varsayılanları JSON’da eksik alanları doldurur (ör. uygulama güncellemesinden 
sonra). Bir önayarı başka bir Mac’e aktarmak isteyen, bu JSON dosyasını basitçe gönde
rir.

TrainingConfig  yapısı RadianceKit’teki her eğitim çalıştırmasının kalbidir. Eğitimi etki
leyen her parametreyi toplar — maksimum iterasyon sayısından sekiz öğrenme hızına ve 
MCMC, Mip-Splatting, müfredat ve sahne farkındalıklı üst sınır mantığı için özel alanlara 
kadar. Bunu kenar çubuğunda Eğitim Yapılandırması bölümü alanında (Expert View) 
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düzenler, bir önayar olarak kaydeder veya başka bir Mac’e JSON dışa aktarımı olarak 
iletirsin. Eğitim sırasında tam olarak bu nesne dondurulur ve GPU arka ucuna iletilir.

Bu bölüm güç kullanıcıları ve script yazarları için referans malzemesidir. Tüm 81 herke
se açık alanı, 9 statik önayarı ve tek herkese açık yöntemi listeler. Kaynak dosya 
TrainingConfig.swift’dir — şüphede orada saklanan doc yorumu ve başlatıcı varsayıla
nı tek doğruluk kaynağıdır.

N OT  ·  U I  V S .  Ö N AYA R / C L I

81 alandan yalnızca 12′sinin Inspector’da (sandboxed App Store yapımı) doğrudan 
bir kaydırıcı, anahtar veya seçici vardır: T1, T2, T17, T20, T22, T38, T56–T58, 
T60, T61, T73. Kalan 69 alan seçilen önayar (Bölüm 7) üzerinden ayarlanır ve 
yalnızca CLI bayrağı (bkz. Bölüm 5) ile doğrudan üzerine yazılabilir. Bu ayrım 
bilinçlidir: varsayılanlar istikrarlı ve üretimde kanıtlanmış kalır, güç kullanıcılarının 
yine de bir kaçış kapısı vardır. Bir alan seni özellikle ilgilendiriyorsa: önce Bölüm 
2′ye (Inspector) ve Bölüm 5′e (CLI) bak, JSON ile uğraşmadan erişebilir misin.

İçindekiler:

1. İterasyon (T1–T2)
2. Öğrenme hızları (T3–T10)
3. Densification — Classic (T11–T16)
4. Loss (T17–T20)
5. SH derece ilerlemesi (T21)
6. Performans (T22–T25)
7. Tanı ve nokta bulutu hazırlığı (T26–T30)
8. Düzenleme (T31–T37)
9. İnce ayar (T38–T44)

10. Sky-Dome (T45–T48)
11. Adam + LR programı (T49–T55)
12. Son işleme + Apple AI (T56–T60)
13. MCMC Densification (T61–T73)
14. Mip-Splatting (Q1.5) (T74–T76)
15. Uyarlanabilir Densification (Q5) (T77–T79)
16. Müfredat (Q6) (T80–T81)
17. Statik önayarlar (TP1–TP9)
18. Yöntem:
19. Hangi alan ne için? (kopya kağıdı)
20. Tehlikeli alanlar
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İterasyon (T1–T2)

T1 maxIterations

D E TAY L A R

Varsayılan: 30 000 (inizializzatore), 35 000 
( .full ), 200 000 ( .fullMCMC ) Range: 1 000 – 
500 000 (slider UI), nessun limite superiore rigido 
nella logica Tanımlandığı yer:

T E K N İ K

Numero totale di iterazioni di training che il backend 
esegue. Un’iterazione indica un forward render di 
una singola fotocamera di training, un backward 
pass su tutti i componenti di loss (L1 + SSIM + rego
larizzazioni opzionali + sky mask) e uno step Adam 
optimizer. Questo numero agisce direttamente sugli 
altri schedule: la learning rate di posizione segue 
una curva di cosine annealing da 0 fino o a T1  
stesso o a T49 positionLRScheduleEndIteration; la 
densification si ferma a T2 densifyUntilIteration; 
il decadimento del rumore MCMC termina a T69 
mcmcNoiseDecayEnd; gli upgrade del grado SH av
vengono ai tre marker definiti in T21 . Con densifi
cation classica il sweet spot determinato empirica
mente è 20 000–35 000 iterazioni (sessioni 1–32, 
test V546), con MCMC 60 000–200 000 (V534). 
Un aumento drastico oltre i valori memorizzati nel 
preset raramente porta qualità aggiuntiva — l’Adam 
momentum satura, e senza fine del LR decay il loss 
ristagna. Viceversa, scendere sotto ~5 000 porta a 
geometrie convergenti in modo incompleto (il den
sity control ha troppo poco tempo per clone/split).

K I S ACA

Quanto a lungo l’app calcola. Più 
iterazioni = risultato migliore, ma 
a un certo punto non più visibil­
mente migliore, ma molto più a 
lungo. I preset sono scelti in mo­
do che tu abbia un buon valore 
senza pensarci: Quick 1 000, Pre­
view 5 000, Balanced 20 000, Qu­
ality 35 000, MCMC Quality 200 
000. Se lo regoli tu stesso: con 
MCMC puoi salire (100 000–200 
000), con Classic non oltre 40 
000 — dopo non porta più nulla.
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T2 densifyUntilIteration

D E TAY L A R

Varsayılan: 15 000 (inizializzatore), 5 000 
( .full ), 160 000 ( .fullMCMC ) Range: 0 – Tanım­
landığı yer:

T E K N İ K

Iterazione a partire dalla quale la densification si 
ferma. Fino a qui le gaussiane vengono clonate, 
divise e prune secondo le regole parametrizzate in 
T11–T16  (Classic) o T67–T70  (MCMC); dopo il nu

mero di gaussiane rimane costante e solo posizioni, 
rotazioni, scale, opacità e coefficienti SH vengono 
ottimizzati (fase di refinement). Nel paper 3DGS ori
ginale il valore è al 50% di T1 , nel preset .full  di 
RadianceKit solo a ~14% (5 000 su 35 000) — con
seguenza degli esperimenti V310/V338, che hanno 
mostrato che dopo 5 000 iterazioni un’ulteriore 
densificazione peggiora piuttosto il risultato (più 
floater, più memoria, nessun guadagno di qualità). 
MCMC invece esegue la rilocazione fino all’80% di 
T1  (V504b), perché MCMC non produce floater 

dannosi. Se T2  è troppo piccolo (< 1 000), nas
cono troppe poche gaussiane; troppo grande con 
Classic (> 50% di T1 ) porta a overgrowth e RGB 
saturation outlier (vedi findings di outdoor overtra
ining).

K I S ACA

Fino a quando l’app può creare 
nuove gaussiane. Dopo viene so­
lo raffinato ciò che è già lì. Con 
training classico di 35 000 itera­
zioni qui 5 000 è il valore giusto 
— tutto sopra rende la scena più 
pastosa. Con MCMC è 80% delle 
iterazioni totali (quindi 160 000 
con run di 200 000). Se modifichi 
il preset Quality, lascia stare qu­
esto campo.
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Öğrenme hızları (T3–T10)

T3 positionLearningRate

D E TAY L A R

Varsayılan: 0.00016 Range: 1e-7 – 1e-3 (racco
mandato) Tanımlandığı yer:

T E K N İ K

Learning rate Adam per la posizione XYZ di ogni 
gaussiana all’inizio del training (iterazione 0). Segue 
una curva di cosine annealing e scende durante il 
training a T4 positionLearningRateFinal. Il default 
0.00016 proviene dal paper 3DGS originale (Kerbl 
et al. 2023) e in RadianceKit non va scalato anche 
all’aumentare della risoluzione dell’immagine — la 
posizione si muove nel sistema di coordinate mon
do, non nello spazio dei pixel. Un aumento significa
tivo (> 0.0005) fa sì che le gaussiane saltino su 
lunghe distanze e il loss diventi instabile; valori sig
nificativamente più bassi (< 0.00005) portano nuvo
le di punti inizializzate in modo errato a non trovare 
mai il loro posto. V414 ha testato il raddoppio del 
valore di init → 16.8% di loss L1 peggiore; i tuning 
V544a hanno confermato il default del paper come 
ottimale. Nota: con .fullMCMC  lasciamo deliberata
mente questo valore al default — MCMC ha bisogno 
di learning rate costanti per la sua logica di rilocazi
one, quindi il tuning qui non porta nulla.

K I S ACA

Quanto velocemente i punti sp­
lat possono muoversi nello spa­
zio. Il valore standard è molto 
ben calibrato e non ha realmen­
te bisogno di modifiche. Solo 
se vedi splat che “sbandano” 
nell’immagine o un intero angolo 
manca perché nulla si sposta, il 
learning rate sarebbe un punto 
su cui regolare — ma tipicamen­
te prima qualcos’altro non quad­
ra (pose delle fotocamere, nuvola 
di punti iniziale).
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T4 positionLearningRateFinal

D E TAY L A R

Varsayılan: 0.0000016 (inizializzatore + paper), 
0.000016 ( .full , .fullMCMC  — 10× più alto) Ran­
ge: 0 – Tanımlandığı yer:

T E K N İ K

Valore finale della curva di cosine anne
aling della LR di posizione. Viene raggiunto o 
a T1 maxIterations  o, se impostato, a T49 
positionLRScheduleEndIteration. Il preset .full  
di RadianceKit usa 0.000016 — quindi 10× più alto 
del default del paper 0.0000016. Gli esperimenti 
V420 hanno mostrato che 0.5× del valore finale 
(0.000008) peggiora il loss del 6.4%; V414 ha 
mostrato che 2× del valore di init lo peggiora del 
16.8%. L’alto valore finale non è un trade-off, ma 
una scelta deliberata: con decay troppo forte le 
gaussiane perdono nella fase di refinement la capa
cità di adattarsi ai candidati di densification appena 
aggiunti. Tramite l’estensione V431/V433 la fase sc
hedule può essere accorciata ( T49 < T1 ), in modo 
che T4  venga raggiunto già prima della fine del 
training e il resto del training corra con mini LR 
costante — configurazione tipica: T49 = 20 000 , 
T1 = 35 000 , refinement quindi a 0.000016 per 15 

000 iterazioni.

K I S ACA

Quanto lentamente diventa la LR 
di posizione alla fine del training. 
L’abbiamo deliberatamente im­
postato meno aggressivo del pa­
per originale — gli splat possono 
ancora tremolare un po’ fino alla 
fine, questo li rende più nitidi. Se 
ci regoli: più alto = splat più irre­
quieti alla fine, più basso = gli 
splat non possono più adattarsi 
quando ne appaiono di nuovi.
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T5 shDCLearningRate

D E TAY L A R

Varsayılan: 0.0025 (inizializzatore + paper), 0.005 
( .full  e tutti i preset MCMC — 2×) Range: 0.0001 
– 0.05 Tanımlandığı yer:

T E K N İ K

Learning rate Adam per la quota DC (grado 0, quindi 
albedo costante) del colore SH. SH-DC corrisponde 
al tono base indipendente dalla direzione di una 
gaussiana, in un certo senso il “colore base”. Gli 
esperimenti V176 e V188 hanno trovato 2× più alto 
del default del paper come ottimale — convergenza 
del colore più veloce, soprattutto perché con tra
ining breve (5 000 iterazioni) altrimenti SH-DC non 
si forma. A differenza delle LR geometriche SH-DC 
non ha decay; la learning rate rimane costante su 
tutte le iterazioni (o segue solo il decay opzionale 
extended phase di T51 ). V416 ha testato la quad
ruplicazione a 0.01 → 6.4% di loss peggiore con 
Adam beta2=0.99.

K I S ACA

Quanto rapidamente il colore ba­
se di ogni splat si adatta. Il valore 
non si cambia quasi mai da soli 
— i preset hanno il valore giusto. 
Più alto andrebbe più veloce, ma 
può portare a colori instabili.
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T6 shRestLearningRate

D E TAY L A R

Varsayılan: 0.000125 (inizializzatore + paper), 
0.00025 ( .full  e MCMC — 2×) Range: 0.000001 
– 0.005 Defined in:

T E K N İ K

Learning rate Adam per i coefficienti SH di ordine 
superiore (grado 1, 2, 3 — quindi le quote di colore 
dipendenti dalla direzione di vista, che si occupano 
di luci speculari, riflessi e ombreggiature morbide). 
20× più piccolo di T5  per convenzione del paper, 
perché questi coefficienti crescono quadraticamen
te in numero (3 per grado 1, 5 per grado 2, 7 
per grado 3 → in totale 15 float per gaussiana) e 
senza learning rate più piccola sovrasaturerebbero 
l’immagine. Viene sbloccato in due passaggi — fino 
al primo marker in T21 shDegreeUpgradeIterations 
è attivo solo il grado 0 (quindi solo T5 ), dopo 1, 
poi 2, infine 3. Valori bassi qui sono particolarmente 
importanti su scene con molta illuminazione diffusa; 
su superfici molto lucide (vernice auto, acqua) non 
vale la pena regolare — la rappresentazione SH di 
per sé è limitata.

K I S ACA

Quanto velocemente imparano 
gli effetti di colore dipendenti 
dalla direzione (riflessi, lucen­
tezza). Di default molto piccolo, 
perché altrimenti tutto luccica. 
Il valore è meglio lasciarlo stare 
— chi vuole ottenere luci specu­
lari migliori è meglio servito da 
MCMC e tempi di training più 
lunghi che da questa LR.
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T7 opacityLearningRate

D E TAY L A R

Varsayılan: 0.05 (inizializzatore + paper), 0.1 
( .full , MCMC — 2×) Range: 0.001 – 1.0 Tanım­
landığı yer:

T E K N İ K

Learning rate Adam per l’opacità logit di ogni gaus
siana. L’app memorizza l’opacità come valore float 
non limitato e la trasforma con sigmoid in [0, 1]; 
la LR agisce nello spazio logit. Il default del paper 
0.05 è ripristinato dopo i test V50 (best single run 
L1 0.1664), V71 ha ripristinato 0.025 di V67. Il rad
doppio V188 a 0.1 rende il pruning più efficiente — 
le gaussiane morte cadono più velocemente sotto 
la T14 pruneOpacityThreshold. V418 ha mostrato: 
0.05 con Adam beta2=0.99 è 7.1% peggiore di 0.1 
— l’interazione con la configurazione Adam non è 
banale. Valori bassi (< 0.01) portano le gaussiane 
“morte” a rimanere in giro per sempre e consumare 
memoria; valori troppo alti (> 0.5) possono porta
re a esplosione dell’opacità, quindi il valore logit 
nell’optimizer viene limitato a [−15, 3] (vedi nota 
“Opacity Explosion Prevention” in CLAUDE.md).

K I S ACA

Quanto velocemente gli splat di­
ventano trasparenti o opachi. Im­
portante per la pulizia — gli splat 
che non contribuiscono devono 
sparire velocemente, altrimenti 
si forma un velo. Il valore stan­
dard va bene, solo i professionis­
ti lo modificano.
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T8 opacityLearningRateFinal

D E TAY L A R

Varsayılan: 0.0 (= “nessun decay”) Range: 0 oppu
re 0.001 – Tanımlandığı yer:

T E K N İ K

Valore finale opzionale di cosine decay per la LR di 
opacità (V427). Se 0.0, decay disabilitato e la LR di 
opacità rimane costante a T7  su tutto il training. 
V427 ha testato un decay 0.1 → 0.01 — risultato 
11.5% di loss peggiore; revertito, da qui il default 
“off”. L’ipotesi dietro il campo: nella fase di refine
ment una LR di opacità costante potrebbe portare a 
oscillazione, in modo che splat che hanno già raggi
unto il giusto grado di trasparenza vengano spostati 
di nuovo da fluttuazioni casuali del gradiente. Empi
ricamente non si conferma — la logica di logit clam
ping lo intercetta comunque. Il campo rimane dispo
nibile per esperimenti futuri; anche run MCMC molto 
lunghi (> 500K iterazioni) potrebbero beneficiarne.

K I S ACA

Se la learning rate di opaci­
tà debba diventare più picco­
la verso la fine. Standard: no. 
L’abbiamo provato, era peggio, lo 
lasciamo disabilitato. Rimani a 0.
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T9 scaleLearningRate

D E TAY L A R

Varsayılan: 0.005 (inizializzatore + paper), 0.01 
( .full , MCMC — 2×) Range: 0.0001 – 0.1 Tanım­
landığı yer:

T E K N İ K

Learning rate Adam per le tre componenti di scala 
di ogni gaussiana nello spazio log (RadianceKit me
morizza log(scale), in modo che le scale rimangano 
positive). Il default del paper 0.005, in RadianceKit 
raddoppiato a 0.01 per migliore convergenza di sca
la con le configurazioni di learning rate ottimizzate. 
Esperimento V423: 0.005 con Adam beta2=0.99 → 
18.7% di loss peggiore e visibilmente troppo poche 
gaussiane (il density control non poteva clonare, 
perché gli update di scala erano troppo lenti). 
La scala controlla l’estensione di ogni gaussiana 
— apprendimento troppo veloce porta a gaussiane 
“ago” (splat estremamente lunghi e sottili, vedi T34 
scaleRatioPruneThreshold), apprendimento troppo 
lento fa rimanere gli splat troppo compatti e il den
sity control deve splittare troppo spesso.

K I S ACA

Quanto velocemente si adatta la 
forma degli splat. Lo standard è 
buono. Se lo aumenti, ottieni vo­
lentieri splat “ago” — gocce est­
remamente lunghe e sottili, che 
fanno fluttuare l’immagine.
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T10 rotationLearningRate

D E TAY L A R

Varsayılan: 0.001 (inizializzatore + paper), 0.002 
( .full , MCMC — 2×) Range: 0.0001 – 0.05 Ta­
nımlandığı yer:

T E K N İ K

Learning rate Adam per le quattro componenti qu
aternione di ogni gaussiana. Il quaternione viene 
rinormalizzato ad ogni step optimizer dopo l’update 
Adam (norma L2 = 1) — altrimenti la matrice 
di covarianza diventerebbe degenere. RadianceKit 
raddoppia il default del paper nei preset Quality, 
perché la rotazione rispetto a scala/posizione ha 
magnitudini di gradiente assolute più piccole (sulla 
sfera unitaria ogni step rimane breve) e senza 2× la 
rotazione nella finestra di 35 000 iterazioni sarebbe 
nettamente sotto-convergente. V188 documentato. 
Su scene NeRF-Blender (Lego, Chair) la rotazione 
si ripercuote in modo particolare — gli spigoli degli 
oggetti si allineano correttamente solo dopo 5 000–
10 000 iterazioni.

K I S ACA

Quanto velocemente gli splat im­
parano a ruotare — quindi a 
venire nell’orientamento corretto 
sulla superficie di un oggetto. Lo 
standard va bene. In altre paro­
le: se gli splat appaiono come 
mattoncini messi storti invece di 
aderire alla superficie, è piuttos­
to il tempo di training troppo 
breve, non questa learning rate 
troppo bassa.
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Densification — Classic (T11–T16)

T11 densifyGradThreshold

D E TAY L A R

Varsayılan: 0.000002 (inizializzatore, calibrato per 
risoluzione 0.5×), 0.0000011 ( .full , calibrato per 
1.0×), 0.000004 ( .quickTest , calibrato per 0.25×), 
2e-7 ( .fullClassicPaper ) Range: 1e-8 – 1e-3 (di
pendente dalla risoluzione) Tanımlandığı yer:

T E K N İ K

Soglia per la norma L2 del gradiente proiettato 
nello screen space dMean2D , sopra la quale una 
gaussiana viene contrassegnata per clone o split. 
Il valore assoluto dipende direttamente dalla risolu
zione di training — dMean2D  scala approssimativa
mente come 1/risoluzione² (più pixel = gradienti 
per pixel più piccoli). Quindi ogni stadio di T22 
trainingRenderScale ha bisogno di una soglia calib
rata: 0.25× → 4e-6, 0.5× → 2e-6, 1.0× → 5e-8 … 
1.1e-6 ( .full ). Il default del paper 0.0002 è NDC-
normalizzato e nella pipeline spazio-mondo di Radi
anceKit non direttamente confrontabile. Con il flag 
T52 adaptiveDensifyThreshold aggiunto in V440 il 
valore può essere calcolato in runtime dal p98 della 
distribuzione attuale del gradiente — ma V440 l’ha 
testato su scene reali e ha prodotto 63 K gaussiane 
(perdita catastrofica di pruning); il flag rimane off. 
Q5 (T77–T79) fornisce una logica adattiva alternati
va via rolling median. Questo campo non è privo 
di pericoli — dimezzandolo si producono 2–4× più 
gaussiane (pressione di memoria, rischio OOM); 
raddoppiandolo si può sotto-densificare la scena.

K I S ACA

Quanto è sensibile l’app quando 
deve decidere se uno splat è sot­
to-rappresentato e deve essere 
moltiplicato. Valore basso = più 
sensibile = più splat. Più alto 
= meno splat. È uno dei valori 
più pericolosi in assoluto: trop­
po basso e il Mac si riempie di 
memoria con milioni di splat e 
potrebbe crashare. Lascia stare il 
campo, o modificalo solo in step 
del 10%.
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T12 densifyFromIteration

D E TAY L A R

Varsayılan: 500 Range: 100 – 5 000 Defined in:

T E K N İ K

Prima iterazione a partire dalla quale la densification 
diventa attiva. Prima avviene solo apprendimento 
“nudo” sulla nuvola di punti SfM iniziale, senza che 
vengano create nuove gaussiane. Il default 500 pro
viene dal paper 3DGS e dà tempo all’inizializzazione 
di stabilizzarsi — se si densifica già dall’iterazione 0, 
i punti SfM posizionati in modo errato si clonano in 
molte copie, prima che trovino il loro posto corretto. 
V349 ha testato 1000 → loss leggermente peggiore; 
il default è ottimale.

K I S ACA

Quando l’app inizia per la pri­
ma volta a clonare splat. Prima 
impara solo i punti già presen­
ti. 500 è il valore standard — 
dà all’app abbastanza tempo per 
orientarsi prima di moltiplicare.

T13 densifyInterval

D E TAY L A R

Varsayılan: 100 (inizializzatore, MCMC), 200 
( .full ) Range: 50 – 1 000 Tanımlandığı yer:

T E K N İ K

Quante iterazioni si trovano tra due step di densi
fication. Nel default del paper 100 — ogni 100 
iterazioni viene valutata la lista dei candidati di 
densify, clonata/divisa e contemporaneamente la 
lista dei candidati di prune (sigmoid(opacity) < T14 
pruneOpacityThreshold) rimossa. I test V112 hanno 
trovato 200 come ottimale per .full  — ciò alleg
gerisce la GPU, perché vengono eseguiti meno pass 
di riorganizzazione, e dà a ogni gaussiana più tempo 
per stabilizzarsi dopo un’azione di clone. V417 ha 
testato 100 con beta2=0.99 → 5.8% peggiore (957 
K gaussiane, sovra-densificazione). Con MCMC lo 
stesso campo viene interpretato come intervallo di 
rilocazione; vedi T67 mcmcRelocationInterval per la 
logica specifica MCMC.

K I S ACA

Con quale frequenza l’app cerca 
nuovi splat. 100 = spesso, 200 
= medio. Più alto significa: ogni 
splat ha più tempo per sistemar­
si prima che venga moltiplicato 
di nuovo. È bene. Abbassarlo a 
50 può tenere la GPU costante­
mente occupata senza diventare 
significativamente migliore.
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T14 pruneOpacityThreshold

D E TAY L A R

Varsayılan: 0.005 (inizializzatore, paper, MCMC), 
0.001 ( .full ) Range: 0.0001 – 0.1 Tanımlandığı 
yer:

T E K N İ K

Soglia di opacità sigmoid sotto la quale una gaus
siana viene eliminata al prossimo step di densifica
tion. Agisce insieme a T7 opacityLearningRate e 
alla logica di logit clamp nell’optimizer. V393 ha 
abbassato il default da 0.005 a 0.001 in .full  — 
conseguenza: gli splat che giocano un ruolo solo 
da angoli di visualizzazione esotici rimangono più 
a lungo e contribuiscono al dettaglio SH. V394 ha 
testato 0.0001 → leggermente peggio (troppo poco 
pruning, memoria sprecata). Importante: il density 
control deve SEMPRE eseguire il pruning, anche 
se la capacità del buffer è già piena tramite altre 
misure (vedi “Density Control Must Always Prune” 
in CLAUDE.md) — altrimenti le gaussiane morte si 
accumulano e il count si congela.

K I S ACA

Quando uno splat è considera­
to “abbastanza trasparente” per 
essere eliminato. 0.005 è lo stan­
dard del paper, in Quality abbi­
amo 0.001 — quindi diamo agli 
splat più chance. Questo rende 
meglio rappresentabili luce mor­
bida e ombre deboli. Impostare 
più alto (sopra 0.01) fa scendere 
rapidamente il numero di splat 
— può essere sensato in caso 
di scarsità di memoria, ma costa 
dettaglio.

122 / 231



R A D I A N C E K I T Bölüm 6 — Eğitim Yapılandırması

T15 opacityResetInterval

D E TAY L A R

Varsayılan: 3 000 (inizializzatore + paper), 100 
000 ( .full  = effettivamente disabilitato), 200 000 
( .fullMCMC  = disabilitato) Range: 1 000 – 100 
000+ Tanımlandığı yer:

T E K N İ K

Ogni quante iterazioni l’opacità di tutte le gaussiane 
viene resettata a un valore basso (~0.01) — una 
misura del paper 3DGS per rivalutare splat “conge
lati”. V194 ha mostrato che con il setup warmup 
+ stochastic training + 2× learning rate di Radiance
Kit il reset di opacità costa il 5.5% di qualità e il 
logit clamp copre già la funzione di reset. Quindi in 
.full  praticamente disabilitato (100 000 > 35 000 

= mai attivato). V421 ha testato reset ogni 3 000 
con beta2=0.99 → 4.9% peggiore; revertito. Con 
.fullClassicPaper  (Q1.5-A, test fedele al paper) è 

deliberatamente riportato a 3 000 — è una delle leve 
con cui si dovevano raggiungere i budget di gaussi
ane con magnitudine paper.

K I S ACA

Ogni quante iterazioni l’app re­
setta la visibilità di tutti gli splat 
a “quasi invisibile” — una sorta 
di pulsante reset per l’opacità. 
Da noi disabilitato (valore così al­
to che non succede mai), perché 
altri meccanismi lo rendono su­
perfluo. Attivarlo solo per esperi­
menti fedeli al paper.

T16 maxScreenSize

D E TAY L A R

Varsayılan: 0.0 (= disabilitato) Range: 0 (off) o > 0 
Tanımlandığı yer:

T E K N İ K

Dimensione massima screen space (in pixel proiet
tati) che una gaussiana può raggiungere prima di 
essere splittata forzatamente. Il valore è impostato 
a 0 (V48 ha testato e revertito) — il density control 
di RadianceKit usa invece la soglia di scala spazio 
mondo della logica dMean2D . Rimane nel catalogo 
dei campi, perché futuri esperimenti con Mip-Splat
ting (T74–T76) o strategie di splatting specifiche 
per scena potrebbero beneficiarne. L’attivazione 
(valore > 0, ad es. 20) costringerebbe gli splat che 
sono diventati molto grandi nello screen a dividersi 
— rilevante con grandi superfici lisce di pareti, dove 
un singolo splat gigante offre troppo poco dettaglio.

K I S ACA

Limite di quanto può diventare 
grande un singolo splat sullo sc­
hermo. Da noi off. Acceso fareb­
be dividere forzatamente splat 
piatti enormi (ad es. su una pa­
rete) in più piccoli. Lascialo off, 
salvo esperimenti espliciti.
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Loss (T17–T20)

T17 ssimWeight

D E TAY L A R

Varsayılan: 0.2 (inizializzatore + paper + .full ), 
0.05 (tutti i preset MCMC) Range: 0.0 – 1.0 Tanım­
landığı yer:

T E K N İ K

Peso della quota D-SSIM nella funzione di loss com
binata loss = (1 - λ) * L1 + λ * D-SSIM, 
dove λ = T17 . Il default del paper 3DGS 0.2 è otti
male per la densification Classic — V383 ha testato 
0.3 → 28.9% peggiore, V373b ha confermato 0.2 
come sweet spot. Per MCMC in V521b/V534 è stato 
indipendentemente stabilito: 0.05 è ottimale, perché 
MCMC tramite la sua esplorazione stocastica ha bi
sogno di una quota di segnale L1 più forte — pesi 
SSIM più alti annacquerebbero le decisioni di riloca
zione. SSIM è significativamente più costoso da cal
colare di L1 (finestre locali 11×11 sull’intera immagi
ne); RadianceKit usa un’implementazione accelerata 
MPS che rimane sotto 1 ms per immagine 1080p. Gli 
sweep Q7-BayesOpt hanno trovato ottimi specifici 
per scena tra 0.05 ( .outdoorPreset : 0.082) e 0.171 
( .indoorPreset ).

K I S ACA

Quanto è importante per l’app, 
oltre a “ogni pixel corretto”, anc­
he “le strutture sono simili”. 0.2 
è lo standard e fornisce una bu­
ona immagine. Più basso = più 
preciso al pixel, ma può ottenere 
transizioni più morbide. Più alto 
= più simile strutturalmente, ma 
i dettagli diventano più morbidi. 
Lascia decidere ai preset.
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T18 ssimWeightRefinement

D E TAY L A R

Varsayılan: 0.0 (= “nessun cambio, mantieni ssim
Weight”) Range: 0 oppure 0 – 1.0 Tanımlandığı 
yer:

T E K N İ K

Valore SSIM opzionale per la fase di refinement do
po T2 densifyUntilIteration. V428 ha testato 0.2 
→ 0.3 in refinement → 16% di loss peggiore (sia L1 
sia SSIM sono peggiorati); revertito, da qui default 
0.0. L’ipotesi dietro il campo era che dopo la densi
fication — quando non nascono più nuove gaussiane 
— una quota SSIM più forte massimizzerebbe la 
nitidezza strutturale. Empiricamente errato: aumen
tare il peso SSIM significa indirettamente abbassare 
il peso L1, e L1 è il segnale nettamente più espres
sivo nella fase di refinement finale. Il campo rimane 
disponibile per esperimenti futuri con loss percetti
va (T60) o edge loss (T19), dove potrebbe essere 
sensata una composizione di loss specifica per refi
nement.

K I S ACA

Impostazione speciale per la se­
conda fase di training (refine­
ment dopo la moltiplicazione 
degli splat). A 0.0: stessa ponde­
razione SSIM di prima. Regolarlo 
empiricamente non porta nulla, 
quindi off.
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T19 edgeLossWeight

D E TAY L A R

Varsayılan: 0.0 (= disabilitato) Range: 0 oppure 
0.001 – 1.0 Tanımlandığı yer:

T E K N İ K

Loss sperimentale V437: peso di un loss L1 sul 
gradient domain Sobel, che confronta direttamen
te i bordi dell’immagine (Sobel ground truth vs 
Sobel render) in aggiunta a L1+SSIM. Ipotesi: 
l’informazione sui bordi è un pilastro percettivo 
della qualità dell’immagine e un termine esplicito 
dovrebbe incoraggiare le gaussiane a colpire meglio 
i bordi. Risultati dei test: peso 0.1 → 11% di loss 
peggiore, 0.01 → neutrale in qualità ma 10% più 
lento. Il pass Sobel costa un forward MPS aggiunti
vo su ground truth e render. Quindi disabilitato in 
modo permanente. Caso d’uso futuro: scene con 
bordi artificiali duri (architettura, mobili, rendering) 
potrebbero beneficiare — i preset Q7-Scene-Class 
però non l’hanno preso, ma hanno invece scalato il 
peso SSIM.

K I S ACA

Aggiunta sperimentale che pren­
de i bordi come extra importanti. 
Empiricamente non porta nulla. 
Rimane off.
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T20 skyMaskingEnabled

D E TAY L A R

Varsayılan: false (inizializzatore e tutti i preset) 
Range: boolean Tanımlandığı yer:

T E K N İ K

Attiva il Sky Masking. In ogni immagine la regione 
del cielo viene mascherata via Apple Vision Frame
work (VNGenerateForegroundInstanceMaskRequest), 
e il loss in quest’area viene impostato a zero. Senso: 
le scene outdoor soffrono spesso del fatto che pixel 
di cielo blu/grigi/bianchi portano l’app a posizionare 
gaussiane esattamente lì — ciò che viene percepito 
come “floater”. Senza sky mask il loss in quest’area 
non sarebbe mai zero, perché il cielo nell’immagine 
varia leggermente e l’app cerca all’infinito di ricost
ruirlo con splat. La maschera Vision viene calcola
ta una volta per fotocamera prima del training e 
mantenuta in RAM. Tipicamente attivata insieme a 
T45 skyDomeEnabled  (logica UI nella view Imposta

zioni). Con scene interne o rendering sintetici lasci
are disabilitato — la maschera riconoscerebbe erro
neamente soffitti o pareti come “cielo”.

K I S ACA

Attiva una modalità speciale per 
riprese esterne: il cielo viene ig­
norato durante il training, in mo­
do da non provare a ricostruirlo 
con splat. Raccomandato per og­
ni scena esterna. Con interni o 
con rendering 3D da Blender las­
ciare off.
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SH derece ilerlemesi (T21)

T21 shDegreeUpgradeIterations

D E TAY L A R

Varsayılan: [1_​000, 2_​000, 3_​000] (inizi
alizzatore), [2_​000, 5_​000, 8_​000] ( .full , 
MCMC), [1_000, 2_000]  ( .preview  — gra
do 3 saltato) Range: [Int] , ogni valore in 
[0, maxIterations] , monotonamente crescente 

Tanımlandığı yer:

T E K N İ K

Iterazioni a cui il grado SH attivo viene aumen
tato da 0→1, 1→2, 2→3. Prima del primo marker 
sono attive solo le componenti DC (quindi T5 
shDCLearningRate), dopo il primo marker DC + 3 
coefficienti di grado 1, dopo il secondo marker + 5 
coefficienti di grado 2, dopo il terzo marker tutti i 
15 coefficienti. Il fabbisogno di memoria per gaussi
ana cresce a stadi — 4 float → 16 float → 36 float 
→ 64 float. I preset Quality ritardano gli upgrade 
rispetto ai default dell’inizializzatore (V228), perché 
la geometria dovrebbe prima stabilizzarsi, prima che 
i dettagli di colore con la loro frequenza più alta 
vengano sopra. V384 ha testato [1K, 2K, 3K]  per 
.full  → 9.3% peggiore — conferma il ritardo. 
.preview  si ferma al grado 2, perché il grado 3 

in 5 000 iterazioni non converge e consuma solo ca
pacità optimizer. Q6 (T80–T81) offre una logica cur
riculum alternativa che sovrascrive dinamicamente 
questa lista.

K I S ACA

In quali punti del training l’app 
impara che i colori da diversi 
angoli di visualizzazione posso­
no apparire diversi (luci, riflessi). 
Solo tardi — in modo che prima 
la forma sia corretta, poi il colo­
re. I valori nei preset sono impos­
tati in modo che funzioni bene. 
Non modificare nulla, salvo che 
tu sappia esattamente perché.
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Performans (T22–T25)

T22 trainingRenderScale

D E TAY L A R

Varsayılan: 1.0 (inizializzatore, .full , MCMC, 
Scene-Class), 0.5 ( .preview ), 0.25 ( .quickTest ) 
Range: 0.05 – 2.0 (tipico 0.25, 0.5, 1.0) Tanımlandı­
ğı yer:

T E K N İ K

Risoluzione di rendering al training relativa alla riso
luzione originale delle immagini di training. A 0.5 
ogni immagine viene ridotta al 50% larghezza × 
50% altezza (quindi 25% dei pixel) e il rendering 
delle gaussiane avviene in questa risoluzione più 
piccola. Riduce quadraticamente sia il fabbisogno di 
memoria che quello di calcolo. Importante: T11
densifyGradThreshold deve corrispondere alla riso
luzione scelta — le magnitudini di gradiente scalano 
con 1/risoluzione², quindi .quickTest  (0.25×) ha 
una soglia molto più alta (4e-6) di .full  (1.0×, 
1.1e-6). RadianceKit avverte con immagini molto 
grandi e adatta automaticamente — risoluzione tar
get 3 MP. Con immagini di input estreme 4K 0.5 o 
anche 0.25 sarebbe sensato, altrimenti ogni Mac va 
in compaction CPU.

K I S ACA

Quanto sono grandi le immagini 
al training. 1.0 = originale, 0.5 = 
metà. Metà dimensione = quattro 
volte più veloce, ma i dettagli più 
fini mancano. I preset scelgono 
il valore giusto; con immagini di 
input estremamente grandi (oltre 
12 megapixel) l’app passa auto­
maticamente verso il basso.
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T23 resolutionWarmupScale

D E TAY L A R

Varsayılan: 0.0 (= disabilitato) Range: 0 oppure 0.1 
– Tanımlandığı yer:

T E K N İ K

Ottimizzazione V133: addestra la fase di densifica
tion (iter 0 a T2 ) in una risoluzione più bassa 
rispetto alla fase di refinement. V308 l’ha spenta di 
nuovo per .full , perché con T22 = 1.0  e cosine 
annealing il guadagno di tempo era marginale e la 
qualità soffriva minimamente. Rimane nel catalogo 
dei campi, perché potrebbe diventare di nuovo sen
sata con input 4K e lunghi run di training — Q6 
Curriculum (T80) ha ripreso una logica simile, lì è 
però accoppiata allo LR schedule. Se attivato e T80 
curriculumResolutionRamp anche true, vince Q6 e 
sovrascrive questo valore.

K I S ACA

Funzione speciale: nella prima 
metà del training imparare con 
immagini più piccole, nella se­
conda con quelle grandi. Rispar­
mia tempo. Off, perché la varian­
te più nuova Q6 lo risolve meglio.

T24 tileSize

D E TAY L A R

Varsayılan: 16 Range: 8, 16, 32 Tanımlandığı yer:

T E K N İ K

Dimensione delle tile di rasterizzazione in pixel. 
Il rendering Gaussian Splatting è basato su tile: 
l’immagine viene divisa in tile 16×16 pixel, ogni tile 
raccoglie le gaussiane rilevanti per essa, le ordina 
per profondità e le compone. 16 è lo standard usato 
praticamente da tutte le implementazioni 3DGS ed 
è hard-coded nei kernel Metal di RadianceKit; una 
modifica di questo valore richiederebbe la ricompi
lazione degli shader e non è effettiva nello stato 
attuale. Rimane come campo, nel caso una futura 
versione del motore supporti dinamicamente la tile 
size.

K I S ACA

Parametro di rendering interno. 
Standard 16, non modificare.
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T25 throttleDelayMs

D E TAY L A R

Varsayılan: 0 (inizializzatore, .full , MCMC, Sce
ne-Class), 0 ( .preview ) Range: 0 – 100 Tanımlan­
dığı yer:

T E K N İ K

Ritardo artificiale tra iterazioni di training in millise
condi. 0 = piena velocità (standard). Valori più alti 
rendono il Mac più “usabile” durante il training, 
dando a GPU/CPU regolari pause di respiro — 
l’usabilità di altre app aumenta, il tempo di training 
però linearmente con il ritardo. Valori tipici: 1–2 ms 
(throttling “leggero”, +5% di tempo training, il Mac 
si sente più reattivo), 5 ms (“medio”, +15% di tem
po training), 10+ ms (“Eco”, potenzialmente tempo 
training doppio). Viene offerto nell’Inspector sotto 
“Performance”, ma non è nella vista standard — vedi 
backlog dev_ux-backlog.md , che propone di rimu
overlo dalla vista esperto, perché frainteso prolunga 
drammaticamente il tempo di training.

K I S ACA

Quanti millisecondi di pausa 
l’app fa tra step di training. 0 
= nessuna pausa, il più veloce 
possibile. Valori più alti rendono 
il Mac più usabile durante il tra­
ining — ma il training dura anche 
più a lungo. Su un M3 Ultra o 
Mac Studio puoi lasciare a 0; su 
un MacBook Air 2 o 5 sarebbe un 
buon valore.
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Tanı ve nokta bulutu hazırlığı (T26–T30)

T26 depthDistortionWeight

D E TAY L A R

Varsayılan: 0.0 (= disabilitato) Range: 0 oppure 
0.0001 – 0.05 Tanımlandığı yer:

T E K N İ K

Sperimentale V366: peso di un loss di regolarizza
zione di depth distortion. Penalizza le gaussiane 
che sono stratificate in profondità lungo un raggio 
di render ma concettualmente appartengono alla 
stessa superficie — ciò incoraggia distribuzioni di 
profondità concentrate e riduce i floater. Test: 0.01 
→ 4.5% peggiore, 0.001 → 8.1% peggiore. Il vantag
gio teorico — migliorare la consistenza multi-view — 
non si riflette nel loss L1, perché l’ipotesi assume 
implicitamente che la geometria SfM sia corretta e 
le gaussiane debbano solo essere “impilate”. In pra
tica la nuvola di punti SfM è di solito il componente 
più debole, non l’impilamento. Rimane disponibile 
per dataset multi-view con pose particolarmente 
pulite (sintetici, Mip-NeRF 360 con ground truth).

K I S ACA

Funzione sperimentale per evita­
re più splat uno dietro l’altro 
nello stesso punto. Non attivato, 
perché i test non hanno portato 
nulla.

T27 singleViewOverfit

D E TAY L A R

Varsayılan: false Range: boolean Tanımlandığı 
yer:

T E K N İ K

Flag diagnostico: se true, in ogni iterazione di tra
ining viene forzatamente usato l’indice di fotocame
ra 0 invece di uno a caso dal pool. Senso: se il 
modello non riesce a fare overfitting nemmeno su 
una singola view (cioè il loss su view 0 anche dopo 
10 000 iterazioni non va a zero), nel forward/back
ward pass c’è un bug fondamentale. Questo switch 
è stato usato intensamente durante lo sviluppo degli 
shader Metal e dei kernel del rasterizzatore diffe
renziabile — fase V42–V47. Oggi disponibile solo 
come sanity check, se qualcuno ha modificato il 
codice backend e vuole fare un regression test. Via 
CLI con --single-view .

K I S ACA

Modalità di test per sviluppatori. 
Possono verificare con essa se 
l’app può in generale imparare 
da UNA sola immagine. Per utenti 
normali irrilevante, sempre lasci­
are off.
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T28 maxCameras

D E TAY L A R

Varsayılan: 0 (= “usare tutte le fotocamere”) Ran­
ge: 0 oppure 1 – N Tanımlandığı yer:

T E K N İ K

Limite diagnostico da V43: addestra solo con le 
prime N fotocamere, ignora tutte le altre. Senso 
originale: testare l’ipotesi che troppe fotocamere 
generino conflitti di gradiente (troppi segnali di 
loss contraddittori per la stessa gaussiana). Risul
tato del test: nessun vantaggio sistematico con 
limitazione artificiale — più frame portano pratica
mente sempre più qualità. Rimane come flag CLI 
( --max-cameras N ) per esperimenti mirati, ad es. 
“il training funziona sulle prime 100 immagini di un 
volo di drone di 1 500 immagini?” Non esposto 
nell’UI.

K I S ACA

Campo diagnostico per sviluppa­
tori — usare solo le prime N 
immagini, ignorare il resto. Uten­
te normale non ne ha bisogno, 
valore a 0 = tutte le immagini. 
Più immagini = risultato migliore 
(vedi feedback_​more-frames-
better.md).

T29 maxInitialPoints

D E TAY L A R

Varsayılan: 0 (= “usare tutti i punti SfM”) Range: 0 
oppure 1 000 – 200 000+ Tanımlandığı yer:

T E K N İ K

Salvaguardia V54: limita il numero di punti SfM inizi
ali con cui inizia il training. Le ricostruzioni COLMAP 
dense possono produrre > 60 000 punti, il che con 
grandi scale iniziali porta a 200–300 gaussiane per 
overlap di pixel — ciò crea un “campo di nebbia” in 
cui il training non converge. Il sottocampionamento 
a ~16 000 punti (logica di hard cap nel motore 
di training) porta la densità iniziale al livello che il 
3DGS di riferimento usa, e riduce drammaticamen
te l’overlap. Viene impostato automaticamente con 
SfM molto densi; via CLI con --max-points N .

K I S ACA

Quanti punti iniziali dalla ricost­
ruzione delle fotocamere vengo­
no usati. Con ricostruzioni molto 
dense (oltre 60 000) l’app limi­
ta automaticamente a 16 000 
— altrimenti c’è troppa nebbia 
all’inizio. Non hai bisogno di im­
postarlo; l’app lo regola.
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T30 cameraClusterOutlierMultiplier

D E TAY L A R

Varsayılan: 10.0 (tutti i preset — mai sovrascritto) 
Range: 1.0 – 100.0 Tanımlandığı yer:

T E K N İ K

Moltiplicatore per il camera cluster outlier filter, int
rodotto in fase 3.10 A.1. Prima del training, il motore 
di training calcola il centroide di tutte le posizioni 
delle fotocamere e la distanza massima di una foto
camera dal centroide. I punti SfM la cui distanza dal 
centroide supera multiplier × maxCameraDistance 
vengono scartati come outlier. Default 10× preserva 
il comportamento prima della fase 3.10. Un bug 
sottile: SfM tighter (fotocamere più strette insieme) 
→ maxCameraDistance più piccolo → soglia più pic
cola → più punti scartati come outlier. SfM looser 
→ soglia più grande → meno punti scartati. Questa 
è una delle cause dell’anti-correlazione funnel-vs-
training della fase 3.9: un SfM migliore può portare 
downstream a un training peggiore, perché vengo
no uccisi troppi punti iniziali. Il campo è disponi
bile come override CLI (--camera-cluster-outlier-
multiplier) per gli sweep A.3; non esposto nell’UI. 
Valori sotto 5 sono di solito troppo restrittivi, sopra 
20 inefficaci.

K I S ACA

Filtro speciale che scarta punti 
dalla ricostruzione lontani dal­
la nuvola della fotocamera. 10 
= l’app è generosa, tiene qu­
asi tutto. Aumentare può essere 
sensato se punti lontani (mon­
tagne sullo sfondo) appaiono 
nell’immagine come grumi flut­
tuanti. Abbassare solo in caso di 
emergenza — perdi così dettag­
lio in lontananza.
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Düzenleme (T31–T37)

T31 coarseToFineBlurRadius

D E TAY L A R

Varsayılan: 0 (= disabilitato) Range: 0 oppure 1 – 
10 Tanımlandığı yer:

T E K N İ K

Sperimentale V369: raggio di box blur che viene 
applicato all’immagine ground truth all’inizio della 
fase di densification e ridotto linearmente fino alla 
fine della densification ( T2 ) a 0. Ipotesi: training 
coarse-to-fine — prima imparare strutture grosso
lane, poi dettagli — dovrebbe fornire geometria 
più stabile. Test: r=3 → 9.6% peggiore, r=1 → 
5.1% peggiore. Il motivo del fallimento: la densifi
cation decide basandosi sui gradienti nel dominio 
dell’immagine, e il blur riduce esattamente i segnali 
importanti per “qui deve essere clonato”. Rimane nel 
catalogo per futuri test con schema di density cont
rol diverso.

K I S ACA

Modalità sperimentale “prima 
grossolano, poi dettagliato”. Non 
ha portato nulla, rimane off.

T32 scaleRegWeight

D E TAY L A R

Varsayılan: 0.0 (= disabilitato) Range: 0 oppure 
0.0001 – 0.05 Tanımlandığı yer:

T E K N İ K

Sperimentale V370: regolarizzazione L1 su scala 
spazio mondo. Penalizza gaussiane che diventano 
troppo grandi — impedisce “mega splat” che copro
no intere superfici di parete con una singola gaussi
ana. Test: 0.01 → 200% di loss peggiore (2 M gaus
siane, esplosione totale), 0.001 → 214% peggiore. Il 
motivo: la regolarizzazione di scala entra in conflitto 
con il density control — scale più piccole significano 
che servono più gaussiane, quindi il density control 
splitta più spesso, il che significa più sforzo di 
gradiente. Disabilitato, ma documentato per esperi
menti Mip-Splatting (T74): in questo contesto un 
limite inferiore di scala potrebbe essere sensato.

K I S ACA

Regolarizzazione che costringe 
gli splat a rimanere piccoli. Nei 
test ha provocato esplosioni di 
splat (milioni di splat). Non atti­
vare.
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T33 anisotropyRegWeight

D E TAY L A R

Varsayılan: 0.0 (= disabilitato) Range: 0 oppure 
0.0001 – 0.05 Tanımlandığı yer:

T E K N İ K

Sperimentale V445: penalità sul rapporto max(sca
le)/min(scale), dovrebbe impedire gaussiane “ago” 
estreme allungate, che vengono percepite come flo
ater. Test: 0.01 → 69% peggiore, 0.001 → 15% 
peggiore. Il motivo: la regolarizzazione costringe gli 
splat verso forma “rotonda”, il che su una superfi
cie piatta (parete, tavolo, pavimento) è esattamente 
sbagliato — lì una gaussiana piatta e larga è più effi
ciente di una sferica. Disabilitato. V549f ha offerto 
con T34 scaleRatioPruneThreshold un approccio 
alternativo più mirato, anch’esso revertito.

K I S ACA

Regolarizzazione che punisce gli 
splat troppo lunghi e sottili. Su­
ona sensato, ma nei test era peg­
gio. Off.

T34 scaleRatioPruneThreshold

D E TAY L A R

Varsayılan: 0.0 (= disabilitato) Range: 0 oppure 5.0 
– 100.0 (tipico 10.0 – 30.0) Tanımlandığı yer:

T E K N İ K

Pruning post-training sperimentale che elimina ogni 
gaussiana il cui rapporto max(scale)/min(scale) su
pera la soglia lineare qui impostata. Mira a floater 
“ago/disco” estremamente allungati che non posso
no essere eliminati con la sola regolarizzazione. Nel 
test il pruning rimuoveva i floater come sperato, 
ma contemporaneamente anche splat piatti sensati 
su pareti e pavimenti — l’immagine è diventata più 
bucata. Quindi di default off, il flag CLI (--scale-
ratio-prune N) rimane disponibile per esperimenti 
mirati. Valori raccomandati se si vuole comunque 
testare: 30 (molto conservativo, rimuove solo outlier 
estremi), 10 (aggressivo, costa dettaglio).

K I S ACA

Tentativo di filtrare gli splat mol­
to allungati dopo il training. Nei 
test era netto-negativo — floater 
via, ma anche dettaglio via. Off.
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T35 opacityRegWeight

D E TAY L A R

Varsayılan: 0.0 (= disabilitato) Range: 0 oppure 
0.0001 – 0.05 Tanımlandığı yer:

T E K N İ K

Sperimentale V446: penalità di binary cross entropy 
che tira l’opacità verso 0 o 1 (quindi via da “semi 
trasparente”). Ipotesi: distribuzione di opacità più 
nitida migliorerebbe la chiarezza dell’immagine. Test 
combinato con T33 → la regolarizzazione costa qu
alità, entrambi disabilitati. Disabilitato. Attenzione: 
nella 1.4.3 beta è emerso un bug che aveva esatta
mente questo campo in una modifica del valore di 
default (inizializzatore = 0.01), il che ha portato a 
mass extinction del gaussian count (460 K → 5 in 
un’iterazione). Dalla 1.4.4 fissato a 0.0 come default.

K I S ACA

Regolarizzazione che rende gli 
splat o completamente traspa­
renti o completamente solidi. 
Non porta nulla, può anche di­
ventare pericoloso (bug mass ex­
tinction 1.4.3). Lascia a 0.
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T36 opacityDecayFactor

D E TAY L A R

Varsayılan: 0.0 (inizializzatore = disabilitato), 
0.9995 ( .full , .classicBalanced  — standard 
HTGS) Range: 0 (off) oppure 0.95 – 1.0 Tanımlan­
dığı yer:

T E K N İ K

Implementazione V546 dello schema HTGS (Hi
erarchical Time-Gating, Eurographics 2025): ogni 
T37 opacityDecayInterval iterazioni l’opacità sig
moid di ogni gaussiana viene moltiplicata con ques
to fattore. 0.9995 × 100 applicazioni dà ~95% di 
rimanenza per fase di densification — una legge
ra ma costante pressione verso il basso su tutte 
le opacità, che fa scendere in modo affidabile le 
gaussiane che contribuiscono poco contro la T14 
pruneOpacityThreshold. Il risultato: 14% di loss L1 
migliore su Horse Full (3-trial-avg V546) rispetto 
a V438 senza decay. Attivo solo durante la fase 
di densification (fino a T2 ), dopo il training pro
segue senza decay, in modo che le opacità stabi
lite nel refinement rimangano stabili. Con MCMC 
non usato (MCMC ha propri meccanismi via T67 
mcmcRelocationInterval

1. T68 mcmcDeadOpacityThreshold).

K I S ACA

“Sbiadimento dolce” di tutti gli 
splat sul tempo di training. Ren­
de gli splat diventati inattivi più 
velocemente trasparenti, in mo­
do che spariscano alla pulizia. È 
stata la leva di qualità più im­
portante dell’update V546: 14% 
migliore. Integrata nel preset Qu­
ality. Non raccomandata per la 
regolazione da soli, perché esat­
tamente bilanciata.

T37 opacityDecayInterval

D E TAY L A R

Varsayılan: 50 Range: 10 – 500 Tanımlandığı yer:

T E K N İ K

Intervallo di iterazione in cui viene applicato T36 
opacityDecayFactor. Default paper HTGS 50, lasci
ato in .full . Intervalli lunghi (>200) annullano 
parzialmente l’effetto, perché tra due applicazioni 
avvengono abbastanza update di gradiente che 
l’opacità risale. Intervalli più brevi (<20) rendono il 
decay troppo aggressivo. Attivo solo in fase di den
sification.

K I S ACA

Con quale frequenza viene appli­
cato lo “sbiadimento”. 50 = ogni 
50 iterazioni un piccolo step di 
sbiadimento. Va bene.
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İnce ayar (T38–T44)

T38 gradientAccumulationSteps

D E TAY L A R

Varsayılan: 1 (= “una view per step Adam”) Range: 
1 – 8 Tanımlandığı yer:

T E K N İ K

Funzione V424: numero di view i cui gradienti 
vengono accumulati prima che venga eseguito un 
update Adam. Con > 1  l’app gira su un percorso 
backward project separato e “unfused” che somma i 
gradienti in un buffer separato; l’applicazione finale 
scala con 1/N per mantenere costante la magnitudi
ne. V424 ha testato 2-view → neutro in qualità, ma 
10% più lento (perché il percorso unfused è più 
costoso del fused). Revertito per .full , ma per 
MCMC deliberatamente usato — .fullMCMC  gira 
con, ma i test V544a hanno mostrato che con esso 
il gap di qualità verso Classic si riduce al 5% (invece 
dell’11%). Nel default dell’inizializzatore 1, nel preset 
attuale 1, rimane flag CLI ( --accum-steps N ).

K I S ACA

Quante immagini l’app guarda 
prima di adattare gli splat. 1 
= ogni immagine singolarmente. 
Più alto = guardare più immagini 
contemporaneamente e poi app­
licare una media. Nel caso stan­
dard non porta nulla; con MCMC 
2 può aiutare un po’.
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T39 testViewIndices

D E TAY L A R

Varsayılan: []  (= vuoto, tutte le view vengono 
usate per il training) Range: Set<Int> , qualsiasi 
sottoinsieme degli indici di fotocamera Tanımlandı­
ğı yer:

T E K N İ K

Funzione V546: set di indici di fotocamera che 
NON vengono usati per il training, ma riservati 
come holdout per la valutazione PSNR/SSIM/LPIPS. 
Viene impostato automaticamente quando il flag 
CLI --benchmark  è attivo: allora ogni ottava view, 
iniziando dall’indice 0 (standard LLFF, identico alle 
convenzioni Mip-NeRF-360 e paper 3DGS). Senza 
benchmark vuoto — il training usa tutte le view. At­
tenzione: l’impostazione manuale di questo campo 
senza comprensione degli indici può rendere inuti
lizzabile il benchmark (ad es. se tutti gli indici sono 
impostati sopra N, mentre ci sono solo N-50 view → 
nessun holdout → nessuna valutazione). Al proprio 
export preset testViewIndices non viene persistito, 
perché è dipendente dalla scena e altrimenti lasce
rebbe valori senza senso tra diversi dataset.

K I S ACA

Quali immagini vengono “salta­
te” al training, per usarle in se­
guito per la misurazione della 
qualità. Non lo imposti tu stesso; 
il flag --benchmark  lo fa auto­
maticamente (ogni ottava imma­
gine è test). Se imposti indici 
tuoi: pericoloso, può falsare il 
benchmark.
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T40 refinementPruneInterval

D E TAY L A R

Varsayılan: 0 (= disabilitato) Range: 0 oppure 100 
– 5 000 Tanımlandığı yer:

T E K N İ K

Funzione V425: ogni N iterazioni durante la 
fase di refinement (dopo T2 ) viene esegu
ito un pass di prune aggiuntivo, che rimu
ove le gaussiane con sigmoid(opacity) < T41 
refinementPruneOpacityThreshold. Senso: durante 
la densification ci sono regolari chiamate di density 
control, dopo non più — le gaussiane la cui opaci
tà continua a scendere rimangono però nel buffer. 
V425 ha testato e revertito: il pruning aggiunti
vo correlava con V426 (Two-Phase Densification, 
anch’esso interrotto in 0-gaussian cascade failure). 
Disabilitato. Flag CLI disponibile per esperimenti; se 
attivato, 1 000 o 2 000 sono valori sensati.

K I S ACA

Pulizia aggiuntiva durante la fase 
di refinement. Non porta nulla, 
rimane off.

T41 refinementPruneOpacityThreshold

D E TAY L A R

Varsayılan: 0.0 (= “usa T14 ”) Range: 0 oppure 
0.001 – 0.1 Tanımlandığı yer:

T E K N İ K

V425b: soglia di opacità separata per refinement 
prune. Dopo la densification la maggior parte 
delle gaussiane ha raggiunto un’opacità decisa
mente più alta (> 0.001), quindi lo standard T14 
pruneOpacityThreshold sarebbe troppo lasco. Se 
T40  attivo, questo campo determina la propria 

soglia. A 0.0 viene continuato l’uso di T14 . Rilevan
te solo se T40 > 0.

K I S ACA

Soglia per la pulizia aggiuntiva di 
refinement (vedi T40). Entrambi i 
campi non attivi, quindi irrilevan­
ti.
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T42 midTrainingCompactificationIterations

D E TAY L A R

Varsayılan: []  (= disabilitato) Range: [Int] , 
valori in (densifyUntilIteration, maxIterations) 
Tanımlandığı yer:

T E K N İ K

Funzione V549: punti di iterazione espliciti duran
te la fase di refinement, in cui viene eseguito un 
pass di compactification (rimuove sigmoid(opacity) 
< 0.01 + gaussiane di scala outlier, stessa logica di 
T56

postTrainingCompactification). Senso: lunghe fa
si di refinement possono mostrare accumulo di 
confetti/floater, il cui SH poi va in overfitting su 
artefatti specifici della view. Configurazione tipi
ca se attivata: [10000, 20000, 30000] per 40K 
Classic. MA: i test V549 A/B sul dataset Family 
hanno mostrato in tutte le configurazioni un L1 
peggiore: [10K,20K,30K]@0.01  → −48% count ma 
+36% L1; [20K,30K]@0.005  → −44% count ma 
+45% L1; [20K,30K]@0.001  → −17% count ma 
+87% L1. Quindi disabilitato. Flag CLI --mid-compact 
"10000,20000" disponibile, se si preferisce il trade
off floater visivo (meno confetti nel viewport) rispet
to alla regressione di loss.

K I S ACA

Azioni di pulizia intermedie du­
rante il training. Nei test la puli­
zia ha reso il risultato finale peg­
giore (sì meno floater, ma anche 
meno dettaglio). Off, può essere 
accesa via CLI se i floater ti dan­
no più fastidio di un’immagine 
leggermente più pastosa.
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T43 frustumCullEnabled

D E TAY L A R

Varsayılan: false Range: boolean Tanımlandığı 
yer:

T E K N İ K

Funzione V549b: dopo il training vengono rimos
se tutte le gaussiane che si trovano al di fuori 
dell’unione di tutti i frustum delle fotocamere di 
training. Tali gaussiane non sono mai state limitate 
dal segnale di loss e sono sempre floater. Partico
larmente efficace per scene in cui la novel view si 
trova dietro o accanto al percorso della fotocamera 
(ad es. retro di un volo di drone lineare) — i floater lì 
non sono mai visibili nella fase di training, ma sì nel
lo spostamento successivo nel viewer 3D. V549b A/
B su voli di drone risultati positivi, quindi disponibile 
come opt-in. Default false, perché con object cap
ture con piena copertura orbit l’unione dei frustum 
comprende l’intera scena e la funzione non rimuove 
nulla — viene offerta nelle Settings sotto “Floater 
Reduction” e testata anche in Q9 Outdoor preset 
implicitamente tramite T44
frustumCullExpansion (Q7-BayesOpt però non l’ha 
attivata, perché Outdoor Sky Dome risolve meglio lo 
stesso problema).

K I S ACA

Filtro speciale per voli di drone 
o riprese lineari: dopo il training 
vengono eliminati gli splat che 
non sono stati “visti” in nessuna 
fotocamera. Opzionalmente atti­
vabile nelle Settings. Per sempli­
ci riprese di oggetto inutile.

T44 frustumCullExpansion

D E TAY L A R

Varsayılan: 1.1 Range: 1.0 – 2.0 Tanımlandığı yer:

T E K N İ K

Margine NDC per T43 frustumCullEnabled. 1.0 
taglierebbe esattamente al bordo dell’immagine, il 
che taglierebbe troppo splat traballanti al bordo 
dell’immagine. 1.1 = 10% di padding oltre l’esatto 
framing della fotocamera — dà un po’ di tolleranza 
per pixel di bordo che in una novel view leggermen
te spostata potrebbero diventare visibili. Valori > 
1.2 rendono il cull praticamente inefficace, perché il 
frustum espanso comprende molto più spazio.

K I S ACA

Quanto rigorosamente il filtro 
descritto sopra taglia. 1.1 = un po’ 
di distanza di sicurezza dal bordo 
dell’immagine. Lascia il valore.
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Sky-Dome (T45–T48)

T45 skyDomeEnabled

D E TAY L A R

Varsayılan: false (inizializzatore + tutti i preset ec
cetto P9 Outdoor) Range: boolean Tanımlandığı 
yer:

T E K N İ K

Funzione V549e: prima dell’avvio del training vi
ene generata una nuvola di punti sferica (sfera 
di Fibonacci con T46  sample point), posizionata 
in un raggio di T47 skyDomeRadiusMultiplier × 
scene_​extent attorno al centro della scena e ini
zializzata con i colori dei pixel mascherati come 
cielo di tutte le fotocamere di training (vedi T20 
skyMaskingEnabled). Queste gaussiane sky dome 
vengono inserite all’inizio del buffer gaussiano e 
“congelate” durante il training (gradienti posizione/
scala/rotazione = 0, solo SH e opacità rimangono 
ottimizzabili). Effetto: invece di aree “confetti” nere 
in lontananza, l’utente vede in novel view un cielo 
reale. MVP V549e funziona molto bene su scene di 
drone e paesaggio; in P9 Outdoor preset default on. 
Con scene interne lasciare off — la sfera pendereb
be inutile fuori dalla stanza.

K I S ACA

Accende una “cupola del cielo” 
artificiale attorno alla scena. 
Rende le riprese esterne molto 
più belle: invece di grumi neri al 
bordo dell’immagine, l’app most­
ra il cielo reale. Obbligatorio per 
voli di drone e paesaggi, inutile 
per interni.
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T46 skyDomeSampleCount

D E TAY L A R

Varsayılan: 5 000 Range: 1 000 – 50 000 (tipico 2 
000 – 10 000) Tanımlandığı yer:

T E K N İ K

Numero di sample point della sfera di Fibonacci 
sulla sfera sky dome. Valori più alti → sky dome 
più denso (migliore con grandi risoluzioni e molto 
cielo visibile), ma più fabbisogno di memoria. 5 000 
è sweet spot per rendering 4K; con risoluzioni più 
basse 2 000–3 000 basta. I punti vengono inizializ
zati per cosine distance a ogni vettore di vista delle 
fotocamere di training con i corrispondenti pixel 
mascherati come cielo — i sample point il cui view 
cone non vede alcuna fotocamera rimangono indiet
ro con un basso valore iniziale di opacità, ma non 
vengono modificati durante il training (congelati).

K I S ACA

Quanto denso è il cielo artifici­
ale. 5 000 punti bastano normal­
mente. Di più = transizione migli­
ore in lontananza, ma costa un 
po’ di memoria.

T47 skyDomeRadiusMultiplier

D E TAY L A R

Varsayılan: 30.0 (inizializzatore + la maggior parte 
dei preset), 59.0 (P9 Outdoor, ottimo Q7-BayesOpt) 
Range: 5.0 – 200.0 Tanımlandığı yer:

T E K N İ K

Raggio della sfera sky dome relativo all’estensione 
della scena (= distanza media tra posizioni delle fo
tocamere). 30 = la sfera ha 30 volte il diametro della 
nuvola della fotocamera. Troppo piccolo (< 5) → lo 
sky dome interferisce con la scena stessa (ad es. 
uno splat sky dome finisce in primo piano); troppo 
grande (> 100) → perdita di precisione float32 sulle 
posizioni sky dome, il che provoca glitch di rende
ring in lontananza. Q7-BayesOpt su Bicycle (Mip-
NeRF 360) ha trovato 59.0 come ottimo specifico 
per scena outdoor — ciò indica che lo standard 30.0 
è troppo piccolo per paesaggi profondi e i pixel sky 
dome nelle aree di bordo immagine renderizzano vi
sibilmente come “parete”.

K I S ACA

Quanto lontana deve essere la 
cupola del cielo artificiale. 30 = 
abbastanza lontano. Con grandi 
paesaggi 50–60 è meglio (Outdo­
or preset lo fa automaticamen­
te). Troppo piccolo sarebbe come 
avere grumi direttamente davan­
ti all’obiettivo.
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T48 frozenGaussianCount

D E TAY L A R

Varsayılan: 0 (= nessuna gaussiana congelata) 
Range: 0 oppure 1 – T46  Tanımlandığı yer:

T E K N İ K

Numero di gaussiane all’inizio del buffer i cui gradi
enti posizione/scala/rotazione vengono impostati a 
zero nell’optimizer — rimangono spazialmente rigi
de su tutto il training. Il density control non può 
clonarle, splittarle o prunarle. Usato per l’iniezione 
sky dome (vedi T45 ): se sky dome è on, qu
esto campo viene impostato automaticamente su 
T46 skyDomeSampleCount. L’impostazione manuale è 
possibile (ad es. per congelare una nuvola di punti 
pre-posizionata da una scansione LiDAR), ma non 
direttamente accessibile nell’UI. Importante: le pri
me N gaussiane nel buffer sono sempre le frozen — 
l’ordine nel buffer decide, non un indice esplicito.

K I S ACA

Quanti splat all’inizio sono fissi 
e non possono muoversi. Viene 
impostato automaticamente sul 
numero sky dome, se sky dome è 
on. Non hai bisogno di regolarlo 
da solo.

Adam + LR programı (T49–T55)

T49 adamResetIteration

D E TAY L A R

Varsayılan: 0 (= disabilitato) Range: 0 oppure 100 
– Tanımlandığı yer:

T E K N İ K

Funzione V430: iterazione a cui gli accumulatori 
di momentum Adam (m1, m2) vengono resettati a 
zero. La correzione del bias successivamente gira 
con (iter - adamResetIteration) invece di iter . 
V430 ha testato reset a 5 000 (dopo fine densifi
cation) → 12.8% di loss peggiore. Motivo: il momen
tum Adam che si è costruito durante la densification 
porta informazioni sulle magnitudini tipiche di gradi
ente e accelera la fase di refinement. Gettarlo via 
costa le prime ~500 iterazioni di refinement in con
vergenza. Disabilitato. Rimane flag CLI per esperi
menti di ricerca.

K I S ACA

Pulsante reset per la “memoria” 
interna dell’ottimizzatore Adam. 
Nei test ha danneggiato, rimane 
off.
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T50 positionLRScheduleEndIteration

D E TAY L A R

Varsayılan: 0 (inizializzatore = “usa maxIterations”), 
20 000 ( .full  — cosine termina a 20K nonos
tante maxIter=35K), 30 000 ( .fullClassicPaper ) 
Range: 0 oppure 1 000 – Tanımlandığı yer:

T E K N İ K

Funzione V431: iterazione a cui la curva di cosine 
annealing per la LR di posizione raggiunge il suo 
minimo. Se 0, è identico a T1 maxIterations . Se 
> 0, lo schedule corre fino a questo valore e dopo 
rimane a T4
positionLearningRateFinal costante. Ciò permette 
una “extended refinement phase” con LR minima 
ma costante — raffina lentamente le posizioni senza 
nuovo decay. .full  lo fa (schedule end a 20K, il 
training corre fino a 35K), V434c/V434d hanno con
fermato: 15K e 25K entrambi più o meno uguali, 20K 
minimamente ottimale. Continua ad essere usato in 
combinazione con T51 , per modificare nella exten
ded phase anche le LR non di posizione.

K I S ACA

Quando l’app smette di abbassa­
re ulteriormente la LR di posizi­
one. Se più basso dell’iterazione 
massima, gira dopo con mini ra­
te costante — ciò raffina molto 
lentamente ma molto stabile. In­
tegrato in Quality preset, non hai 
bisogno di regolarlo.

T51 extendedPhaseLRDecay

D E TAY L A R

Varsayılan: 0.0 (= disabilitato, LR costanti) Range: 
0 oppure 0.01 – 1.0 Tanımlandığı yer:

T E K N İ K

Funzione V433: moltiplicatore minimo per le LR non 
di posizione (scala, rotazione, opacità, SH) nella 
“extended phase” — cioè dopo che T50  è raggiun
to e la LR di posizione è già a T4 . Se 0.1, scala/
rotazione/opacità/SH vengono a loro volta cosine-
decayed da 1.0 (= la loro LR standard) a 0.1× del 
loro standard. Se 0.0 (default), rimangono costanti. 
V457 ha testato decay completo (0.0 = decay-
fino-a-zero) contro nessun decay e ha trovato: avg 
0.0400 (2 run) = stesso loss di V438 senza decay. 
Comportamento più pulito con decay, ma non misu
rabilmente migliore. Quindi disabilitato. Rimane nel 
CLI come --nonpos-lr-scale F.

K I S ACA

Nella fase tardiva di refinement 
anche le learning rate di colore 
e forma più piccole. Rende il tra­
ining più “stabile”, ma empirica­
mente non migliore. Off.
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T52 adaptiveDensifyThreshold

D E TAY L A R

Varsayılan: false Range: boolean Tanımlandığı 
yer:

T E K N İ K

Sperimentale V440: se true, l’app calcola in ogni 
step di densification il p98 dell’attuale distribuzione 
del gradiente e lo usa come soglia dinamica (limitata 
ad almeno 0.5× del valore configurato da T11 , in 
modo che non sbordi troppo). Ipotesi: l’adattamento 
automatico alla fase di scena attuale renderebbe 
il density control più robusto — ad es. all’inizio pru
ning più severo, dopo più lasco, o viceversa. V440 
ha testato e revertito: drop catastrofico a 63 K 
gaussiane (mass pruning, perché il p98 nelle prime 
iterazioni è estremamente alto e poi quasi nulla su
pera la soglia). La soglia fissa è già ben calibrata, 
l’adattamento dinamico danneggia più di quanto gi
ovi. Q5 (T77) offre una logica adattiva alternativa via 
rolling median che aggira il problema.

K I S ACA

Versione adattiva della soglia 
di densify. Nei test catastrofica 
(numero di splat crollato a 63K). 
Off. Q5 ne ha una variante migli­
ore.

T53 mergeAfterDensification

D E TAY L A R

Varsayılan: false (inizializzatore), true ( .full , 
.classicBalanced , .fullClassicPaper ) Range: 

boolean Tanımlandığı yer:

T E K N İ K

Funzione V438: alla fine della fase di densification 
(iter T2 ) viene eseguito un pass di merge una 
tantum, che unisce gaussiane vicine tra loro con 
scala e colore simili. Riduce il numero di gaussiane 
tipicamente del 5–15% senza perdita di qualità vi
sibile. Senso: dopo un intenso clonaggio nascono 
cluster di gaussiane quasi identiche, che non contri
buiscono nulla di nuovo — il merging libera capacità 
optimizer per altre aree. Standard nei preset Classic 
Quality. Con MCMC non usato, perché MCMC trami
te la sua logica di rilocazione non lascia nemmeno 
nascere tali cluster.

K I S ACA

Alla fine della fase di moltiplica­
zione degli splat unire i cloni che 
sono quasi identici. Riduce la qu­
antità di dati senza effetto visibi­
le. Standardmente on nel preset 
Quality.
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T54 densifyPhase2FromIteration

D E TAY L A R

Varsayılan: 0 (= disabilitato) Range: 0 oppure T2  
– T1  Tanımlandığı yer:

T E K N İ K

Sperimentale V426: abilita una seconda fase di den
sification che inizia dopo la pausa di refinement 
a questa iterazione e corre fino a T55 . Ipotesi: 
dopo una fase di refinement gli accumulatori di gra
diente hanno magnitudini più stabili e possono dire 
più precisamente quali aree hanno bisogno di gaus
siane aggiuntive. V426 ha testato e revertito: densi
fication a due fasi è caduta in 0-gaussian-cascade-
failure (combinata con V425 refinement pruning ha 
distrutto il buffer). Disabilitata. Flag CLI disponibile 
per esperimenti.

K I S ACA

Seconda fase di moltiplicazione 
dopo pausa. Nei test ha distrutto 
la popolazione di splat. Off.

T55 densifyPhase2UntilIteration

D E TAY L A R

Varsayılan: 0 Range: 0 oppure T54  – T1  Defined 
in:

T E K N İ K

Fine della Two-Phase Densification V426. Rilevante 
solo se T54 > 0 . Entrambi i campi insieme disabili
tati.

K I S ACA

Fine della seconda fase di mol­
tiplicazione (vedi T54). Entrambi 
off.
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Son işleme + Apple AI (T56–T60)

T56 postTrainingCompactification

D E TAY L A R

Varsayılan: true (in tutti i preset di produzione), 
false ( .quickTest , .preview ) Range: boolean Ta­
nımlandığı yer:

T E K N İ K

Funzione V443: dopo la fine del training le gaussi
ane con sigmoid(opacity) < 0.01 vengono rimosse 
duramente (non contribuiscono praticamente più 
all’immagine). Riduce il gaussian count tipicamente 
del 58% e la dimensione del file di export del 55% 
senza perdita di qualità visibile. Attiva di default nei 
preset di produzione — il risultato finale dovrebbe 
poter essere consegnato il più compatto possibile. 
In .quickTest  off, perché un run diagnostico non 
viene comunque esportato. A differenza di T42
midTrainingCompactificationIterations (V549) la 
compactification avviene solo alla fine — il refine
ment può usare fino ad allora tutte le gaussiane.

K I S ACA

Pulizia dopo il training: gli splat 
quasi invisibili vengono rimossi. 
Rende il file di export circa la 
metà più piccolo senza perdita 
di qualità. Funzione obbligatoria, 
off solo nei run diagnostici.

T57 metalFXUpscaling

D E TAY L A R

Varsayılan: false Range: boolean Tanımlandığı 
yer:

T E K N İ K

Funzione V444: attiva l’upscaler spaziale MetalFX di 
Apple invece dell’interpolazione bilineare nell’output 
del viewer 3D. Se la risoluzione di training < dimen
sione viewport (ad es. training a 0.5×, visualizza
zione viewport in piena risoluzione), MetalFX può 
fornire un’immagine decisamente più nitida. Cam
bia live nel viewport, nessun re-training necessario. 
Si esclude con T58 mpsLanczosScaling — MetalFX 
ha la precedenza. Raccomandazione: accendere se 
l’immagine nel viewer appare “sbiadita” rispetto al 
dettaglio atteso.

K I S ACA

Affinamento dell’immagine ba­
sato su ML Apple nel viewer 3D. 
Aiuta se hai addestrato a una ri­
soluzione più bassa e mostri il ri­
sultato a schermo intero. Toggle 
dal vivo, prova.
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T58 mpsLanczosScaling

D E TAY L A R

Varsayılan: false Range: boolean Tanımlandığı 
yer:

T E K N İ K

Funzione V444: MPSImageLanczosScale per lo sca
ling viewport invece dell’interpolazione bilineare. 
Lanczos è un metodo di ricampionamento classico 
basato su sinc che fornisce risultati decisamente più 
nitidi del bilineare con overhead minimo. Toggle dal 
vivo. Viene sovrascritto da T57  se entrambi attivi.

K I S ACA

Metodo di affinamento classi­
co per il viewer 3D (Lanczos). 
MetalFX (T57) è basato su ML 
e di solito migliore; Lanczos è 
un’alternativa meno aggressiva.

T59 livePreviewInterval

D E TAY L A R

Varsayılan: 50 (inizializzatore e la maggior parte 
dei preset) Range: 0 (off) oppure 10 – 5 000 Ta­
nımlandığı yer:

T E K N İ K

Quanto spesso durante il training il viewer 3D viene 
aggiornato con le gaussiane attuali. 50 = ogni 50 
iterazioni un nuovo render nel viewer — abbastan
za per osservare il progresso senza rallentare il 
training. 0 = il viewer non viene aggiornato affatto 
(training in background, max velocità). Adattamento 
tipico: con .quickTest  giù a 10 (si vuole vedere 
ogni step), con lunghi run MCMC su a 500–2000 
(overhead di update in totale percettibile).

K I S ACA

Con quale frequenza l’anteprima 
3D viene aggiornata durante il 
training. 50 = ogni 50 iterazioni. 
Più alto = meno spesso = un po’ 
più veloce, ma vedi meno spesso 
il progresso. 0 = nessuna antep­
rima (per la massima velocità).
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T60 perceptualLossWeight

D E TAY L A R

Varsayılan: 0.0 (= disabilitato) Range: 0 oppure 
0.001 – 0.5 Tanımlandığı yer:

T E K N İ K

Funzione futura V444: peso di un termine di loss 
percettivo via MPSGraph (piccola rete simil-VGG). 
Catturerebbe similarità strutturale e di texture a 
un livello semantico superiore a L1+SSIM — tipico 
in pipeline di ricerca, dove “pixel-perfect” è meno 
importante di “sembra realistico”. Implementazione 
ancora in attesa (stub di codice presente, ma for
ward pass non implementato). Default 0.0. Rimane 
nel catalogo dei campi per attivazione futura; flag 
CLI --percep-weight F  riservato.

K I S ACA

Funzione pianificata che con ai­
uto AI mira ad “aspetto natura­
le” invece di “preciso al pixel”. 
Non ancora completamente imp­
lementata.

MCMC Densification (T61–T73)

T61 densificationStrategy

D E TAY L A R

Varsayılan: .classic  (inizializzatore + preset 
Classic), .mcmc  (tutti i preset MCMC + Scene-
Class) Range: .classic  o .mcmc  Tanımlandığı 
yer:

T E K N İ K

Sceglie tra densification classica (clone/split/prune, 
Kerbl et al. 2023) e densification MCMC (Stochas
tic Gradient Langevin Dynamics con rilocazione, 
Kheradmand et al. NeurIPS 2024). Con .classic  
vengono valutati T11–T16 , con .mcmc  i T62–T73 . 
Attenzione al cambio: i default Classic e i default 
MCMC sono calibrati in modo completamente diver
so — chi flippa il picker nella vista esperto senza 
caricare un preset appropriato, rischia mass extinc
tion in stile 1.4.3 bug (460 K → 5 in un’iterazione, 
perché MCMC OpacityReg a 0.01 uccide le opacità 
Classic). Quindi i default init MCMC deliberatamente 
“addolciti” (tutti i valori reg 0.0).

K I S ACA

Quale algoritmo viene usato per 
moltiplicare gli splat. Classic = 
metodo originale (veloce, molti 
splat). MCMC = metodo più nuovo 
(più lento, molti meno splat, in 
compenso più compatto). I pre­
set scelgono quello giusto. Cam­
bialo da solo solo se carichi anc­
he il preset corrispondente (P5–
P7 o P8–P10).
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T62 mcmcMaxGaussians

D E TAY L A R

Varsayılan: 150 000 (inizializzatore + .fullMCMC  
+ .mcmcBalanced ), 100 000 ( .mcmcPreview ), 1 
500 000 ( .fullMCMCMip  — variante Mip-Splatting 
con budget 10×), 1.19 M ( .renderPreset ), 1.25 M 
( .outdoorPreset ), 670 K ( .indoorPreset ) Ran­
ge: 0 (= “usa capacità buffer”) oppure 10 000 – 5 
000 000 Defined in:

T E K N İ K

Limite superiore rigido per il numero di gaussiane 
con strategia MCMC. Il numero cresce gradualmen

te di 
T70

mcmcGrowthRate  (tipico 5%) per step di riloca
zione fino a questo cap. V473/V531 hanno trovato 
150 K come sweet spot — oltre 200 K si dilata la 
qualità degli splat (troppe gaussiane piccole, ridon
danti), sotto 100 K la scena rimane sotto-densifica
ta. Con scene molto grandi (ad es. volo di drone da 
1 545 foto con 158 K SfM-init) 150 K è troppo basso 
— da qui l’estensione 1.4.5 T72 mcmcCapMultiplier 
+ T73
mcmcAutoScaleByScene. Q7-BayesOpt ha trovato ot
timi specifici per scena tra 670 K (Indoor) e 1.25 M 
(Outdoor). Con valore 0 il motore usa la piena capa
cità buffer come cap.

K I S ACA

Numero massimo di splat con 
MCMC. 150 000 è lo standard e 
basta per la maggior parte delle 
scene. Outdoor e Render preset 
(P8, P9) salgono a 1+ milione 
per scene più ricche di dettagli. 
Aumentare può portare dettaglio, 
costa memoria; abbassare è pi­
uttosto un freno di emergenza.
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T63 mcmcNoiseScale

D E TAY L A R

Varsayılan: 0.00005 (5e-5 = default paper) Range: 
1e-6 – 1e-3 Tanımlandığı yer:

T E K N İ K

Moltiplicatore per il rumore gaussiano che in ogni 
iterazione MCMC viene aggiunto alla posizione di 
ogni gaussiana (logica SGLD). Più alto = più esplo
razione (le gaussiane vagano di più, trovano poten
zialmente posti migliori), più basso = più exploitati
on (le gaussiane rimangono dove sono già buone). 
V467 e V536 hanno confermato 5e-5 come ottimale 
— 1e-5/2e-5 troppo poco esplorazione, 1e-4 troppo 
(gli splat si dissipano). Viene cosine-decayed sul 
tempo di training fino a T69 mcmcNoiseDecayEnd — 
alla fine della zona di decay il rumore è effettiva
mente 0 e le gaussiane convergono.

K I S ACA

Quanto “tremolio” casuale l’app 
permette agli splat, in modo che 
trovino da soli il posto migliore. 
Il valore standard è ottimalmente 
testato. Se lo aumenti, gli splat 
diventano irrequieti.

T64 mcmcOpacityRegWeight

D E TAY L A R

Varsayılan: 0.0 (= disabilitato nei default Radiance
Kit, paper: 0.01) Range: 0 oppure 0.001 – 0.05 
Tanımlandığı yer:

T E K N İ K

Penalità L1 specifica MCMC sull’opacità. Default 
paper 0.01 (spinge le gaussiane non usate verso 
zero, le rende disponibili per rilocazione). V464b ha 
mostrato però: senza reg in RadianceKit è misura
bilmente migliore (sessione 28 conferma). Motivo: il 
criterio di pruning definito con T68
mcmcDeadOpacityThreshold basta da solo — una 
penalità L1 aggiuntiva costringe a morire anche 
gaussiane preziose a bassa opacità. Quindi defa
ult 0. Attenzione: nella build 1.4.3 beta il default 
dell’inizializzatore era erroneamente 0.01, il che è 
risultato nel mass extinction bug (vedi spiegazione 
T61); dalla 1.4.4 fissato a 0.0.

K I S ACA

Regolarizzazione speciale MCMC. 
Off, perché l’altro meccanismo 
MCMC (soglia in T68) lo copre 
già. Lascia a 0.
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T65 mcmcScaleRegWeight

D E TAY L A R

Varsayılan: 0.0 (= disabilitato, paper: 0.01) Range: 
0 oppure 0.001 – 0.05 Tanımlandığı yer:

T E K N İ K

Penalità L1 specifica MCMC sugli autovalori di scala. 
Default paper 0.01. V464b: senza reg migliore, stes
so ragionamento di T64. Disabilitato in tutti i preset 
MCMC di RadianceKit. Attenzione come per T64: 
bug 1.4.3.

K I S ACA

Come T64, ma per dimensione 
splat. Off.

T66 mcmcRelocationInterval

D E TAY L A R

Varsayılan: 100 (inizializzatore + tutti i preset 
MCMC, standard paper), 155 (P9 Outdoor — ottimo 
Q7-BayesOpt) Range: 50 – 500 Tanımlandığı yer:

T E K N İ K

Intervallo di iterazione in cui MCMC riloca 
le gaussiane morte (sigmoid(opacity) < T68 
mcmcDeadOpacityThreshold) in nuove posizioni. 
V537 ha testato 50 (troppo dirompente, loss oscilla) 
e 200 (marginalmente peggio, MCMC perde reattivi
tà). 100 è ottimale. Q7-BayesOpt su Bicycle ha tro
vato 155 come ottimo specifico per scena outdoor 
— gli intervalli un po’ più lunghi danno ad Adam più 
tempo per integrare le gaussiane nuove posizionate, 
prima che il prossimo evento di reloc le metta sotto 
pressione.

K I S ACA

Ogni quante iterazioni MCMC 
sposta gli splat morti da qualche 
altra parte. 100 è standard. Non 
hai bisogno di regolarlo da solo 
— Outdoor preset ha già il valore 
ottimale.
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T67 mcmcWarmupIterations

D E TAY L A R

Varsayılan: 500 Range: 100 – 5 000 Tanımlandığı 
yer:

T E K N İ K

Numero di iterazioni iniziali in cui non avviene anco
ra rilocazione MCMC. Solo dopo questo warmup 
inizia la logica di reloc. Senso: nelle prime iterazi
oni i valori di opacità non sono ancora stabilizzati 
— se si iniziasse subito con reloc, le gaussiane ver
rebbero posizionate in punti sbagliati e dovrebbero 
essere subito spostate, il che distrugge il momen
tum Adam. Default paper 500. RadianceKit assume 
questo valore, perché V464b ha mostrato che è ro
busto.

K I S ACA

Quante iterazioni MCMC ha pri­
ma di “arrivare”, prima di iniziare 
a riposizionare gli splat. 500 è 
standard e va bene.

T68 mcmcDeadOpacityThreshold

D E TAY L A R

Varsayılan: 0.005 (inizializzatore, standard paper), 
0.01 ( .fullMCMC  e tutti i preset MCMC — ottimo 
V535) Range: 0.001 – 0.05 Tanımlandığı yer:

T E K N İ K

Soglia sigmoid(opacity) sotto la quale una gaus
siana è considerata “morta” ed entra in considera
zione per rilocazione. V535 ha trovato 0.01 come 
ottimale (0.005 marginale, 0.02 peggiore). Più alto = 
reloc più aggressivo (più gaussiane vengono spos
tate), più basso = più cauto. 0.01 corrisponde a 
circa “0.5% di visibilità visiva”. P10 Indoor usa via 
Q7-BayesOpt 0.0142 come ottimo.

K I S ACA

A partire da quale trasparenza 
uno splat è considerato “morto”, 
così che MCMC lo sposti altrove. 
0.01 è ottimale nei nostri test. 
Non hai bisogno di regolarlo da 
solo.
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T69 mcmcNoiseDecayEnd

D E TAY L A R

Varsayılan: 0 (inizializzatore = “nessun decay”), 
160 000 ( .fullMCMC  = 80% di 200K), 96 
000 ( .mcmcBalanced  = 80% di 120K), 40 000 
( .mcmcPreview ) Range: 0 oppure 1 000 – Tanım­
landığı yer:

T E K N İ K

Iterazione a cui il rumore T63 mcmcNoiseScale  vi
ene smorzato completamente a zero (cosine decay 
da iter 0 a qui). V497c/V502 hanno trovato 80% del 
maxIterations ottimale — dà a MCMC abbastanza 
tempo di esplorazione, ma lascia l’ultimo 20% alla 
convergenza senza rumore. 0 = rumore costante su 
tutte le iterazioni (raramente sensato, MCMC non 
può poi convergere).

K I S ACA

Quando il “tremolio” casuale 
degli splat termina. Nei preset 
MCMC all’80% delle iterazioni to­
tali — prima esplorazione, poi 
convergenza. Lascia il valore.

T70 mcmcGrowthRate

D E TAY L A R

Varsayılan: 0.05 (standard paper = 5%) Range: 
0.01 – 0.2 Tanımlandığı yer:

T E K N İ K

Tasso di crescita del target di popolazione MCMC 
per step di rilocazione. La logica: ad ogni evento 
reloc la dimensione target di popolazione viene 
aumentata di (1 + growthRate) , fino a quando 
T62 mcmcMaxGaussians (o la variante scalata via T72/​
T73) viene raggiunta. V512/V522 hanno trovato 0.05 
come ottimale — valori più alti portano a crescita 
troppo veloce (le gaussiane vengono inserite prima 
che l’Adam momentum possa integrarle), più bassi a 
scene sotto-densificate alla fine.

K I S ACA

Quanto velocemente cresce il 
numero di splat con MCMC. 5% 
per step è ottimale. Lascia il va­
lore.
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T71 mcmcSigmoidK

D E TAY L A R

Varsayılan: 100.0 Range: 10.0 – 500.0 Defined in:

T E K N İ K

Parametro di sharpness sigmoid per l’attenuazione 
del rumore MCMC. Nello step SGLD il rumore per 
gaussiana viene smorzato attraverso — gaussiane 
ad alta opacità (il cui logit è positivo) ricevono 
esponenzialmente meno rumore di quelle a bassa 
opacità. K = 100 è nitido, cioè la transizione da “pi
eno-rumore” a “nessun-rumore” avviene molto ve
locemente attorno a opacità 0.5. V484–V487 hanno 
trovato K = 100 ottimale — valori più piccoli (10–
50) lasciano tremare anche gaussiane ad alta opaci
tà (distrugge gaussiane convergenti), più grandi (> 
500) rendono la transizione artificialmente dura e le 
gaussiane morte non vengono più spostate.

K I S ACA

Parametro speciale che deter­
mina quanto nettamente MCMC 
distingue tra “abbastanza tras­
parente per spostare” e “solido, 
non toccare”. Il valore standard è 
ottimale. Non regolare.

T72 mcmcCapMultiplier

D E TAY L A R

Varsayılan: 3.0 (inizializzatore + .fullMCMC ), 2.0 
( .mcmcPreview ), 2.5 ( .mcmcBalanced ), 2.98 (P8 
Render), 5.32 (P9 Outdoor), 1.76 (P10 Indoor) Ran­
ge: 0 (= disabilitato) oppure 1.0 – 10.0 Tanımlandığı 
yer:

T E K N İ K

Funzione 1.4.5: scaling cap adattivo alla scena. Se 
T73 mcmcAutoScaleByScene è true, il cap effettivo 
viene calcolato come (limitato a capacità buffer). 
Sfondo: con scene grandi (ad es. volo di drone da 1 
545 foto → 158 K SfM-init) T62 = 150 000  è trop
po basso — il density control non potrebbe affatto 
crescere. Con multiplier 3.0 il cap in questo esempio 
viene scalato a 474 K (158 K × 3.0). Q7-BayesOpt 
ha trovato ottimi specifici per scena: Outdoor bene
ficia di multiplier alto (5.32 → ~830 K cap con 156 
K bicycle init), Indoor si accontenta di 1.76 (le pare
ti saturano più velocemente). Risoluzione completa 
del cap vedi metodo.

K I S ACA

Moltiplicatore che adatta auto­
maticamente il cap di splat alla 
dimensione della scena. Scena 
grande = più punti iniziali = cap 
più alto. Standard 3× va bene 
per la maggior parte delle scene; 
Outdoor preset sale a 5× (gran­
di range di profondità), Indoor a 
1.76× (le pareti limitano comun­
que).
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T73 mcmcAutoScaleByScene

D E TAY L A R

Varsayılan: true (inizializzatore + tutti i preset 
MCMC) Range: boolean Tanımlandığı yer:

T E K N İ K

Funzione 1.4.5: master switch per la logica cap sce
ne-aware (vedi T72 +). Se false, viene usato esclu
sivamente T62 mcmcMaxGaussians come cap (ritorno 
al comportamento 1.4.4). Standardmente on, perché 
altrimenti i problemi di mass extinction con scene 
grandi della 1.4.3 ritornano. Disattivare manualmen
te solo se vuoi esplicitamente impostare un cap 
rigido — ad es. per addestrare una variante 150 K la 
cui dimensione finale è pianificabile.

K I S ACA

Accende l’adattamento automa­
tico del cap splat alla dimensione 
della scena. Standardmente on. 
Lascia off solo se vuoi tu stesso 
esattamente un determinato nu­
mero di splat.

Mip-Splatting (Q1.5) (T74–T76)

Stato: Q1.5 il 2026-05-25 dopo 14 iterazioni autonome + overnight 1.5M confiden
ce check è stato scartato come “closed no-win” (max Δ@2× = +0.27 dB, il gate 
originale richiedeva ≥ +1.5 dB di media su 0.5×/2×, FALLISCE su 0/11 pair scenes). 
I campi rimangono opt-in per esperimenti di ricerca; tutti i preset di produzione 
hanno. Vedi verdetto: docs/​plans/​2026-05-25-phase-q1.5-final-verdict.md.
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T74 useMipSplatting

D E TAY L A R

Varsayılan: false (tutti i preset di produzione), true 
( .fullMCMCMip  — sibling di ricerca) Range: boole
an Tanımlandığı yer:

T E K N İ K

Attiva Mip-Splatting (Yu et al. CVPR 2024): filtro di 
smoothing 3D + filtro 2D + compensazione α, che 
limita la frequenza per gaussiana al limite di Nyquist 
della densità di campionamento più alta della foto
camera di training. Obiettivo teorico: eliminazione 
dell’aliasing al rendering in scale fuori training (0.5× 
o 2× della risoluzione di training). Attivato negli 
shader di preprocess e backward projection, funzi
onalmente verificato corretto nel test Q1.5-D. Ma: il 
gate di accettazione originale (Δ@1× ≥ +0.3 dB E 
avg(Δ@0.5×, Δ@2×) ≥ +1.5 dB) non è stato raggiun
to su nessuna delle 11 pair scenes. Massimo osser
vato: family 750K classic Δ@2× = +0.270 dB. Le 
scene outdoor (Truck, Flowers) hanno mostrato ad
dirittura peggioramento 1× e 0.5×. Ipotesi: lo smoot
hing 3D compete con la rilocazione MCMC con 
high-Gs. Il campo rimane per future re-eval multi-
scala con metodologia Mip-NeRF-360 corretta (vedi 
O3-backlog nel benchmark path).

K I S ACA

Filtro antialiasing da un paper 
del 2024. Teoricamente fantasti­
co, praticamente nei nostri test 
non ha portato nulla e talvolta 
addirittura danneggiato. Rimane 
disponibile per sperimentatori, 
ma non lo raccomandiamo. Las­
cia off.

T75 mipSmoothing3DScale

D E TAY L A R

Varsayılan: 0.2 (default paper) Range: 0.05 – 1.0 
Tanımlandığı yer:

T E K N İ K

Parametro di scala di smoothing 3D (Yu et al. §3.3, 
default paper 0.2). Più grande = più smoothing 
spazio mondo per gaussiana (= più antialiasing, ma 
anche più blur nella scala di default), più piccolo = 
più nitido ma più suscettibile all’aliasing. Viene con
sultato solo se T74 useMipSplatting =
true. Nei test Q1.5 non ulteriormente ottimizzato — 
il gate A/B ha già perso con default paper 0.2, ulte
riori sweep sarebbero inutili.

K I S ACA

Parametro Mip-Splatting. Se non 
hai acceso Mip, irrilevante.
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T76 mipFilter2DVariance

D E TAY L A R

Varsayılan: 0.3 (= esattamente il comportamento 
legacy V242) Range: 0.1 – 1.0 Tanımlandığı yer:

T E K N İ K

Varianza filtro 2D Mip che viene aggiunta alla diago
nale Σ_2D (varianza direttamente, non al quadrato). 
0.3 è esattamente il valore legacy V242, che prima 
di Mip-Splatting era hardcoded nel kernel. Se T74 
useMipSplatting = false, il kernel ignora comple
tamente questo valore e scrive lo hard-coded 0.3 — 
in modo che la baseline non possa regredire (garan
zia Codex-Round-1-S3-1). Se, viene usato il valore 
qui impostato. Rimane nel catalogo dei campi per 
sweep Mip.

K I S ACA

Altro parametro Mip-Splatting. 
Con Mip off: irrilevante.

Uyarlanabilir Densification (Q5) (T77–T79)

T77 adaptiveDensification

D E TAY L A R

Varsayılan: false Range: boolean Tanımlandığı 
yer:

T E K N İ K

Funzione Q5: rolling median tracker come al
ternativa al fisso T11 densifyGradThreshold. Se 
true, in ogni step di densify la soglia attuale 
viene sovrascritta con median(ultimi N avgGrad 
samples) × T79 adaptiveDensifyMultiplier. N = 
T78 adaptiveWindow . Più rigoroso di V440 p98 (la 

trappola catastrofica di 63 K pruning), median + 
2× si trova circa al p70–p80 della distribuzione 
del gradiente in steady state. Test Q5: da solo 
FAIL 0/3 scene, ma insieme a Q6 (vedi T80/T81) 
PASS 1/3 scene — il bundle Q5+Q6 è stato passato 
come opt-in il 2026-05-25 ed è attivabile via CLI 
--adaptive-densify . Q6 è così il “portatore” del 

guadagno di qualità, Q5 contribuisce piuttosto alla 
stabilità.

K I S ACA

Soglia di densify auto-appren­
dente. Invece di una sensibilità 
impostata fissa, l’app si adatta 
alla scena. Da sola testata non 
migliore, ma insieme al curricu­
lum Q6 sì. Accendere entrambi 
insieme o entrambi off.
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T78 adaptiveWindow

D E TAY L A R

Varsayılan: 1 000 Range: 100 – 10 000 Defined in:

T E K N İ K

Rolling median window in eventi di densification 
(NON iterazioni — ogni step T13 densifyInterval 
fornisce un sample). Default 1 000 — con significa 
che le ultime 100 000 iterazioni di training contribu
iscono al median, quindi tipicamente l’intera storia 
del training fino a qui. Fase iniziale (prima dei samp
le T78 ): il tracker restituisce nil → fallback alla 
soglia fissa T11 . Rilevante solo se.

K I S ACA

Quanti vecchi step di densify 
confluiscono nel median per T77. 
Standard 1000 va bene. Rilevante 
solo se Q5 Adaptive è on.

T79 adaptiveDensifyMultiplier

D E TAY L A R

Varsayılan: 2.0 Range: 1.0 – 4.0 Tanımlandığı yer:

T E K N İ K

Moltiplicatore sul rolling median per la soglia adatti
va. Default 2.0 corrisponde approssimativamente a 
p70–p80 della distribuzione tipica del gradiente. Più 
basso = crescita più aggressiva (più cloni), più alto 
= più rigoroso (meno cloni). Test Q5 in range 1.5–
3.0 — 2.0 miglior default. Rilevante solo se.

K I S ACA

Fattore per T77/T78. Standard 2.0 
= più rigoroso del median tipico. 
Non regolare.
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Müfredat (Q6) (T80–T81)

T80 curriculumResolutionRamp

D E TAY L A R

Varsayılan: false Range: boolean Tanımlandığı 
yer:

T E K N İ K

Funzione Q6: la risoluzione di training inizia a 0.5× 
e cambia a T50 positionLRScheduleEndIteration /​ 
2 (o T1 maxIterations /​ 2, se T50 non è imposta
to) a T22 trainingRenderScale. Usa l’infrastruttura 
resize/​restoreImageBuffers sviluppata in Q1.5.1. 
Sovrascrive T23 resolutionWarmupScale se attivato. 
Q6 è passato come “portatore del guadagno di qu
alità” nel bundle Q5+Q6 (vedi T77) — l’aumento 
graduale di risoluzione dà all’app tempo di trovare 
geometria grossolana sulla risoluzione più bassa, 
prima di passare al lavoro di dettaglio fine. Via CLI: 
--curriculum-resolution.

K I S ACA

“Prima grossolano, poi fine” per 
la risoluzione di training. Metà ri­
soluzione nella prima metà, poi 
piena risoluzione. Aiuta in deter­
minate scene, in altre no — meg­
lio accendere insieme a T81.

T81 curriculumSHProgression

D E TAY L A R

Varsayılan: false Range: boolean Tanımlandığı 
yer:

T E K N İ K

Funzione Q6: sovrascrive T21 
shDegreeUpgradeIterations con [maxIter/​4, 
maxIter/​2, maxIter*3/​4], distribuisce quindi gli 
upgrade SH uniformemente sul tempo di training 
invece di caricarli sul fronte. Ipotesi: la geometria 
stabile viene stabilita prima dell’esplosione del color 
detail, il che posiziona più precisamente gli effetti 
di luce dipendenti dalla direzione di vista. Q5+Q6 
insieme PASS 1/3 scene, Q6 come portatore del gu
adagno (Q5 alone FAIL). Via CLI: --curriculum-sh .

K I S ACA

“Prima forma, poi colore” — gli 
effetti di lucentezza vengono sb­
loccati solo tardi nel training, in 
modo che gli splat trovino prima 
la loro posizione e dimensione. 
Con T80 insieme accendibile; da 
solo non porta tanto.
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Statik önayarlar (TP1–TP9)

Burada yalnızca başlatıcı varsayılanına göre yapısal farklar yer alır. On bir UI önayarı P1–
P11 için tam pazarlama açıklamasını Bölüm 7′de bulursun.

TP1 .preview

D E TAY L A R

Preset diagnostico/anteprima per sistemi ≥ 10 GB 
RAM. Override rispetto all’inizializzatore: - 30 000 
→ 5 000 - 15 000 → 3 500 (70% di maxIter) - 1.6e-6 
→ 1.6e-5 (10× più alto, decay meno aggressivo) - ,,,, 
ciascuno 2× (V176) - 3 000 → 100 000 (effettiva
mente off, V172: il reset distrugge i training brevi)
• [1K, 2K, 3K]  → [1K, 2K]  (V182: il grado 3 non 

converge

in 2K iter) - 1.0 → 0.5

K I S ACA

qualsiasi valutazione iniziale di 
una serie di immagini appena 
importate — 2–3 min di attesa, 
dopo il risultato basta per una 
domanda binaria “vale la pena un 
run Quality?”.

TP2 .full

D E TAY L A R

Quality di produzione Classic. Override: - 30 000 → 
35 000 (V550: i test 40K Truck overtraining +10.7% 
Gs con −1.3% L1) - 15 000 → 5 000 (V310 sweet 
spot, V338 7K worse) - Tutte le LR 2× (V188) - 
1.6e-6 → 1.6e-5 (V45 10×) - 2e-6 → 1.1e-6 (V335)
• 100 → 200 (V112) - 0.005 → 0.001 (V393) - 3 000 

→ 100 000

(V194 disabilitato, V421 confermato) - 
[1K, 2K, 3K]  → [2K, 5K, 8K]  (V228 ritardato) - 

0.0 → 0.9995 (V546 HTGS, 14% di miglioramento) - 
50 (invariato, V546) - false → true (V438)
• 0 → 20 000 (V431) - true (V443, già default

dell’inizializzatore per .full )

K I S ACA

ogni ripresa fotografica standard 
(oggetto, piccola stanza, scultu­
ra) con < 500 immagini. Il mig­
lioramento del 14% del loss an­
nunciato in V546 contro V438 è 
stato confermato su Horse Full 
come media di 3 trial.
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TP3 .fullClassicPaper

D E TAY L A R

Sibling di test Q1.5-A di TP2, Classic fedele al paper. 
Override rispetto a TP2: - 35 000 → 30 000 (stan
dard paper) - 5 000 → 15 000 (paper: 50% di 
maxIter) - 1.6e-5 → 1.6e-6 (default paper) - ,, indi
etro a default paper (0.05, 0.005, 0.001) - 1.1e-6 → 
2e-7 (calibrato per ~1-2M Gs su Bicycle) - 200 → 
100 (paper) - 0.001 → 0.005 (default paper) - 100 
000 → 3 000 (paper §5.2, rischioso — può scatena
re regressione V194) - 0.9995 → 0.0 (paper non ha 
decay) - 20 000 → 30 000 (cosine gira al 100% di 
maxIter)

K I S ACA

esperimenti di ricerca Q1.5 che 
hanno bisogno di budget di ga­
ussiane di magnitudine paper (1–
2 M) per test Mip-Splatting. Dopo 
il verdetto Q1.5 “closed no-win” 
il preset rimane accessibile per 
utenti avanzati, ma non è racco­
mandato per produzione.

TP4 .fullMCMC

D E TAY L A R

Quality di produzione MCMC. Override rispetto 
all’inizializzatore: - 30 000 → 200 000 (V534, 
MCMC ha bisogno di 5× più iter di Classic) - 
15 000 → 160 000 (V504b 80% di maxIter) - 
1.6e-6 → 1.6e-5 - LR schedule come TP2 (tutte 
2×) - 0.2 → 0.05 (V521b/V534: MCMC ha bisog
no di segnale L1 più forte) - [1K, 2K, 3K]  → 
[2K, 5K, 8K]  - .classic  → .mcmc  - 150 000 

(già nell’inizializzatore, nel preset confermato) - 
5e-5 (V467/V536 ottimale) - 0.005 → 0.01 (V535 
ottimale) - 0 → 160 000 (80% di maxIter, V497c/
V502) - 3.0 (già nell’inizializzatore) - true (già 
nell’inizializzatore) - 3 000 → 200 000 (effettiva
mente off, MCMC usa reloc invece di reset)

K I S ACA

consegna web, object capture 
con aspirazione al dettaglio, voli 
di drone (anche se P9 Outdoor è 
ancora migliore). 71% in meno di 
gaussiane di Classic con L1 para­
gonabile.

TP5 .fullMCMCMip

D E TAY L A R

Sibling di test Q1.5-D di TP4, con Mip-Splatting 
+ budget MCMC di magnitudine paper. Override ris
petto a TP4:
• mcmcMaxGaussians 150 000 → 1 500 000 (10×, 

magnitudine paper)
• useMipSplatting false → true (Mip on)

K I S ACA

Tutti gli altri campi identici a 
TP4. Q1.5 D-PASS su Bicycle 
2026-05-24 (interrompe la stris­
cia di 12-iter multi-scale-FAIL). 
Verdetto finale Q1.5 2026-05-25 
comunque closed-no-win — il 
guadagno Mip-Splatting non rip­
roducibile su 11 pair scenes. Il 
preset rimane opt-in.
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TP6 .classicBalanced

D E TAY L A R

Mid-tier Classic. Override rispetto a TP2: - 35 000 
→ 20 000 (V149: 20K = 30K con 33% in meno di 
tempo) - 20 000 → 0 (cosine corre su maxIter = 
20K, nessuna extended phase)

K I S ACA

casi standard con tempo di atte­
sa più breve. V149 identificato 
come sweet spot.

TP7 .mcmcPreview

D E TAY L A R

Diagnostica MCMC. Override rispetto a TP4: - 200 
000 → 60 000 (V494b) - 160 000 → 48 000 (80%) 
- 150 000 → 100 000 (V473b) - 160 000 → 40 000 
(V494b) - 3.0 → 2.0 (1.4.5: Preview = scaling più 
leggero)

K I S ACA

vedere rapidamente un risultato 
MCMC, per valutare se TP4 o un 
preset Scene-Class vale la pena.

TP8 .mcmcBalanced

D E TAY L A R

Mid-tier MCMC. Override rispetto a TP4: - 200 000 
→ 120 000 (V518) - 160 000 → 96 000 (80%) - 160 
000 → 96 000 (80%) - 3.0 → 2.5 (tra Preview 2.0 e 
Full 3.0)

K I S ACA

MCMC senza il pieno run 200K. 
~120 K iterazioni sono un buon 
compromesso tra qualità e tem­
po di attesa.

TP9 .quickTest

D E TAY L A R

Puro test funzionale. Override rispetto 
all’inizializzatore: - 30 000 → 1 000 - 15 000 → 
500 - 2e-6 → 4e-6 (calibrato per risoluzione 0.25×) 
- 100 → 50 - 3 000 → 100 000 (off, perché troppo 
breve) - 1.0 → 0.25

K I S ACA

sanity check “il training parte in 
generale sensatamente?”. Durata 
< 30 s su M3 Ultra. Sicuramente 
sembra pastoso.

Yöntem:

Signature: public func resolveMcmcMaxGaussians(initialPointCount: Int, 
bufferCapacity: Int) -> Int Tanımlandığı yer:

TECNICO  Unica fonte di verità per la domanda “quante gaussiane MCMC può far cres
cere al massimo?”. Si calcola da tre input: il T62 mcmcMaxGaussians configurato (con 
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floor mass extinction 150 000, se 0), il (numero di punti SfM init) e la (dimensione del 
buffer gaussiano pre-allocato). Logica:

1. base = T62 > 0 ? T62: 150_​000 (il floor mass extinction protegge contro bug di 
default dell’inizializzatore come l’incidente mass extinction 1.4.3)

2. Se T73 mcmcAutoScaleByScene && initialPointCount > 0 && T72 
mcmcCapMultiplier > 0:
• scaled = max(base, ceil(initialPointCount × T72)) altrimenti

3. Se bufferCapacity > 0 : return min(scaled, bufferCapacity)

4. Altrimenti return scaled

Esempio: Bicycle (Mip-NeRF 360, 194 foto-frame) → SfM-init ~156 K punti, 
T62 = 150 000 , T72 = 5.32 , capacità buffer 8 M. Resolved cap = min(8M, max(150K, 
ceil(156K × 5.32))) = min(8M, 830K) = 830 K. È il cap di crescita effettivo a cui si 
attiene la logica di rilocazione MCMC.

IN PAROLE SEMPLICI  Calcola il vero numero massimo di splat con MCMC. Prende la tua 
impostazione, guarda quanti punti ha la tua scena all’inizio, e scala con il Multiplier  
se l’adattamento automatico è on. Così il cap si adatta alla scena, invece di forzare 
lo stesso valore per una scena piccola e una enorme. Non devi chiamare il metodo tu 
stesso — il training lo usa internamente.
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Hangi alan ne için? (kopya kağıdı)

Obiettivo Campi da regolare

Più dettaglio in 
lontananza

T62 mcmcMaxGaussians alto, T72 mcmcCapMultiplier 5+

Più dettaglio in ge
nerale (Classic)

T1 maxIterations  alto (≤ 40K), T2 densifyUntilIteration ≤ 
14% di T1

Ridurre floater nei 
voli di drone

T43 frustumCullEnabled on, T20 skyMaskingEnabled on, 
T45 skyDomeEnabled  on

Bel cielo in scene 
esterne

T45 skyDomeEnabled  on, T47 skyDomeRadiusMultiplier 30–60

File di export più 
piccolo

Strategia .mcmc  (T61), T56 postTrainingCompactification on, 
T62 mcmcMaxGaussians ≤ 200K

Training più veloce T22 trainingRenderScale 0.5, T1 maxIterations  dimezzare — 
ma non entrambi!

Migliori luci specu
lari

T21 shDegreeUpgradeIterations con [2K, 5K, 8K]  (nessun 
early front load), MCMC + 200K iter

Mantenere il Mac 
reattivo

T25 throttleDelayMs 5–10 (costa ~15% di tempo training)

Live preview più 
frequente

T59 livePreviewInterval giù a 10–20

Transizioni più 
morbide alle omb

re

T17 ssimWeight  un po’ alto (0.15–0.25), ma non oltre 0.3

Mantenere interni 
compatti

Preset P10 Indoor (, T72 = 1.76 )

Tehlikeli alanlar

Questi campi con configurazione errata possono portare a OOM, crash dell’app, mass 
extinction delle gaussiane o dati benchmark inutilizzabili. Da trattare con cautela:

• T11 densifyGradThreshold — un dimezzamento può generare 2–4× più gaussiane, 
il che fa rapidamente esplodere la memoria GPU. Da considerare anche: deve corris
pondere a T22 trainingRenderScale (1.0× → 1e-6, 0.5× → 2e-6, 0.25× → 4e-6).

• T72 mcmcCapMultiplier — con scene grandi con > 200 K punti SfM-init e multiplier 
> 5 nasce un cap risolto di milioni di gaussiane. Su Mac da 36 GB di RAM OOM 
possibile. Il 5.32 del preset Outdoor funziona solo perché Mip-NeRF-360 Bicycle ha 
156 K punti init → 830 K cap.

• T39 testViewIndices — l’impostazione manuale può rendere il benchmark inutilizza
bile (tutti gli indici > N → nessun holdout). Lascia che il flag --benchmark  lo imposti.
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• T64 mcmcOpacityRegWeight e T65 mcmcScaleRegWeight — nella 1.4.3 beta impostati a 
0.01, il che ha portato a mass extinction (460 K → 5 gaussiane in un’iterazione). Dalla 
1.4.4 fissato a 0.0, ma l’aumento manuale può riprodurre il problema.

• T15 opacityResetInterval — se non 100 000+ (effettivamente off) e il training è più 
breve di 10 000 iterazioni, il reset distrugge la convergenza. .preview  ce l’ha quindi 
su 100 000 nonostante maxIterations = 5 000.

• T54/​T55 densifyPhase2* — la densification a due fasi è stata interrotta nei test in 0-
gaussian cascade. Lascia entrambi a 0.

• T74 useMipSplatting — Q1.5 closed-no-win 2026-05-25, può addirittura peggiorare il 
PSNR su alcune scene outdoor. Default off, opt-in solo per ricerca.

Se un campo è in questa lista e vuoi modificarlo, fai prima un backup del tuo preset 
attuale (export come JSON) e considera se puoi misurare in modo riproducibile il risul
tato — altrimenti dopo non sai se hai prodotto un miglioramento o un peggioramento.
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B Ö L Ü M

Bölüm 7 — Yerleşik Kalite Önayarları

Şekil 27:  Dört grubun tamamı açık hâlde Önayarlar bölümü — CAPTURE CLASS (4 önayar: 
Drone/Aerial, 360° Walkaround, 360° Walkaround (High Detail), Photo/Object), CLASSIC 
(5 önayar: Quick/Preview/Balanced/Quality/Ultra Detail), MCMC (3 önayar, „No threshold 

tuning“ notuyla), HYBRID (1 önayar: Balanced (Hybrid))

RESIMDE NE GÖRÜNDÜĞÜ  Inspector’daki Önayarlar bölümü, dört grup da açık. CAPTURE 
CLASS, dört kuratörlü gerçek-dünya önayarıyla (Drone / Aerial, 360° Walkaround, 360° 
Walkaround (High Detail), Photo / Object) — bu, birincil gruptur ve Başlangıç modunda 
görünen tek gruptur. CLASSIC: Quick (1K iter), Preview (5K iter, mavi onay işaretiyle et
kin seçim), Balanced (20K iter), Quality (35K iter) ve Ultra Detail (35K iter). MCMC „No 
threshold tuning“ alt başlığıyla — MCMC, Densify-Until eşiği gerektirmez: Preview (60K 
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iter, 100K Gaussian), Balanced (120K, 150K), Quality (200K, 150K). HYBRID, Balanced 
(Hybrid) önayarıyla (20K iter, 150K Gaussian). Alt eylem satırı: Save…, Export…, Import…

Bir önayar, eğitim için hazırlanmış bir yapılandırmadır. RadianceKit on üç yerleşik önayarı 
dört grupta getirir: dört Capture-Class önayarı (P9–P12) — gerçek topluluk mater
yaline karşı gözle doğrulanmış, gerçek çekim türleri (dron, 360° gezinti, foto-nesne) 
için kuratörlü reçeteler ve v1.6′dan beri birincil eksen —, beş Classic önayarı (P1–
P5: Quick/Preview/Balanced/Quality/Ultra Detail), üç MCMC önayarı (P6–P8) ve Classic 
ile MCMC stratejilerini birleştiren bir Hibrit önayar (P13). Eski „Scene-Class“ önayarları 
(Render/3D, Outdoor, Indoor; Faz Q7′de Mip-NeRF-360 ve NeRF-Blender sahnelerine 
karşı akademik olarak ayarlanmıştı) v1.6′da görünür bir grup olarak geri çekildi — gerçek 
materyale karşı gözle doğrulanan Capture-Class artık birincil eksendir; Q7′de ayarlanan 
yapılandırmalar yalnızca dahili olarak korunur. Bunları kenar çubuğunda Presets alanın
da ya da Başlangıç modunda içe aktarırken seçersin. +  düğmeleri kendi önayarlarını 
yan yana oluşturmak için diyaloglar açar — on üç yerleşik önayar silinemez ama çoğaltı
labilir.

Expert View’da önayarlar çekim türüne ve stratejiye göre gruplanmış görünür (Capture 
Class / Classic / MCMC / Hibrit). Bir girdiye tıklamak, atanmış eğitim yapılandırmasını 
mevcut duruma yazar. Bu bir anlık görüntü değildir — ardından kaydırıcıları çevirirsen 
durum değişir, ama önayarın kendisi değişmez; renkli bir uyarı „modified“ gösterir.

Hangi önayarın ne zaman doğru olduğu çoğunlukla sahne tipine ve donanıma bağlıdır. 
Bölüm sonundaki üç tablo halinde özet bunu toparlar.

P1 — Quick

N E R E D E

Inspector → Önayarlar bölümü → „Classic“ grubu → 
„Quick” girdisi. UUID son eki …001 .

T E K N İ K

1 000 iterasyon, klasik (uyarlanabilir) Densification 
stratejisi ve 0.25× eğitim çözünürlük ölçeklemesiyle 
(girdi görüntüsü eğitimden önce %25′e küçültülür) 
bir tanı önayarı. Bir sahnenin gönderimi için değil, 
kurulumun (kamera pozları, nokta bulutu, görüntü 
serisi) Loss değerlerinde anlamlı bir hareket gösterip 
göstermediğini hızlıca tespit etmek için tasarlandı. 
Bir M3 Ultra’da 50–200 görüntüde tipik olarak 30 
saniyenin altında. Küçük çözünürlük gerçek görüntü 
kalitesini gizler, ama bellek ihtiyacını ve render mali
yetini çok düşük tutar. Sistem 10 GB RAM’den az 
olduğunda ilk başlatmada otomatik olarak varsayılan 
seçilir.

K I S ACA

Hızlı işlev testi. Görüntüleri ver, 
kısa bir yarım dakika bekle, sah­
nenin kaba ana hatlarının çıkıp 
çıkmadığına bak. Görüntüleyici 
penceredeki resim çamurlu bir 
leke gibi görünüyorsa — tamam, 
böyle olmalı. Sadece koyu nok­
talar ya da tamamen bozulmuş 
bir biçim görüyorsan, muhteme­
len kamera pozları yanlıştır (bkz. 
Bölüm 9). Gösterilebilir bir sonuç 
için ardından en az P2 ya da P3′e 
ihtiyacın var.
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P2 — Preview (Classic)

N E R E D E

Inspector → Önayarlar bölümü → „Classic“ grubu → 
„Preview” girdisi. UUID son eki …002 .

T E K N İ K

5 000 iterasyon Classic Densification, 0.5× çözü
nürlük ölçeklemesi, standarda göre iki kat öğrenme 
hızı. Densification (klonlama + bölme) ilk 2 500 ite
rasyon boyunca aktif, sonra yalnızca budama. ≥ 10 
GB RAM’li sistemler için varsayılan önayar. Bir M3 
Ultra’da 200 görüntülü bir sahne için tipik olarak 
90 saniye ile 3 dakika. Geometri ve kamera pozu 
hakkında kullanılabilir bir izlenim verir ama dokular 
gözle görülür biçimde yumuşatılmıştır — 0.5× ren
der çözünürlüğü, ardından P3 ya da P4 ile yeniden 
eğitmek yoluyla doğrudan aşılamaz, çünkü öğrenme 
hızları yarı çözünürlüğe uygun ayarlanmıştır.

K I S ACA

„Bir kez kısaca bak“ için stan­
dart. Yeni görüntüler içe aktar­
dın ve sahnenin gerçekten yeni­
den yapılandırılabilir olup olma­
dığını görmek istiyorsan, doğru 
aşama budur. Yaklaşık 2–3 dakika 
bekleme süresi, ardından 3D gö­
rüntüleyicide döndürebilir ve da­
ha fazla eğitim geçişine yatırım 
yapmanın anlamlı olup olmadığı­
nı değerlendirebilirsin. Ön izleme 
sonucu zaten iyi görünüyorsa, 
ancak o zaman Balanced veya 
Quality zahmete değer.

P3 — Balanced (Classic)

N E R E D E

Inspector → Önayarlar bölümü → „Classic“ grubu → 
„Balanced” girdisi. UUID son eki …005 .

T E K N İ K

Tam görüntü çözünürlüğünde 20 000 iterasyon 
Classic Densification. Densification ilk 15 000 ite
rasyon boyunca çalışır, iter 3 000′den itibaren 
100′lük Densify aralığıyla. Belgelenen eğitim otu
rumlarında ampirik „tatlı nokta“: klasik Densification 
ile Horse Full ve Truck’ta L1 kaybı iter 18 000–
22 000 arasında dengelenir, daha uzun eğitim 
Quality’nin (P4) altında anlamlı bir iyileşme getir
mez. Bir M3 Ultra’da 200 görüntüde tipik olarak 30–
60 saniye, 1 000+ görüntüde 5–8 dakika.

K I S ACA

„İyi uzlaşma“. Çoğu sahne bu­
nunla zaten iyi görünür ve bir sa­
at beklemek zorunda kalmazsın. 
Sonuç bir yerde göstermek isti­
yorsan (sosyal medya, web sitesi, 
bir müşteri demosu) çoğu kez 
yeterli. Splat modeline yakınlaş­
tırmak ya da yüzey doku detayla­
rı istemek ancak gerektiğinde P4 
Quality ya da P7 MCMC’ye sıçra­
mak zahmete değer.
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P4 — Quality (Classic)

N E R E D E

Inspector → Önayarlar bölümü → „Classic“ grubu → 
„Quality” girdisi. UUID son eki …003 .

T E K N İ K

V546 „Opacity Decay“ (HTGS, Eurographics 2025) 
ile 35 000 iterasyon Classic Densification: her Den
sify döngüsünden sonra mevcut tüm Gaussian’ların 
opaklığı < 1.0 bir faktörle çarpılır; bu, inaktif hale 
gelmiş Gaussian’ları budama sırasında güvenilir bi
çimde kaldırır ve böylece aynı iter sayısında klasik 
35 000 çalıştırmasına göre %14 daha iyi L1 kaybı 
elde eder. SSIM kaybı etkindir ( ssimWeight=0.05 ). 
Bir M3 Ultra’da 200 görüntüde tipik olarak 2–4 
dakika. NeRF-Blender’da (Lego, Chair, Drums) final 
L1 ≈ 0.023 verir — belgelenen 560+ deneydeki en 
iyi Classic varyantı. Dikkat: ~3–5 GB GPU belleği ge
rektirir; 8 GB sistemlerde P3 güvenli seçimdir.

K I S ACA

En iyi klasik varyant. Keskin doku 
ve ince geometri verir, özellikle 
nesne çekimlerinde (bir heykel, 
bir sandalye, bir vazo). Büyük dış 
mekân sahnelerinde ya da oda­
larda ise Balanced’a göre nere­
deyse hiç fark hissetmezsin — 
orada bir MCMC önayarına (P6–
P8) ya da bir Capture-Class öna­
yarına (P9–P12) geçmek, P3′ten 
P4′e sıçramaktan daha çok işe 
yarar. Classic ailesinin mutlak 
maksimumunu isteyen P5 Ultra 
Detail’i kullanır.

P5 — Ultra Detail (Classic)

N E R E D E

Inspector → Önayarlar bölümü → „Classic“ grubu → 
„Ultra Detail” girdisi. UUID son eki …008 .

T E K N İ K

Yaklaşık 35 000 iterasyon Classic Densificati
on — Quality matrisinin held-out geçişinin galibi 
(2026-06-10). Test edilen üç Mip-NeRF-360 sahne
sinin tamamında Ultra Detail, karşılaştırılabilir duvar 
saati süresinde yerleşik MCMC „Quality“ önayarını 
(P8) yaklaşık +0.94 dB PSNR ile yener. Böyle
ce Classic grubunun en güçlü Quality önayarı ve 
RadianceKit’in getirdiği en keskin Classic varyantı
dır. Bir M3 Ultra’da tipik olarak P4 Quality ile aynı 
zaman diliminde (200 görüntüde 2–5 dakika), ama 
biraz daha fazla GPU belleği gerektirir; 8 GB sistem
lerde P3 güvenli seçim olmaya devam eder.

K I S ACA

En keskin Classic kademesi ve 
kalite testlerimizin held-out ga­
libi: gerçek sahnelerde MCMC 
„Quality“ varyantından yaklaşık 
bir desibel daha iyi — benzer 
bekleme süresinde. Kanıtlanmış 
klasik Densification ile maksi­
mum detay sadakati istiyorsan 
ve yeterli GPU belleğin varsa, ilk 
tercih budur. Bellek yetmiyorsa 
ya da mümkün olan en küçük 
dışa aktarma dosyasına ihtiyacın 
varsa, P4 Quality’de ya da bir 
MCMC önayarında kal.
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P6 — Preview (MCMC)

N E R E D E

Inspector → Önayarlar bölümü → „MCMC“ grubu → 
„Preview” girdisi. UUID son eki …006 .

T E K N İ K

100 000 Gaussian üst sınırında 60 000 iterasyon 
MCMC Densification (3DGS-MCMC, NeurIPS 2024). 
MCMC, sezgisel klon/bölme mantığını Markov Zinciri 
Monte Carlo yeniden konumlandırmasıyla değiştirir: 
ölü Gaussian’lar Sigmoid ağırlıklı örnekleme derinliği 
üzerinden yeniden konumlandırılır; bu da kontrollü 
ve yeniden üretilebilir bir Gaussian sayısı verir. Üst 
sınır maksimum sayıyı 100K ile kesin biçimde sınırlar 
— bu, bellek ve render süresi kazandırır, ama detaya 
mal olur. Bir M3 Ultra’da 200 görüntüde tipik olarak 
5–8 dakika. „MCMC işlev testi“ olarak uygundur — 
P7 ya da P8′e daha fazla zaman yatırmadan önce 
Classic’ten MCMC’ye geçişin anlamlı olup olmaya
cağını değerlendirmeye yardım eder.

K I S ACA

P2 Preview gibi, ama daha ye­
ni MCMC yöntemiyle. Çoğu kez 
Classic varyantına kıyasla biraz 
daha kompakt, daha eşit dağılmış 
splat bulutları verir. Bir sahnenin 
ilk değerlendirmesi için 5–8 da­
kika genellikle yeterli. Ön izleme 
sonucu hoşuna giderse, bir son­
raki adım P7 (Balanced) ya da 
doğrudan P8 (Quality MCMC).

P7 — Balanced (MCMC)

N E R E D E

Inspector → Önayarlar bölümü → „MCMC“ grubu → 
„Balanced” girdisi. UUID son eki …007 .

T E K N İ K

150 000 Gaussian üst sınırında 120 000 iterasyon 
MCMC. Orta MCMC kademesi — P8 Quality’nin ne
redeyse son Gaussian sayısına, ama yalnızca iteras
yonların %60′ına sahip. Belgelenen eğitim oturumla
rında ampirik olarak L1 kaybı Horse Full’da 0.026–
0.028 aralığındadır, P8′e karşı 0.0246 — yani yakla
şık %7 daha yüksek, karşılığında yarı bekleme süre
si. Bir M3 Ultra’da 200 görüntüde tipik olarak 8–15 
dakika. Etkili Gaussian üst sınırını girdi SfM nokta 
bulutunun nokta yoğunluğuna ölçekleyen bir yöntem 
kullanır (bkz. Bölüm 6, T75).

K I S ACA

Yeterli detay derinliğine sahip 
MCMC, ama P8′in uzun tam ça­
lıştırması olmadan. Çoğu sahne 
için yeterli, özellikle bir MCMC 
çalıştırmasını öğle arası süresi­
ne sıkıştırmak istiyorsan. Bellek 
sıkıştığında (örneğin yalnızca 16 
GB’lık M işlemcilerde) burada kal 
— P8 daha fazla GPU belleği ge­
rektirir.
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P8 — Quality (MCMC)

N E R E D E

Inspector → Önayarlar bölümü → „MCMC“ grubu → 
„Quality” girdisi. UUID son eki …004 .

T E K N İ K

150 000 Gaussian üst sınırında 200 000 iterasyon 
MCMC, SSIM kaybı 0.05, iterasyonların %80′i bo
yunca MCMC gürültü azalması. 560+ deneydeki en 
iyi tek çalıştırma L1′i: Horse Full’da 0.0238, 3 dene
menin ortalaması 0.0246 (aynı sahnede P4 0.0230′a 
karşı). MCMC bunu %71 daha az Gaussian ile sağ
lar (150K vs ~524K) — web üzerinde sonuç teslim 
edeceksen belirleyicidir, çünkü küçük bulut belirgin 
biçimde daha küçük dışa aktarma dosyaları üretir. 
Bir M3 Ultra’da 200 görüntüde tipik eğitim süresi 
20–35 dakika; 1 000+ görüntülük setlerde 1–2 saat. 
Minimum son boyutta maksimum görüntü kalitesi is
tendiğinde en iyi seçim.

K I S ACA

En iyi MCMC varyantı. Çok temiz, 
kompakt splat bulutları verir — 
sonucu daha sonra web 3D gö­
rüntüleyici olarak gömmek ya da 
dosya olarak göndermek istiyor­
san idealdir (P4 Quality’ye ben­
zer optik kalitede daha küçük bir 
dosyadır). Ama bunun için sabra 
ihtiyacın olur — büyük çekim­
lerde bir saatten uzun bekleme 
süresi. Bunu daha çok „gece üze­
rinde“ bir çalıştırma olarak plan­
la.
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Şekil 28:  CAPTURE CLASS grubu açık, dört kuratörlü gerçek-dünya önayarının tamamıyla — 
Drone / Aerial (MCMC, 40K iter, Üst sınır 1,5 M), 360° Walkaround (MCMC, 40K, Üst sınır 

1,5 M), 360° Walkaround (High Detail) (Hibrit, 40K, Üst sınır 1,5 M, opt-in) ve Photo / Object 
(Hibrit, 40K, Üst sınır 1,5 M). Bu grup en üstte yer alır ve Başlangıç modunda görünen tek 

gruptur.

RESIMDE NE GÖRÜNDÜĞÜ  CAPTURE CLASS grubu açık Inspector — v1.6′dan beri birincil 
önayar grubu, Başlangıç modunda gösterilen tek grup. Her girdi, somut bir çekim türü 
(dron, 360° gezinti, foto-nesne) için gerçek topluluk materyaline karşı gözle doğrulan
mış bir reçetedir; akademik bir test setine karşı optimize edilmiş bir değer değildir. 
Tıklayarak seçim, atanmış eğitim yapılandırmasını mevcut duruma yazar.
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P9 — Drone / Aerial

N E R E D E

Inspector → Önayarlar bölümü → „Capture Class“ 
grubu → „Drone / Aerial” girdisi. UUID son eki 
…010 .

T E K N İ K

Binaların ve manzaraların hava ve dron orbitleri için 
Capture-Class önayarı. MCMC Densifier, 40 000 ite
rasyon, üst sınır 1,5 milyon Gaussian, SSIM kaybı 0.5 
artı Edge-Aware terimi 0.1. Belirleyici olan, oran eşiği 
6′da ağırlık 0.003 ile anizotropi cezasıdır — dron 
materyalinin ürettiği tipik iğne biçimli artefaktlara 
karşı „spagetti-öldürücü“. Pensford Viyadüğü üze
rinde gerçek bir DJI 4K dron uçuşunda doğrulandı 
(yalnızca metrik değil, gözle test edildi).

K I S ACA

Havadan çekimler için — bir bi­
nanın etrafında dron uçuşları, bir 
manzara üzerinde, bir cephe bo­
yunca. Güçlü anizotropi cezası, 
dron materyalinin sıkça ürettiği 
iğne ya da spagetti biçimli arte­
faktları temizler. Materyalin yer­
den çekildiyse, daha çok Photo / 
Object ya da bir Classic önayar 
uygundur.

P10 — 360° Walkaround

N E R E D E

Inspector → Önayarlar bölümü → „Capture Class“ 
grubu → „360° Walkaround” girdisi. UUID son eki 
…011 .

T E K N İ K

360° gezinti videoları için Capture-Class önayarı. 
MCMC Densifier, 40 000 iterasyon, üst sınır 1,5 mil
yon Gaussian, SSIM kaybı 0.5 artı Edge-Aware terimi 
0.1, yumuşak anizotropi cezası (oran eşiği 15′te ağır
lık 0.001). Kişi ve gök maskesi etkin. Önayar, eğitim 
başlamadan önce dahili olarak yaklaşık 90° geniş
liğinde perspektif kırpmalara yeniden projeksiyonla
nan bir 360° equirect video bekler. Selfie çubuklu 
8K 360° gezintilerde doğrulandı (Monument sahne
si, gözle test edildi).

K I S ACA

360° gezinti videoları için — bir 
360° kamera ya da selfie çubu­
ğuyla bir odanın içinde ya da 
bir nesnenin etrafında dolaşır­
sın. RadianceKit küre panorama­
sını kendi başına normal bakış 
açılarına ayırır ve geçen kişileri 
ve göğü maskeleyip çıkarır. Aynı 
materyalde maksimum keskinlik 
için ek olarak High-Detail varyan­
tını (P11) dene.
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P11 — 360° Walkaround (High Detail)

N E R E D E

Inspector → Önayarlar bölümü → „Capture Class“ 
grubu → „360° Walkaround (High Detail)” girdisi. 
UUID son eki …013  (Opt-in).

T E K N İ K

Maksimum detayla 360° gezinti videoları için opt-in 
Capture-Class önayarı. Hibrit Densifier (klasik Abs-
gradyan klonlama/bölme + MCMC gürültüsü + yeni
den konumlandırma), 40 000 iterasyon, üst sınır 1,5 
milyon Gaussian, oran eşiği 15′te anizotropi cezası 
0.0015, SSIM kaybı 0.2 ve Edge-Aware terimi 0 — 
kilitli „r50″ screen-split reçetesi. 360° materyalde, 
standart MCMC önayarı „360° Walkaround“u (P10) 
PSNR, LPIPS ve görünür konfetide yener, üstelik 
yaklaşık üçte bir splat sayısıyla. Daha fazla sahnede 
doğrulanana kadar standart 360 önayarının yanında 
kasıtlı olarak opt-in durur.

K I S ACA

Standart 360 önayarına (P10) da­
ha keskin alternatif: daha fazla 
detay, daha az konfeti, belirgin 
biçimde daha küçük dosya. Onun 
yerini almak yerine kasıtlı ola­
rak yanında durur — şimdiye ka­
dar bir avuç sahnede doğrulandı. 
360° gezintin temiz çekildiyse, 
önce bu önayarı dene ve sonucu 
P10 ile karşılaştır.

P12 — Photo / Object

N E R E D E

Inspector → Önayarlar bölümü → „Capture Class“ 
grubu → „Photo / Object” girdisi. UUID son eki 
…012 .

T E K N İ K

Keskin tekil fotoğraflardan (video değil) nesne orbit
leri için Capture-Class önayarı. Hibrit-t1 Densifier 
(yeniden konumlandırmalı), 40 000 iterasyon, üst 
sınır 1,5 milyon Gaussian, SSIM kaybı 0.5 artı Edge-
Aware terimi 0.1, yumuşak anizotropi cezası (oran 
eşiği 15′te ağırlık 0.001), her 50 iterasyonda Opacity 
Decay 0.9995, maske yok. Bir iskeletin 163 yüksek 
çözünürlüklü 41 MP fotoğrafında doğrulandı (gözle 
test edildi). Az view (yaklaşık 600′e kadar) bunda 
Hibrit çöküş eşiğinin altında kalır.

K I S ACA

Keskin tekil fotoğraflardan nes­
ne çekimleri için — bir heykelin, 
bir modelin, bir ürünün etrafında 
kamerayla dolaşır ve video yeri­
ne fotoğraf çekersin. Maske yok, 
çünkü keskin fotoğraflar genel­
likle temiz arka plana sahiptir. Vi­
deo kaynakları için bunun yerine 
bir 360° ya da Drone önayarı kul­
lan.
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P13 — Dengeli (Hibrit)

N E R E D E

Inspector → Önayarlar bölümü → „Hibrit“ grubu → 
„Dengeli (Hibrit)” girdisi. UUID son eki …009 .

T E K N İ K

Hibrit Densification stratejisiyle 20 000 iteras
yon: klasik gradyan güdümlü clone/split, kapasite
yi loss’un ihtiyaç duyduğu yere yerleştirir, MCMC 
SGLD gürültüsü keşfetmeye devam eder ve ölü 
Gaussian’lar budamada kaybolmak yerine yeniden 
konumlandırılır. Opacity Decay (V546), opacity sıfır
lamalarının yerini alır; bir anizotropi cezası (ağırlık 
0.001, oran eşiği 15) iğne biçimli splat’leri kontrol 
altında tutar. Gaussian üst sınırı sahneyle ölçeklenir 
(150K taban, sahne duyarlı ×3.0). Aynı bütçede saf 
MCMC’ye karşı beş sahnede doğrulandı: %20–30 
daha az Gaussian’la ortalama +0.45 dB PSNR (sto
nehenge +1.23, family +0.82, garden +0.47 dB). M3 
Ultra’da 200 görüntüde tipik olarak 5–10 dakika.

K I S ACA

Nihai bir sonuç için güçlü bir 
ilk seçim: MCMC önayarlarından 
daha keskin detay, benzer kom­
paktlıkta bir dosyada ve P8 eği­
tim süresinin küçük bir kısmında. 
Yalnızca tek bir kalite çalıştırma­
sı için zamanın varsa ve Captu­
re sınıflarından hiçbiri açıkça uy­
muyorsa, buradan başla. Classic 
önayarlar hızlı testler için daha 
iyi kalır ve sahnen bu çekim 
türlerinden birine açıkça uyuyor­
sa Capture-Class önayarları (P9–
P12) ilk tercihtir.
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Ne zaman hangi önayar?

Senaryo İlk test Ana çalıştırma

Yeni görüntülerin işlev 
testi, < 30 sn

P1 Quick —

Keskin tekil fotoğraflar
dan nesne orbiti

P2 Preview P12 Photo / Object

Tek nesne taraması (vi
deo), < 500 fotoğraf

P2 Preview P4 Quality veya P8 Quality 
MCMC

360° gezinti videosu P6 Preview MCMC P10 360° Walkaround (kes
kin: P11 High Detail)

Hava / dron orbiti, manza
ra

P6 Preview MCMC P9 Drone / Aerial

Web teslimi (küçük, kom
pakt)

P2 P8 Quality MCMC (tam kali
tede en küçük dosya)

Az zamanda keskin detay, 
kompakt dışa aktarma

P2 veya P6 P13 Dengeli (Hibrit)

Maksimum detay sadaka
ti, Classic stratejisi

P3 veya P6 P5 Ultra Detail

Baskı, pazarlama, tam de
tay

P3 veya P6 P4 Quality (Classic) veya 
P5 Ultra Detail
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Hızlı karşılaştırma
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Öna­
yar

Stra­
teji

İter Maks-
Gs

Render 
ölçeği

Tipik süre (200 görüntü, M3 
Ultra)

Q-Swe­
ep

P1 
Qu
ick

Classic 1 000 ∞ 0.25× ~30 sn —

P2 
Pre
vi
ew

Classic 5 000 ∞ 0.5× 2–3 dk —

P3 
Ba
lan
ced

Classic20 000 ∞ 1.0× 30–60 sn —

P4 
Qu
ality

Classic35 000 ∞ 1.0× 2–4 dk V546 
HTGS

P5 
Ult
ra 

De
tail

Classic ~35 
000

∞ 1.0× 2–5 dk Mat
rix Δ+0.94 

dB

P6 
Pre
vi

ew MCMC

MCMC60 000 100 
K

1.0× 5–8 dk —

P7 
Ba
lan

ced MCMC

MCMC 120 
000

150 
K

1.0× 8–15 dk —

P8 
Qu

ality MCMC

MCMC 200 
000

150 
K

1.0× 20–35 dk V544a

P9 Dro
ne / 
Aeri

al

MCMC40 000 1.5 
M

1.0× 10–25 dk Göz / 
Viya
dük

P10 360° 
Wal
ka
ro

und

MCMC40 000 1.5 
M

1.0× 10–25 dk Göz / 
Mo
nu

ment

P11 360° 
Wal
ka
ro

und (High 
De
tail)

Hibrit 40 000 1.5 
M

1.0× 10–25 dk Göz 
(opt-
in)

P12 Pho
to / 
Ob
ject

Hibrit 40 000 1.5 
M

1.0× 10–25 dk Göz / 
İske
let

P13 Den
geli 
(Hib
rit)

Hibrit 20 000 150 
K

1.0× 5–10 dk Mat
rix Δ+0.45 

dB
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Kendi önayarların

Önayarlar bölümündeki (Bölüm 2′de I1) Save… düğmesi üzerinden, mevcut eğitim yapı
landırmasını kendi önayarın olarak kaydedersin. Kendi önayarların „Built-in“ değildir; 
yeniden adlandırılabilir, dışa aktarılabilir (JSON olarak), sürükle-bırakla paylaşılabilir, ço
ğaltılabilir ve silinebilir. On üç yerleşik önayar P1–P13, sil düğmesinden etkilenmez.

Pratik kural: Bir önayarda daha sık ihtiyaç duyacağın bir şey değiştirdiğinde — Sky-
Dome açık, belirli bir sahne sınıfı için daha yüksek SSIM ağırlığı, farklı iter sayıları — 
varyantı kendi önayarın olarak kaydet. Böylece bir sonraki çalıştırmada bunun standart
tan farklı bir yapılandırma olduğunu hemen bilirsin.
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B Ö L Ü M

Bölüm 8 — Dışa Aktarma Biçimleri

Şekil 29:  Simple modunda dışa aktarma biçim seçimi — altı biçim kartı

Şekil 30:  Çiçek demeti üzerinde 5K iter eğitim sonrası canlı dışa aktarma biçim ızgarası — 
dinamik boyut hesaplı altı kart (PLY 742 KB seçili, SPZ 74 KB, glTF 708 KB, .splat 96 KB, 

Orbit Video ~Sıfır KB, Web Viewer 133 KB), sağda zaten kaydedilmiş PLY ile Dışa Aktarma 
Geçmişi

Resimde ne göründüğü (2 991 Gaussian, SH derecesi 3, IP-temiz test seti olarak 
sentetik bir Blender çiçek demeti): Her biçim kartının altındaki boyut bilgileri mevcut 
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Gaussian sayısı ve biçim yükünden canlı olarak hesaplanır — sabit kodlanmamıştır. 2 
991 Gaussian’dan (SH derecesi 3) böylece 742 KB PLY, 74 KB SPZ (kuantizasyon 
sayesinde ~10× daha küçük çarpan), 708 KB glTF (KHR_​gaussian_​splatting uzantısıyla, 
bu yüzden neredeyse PLY eşdeğeri), 96 KB .splat (sıkıştırılmış Gaussian başına 24 
bayt biçim) oluşur. Orbit Video „~Sıfır KB“ gösterir, çünkü boyut ancak MP4 kodla
masından sonra bilinir. Web Viewer (133 KB) bağımsız bir HTML dosyasını gömülü 
WebGL görüntüleyici ve sıkıştırılmış splat verileriyle paketler — görüntüleyici ek yükü 
nedeniyle saf .splat’tan daha büyüktür. Sağdaki Dışa Aktarma Geçmişi, biçim hapı 
ve Finder’da göster eylemiyle birlikte zaten tamamlanmış PLY dışa aktarmayı listeler 
(„training_20260527T211321Z.ply, 743 KB, 23:13”).

Tamamlanmış bir eğitim bir Gaussian bulutu sağlar — birkaç yüz binden milyonlarcaya 
kadar 3B Gauss dağılımının sahneyi yeniden yapılandıran toplamı. RadianceKit bu bulu
tu sabit diske yazmanın on yolunu bilir. Bunlardan altısı saf 3D veri biçimidir (PLY, 
Compressed PLY, SPZ, SOG, glTF, .splat), biri bulutu hazır HTML görüntüleyiciyle (Web 
Viewer) birlikte paketler, biri bir orbit kamera çekiminden MP4 dosyası render eder (Or
bit Video) ve ikisi Gaussian içerik dışa aktarmaz, yalnızca diğer eğitim pipeline’larında 
yeniden kullanım için SfM sonucunu (kamera pozları ve kabaca nokta bulutu) dışa aktarır 
(transforms.json + COLMAP-Workspace).

Hangi biçimin ne zaman doğru olduğu hedefe bağlıdır. Kalite kaybı olmadan tüm 
verinin arşivlenmesi için PLY alınır. Kendi sitende web görüntüleyici için çoğu kez .splat 
veya yerleşik Web Viewer yeterlidir. Dosya minimum olmalıysa SPZ veya SOG zahme
te değer. SfM sonucunun Nerfstudio, Postshot veya Brush’ta yeniden kullanımı için 
transforms.json ve COLMAP Workspace doğru yollardır.

Tüm dışa aktarma işlevleri „Export“ menüsünde ve Simple modunun son sihirbaz aşa
masında bulunur. Çoğu biçim tamamen sandbox uyumludur ve App Store sürümünde 
çalışır. Yalnızca SOG harici bir ikili ( cwebp ) gerektirir; bu, App Store yapısında her 
zaman bulunmaz — detaylar için bkz. E4.
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E1 — PLY (.ply)

N E R E D E

Menü çubuğu → Export → 3D Formats → Export 
PLY… (⌘E). Simple modu: Sihirbaz adımı Export 
→ „PLY“ biçim kartı. Boyut: tipik %100 (referans 
değer). Şununla uyumlu: SuperSplat, PolyCam, tüm 
3DGS görüntüleyicileri.

T E K N İ K

PLY, 3D Gaussian Splatting için kanonik depola
ma biçimidir. RadianceKit standartlaştırılmış 3DGS 
özellik düzeniyle ikili little-endian bir dosya ya
zar: Gaussian başına üç bileşenli konum, her 
zaman sıfıra ayarlanmış üç normal, taban RGB 
rengi için üç DC-SH katsayısı ( f_dc_0..2 ), ardın
dan Kerbl-2023 makalesinde tanımlanmış transpoze 
edilmiş kanal-büyük dizimde 45′e kadar SH katsayı
sı ( f_rest_0..44 ) (önce tüm R kanal katsayıları, 
sonra tüm G, sonra tüm B), ardından logit opaklık 
(ham sigmoid öncesi değerler), üç log-uzay ölçeği 
ve wxyz dörtlü dönüşü. İhraç edilen maksimum SH 
derecesi, kullanıcı isteği ile gerçek öğrenilen dere
cenin minimumuna sıkıştırılır; varsayılan 3′tür (45 
kalan katsayı). Yazılmadan önce çok büyük bulutlar
da taşmayı yakalamak için yük boyutu 64 bit tamsayı 
olarak hesaplanır. Dosya atomik olarak yazılır; bu, 
büyük bulutlarda kısa süreliğine iki kat disk alanı 
kaplar.

K I S ACA

Bu „orijinal dosya“dır. En büyük 
dosya, en yüksek uyumluluk, ka­
yıp yok. Hangi biçimi alacağını 
bilmiyorsan PLY al — neredeyse 
her 3DGS aracında açılır. 1 milyon 
Gaussian için SH derecesine göre 
200 ile 800 MB arasıdır. Dosya 
çok büyürse, E2′ye (sıkıştırılmış 
PLY) veya E3′e (SPZ) bak.
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E2 — Compressed PLY (.ply)

N E R E D E

Menü çubuğu → Export → 3D Formats → Ex
port Compressed PLY…. Simple modu: „Compres
sed PLY“ biçim kartı. Boyut: PLY’ye göre yaklaşık 
%10–20 (5 ile 10 kat sıkıştırma). Şununla uyumlu: 
SuperSplat, PlayCanvas-Engine, web tabanlı görün
tüleyiciler.

T E K N İ K

PLY biçiminin parçalı kuantizasyonlu PlayCanvas 
varyantı. Gaussian’lar 256′lık parçalar halinde grup
lanır. Parça başına konum, ölçek ve renk için min/
maks sınırlar ayrı ayrı başlığa yerleştirilir; tekil 
Gaussian’lar değerlerine bu sınırlara göre referans 
verir ve her biri 32 bite sıkıştırılır: konum ve öl
çek 11-10-11 bit paketleme ile, dönüş 2-10-10-10 
bit „smallest-three“ dörtlü olarak, renk 8-8-8-8 
RGBA olarak. Daha yüksek SH katsayıları bileşen 
başına sadece 8 bit ile kuantize edilir (Gaussian 
başına shCoeffCount * 3  uchar). Biçimin kendisi 
hâlâ ASCII başlıklı PLY’dir ve dolayısıyla temel olarak 
PLY araçlarıyla doğrulanabilir, ama vertex özellikleri 
uint  alanları olarak ilan edilmiştir. SH derecesi sı

kıştırmayı maksimize etmek için varsayılan 0′dır (ka
lan katsayı yok) — daha yüksek SH dereceleri açıkça 
seçilebilir.

K I S ACA

Yer kazandırıcı PLY varyantı. Nor­
mal PLY ile aynı motor uyum­
luluğu, ama 5 ile 10 kat daha 
küçük. SuperSplat ve PlayCanvas 
yerel olarak okur. Web dağıtımı 
için neredeyse her zaman normal 
PLY’den iyidir. Kuantizasyondan 
kaynaklanan kalite kaybı, sahne 
aşırı yüksek frekanslı detaylar 
içermediği sürece görsel olarak 
çoğunlukla fark edilmez.
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E3 — SPZ (.spz)

N E R E D E

Menü çubuğu → Export → 3D Formats → Export 
SPZ…. Simple modu: „SPZ“ biçim kartı. Boyut: 
PLY’ye göre yaklaşık %10 (%90 daha küçük). Şu­
nunla uyumlu: Niantic Scaniverse, Niantic Spatial 
Fields, MetalSplatter.

T E K N İ K

Niantic’in SPZ-v2 biçimi. Konumlar 24 bit sabit nok
ta olarak paketlenir (bu yaklaşık 0,25 mm çözünür
lük verir), ölçekler log uzayda 8 bit kuantizasyonla, 
dönüşler 8 bit smallest-three olarak (v2′de yalnızca 
xyz saklanır, w decoder’da dörtlünün normundan tü
retilir), opaklıklar sigmoidlenmiş 8 bit değerler ola
rak. DC-SH, SPZ’ye özgü bir paketleme formülüyle 
(dc_​raw * 0.15 * 255 + 0.5 *
255) saklanır, daha yüksek SH bantları katsayı başına 
5 bit (Bant 1) veya 4 bit (Bant 2-3) ile. Paketlenen 
tüm ikili blob ardından standart gzip (RFC 1952) ile 
sıkıştırılır; bu da 1f 8b  sihirli bayt’larıyla gzip’li bir 
konteyner biçim verir. RadianceKit bunun için sistem 
gzip ’ini çağırır, çünkü Apple’ın yerleşik zlib API’si 

Spatial Fields veya MetalSplatter’daki SPZ okuyucu
larıyla uyumlu olmayan tescilli Apple framing’i üretir. 
Sistem gzip ’i macOS sandbox içinde de çağrılabilir 
kalır.

K I S ACA

En küçük standart dosya. 
Niantic’in Scaniverse’i biliyorsan 
— uygulamanın kullandığı biçim 
budur. Çok küçük, mobil uygula­
malar için çok yükleme dostu. 
Niantic’in kendi bulut görüntüle­
yicisinde (Spatial Fields) doğru­
dan kullanılabilir. Aynı verilerle 
bir PLY’den yaklaşık %90 daha 
küçük, çoğu sahnede optik olarak 
neredeyse ayırt edilemez.
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E4 — SOG (.sog)

N E R E D E

Menü çubuğu → Export → 3D Formats → Export 
SOG…. Simple modu: „SOG“ biçim kartı. Boyut: 
PLY’ye göre yaklaşık %5–6 (15 ile 20 kat sıkıştırma 
— en küçük seçenek). Şununla uyumlu: PlayCan
vas-Engine, SuperSplat editör.

T E K N İ K

„Spatially Ordered Gaussians“ — bulutu birden 
çok kayıpsız WebP görüntüsünde GPU’ya hazır 
olarak saklayan bir PlayCanvas biçimi. Önce tüm 
Gaussian’lar 3B Morton kodu (30 bit Z-sırası, eksen 
başına 10 bit) ile uzaysal olarak sıralanır; bu, görün
tülere render’da sonradan önbellek yerelliği sağlar. 
Ardından konumlar simetrik log-dönüşümüyle (daha 
iyi dinamik aralık için) 16 bit değerlere kuantize edi
lir ve iki RGBA görüntüye bölünür (alt 8 bit için 
means_l.webp , üst 8 bit için means_u.webp ). Dö

nüşler 3×8 bit artı 2 bit mod ile bir RGBA görüntü
sünde smallest-three olarak kodlanır (Mod alpha’ya 
252 + largest  olarak yerleşir). Ölçekler ve DC-SH 

her biri 256 girişlik bir kod kitabıyla (tüm değerler 
üzerinde yüzdelik tabanlı dağıtılmış) kuantize edilir, 
indeksler scales.webp  ve sh0.webp ’e yerleşir. Beş 
görüntü artı kod kitapları ve sınırlarla bir meta.json  
bir ZIP dosyasına paketlenir (özel kodlayıcı, çünkü 
sandbox sistem zip ’ini engeller) ve .sog  uzantı
sıyla kaydedilir.

Dikkat Sandbox: SOG, harici bir ikili gerektiren 
tek biçim seçeneğidir. WebP kodlayıcı aşaması /​usr/​
local/​bin/​cwebp veya /​opt/​homebrew/​bin/​cwebp’ten 
cwebp  çağırır. cwebp ikilisi bulunamazsa, kod ham 

PNG kodlamaya geri döner — ama: PNG geri dö­
nüşü SuperSplat’ta çalışmaz. App Store sürümün
de yapı varyantına göre kullanılabilirliği değerlendir; 
geliştirici varyantında cwebp Homebrew ile kurulu 
olmalıdır ( brew install webp ).

K I S ACA

Genel olarak en küçük 3DGS 
biçimi, SPZ’den belirgin biçim­
de daha küçük. Ama: Mac’inde 
cwebp  aracına ihtiyaç duyar, 

çünkü RadianceKit kendisi tüm 
görüntü biçimlerini üretemez. 
Bir kez Homebrew ile kur, son­
ra her şey çalışır. App Store 
sürümünde tam çalışmıyor ola­
bilir — dışa aktarmada WebP 
yerine PNG çıkıyorsa, dosyayı 
doğrudan SuperSplat’ta açamaz­
sın. Homebrew olmadan çalışan 
SPZ’yi (E3) alır.
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E5 — glTF (.glb)

N E R E D E

Menü çubuğu → Export → 3D Formats → Export 
glTF…. Simple modu: „glTF“ biçim kartı. Boyut: PLY 
ile karşılaştırılabilir. Şununla uyumlu: KHR_​gaussian_​
splatting uzantılı glTF görüntüleyicileri (Khronos 
taslak standardı).

T E K N İ K

KHR_​gaussian_​splatting uzantı belirtimine göre 
kendi kendine yeten bir .glb  ikili dosyası (ayrı 
bin dosya eki yok) yazar. Konumlar normal glTF 
POSITION  köşe verisi (float3) olarak saklanır, diğer 

tüm özellikler (dönüş float4 olarak, ölçek float3 
olarak, opaklık float olarak, SH katsayıları float3 
× shCoeffCount olarak) ek köşe özelliklerinde yer 
alır ve uzantı üzerinden referans verilir. Önemli: 
glTF sağ elli Y-up koordinat sistemini kullanır, COL
MAP/3DGS Y-down/Z-ileri çalışır. Bu yüzden dışa 
aktarıcı X ekseninde 180 derece dönüş uygular — 
konumlar (x, -y, -z)  ile yeniden yazılır, dörtlüler 
(w, x, -y, -z) ’ye uyarlanır. Bu, glTF görüntüleyi

cilerinde geometrik olarak doğru, ellerle uyumlu (ay
na ters değil) bir temsil sağlar. JSON ve ikili parçalar 
GLB standardının gerektirdiği gibi 4 bayt hizalamaya 
doldurulur.

K I S ACA

Khronos’un 3D veriler için res­
mi standart biçimi, Gaussian 
splat’ları için yeni uzantıda. 
Avantaj: glTF tüm büyük 3D 
motorlarda yaygındır (Babylon.js, 
Three.js, Unity, Unreal). Dezavan­
taj: Uzantı 2026′da hâlâ taslak 
aşamasındadır, çoğu görüntüle­
yici henüz kullanamaz. Özellikle 
mevcut bir glTF pipeline’ına splat 
verisi entegre etmek veya zaten 
glTF yetenekli bir görüntüleyici 
yazıyorsan anlamlıdır.
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E6 — Splat (.splat)

N E R E D E

Menü çubuğu → Export → 3D Formats → Export .sp
lat…. Simple modu: „.splat“ biçim kartı. Boyut: Ga
ussian başına tam olarak 32 bayt. Şununla uyumlu: 
gsplat.js, web tabanlı görüntüleyiciler (antimatter15 
referansı), çoğu tarayıcı 3DGS demosu.

T E K N İ K

antimatter15 .splat  biçimi — Gaussian başına 32 
bayt, başlık yok, dolaylama yok. Girdi başına dü
zen: 3 × float32 konum (dünya koordinatları), 3 × 
float32 ölçek (iç buffer’ın log-uzayından exp ile dö
nüştürülmüş), 4 × uint8 RGBA renk (DC-SH katsayı
sı SH_C0 = 0.282...  ile ölçeklenmiş ve [0,255]‘e 
sıkıştırılmış), 4 × uint8 dörtlü (w,x,y,z, normalize 
edilmiş ve bayt aralığına 128 + 128*q  olarak kod
lanmış). Yalnızca DC-SH saklanır — daha yüksek SH 
bantları atılır. Bu, biçimi son derece kompakt yapar, 
ama yansımalarda veya speküler vurgularda ortaya 
çıkan görünüm bağımlı renk değişikliklerine mal olur. 
Yazma sırası tam olarak bulutun indeks sırasıdır 
(uzaysal sıralama yok); gsplat.js  gibi web görün
tüleyicileri bu varsayımdan yola çıkarak render eder.

K I S ACA

Splat’ı gsplat.js  ile kendi 
web görüntüleyicinde göstermek 
istiyorsan tercih edilen biçim. 
Çok kompakt (Gaussian başına 
32 bayt), ama daha yüksek SH 
derecesi yok — yani bakış açısı­
na göre parlak yansımalar veya 
ince renk değişiklikleri yok. Çoğu 
web uygulaması için sorun değil, 
çünkü DC renk tamamen yeterli 
ve eksik görünüm bağımlılığı pek 
dikkat çekmez.
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Şekil 31:  Firefox’ta açık Web Viewer — etrafında kamera işaretleri kürelerle render edilmiş 
çiçek demeti splat’ı, üstte tarayıcı sekme çubuğu görünür, CDN/sunucu kurulumu gerekmez. 
Bağımsız flowers-01.html  doğrudan Finder’dan çift tıklamayla varsayılan tarayıcıda 

açıldı — gömülü WebGL2 programı Gaussian bulutunu ağ veya sunucu olmadan hemen 
render eder. Çiçek demeti etrafındaki siyah işaretler eğitim kameralarıdır, isteğe bağlı olarak 

gösterilebilir. Fare sürükle döndürür, kaydırma yakınlaştırır.
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E7 — Web Viewer (.html)

N E R E D E

Menü çubuğu → Export → Media → Export Web 
Viewer…. Simple modu: „Web Viewer“ biçim kartı. 
Boyut: base64 kodlu splat verisi (≈ 4/3 ek yük) + 
yaklaşık 5 KB HTML/JS kabuğu. Şununla uyumlu: 
WebGL2′li herhangi modern tarayıcı (tüm masaüst
leri, iOS 15+, Android 5+).

T E K N İ K

Gaussian bulutunu tamamen satır içi yazılmış bir 
WebGL2 render’cıyla tek bir .html  dosyasında 
paketler. CDN bağımlılığı yok, WASM yok, ikinci 
dosya yok. Bulut önce dahili olarak .splat  ikili 
olarak kodlanır (E6 ile aynı 32 bayt mantığı), sonra 
base64 gömülür, sonra tarayıcıda atob  ile çözülür. 
Yerleşik render’cı kendi WebGL2 sıralamasını, fare 
orbit kontrolünü ve kare başına CPU sıralamasını 
yapar; tüm JS kodu (shader’lar, matematik, dön
gü) çıktı HTML’de görülebilir. Depolama-render’cı 
sınırındaki eksen kuralı E5′tekiyle aynıdır: Konum 
(x, -y, -z) , dörtlü (w, x, -y, -z) . İsteğe bağlı 

bir markalama bindirmesi gösterilebilir (ücretsiz kat
man anahtarı). Her şey satır içi olduğundan dosya 
file:/​/​ protokolünden doğrudan da çalışır — test 
için yerel web sunucusuna gerek yoktur.

K I S ACA

Birine e-postayla gönderebilece­
ğin ya da bir web sayfasına gö­
mebileceğin tek bir HTML dosya­
sı. Finder’da çift tıkla, tarayıcı 
sahneni fare döndürmesiyle gös­
terir. Buluta yükleme gerekmez, 
ikinci dosya yok, sunucu yok. 
Müşteri sunumları, portfolyo, e-
posta ekleri için idealdir. Deza­
vantaj: dosya base64 kodlama 
nedeniyle saf .splat ’tan yak­
laşık üçte bir daha büyük olur — 
bu yüzden çok büyük sahneler­
de .splat  dosyasının standart 
bir görüntüleyiciyle ayrı barındı­
rılması zahmete değer.
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Şekil 32:  flowers-01.mp4′ten çıkarılan tek kare — profil render’ında çiçek demeti, kamera 
işaretleri görünür beyaz platform, siyah arka plan (varsayılan görüntüleyici arka planı, 

Ayarlar’da değiştirilebilir). Kamera sahnenin etrafında parametrik bir yörüngede döner (yük­
seklik

1. mesafe sabit, yaw döner), tipik süre 30 veya 60 fps’de 6–10

saniye. Kare çözünürlüğü VideoPreset üzerinden 480p’den 8K’ya ölçeklenebilir.
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E8 — Orbit Video (.mp4/.mov)

N E R E D E

Menü çubuğu → Viewport → Record Turntable Video 
VEYA Menü çubuğu → Export → Media → Export 
Orbit Video…. Simple modu: 3–30 sn süre kaydı
rıcısıyla „Orbit Video“ biçim kartı. Boyut: süreye, 
çözünürlüğe, bit hızına bağlı. Şununla uyumlu: tüm 
platformlar (H.264 ve HEVC Apple standardıdır).

T E K N İ K

Gaussian bulutunu bir parametrik orbit kamera çe
kimi boyunca render eder ve her kareyi AVAsse
tWriter üzerinden bir MP4 veya MOV dosyasına 
kodlar. Orbit yapılandırması dönüş hızını (devirler), 
mesafeyi, yüksekliği, FOV’yu, süreyi ve ease-in/
out faktörünü kontrol eder. Orbit-video dışa ak
tarması, tam SH değerlendirmesiyle RadianceKit’in 
KENDİ ForwardPass’i üzerinden çalışır — uygulama 
içi görüntüleyiciyle piksel düzeyinde aynıdır (WYSI
WYG). Kare başına dünya uyum matrisi (render’cı 
tarafından dahili koordinatları Y-up orbit dünyası
na döndürmek için hesaplanır) kamera ile çarpılır, 
ardından bir kamera kuralı dönüşü (camFlip: orbit 
Y-up → COLMAP Y-down) uygulanır. Ekran dışı ren
der hedefi IOSurface üzerinden kodlayıcı için bir 
CVPixelBuffer’a çekilir. Kodlayıcı H.264 ve HEVC, 
yapılandırılabilir bit hızı ve 480p’den 8K’ya çözünür
lük destekler. İlk kareden önce render’cı 200 ms 
bekler, böylece ilk splat sıralaması tamamlanır. Bu 
dışa aktarma GPU bağlıdır — 8K ve milyonlarca 
Gaussian’da kare başına render süresi birkaç sani
yedir; yani 6 sn’lik video için 10–30 dakika toplam 
render süresi mümkündür.

K I S ACA

Sahnen etrafında bir dönüşle 
hazır bir MP4 dosyası. Sosyal 
medya, pazarlama, sunumlar için 
mükemmel. Süreyi (3–30 sani­
ye), dönüş yönünü ve hızı ayar­
layabilirsin. Dosya YouTube’a, 
Instagram’a, PowerPoint’e ve her 
yere doğrudan gömülebilir. Ba­
zen yavaştır, çünkü uygulama her 
kareyi tamamen render etmek 
zorundadır — 8K video için Gaus­
sian sayısına bağlı olarak beş ile 
otuz dakika planlayabilirsin.

195 / 231



R A D I A N C E K I T Bölüm 8 — Dışa Aktarma Biçimleri

E9 — SfM Transforms (transforms.json)

N E R E D E

Menü çubuğu → Export → Photogrammetry → Ex
port SfM (transforms.json)…. Boyut: tipik 1–10 KB 
(yalnızca pozlar + intrinsikler, görüntü yok, Gaussian 
yok). Şununla uyumlu: nerfstudio, Brush, gsplat, 
OpenSplat, Meshroom, tüm modern feed-forward 
3DGS eğiticileri.

T E K N İ K

Kamera pozları listesi artı paylaşılan intrinsiklerle 
nerfstudio transforms.json  biçimini yazar. Kamera 
başına view matrisi (RadianceKit içi: COLMAP kura
lında World-to-Camera) ters çevrilir, ardından kame
ra yerel Y ve Z taban vektörleri nerfstudio kuralına 
dönüştürülmek için yansıtılır (OpenGL stili, kamera 
-Z  boyunca bakar, +Y  yukarıdır). Son 4×4 matris 

her karenin transform_matrix  alanına çift sayıdan 
oluşan satır büyük iç içe dizi olarak yerleşir. Intrin
sikler üst düzeyde saklanır (odak uzaklığı x/y, ana 
nokta x/y, görüntü genişliği/yüksekliği, camera_​model 
=

"OPENCV", artı bozulma katsayıları k1, k2, p1, p2 ) 
— dışa aktarıcı birden çok farklı intrinsik seti algı
larsa kare başına yazılır. Görüntü yolları JSON dos
yasına göre images/​<filename> olarak yazılır; kulla
nıcı eğitim fotoğraflarıyla bir kardeş images/​ klasörü 
oluşturmalıdır.

K I S ACA

Bu JSON dosyası her fotoğraf 
için kameranın nerede durduğu­
nu ve nereye baktığını tanımlar. 
Dosya tek başına küçük ve kul­
lanışsızdır — orijinal görüntüler­
le birlikte bir klasörde kullanılır. 
Nerfstudio, Brush ve birkaç baş­
ka eğitici tam olarak bu biçimi 
okur ve onunla RadianceKit SfM 
sonuçlarını orada kamera yeni­
den yapılandırma yeniden hesap­
lanmak zorunda kalmadan başka 
bir araca aktarabilirsin. Büyük 
sahnelerde saatler kazandırır.
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E10 — COLMAP Workspace (sparse/0/)

N E R E D E

Menü çubuğu → Export → Photogrammetry → Ex
port SfM (COLMAP Workspace)…. Boyut: üç ikili 
dosya birlikte tipik 4–8 MB — points3D.bin  bas
kındır (seyrek bulutun 3B noktası başına bir satır), 
images.bin  ve cameras.bin  her biri 100 KB’nin 

oldukça altındadır. Şununla uyumlu: COLMAP’in 
kendisi, Nerfstudio, Postshot, Meshroom, bir COL
MAP sparse/​ dizini bekleyen tüm araçlar.

T E K N İ K

Üç ikili dosyayla standart COLMAP sparse/​
0/​ düzenini yazar: cameras.bin , images.bin , 
points3D.bin . Biçim referansı resmi COLMAP bel

geleridir. cameras.bin  tekilleştirilmiş intrinsik liste
sini içerir (aynı intrinsiklere ve görüntü boyutuna 
sahip kameralar tek bir girdiye birleştirilir); kullanılan 
kamera modeli OPENCV  (Model 4), fx/fy/cx/cy artı 
dört bozulma katsayısı k1/k2/p1/p2 ile. images.bin  
görüntü başına pozu wxyz  dörtlü artı çeviri olarak, 
ardından kamera kimliği ve dosya adıyla listeler; 
2D-3D karşılıkları saklanmaz. points3D.bin  SfM 
nokta bulutunu konum, renk (0-255 RGB) ve yeni
den projeksiyon ile track uzunluğu için varsayılan 
değerlerle içerir. Her şey little-endian olarak yazılır. 
RadianceKit’e yeniden içe aktarma File menüsü → 
„Import COLMAP/Metashape Workspace…“ üzerin
den çalışır (SfM Arka Uç bölümünde bkz. Q3).

K I S ACA

Resmi COLMAP biçimi. Eğitimini 
Postshot, Nerfstudio veya baş­
ka bir COLMAP yetenekli yazı­
lımda sürdürmek istiyorsan yol 
budur. Üç küçük dosya artı ori­
jinal görüntülerin ve hedef prog­
ram bunu sanki COLMAP’in ken­
disi kaynak programmış gibi ka­
bul eder. transforms.json biçimi­
ne (E9) göre daha çok program 
bunu anlar; aynı zamanda metin 
tabanlı yerine ikili olduğu için bi­
raz daha az pratiktir.
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Hangi biçim ne zaman?

Hedef Biçim

Kendi sitende web görüntüleyici E7 Web Viewer (.html)

gsplat.js  ile web görüntüleyici E6 Splat (.splat)

Postshot / Nerfstudio’da pipeline ye
niden kullanımı

E9 transforms.json + E10 COLMAP Workspace

SuperSplat düzenleme E1 PLY veya E2 Compressed PLY

Niantic Scaniverse / Spatial Fields E3 SPZ

Maksimum sıkıştırma E4 SOG (cwebp gerekli)

Pazarlama/sosyal video E8 Orbit Video
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Hızlı karşılaştırma

Biçim Uzantı Sandbox Boyut (1M Gauss) En iyi kul­
lanım

E1 PLY .ply evet ~250 MB Arşiv, en 
yüksek 

uyumluluk

E2 
Comp
ressed 

PLY

.ply evet ~40 MB Web + Su
perSplat

E3 SPZ .spz evet (gzip 
spawn)

~40 MB Niantic + 
Mobil

E4 SOG .sog koşullu 
(cwebp)

~20 MB Maksimum 
sıkıştırma

E5 glTF .glb evet ~250 MB Khronos pi
peline

E6 Splat .splat evet ~32 MB gsplat.js 
web görün

tüleyici

E7 Web 
Viewer

.html evet ~45 MB Bağım
sız tarayıcı 

dosyası

E8 Orbit 
Video

.mp4 / .mov evet değişken Sosyal/Pa
zarlama

E9 SfM 
Trans
forms

.json evet ~5 KB Poz aktarımı

E10 
COLMAP 
Works
pace

Dizin evet ~4–8 MB Poz aktarımı 
ikili

Boyut sütunu SH derecesi 3 ile 1 Mln Gaussian için kabaca yön göstericidir. Gerçek de
ğerler sahnenin sıkıştırılabilirliğine göre değişir; SH derecesi 0, PLY/glTF’yi 4 kat azaltır.
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B Ö L Ü M

Bölüm 9 — SfM Arka Uçları

Şekil 33:  Inspector’da Camera Alignment seçici ile Uzman modu (Apple Photogrammetry / 
Native (Beta))

Şekil 34:  Native (Beta) etkin Inspector — Camera Alignment seçicide ikinci seçenek seçili, 
diğer tüm eğitim yapılandırma parametreleri değişmemiş

RESIMDE NE GÖRÜNDÜĞÜ  Inspector’daki Camera Alignment seçici iki seçeneği olan bir 
segmented control’dür — Apple Photogrammetry (App Store yapımları için varsayılan, 
tam sandbox uyumlu) ve Native (Beta) (RadianceKit’in kendi FAST+BRIEF+GLOMAP-
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pipeline arka ucu, Faz 3.8/3.9 sırasında geliştirildi, 2026-05 durumu). Native (Beta) 
yalnızca orbit modunda doğrulanmıştır ve ≥1 000 kare için Apple Photogrammetry’den 
daha hızlıdır, ancak henüz Faz-3 §5 kalite kapısını (finalLoss ≤ 0.0115) karşılamaz — bu 
yüzden Beta etiketi var. Metashape, COLMAP veya başka bir fotogrametri yazılımından 
gelen harici SfM sonuçları ayrıca File menüsünden içe aktarılabilir (Q3 COLMAP metin 
biçimi, Q6 Workspace içe aktarma) — seçici değişmez, ama içe aktarılan pozlar SfM 
sonucunun yerini alır.

SfM, Structure from Motion anlamına gelir. Bir dizi örtüşen fotoğraftan yola çıkarak ya
zılım, her görüntü için kameranın ortak bir 3B koordinat sisteminde konumunu ve bakış 
yönünü yeniden yapılandırır. Bu süreçte, Gaussian Splatting eğitimini başlatan kabaca 
bir 3B nokta bulutu üretilir. SfM sonucu, asıl eğitimin girdisidir ve sonraki görüntü kalite
sini belirleyici biçimde etkiler.

RadianceKit beş SfM yolu sunar: uygulamaya yerleşik iki arka uç (Q1 Apple Photogram
metry, Q4/Q5 Native), harici araçlardan iki içe aktarma yolu (Q3 COLMAP metin biçimi, 
Q6 ikili Workspace içe aktarma) ve yalnızca App Store dışındaki geliştirici yapılarında 
kullanılabilen Q2 COLMAP ikili. Hangisinin doğru olduğu, sahne tipine (nesne etrafında 
orbit, iç mekân, dron uçuşu) ve harici bir yazılımın halihazırda yeniden yapılandırma 
sunup sunmadığına bağlıdır.

Q1 — Apple Photogrammetry

N E R E D E

Expert View → Inspector → Eğitim yapılandırması → 
Camera Alignment seçici, „Apple Photogrammetry“ 
girdisi.

T E K N İ K

Apple’ın aslen Object Capture için geliştirdiği yerle
şik fotogrametri çatısını sarar. Apple içeride özel bir 
pipeline ile özellikleri çıkarır (adımlar kamuya açık 
biçimde belgelenmemiştir), bunları çok görünümlü 
eşleştirmeyle doğrular ve bundle adjustment’i Apple 
Silicon Neural Engine + GPU üzerinde çözer. Arka 
uç tamamen App Store uyumludur (harici ikili yok, 
Sandbox=true, cihaz üzerinde), ama yalnızca kame
ra pozlarını ve kabaca bir nokta bulutu sağlar — 
track uzunluğu ya da yeniden projeksiyon hatası gibi 
tanı metrikleri yoktur. Apple’ın önerisine göre birkaç 
yüz görüntüye kadar ölçeklenir. Doğrusal dron uçuş
larında veya büyük dış mekân sahnelerinde ~500 
kareden fazla olduğunda yeniden üretilebilir çökme
ler veya tekil kameraların sessizce atılması gözlen
miştir.

K I S ACA

Bu en kolay yol. Görüntüleri ver, 
uygulama hesaplasın. Klasik nes­
ne taramalarında çok iyi çalışır 
— bir mobilya parçası ya da hey­
kelin etrafında gezinip 50–200 
fotoğraf çektiğinde. Manzaralar 
üzerindeki dron uçuşlarında ve­
ya çok fazla görüntüde (500′ün 
üstünde) ise Apple’ın yöntemi 
kararsızlaşmaya başlar. Bu tür 
sahnelerde Native arka ucunu 
(Q4/Q5) dene ya da kameraları 
Metashape’te hesapla ve Works­
pace içe aktarma (Q6) yoluyla 
yükle.
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P OW E R - U S E R

Q2 COLMAP ikili — harici COLMAP programını alt süreç olarak başlatır ve bu ne
denle App Store sürümünde (sandbox) kullanılamaz. Yalnızca App Store dışındaki 
geliştirici yapılarında çalışır. COLMAP’in sunduğu kalite için App Store sürümünde 
Workspace içe aktarma (Q3 veya Q6) vardır: SfM’yi COLMAP veya Metashape’te 
dışarıda hesapla ve sonucu yükle.

Q3 — COLMAP Metin Biçimi (Metashape / ETH3D)

N E R E D E

„File → Import COLMAP / Metashape Works
pace…“ (Cmd+⇧+I) menüsü VEYA sparse/​0/​
cameras.txt içeren bir klasörü sürükle bırak.

T E K N İ K

Standartlaştırılmış COLMAP metin dışa aktarmasını 
okur — sparse/​0/​ alt klasöründeki üç metin dosyası 
cameras.txt , images.txt , points3D.txt  — ve 

dahili SfM sonucu modeline dönüştürür. COLMAP 
ikili dışa aktarmasıyla aynı biçim tanımı, sadece 
ikili yerine ASCII. Agisoft Metashape, RealityCap
ture, PolyCam ve ETH3D benchmark’ı tam olarak 
bu düzende dışa aktarır. Ayrıştırıcı, kamera mode
li tanımayı ikili ayrıştırıcıyla paylaşır (tüm yaygın 
modeller: SIMPLE_PINHOLE, PINHOLE, OPENCV, 
OPENCV_FISHEYE, FULL_OPENCV). Yorum satırları
na ve boş satırlara karşı dayanıklıdır. Testlerde ~1 
400 kameraya kadar (ETH3D Tunnel) sorunsuz öl
çeklenir.

K I S ACA

Daha önce Metashape, Reality­
Capture veya başka bir tica­
ri foto-3D yazılımıyla çalıştıy­
san ve sonucu dışa aktardıy­
san — bu dışa aktarmayı uy­
gulamanın yeniden hesaplama­
sına gerek kalmadan doğrudan 
RadianceKit’e yükleyebilirsin. Bu, 
saatlerce bekleme süresinden ta­
sarruf sağlar. Tüm klasörü File 
menüsünden yükle ya da pence­
reye sürükle.
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Q4 — Native SfM (artımlı)

N E R E D E

Expert View → Inspector → Eğitim yapılandırması 
→ Camera Alignment seçici, „Native (Beta)“ gir
disi. Artımlı bu arka ucun varsayılan modudur — 
Inspector’da ayrı bir mapper seçici yoktur. CLI 
üzerinden mod açıkça --native-sfm  veya --sfm-
mapper incremental ile ayarlanabilir.

T E K N İ K

Tüm SfM pipeline’ının kendi GPU hızlandırmalı uygu
laması: FAST+BRIEF özellikleri YA DA CoreML üze
rinden SuperPoint+LightGlue ( --coreml-features  
ile), ardından Hamming-KNN eşleştirme, RANSAC 
temel matrisi, track oluşturma, başlangıç çifti seçi
mi, iki görünümlü bootstrap (F→E artı DLT), PnP 
kaydı ve çok görünümlü üçgenleme ile açgözlü ar
tımlı mapper ve Huber kaybı ile Schur-indirgenmiş 
Levenberg-Marquardt ve Cholesky çözümü üzerin
den analitik Jacobian’lar ile son bundle adjustment. 
Tamamen App Store uyumlu: harici ikili yok, Sand
box=true. Faz 3.10′da gönderilen R2 çökme dedek
törü ile: uygulama girdi karelerinin %60′ından azını 
kaydederse veya kamera başına nokta oranı 13′ün 
altına düşerse, otomatik olarak global mapper’a 
(Q5) geçilir. Orbit/turntable sahnelerinde ampirik 
olarak temiz; daha genel hareketlerde (dron uçuşu, 
karmaşık geometrili iç mekânlar) başarı oranı daha 
düşüktür — ama dedektör bu durumları yakalar. 
Güvenilir biçimde ~200 kameraya kadar ölçeklenir, 
daha fazlası belirgin biçimde daha uzun çalışma sü
resiyle olur.

K I S ACA

Apple’ın güçlü yönleri (App Sto­
re uyumlu, orbitler için hızlı) ve 
ek tanı değerleri. Object Capture 
için olduğu gibi bir konunun et­
rafında dolaştığında özellikle iyi 
çalışır. Daha karmaşık çekimler­
de (dron uçuşu ya da oturma 
odası) RadianceKit bunun yürü­
meyeceğini otomatik algılar ve 
global yönteme atlar. „Beta“ eti­
ketli çünkü hâlâ deneme aşama­
sında — standart öneri basit 
nesne taramaları için Apple Pho­
togrammetry ve zorlu dış mekân 
setleri için Workspace içe aktar­
ma (Q3 veya Q6) olmaya devam 
ediyor.
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Q5 — Native SfM (global)

N E R E D E

Artımlı mapper (Q4) çökme dedektörünü tetikledi
ğinde (girdi karelerinin %60′ından azı kaydedildi 
veya kamera başına nokta oranı 13′ün altında) oto
matik olarak çağrılır. Yalnızca CLI ile --sfm-mapper 
global üzerinden zorla başlatılabilir. Inspector’da 
global yöntem ayrı bir seçici aracılığıyla erişilebilir 
değildir — uygulama ne zaman geçeceğine kendi 
karar verir.

T E K N İ K

Yerel pipeline’ın global varyantı. Önce Q4 gibi özel
lik çıkarma + eşleştirme, ardından tüm doğrulanmış 
çiftler için göreli poz tahmini, ardından rotation ave
raging (tüm kamera dönüşlerini dünya koordinat sis
teminde senkronize eder) ve translation averaging 
(büyük kamera sayılarında tamsayı taşmasını önle
mek için matrissiz seyrek bir formülasyon üzerinde 
LSQR tabanlı). Prensipte ~5 000 kameraya kadar 
ölçeklenir, pratikte birkaç yüz kameranın üzerinde 
kalite düşer — K-1351′de Faz 3.8 §5 kabul kapısı öl
çümü, hedeflenen 0.0115 yerine finalLoss 0.07 verdi. 
„Fallback tier“ olarak ele alınır: artımlı mapper bo
zulduğunda devreye girer, ama kendisi tekrar kalite 
açısından kontrol edilmez.

K I S ACA

Native motor için B planı yolu. 
Daha hızlı artımlı yol başarısız ol­
duğunda otomatik olarak çağrılır. 
Kullanılabilir bir sonuç verir, an­
cak çok büyük veya zor sahneler­
de genellikle Metashape’ten ya 
da harici bir COLMAP kurulumun­
dan aldığın kadar hassas değildir. 
Native standart iş akışın olursa, 
bu gibi durumlarda Workspace 
içe aktarma (Q3 veya Q6) üzerin­
den gitmek zahmete değer.
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Q6 — Metashape / COLMAP-Metin Workspace İçe Aktarma (Faz Q7)

N E R E D E

File menüsü → „Import COLMAP / Metasha
pe Workspace…“ (Cmd+⇧+I). sparse/​0/​cameras.
{bin,txt} ve images/​ içeren bir klasörü sürükle bı
rak.

T E K N İ K

Sürükle-bırak veya Open Panel ile seçilen bir kla
sörün üç COLMAP workspace düzeninden birine 
(sparse/​0/​, sparse/​ veya kök) uyup uymadığını ve 
yeniden yapılandırmanın ikili ( cameras.bin ) mı me
tin ( cameras.txt ) mi olduğunu otomatik algılar. İkili 
yol COLMAP ikili ayrıştırıcısını, metin yolu ETH3D 
yükleyicisini kullanır — her ikisi de aynı SfM sonucu 
modelini üretir ve pipeline’ın geri kalanı (görüntüle
ri içe aktarma, MCMC eğitimini başlatma) kaynağa 
karşı agnostiktir. Görüntüler uygulama sandbox bo
okmark sistemi üzerinden güvenlik kapsamlı (secu
rity-scoped) açılır, böylece içe aktarma App Store 
sürümünde de çalışır. Özellikle „Metashape dışa ak
tarmayı yeniden yapılandırmayı yeniden hesaplama
dan kullan“ durumu için tasarlanmıştır. File menüsü 
girdisinde bahsedilen tanıma, seçilen klasör tanına
bilir bir workspace değilse uygulama günlüğünde 
uyarır.

K I S ACA

Özellikle Metashape kullanıcı iş­
levi. Metashape veya RealityCap­
ture lisansın varsa ve kamera ye­
niden yapılandırmayı orada yap­
tıysan, dışa aktarma klasörünü 
buraya sürükleyip hemen eğiti­
me başlayabilirsin. Büyük sahne­
lerde birkaç saatlik hesaplama 
süresinden tasarruf ettirir, çünkü 
RadianceKit o zaman SfM’yi ken­
disi yapmaz.
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Hangi arka uç ne zaman?

Senaryo Önerilen arka uç

Nesne taraması, 50–200 
fotoğraf

Q1 Apple Photogrammetry

Büyük dış mekân / dron / 
>500 görüntü

Q6 Workspace içe aktarma (Metashape veya COLMAP’te 
hesapla, sonra yükle)

Metashape/RealityCapture 
dışa aktarması mevcut

Q6 İçe aktarma (SfM gerekmez)

ETH3D / akademik COL
MAP metin seti

Q3 COLMAP metin içe aktarma

Sıkı App Store uyumlu + 
orbit sahne

Q4 Native artımlı

Q4 başarısız oluyor Q5 Native global (otomatik)

ETH3D benchmark verileri Q3 (autotest precomputed)

Hızlı karşılaştırma

Arka uç App Store Sand­
box

Harici ikili En iyi 
kullanım

Maks 
~cam

Q1 Apple 
PG

✅ ✅ — Orbit-Nes
ne

~300

Q2 COL
MAP İkili

❌ (sade
ce geliştirici 

yapı)

— colmap/glomap Büyük dış 
mekân

~5 000

Q3 COL
MAP-

Metin içe 
aktarma

✅ ✅ — Bench rig ~1 500

Q4 Nati
ve artımlı

✅ ✅ — Orbit-Nes
ne

~200

Q5 Nati
ve global

✅ ✅ — Q4 fall
back

~1 351

Q6 
Works

pace içe 
aktarma

✅ ✅ — Metasha
pe yeniden 
kullanımı

kaynağa gö
re
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B Ö L Ü M

Bölüm 10 — Başlangıç Modu

Başlangıç Modu (İng. Simple Mode, Cmd+1) ilk kez bir 3D Gaussian Splatting sahnesi 
yeniden yapılandıran herkes için rehberli iş akışıdır. Inspector alanlarıyla dolu bir kenar 
çubuğu göstermek yerine, uygulama dört adımdan geçirir: önce görüntüler veya bir 
video içe aktar ve bir kalite önayarı seç, sonra işleme çalışır (SfM + Eğitim), ardından 
bitmiş sahne bir 3D önizlemede incelenebilir ve sonunda istenilen biçime dışa aktarılır. 
Pencere kenarındaki dar bir ilerleme çubuğu her an hangi adımda olduğunu gösterir.

Tüm kontrol alanlarını aynı anda gösteren Expert moduyla (Cmd+2) karşılaştırıldığında, 
Başlangıç modu kullanılmayan seçenekleri gizler, çok az veya kötü görüntülerde doğru
lama uyarıları verir ve her adımda yalnızca mevcut durumda anlamlı olan düğmeleri 
sunar. İstediğin zaman Başlangıç ve Expert modları arasında geçebilirsin (Cmd+1 / 
Cmd+2); tüm durum — içe aktarılan görüntüler, seçilen önayar, şu anda çalışan eğitim, 
biten nokta bulutu — korunur ve diğer modda hemen kullanılabilir.

Z1 — İçe Aktarma (Görüntüler ve Önayar seç)

Şekil 35:  Simple modu adım 1 — görüntü içe aktarmadan önce boş bırakma bölgesi, üstte 
ekmek kırıntısı (Import → Frame Quality → Cameras → Training → Preview → Export), biçim 

hapları JPG/PNG/TIFF/HEIC/MP4/MOV/PLY/SPZ/SPLAT/SCENE/COLMAP

RESIMDE NE GÖRÜNDÜĞÜ  Ekmek kırıntısı (Import aktif) dört adımlı iş akışını gösterir. Sol 
bırakma bölgesi üç CTA ile: „Browse Files“ (NSOpenPanel), „Try Sample Scene” (paket 
halinde demo), „Download Sample Photos (~427 MB)“ (Mip-NeRF360 flowers alt küme
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si). Altındaki biçim hapları tüm kabul edilen dosya tiplerini listeler. Sağda „Imported 
Files” sayacıyla „0 images“ ve boş durum „No files imported yet”. Altta Kalite seçici 
(Varsayılan: Preview) ve „Start Processing“ (görüntü yokken devre dışı).

İlk adım, uygulamaya görüntü materyali vermektir. Ortadaki büyük kesik kenarlı alana 
sürükle bırakla, „Browse Files“ düğmesiyle veya gelen örnek sahneye tıklayarak. Sağda 
içe aktarılan tüm görüntülerin çözünürlük ve dosya boyutuyla bir listesi görünür; altta 
yüzen araç çubuğunda kalite önayarını seçer ve „Start Processing” ile pipeline’ı başla
tırsın. Doğrulama uyarıları (< 3 veya < 10 görüntüde kırmızı, 10–19′da turuncu) uygula
manın anlamlı bir yeniden yapılandırma beklediğini veya beklemediğini gösterir.

C-01 ProgressIndicator (Adım göstergesi)

N E R E D E

İş akışının üstünde, her zaman görünür.

T E K N İ K

Aşama tahsisi ile tüm pipeline (Frame-Quality → 
SfM → Training) üzerinde yatay bir ilerleme çubu
ğu gösterir: Frame-Quality %0–5′i kaplar (Faz 3.11, 
çok kısa), SfM çubuğun %0–30′unu, Training %30–
100′ünü kaplar. Yanında durum metni ve faz adlı 
yüzde gösterimi („SfM %41″, „Training 12 500/20 
000″), böylece kullanıcılar görünen geri adımı „%41 
SfM → %25 Training“ hata olarak okumasın — çu
buk tüm pipeline ilerlemesini gösterir, alt aşamayı 
değil. ETA hesabı yeterli eğitim hızı ölçüldüğünde 
(genellikle ilk 100 iterasyondan sonra) başlar. Aynı 
gösterim Expert modunda da Inspector’ın üzerinde 
kullanılır.

K I S ACA

En üstteki dar çubuk iş akışı 
boyunca haritandır. Yalnızca uy­
gulamanın şu anda ne yaptığını 
(kameraları hizalama, eğitim ça­
lışıyor, …) değil, aynı zamanda 
toplamda ne kadar ilerlediğini 
de söyler. Bölünme bilinçli ola­
rak öyledir ki kamera hesaplama 
çubuğun ilk üçte birini, asıl eği­
tim arka iki üçtebirini kaplar — 
aksi takdirde SfM’den sonra iler­
lemenin aniden sıfıra geri dön­
müş gibi görünürdü. Yani rahat­
ça arkana yaslanabilirsin, kabaca 
aşamayı görmek için çubuğa bir 
bakış yeterlidir. Yanındaki metin, 
sayıların kafa karıştırıcı görün­
memesi için şu anda SfM aşa­
masında mı (ör. „SfM %41″) yok­
sa eğitimde mi (ör. „Training 12 
500/20 000″) olduğunu söyler. 
ETA gösterilmiyorsa, eğitim he­
nüz çok gençtir — uygulama ye­
terli hız ölçtüğünde tahmin eder.
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C-03 DropZoneView (Sürükle bırak alanı)

N E R E D E

İçe aktarma adımının sol tarafı, simgeli büyük kesik 
kenarlı dikdörtgen. Başlangıç modunda „Drop pho
tos or a video here“ etiketiyle gösterilir.

T E K N İ K

Sürükle ögeleri alanın üzerinde dolaştığında simgeyi 
kısaca zıplatan ve arka planı renklendirilen bırak
ma alanı. JPG, PNG, TIFF, HEIC, MP4, MOV, PLY, 
SPZ, .splat, .radiancescene paketleri ve dizinleri 
kabul eder. Türe göre bırakma yönlendirmesi: görün
tüler toplanır ve sıralı olarak iletilir, videolar kare 
örnekleme yolunu tetikler, splat dosyaları doğrudan 
önizlemeyi açar, Sahne paketleri okunur. Dizinler 
numaralandırılır ve içerdiği tüm görüntüler içe akta
rılır. Sandbox uyumlu erişim için güvenlik kapsamlı 
bookmarklar doğru biçimde alınır ve serbest bırakı
lır. Desteklenmeyen uzantılar 5 saniye boyunca uyarı 
banner olarak gösterilir.

K I S ACA

Büyük kesik kenarlı alan ilk adı­
mın ana kontrolüdür. Sadece fo­
toğrafları veya bir videoyu, ya da 
tüm bir klasörü içine sürükle — 
uygulama tanıdığı her şeyi alır 
ve gerisini yok sayar. Alan ma­
vileşir ve simge kısaca zıplarsa, 
uygulama sürüklemeyi algılamış­
tır. Bırak ve içe aktarma hemen 
başlar: görüntüler sağdaki liste­
ye gider, videolar otomatik ola­
rak kare örnekleme adımını tetik­
ler ve zaten eğitilmiş .ply /
.spz / .splat  dosyaları doğ­

rudan önizlemeyi açar. Bir biçim 
hiç uymazsa (örneğin PDF veya 
BMP), üst kenarda kısa bir uyarı 
görünür — uygulama bilinmeyen 
materyali sessizce yutmaz.

C-05 Browse Files düğmesi

N E R E D E

Bırakma bölgesi içinde, belirgin düğme.

T E K N İ K

Çoklu seçim ve JPG, PNG, TIFF, MP4, MOV, klasörler 
ve uygulamanın kendi Sahne biçimiyle macOS dosya 
diyaloğunu açan düğme. Sonuç URL’leri güvenlik 
kapsamlıdır ve sürükle bırakla aynı içe aktarma yol
ları üzerinden iletilir. Kullanıcı bir klasör seçerse, 
o klasör görüntüler için özyinelemeli olarak numara
landırılır.

K I S ACA

Sürükle bırak rahatsız edici geli­
yorsa, basitçe bu düğmeye tıkla 
ve macOS dosya diyaloğunda fo­
toğraflarına git. Aynı anda birden 
çok dosya seçebilirsin (tekil gö­
rüntülere Cmd-tıklama) veya tüm 
bir klasör seçebilirsin — uygu­
lama klasörü sonra özyinelemeli 
olarak desteklenen tüm görün­
tü türleri için tarar. Çekimlerin 
alt klasörlerde iç içe yer aldı­
ğında (ör. „shoot-day1/“, „shoot-
day2/”) özellikle pratiktir — ana 
klasöre bir tıklama yeterlidir. İş­
levsel olarak düğme, sürükle bı­
rakın yaptığının aynısını yapar; 
sadece sana daha rahat olan yolu 
seç.
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C-06 Try Sample Scene düğmesi

N E R E D E

Bırakma bölgesi içinde, yalnızca uygulama paketi 
Sample Scene içerirse ve henüz görüntüler/splat’lar 
içe aktarılmamışsa görünür.

T E K N İ K

Yalnızca (a) uygulama paketinde bir 
sample-scene.splat , .spz  veya .ply  mevcutsa 

VE (b) henüz görüntüler/videolar içe aktarılmadıysa 
ve henüz nokta bulutu yoksa görünür. Tıklamada 
bitmiş nokta bulutunu yükler (tercihen en küçük bi
çim — .splat  ~3 MB, .spz  ~1.4 MB, geri dönüş 
.ply ) ve 400 ms sonra estetik olarak anlamlı bir 

giriş perspektifi için çiçek sahnesinin orijinal meta 
verilerinden sert kodlanmış kamera değerlerini ayar
lar.

K I S ACA

Uygulamayı ilk kez başlattığın­
da ve sonunda ne çıktığını ba­
sitçe görmek istediğinde — bu­
raya tıkla. Uygulamanın hesapla­
ması gerekmeden hemen döndü­
rüp dışa aktarabileceğin önceden 
eğitilmiş bir çiçek sahnesi açar. 
Kamera estetik olarak anlamlı bir 
giriş perspektifine önceden ayar­
lanmıştır, böylece hemen güzel 
bir şey görürsün. Kendi çekim­
lerine gitmeden önce 3D kont­
rolünü ve dışa aktarma adımını 
risksiz denemek için mükemmel. 
Kendi görüntülerini içe aktarır 
aktarmaz düğme otomatik olarak 
kaybolur — yalnızca proje tama­
men boşken gösterilir.

C-07 Download Sample Photos düğmesi

N E R E D E

Bırakma bölgesi içinde, „Try Sample Scene“in yanın
da; aynı görünürlük koşulları.

T E K N İ K

Bir indirme tetikler (depo github.com/​bkindler/​
radiancekit-sample-photos), yaklaşık 427 MB 960 
tam çözünürlük karesi yükler ve uygulamaya bes
ler. İndirme sırasında düğme devre dışıdır. İlerleme 
üst ilerleme çubuğunda kendi aşamasında „Downlo
ading %X“ olarak görünür, çünkü bu aşama kendi 
%0–100 ölçeğini korur ve sonraki SfM aşamasıyla 
örtüşmez.

K I S ACA

Sample Scene gibi tam olarak, 
ama bitmiş sonuç yerine çı­
kış fotoğraflarıyla. Böylece tüm 
pipeline’ı kendin çalıştırabilir ve 
SfM ile eğitimin Mac’inde ger­
çekten ne kadar sürdüğünü göre­
bilirsin. İndirme büyük (yaklaşık 
yarım DVD = 427 MB), ama yalnız­
ca bir kez gerçekleşir — ardından 
fotoğraflar yereldir ve pipeline’ı 
farklı önayarlarla istediğin kadar 
sıklıkla yeniden başlatabilirsin. 
İndirme sürerken üst ilerleme çu­
buğu mevcut indirme durumunu 
yüzde olarak gösterir, böylece 
ne zaman başlayacağını tahmin 
edebilirsin. İpucu: bunun için en 
iyisi hızlı bir WLAN veya kablo ağı 
al — 427 MB aksi takdirde uzayıp 
gider.
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C-09 Kalite Önayarları seçici

N E R E D E

İçe aktarma bindirmesinin yüzen alt araç çubuğu, 
Start düğmesinin solunda.

T E K N İ K

„Quality“ etiketli kontrol, mevcut önayarları katego
riye göre gruplar (Classic / MCMC / Custom). Yerle
şik önayarlar kategoriye göre gruplandırılır; bölüm 
başlıkları sert kodlanmıştır. Özel önayarlar yalnızca 
varsa görünür. Kilitli durum: Free listesinde (Quick + 
Preview) olmayan önayarlar, kullanıcı satın almadıy

sa ad sonuna „🔒” eki alır; seçimde seçici Preview’a 
geri sıçrar ve otomatik olarak Purchase sheet’i açar. 
Seçimde önayar uygulanır, bu da tüm eğitim yapılan
dırmasını değiştirir.

K I S ACA

Burada uygulamanın ne kadar 
hassas ve ne kadar uzun he­
saplayacağını seçersin. „Quick“ 
ve „Preview” satın alma olma­
dan kullanılabilir ve birkaç dakika 
içinde ilk sonuç verir — görün­
tülerin genel olarak anlamlı olup 
olmadığını test etmek için ideal­
dir. „Balanced“ ve „Quality” tam 
sürüm gerektirir ve önemli ölçü­
de temiz modeller verir, karşılı­
ğında dakikalar yerine saatler sü­
rer. MCMC, daha az Gauss splat 
ile yetinen farklı bir stratejidir 
— daha sonra modeli kompakt 
olarak dışa aktarmak veya web’e 
koymak istiyorsan iyidir. Premi­
um önayarları adda küçük bir 
kilit sembolüyle tanırsın; lisans­
sız birine dokunduğunda seçici 
Preview’a geri sıçrar ve satın al­
ma sheet’i otomatik olarak açılır. 
Pratik kural: her zaman Preview 
ile başla, sonuca bak ve sonra 
daha uzun bir çalıştırmanın de­
ğer olup olmadığına karar ver.

C-10 Start Processing düğmesi

N E R E D E

İçe aktarma bindirmesinin yüzen alt araç çubuğu, 
önayar seçicinin sağında.

T E K N İ K

Ne görüntüler ne de bir video içe aktarılmadığı süre
ce gri kalan düğme. Tıklamada pipeline başlar ve 
aşama makinesini Frame-Quality → SfM → Training 
sırasına geçirir. Düğmenin kendisi başka bir duruma 
sahip değildir; çalışan bir işleme bunun yerine ayrı 
bir işleme ekranı olarak görünür.

K I S ACA

„Başlayalım“ düğmesi. Gri oldu­
ğu sürece hâlâ giriş görüntüleri 
veya bir video eksiktir. Fotoğraf­
ları içeri çektiğin anda etkin olur 
ve SfM ile eğitimi art arda başlat­
mak için tıklarsın. Bu noktadan 
itibaren uygulama tüm akışı dev­
ralır ve otomatik olarak işleme 
ekranına (Z2) düşersin. Başka bir 
şey tıklaman gerekmez — eği­
tim bittiğinde uygulama yeniden 
önizlemeye (Z3) geçer. Yine de 
fikrini değiştirirsen, daha sonra 
istediğin zaman Cancel ile iptal 
edebilirsin.
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C-11 Video Sampling kaydırıcı

N E R E D E

Sağdaki görüntü listesi, yalnızca bir video (görüntü 
yerine) içe aktarıldığında görünür.

T E K N İ K

0.5 fps – 30 fps arası 0.5′lik adımlarda kaydırıcı. De
ğişimde kare yoğunluğu güncellenir ve ek olarak he
def kare sayısı (en az 10) yoğunluk ve video uzunlu
ğundan hesaplanır. Liste ögeleri kaydırıcılardan fare 
olaylarını engelleyeceği için kaydırıcı görüntü listesi
nin dışındadır. Kaydırıcının altında hesaplanan hedef 
kareler („247 frames“) ve video uzunluğu („1m23s 
video”) yer alır. Tooltip uyarı: „Yoğunluğun iki katına 
çıkması, kare sayısının iki katına çıkmasına ve SfM 
süresinin yaklaşık %100 artmasına neden olur.“,

K I S ACA

Fotoğraflar yerine bir video içe 
aktardıysan, bu kaydırıcı uygula­
manın videodan kaç tek kare çı­
karacağına karar verir. Daha fazla 
görüntü = daha iyi kalite, ama 
doğrusal olarak daha fazla he­
saplama süresi. 30 saniyelik bir 
orbit video için 5 fps (150 görün­
tü) iyi bir başlangıç; 1 dakikalık 
çekimlerde sıklıkla 3 fps tama­
men yeterlidir. Kaydırıcının altın­
da uygulama mevcut ayarda kaç 
kare çıkacağını canlı gösterir — 
böylece 100–300 görüntülük an­
lamlı aralığa düşüp düşmediğini 
hemen görürsün. Sonuç kötü çı­
karsa kaydırıcıyı sağa çek ve tek­
rar dene; ama kare hızının iki 
katına çıkması SfM süresini de 
kabaca iki katına çıkarır.

C-12 Clear All düğmesi

N E R E D E

Sağdaki görüntü listesi, sağ altta; yalnızca görüntü
ler içe aktarılmışsa görünür.

T E K N İ K

Kırmızı düğme. Tıklama „Clear all imported files?“ 
başlıklı ve „N images will be removed.” mesajlı bir 
onay diyaloğunu açar. Onay tüm içe aktarılan görün
tüleri/videoları, staging dizinlerini, nokta bulutunu, 
eğitim durumunu, SfM sonucunu ve tüm önbel
lekleri temizler; aşama İçe Aktarma’ya geri sıçrar. 
Cancel’da her şey korunur. Diyalog yıkıcı olmayan 
varsayılan yol olarak yapılandırılmıştır (yıkıcı düğme 
kırmızı işaretli).

K I S ACA

Tamamen yeniden başlamak is­
tersen buraya tıkla. Silme, mev­
cut tüm içe aktarmaları, varsa 
zaten hesaplanmış kameralar ve 
eğitim sonuçları dahil attığı için 
onay sorusu görünür — geri ala­
mazsın. Seçilen görüntü mater­
yalini tamamen değiştirmek isti­
yorsan veya yenisini başlatma­
dan önce eski bir projeden kur­
tulmak istiyorsan anlamlıdır. Dik­
kat: tekil bir görüntüyü çıkarmak 
sağdaki liste üzerinden gider (bir 
sonraki maddeye bak), bu düğ­
me üzerinden değil. Diskinizdeki 
dosyalar bu sırada silinmez — 
uygulama yalnızca referanslarını 
unutur.
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C-13 File List ForEach (Tekil görüntü kaldırma)

N E R E D E

Sağdaki görüntü listesi, her girdi.

T E K N İ K

Silmek için kaydırma ile içe aktarılan görüntüler 
üzerinde liste. Görüntü başına simge, dosya adı, çö
zünürlük („1920 × 1080″) ve dosya boyutu (KB/MB 
olarak biçimlendirilmiş) ile bir satır. Çözünürlük, UI’yi 
engellememek için görüntü başlıklarından eşzaman
sız olarak doldurulan bir meta veri önbelleğinden 
gelir. Silme eylemi macOS tipik kaydırma ile silmeyi 
(bir satırda trackpad sola kaydırma) ve seçili satırda 
klavye Delete sunar. Not: Açık eksi düğmesi, Backs
pace ve geri almak için Cmd-Z ile genişletilmiş 
görüntü silme yolu yalnızca Expert modunda Project 
Navigator’a eklendi — Başlangıç modunda kaydırma 
ile silme kalır.

K I S ACA

Sağdaki liste her içe aktarılan gö­
rüntüyü çözünürlük ve dosya bo­
yutuyla gösterir — yüksek çözü­
nürlüklü ile düşük çözünürlüklü 
materyali karıştırmış olup olma­
dığını bir bakışta görmek için 
pratiktir. Tek bir görüntüyü çıkar­
mak için trackpad’de iki parmak­
la sola kaydır — iOS Mail’deki gibi 
— veya seç ve Delete’e bas. Uy­
gulama dosyayı kendisi silmez; 
sadece onu mevcut projeden çı­
karır. Gerçek bir eksi düğmesi 
veya Cmd-Z ile geri alma gereki­
yorsa Expert moda geç (Cmd+2), 
orada Project Navigator’da mev­
cuttur. Başlangıç modunda bi­
linçli olarak basit kaydırma dese­
nine kalır.

C-15 Doğrulama uyarıları (3 aşamalı katman)

N E R E D E

Görüntü listesinin altında, Clear All düğmesinin üs
tünde.

T E K N İ K

İçe aktarılan görüntü sayısına dayalı üç ardışık eşik 
(yalnızca görüntüler mevcut ve video yokken etkin): 
- < 3 görüntü: kırmızı banner (kırmızı sekizgen), 
metin „At least 3 images are required. Camera align
ment cannot be computed from fewer images.“ - 
3–9 görüntü: kırmızı banner, metin „With fewer than 
10 images, SfM often fails and the trained scene 
tends to overfit […]. 15–20 images minimum recom
mended; 30+ for object captures.” - 10–19 görüntü: 
turuncu banner (uyarı üçgeni), metin „Workable, but 
quality usually improves with 20+ images and good 
coverage around the scene.“

20 görüntüden itibaren banner kaybolur. Eşik değer
leri sert kodlanmış ve ampirik 560+ eğitim deneyine 
dayanmaktadır.

K I S ACA

Uygulama kaç görüntü içe aktar­
dığına bakar ve sana renkli bir 
değerlendirme verir. Kırmızı şu 
anlama gelir: bu yüksek olasılıkla 
bir şey olmaz — ya SfM kamera­
ları hesaplayamaz ya da eğitim 
çok az materyale aşırı uyum sağ­
lar. Turuncu şu anlama gelir: ola­
bilir, ama üst kalite bekleme; al­
goritma görüntüler arasında az 
örtüşme bulur. Banner yok şu 
anlama gelir: iyi koşullar, yeterli 
materyalin var. Gerçekten temiz 
modeller istiyorsan, konunun et­
rafında en az 30–50 eşit dağılmış 
çekim hedefle — dış mekân sah­
nelerinde veya büyük odalarda 
belirgin biçimde daha fazla da 
olabilir. Uyarıya rağmen başlata­
bilirsin, ama SfM yorumsuz iptal 
ettiğinde veya model delikli gö­
ründüğünde şaşırma.
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C-16 COLMAP Workspace algılama

N E R E D E

Bir klasör bırakıldığında — görünür düğme değil, al
gılama mantığı.

T E K N İ K

Bir dizin bırakıldığında, içinde üç kanonik Works
pace düzeninden birinin olup olmadığı kontrol edi
lir: sparse/​0/​cameras.bin, sparse/​cameras.bin veya 
doğrudan kökteki cameras.bin . Uyuyorsa stan
dart görüntü numaralandırması iptal edilir ve bunun 
yerine kullanıcıya mevcut yeniden yapılandırmanın 
mı kullanılacağını yoksa görüntülerin Apple Photog
rammetry üzerinden yeniden mi gönderileceğini so
ran bir modal uyarı açılır. Aynı yol metin biçimi 
workspace’leri (cameras.txt) ve ETH3D dışa aktar
maları için de geçerlidir. Detaylar için Bölüm 9 Arka 
Uç Q6′ya bak. Başlangıç modunda Expert moduyla 
aynı şekilde çalışır.

K I S ACA

Daha önce Metashape, Reality­
Capture veya COLMAP ile çalış­
tıysan ve kamera hesabını orada 
zaten çalıştırdıysan, dışa aktar­
ma klasörünü basitçe buraya çe­
kebilirsin. RadianceKit içerikten 
otomatik olarak COLMAP Works­
pace olduğunu algılar (sparse/​
0/​, cameras.bin  vb. kontrol 
eder) ve bitmiş hesabı devral­
masını mı yoksa kendisinin yeni­
den hesaplamasını mı isteyip is­
temediğini sorar. Devralmak bü­
yük sahnelerde saatlerce bekle­
me süresinden tasarruf sağlar, 
çünkü SfM tamamen atlanır — 
eğitim hemen başlar. Metin bi­
çimi workspace’ler (cameras.txt) 
ve ETH3D dışa aktarmaları da 
algılanır. Bu işlev Başlangıç mo­
dunda Expert moduyla aynı şekil­
de kullanılabilir; daha fazla detay 
için Bölüm 9′a, Arka Uç Q6 altına 
bak.

Bir sonraki aşamaya ne zaman?

Start Processing’e tıklayabilirsin: (a) en az bir görüntü veya bir video içe aktarıldığında 
ve (b) doğrulama banner turuncuysa veya kayboltuğunda. Kırmızı banner varken uygu
lama yine de başlatmana izin verir, ama yüksek olasılıkla işlemeyi hemen iptal etmek 
zorunda kalırsın. Önerilen: en az 20 görüntü, keskin, ardışık çekimler arasında belirgin 
örtüşmeyle, hepsi konuya yaklaşık aynı mesafede. Başlamadan önce zaman bütçene 
uyan bir önayar seç — 30 görüntü ve Quick önayar ile birkaç dakikada bitirirsin, Quality 
ile daha çok 1–2 saat sürer.
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Z2 — İşleme (SfM + Eğitim)

Şekil 36:  Z2 SfM fazı — büyük dairede %41 ile Aşama simgesi „Structure from Motion“, „SfM 
%25” durum çubuğu üstte, sağ altta Cancel düğmesi

SfM fazı (Kameralar hizalanır): Büyük ilerleme dairesi alt aşama ilerlemesini gösterir 
(burada çalışan Apple Photogrammetry oturumunun %41′i). Üst solda durum metni 
„Aligning cameras…“. Ekmek kırıntısı aktif aşama olarak „Cameras”ı işaretler. Üst durum 
çubuğu pipeline genel ilerlemesini gösterir (%25) — SfM çubuğun ilk yarısını kaplar. 
Arka plandaki yüzen wireframe kameralar pozların tahmin edildiğini ima eder.

Şekil 37:  Z2 eğitim fazı — %6 ile Aşama simgesi „Training Gaussians“, üstte canlı metrikler 
(Training: 400/5000 — Loss: 0.1642 — 138.7 it/s), ETA 33s, altta Pause/Cancel

Eğitim fazı (Gaussian’lar optimize edilir): Alt aşama simgesi „Training Gaussians“a 
geçer, yüzde seçilen önayardan iterasyonları sayar (burada Preview önayarı için 400 / 
5 000 = aşamanın %8′i). Canlı metrik satırı Loss değerini (0.1642), saniye başına iteras
yonu (138.7 it/s) ve ETA’yı (33 sn) gösterir. Pipeline genel ilerlemesi bu faz sırasında 
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%50′den %100′e tırmanır. Pause düğmesi (SfM fazında Cancel-Only yerine) sonradan 
Resume’a izin verir; Cancel eğitim sonucunu atar ve Z1′e geri döner.

Pipeline çalışır çalışmaz uygulama içe aktarma bindirmesini gizler ve tam alanlı bir 
işleme ekranı gösterir. Ortada büyük bir ilerleme dairesi (220 × 220 piksel) aşama sim
gesi, durum metni ve yüzde sayısıyla çalışır; arka planda mütevazı bir splat animasyonu 
çalışan hesaplamayı sembolik olarak görselleştirir. Üst solda eğitim ve SfM’den canlı 
metrikleri gösteren bir bilgi paneli gösterilebilir. Altta Pause/Resume, Cancel ve hata 
durumunda bir Retry düğmesi vardır.

C-18 SplatTrainingView (Arka plan animasyonu)

N E R E D E

İlerleme dairesinin arkasında tam alanlı arka plan, ip
talde veya hatada gizlenir.

T E K N İ K

Pipeline ilerlemesine (0…1) göre artan sayıda küçük 
animasyonlu splat parçacığı render eden dekoratif 
animasyon. Kaynak SfM fazlarını 0–0.2′ye ve eğitimi 
0.2–1.0′a eşleyen hesaplanan bir ilerleme değeridir 
(Frame-Quality 0–0.05′e). Böylece splat’lar eğitim 
çalışırken gözle görülür biçimde „oluşur“. Yalnızca 
dekoratif — gösterim mevcut eğitimin gerçek ara 
sonuçlarını göstermez (bu Expert modundaki Canlı 
Önizleme olurdu). İptal veya başarısızlıkta gizlenir ve 
yalnızca durum dairesi görünür kalır.

K I S ACA

Arka planda hesaplama sırasın­
da ekranın boş görünmemesi için 
dans eden noktalardan küçük bir 
animasyon çalışır. Bu senin ger­
çek 3D modelin değil — onu Z3 
adımında ancak eğitimden sonra 
görürsün. Ama animasyon aynı 
tonalitedir, böylece kabaca yo­
ğunlaşma derecesinden eğitimin 
ne kadar ilerlediğini okuyabilir­
sin. Başlangıçta yalnızca birkaç 
nokta görünür, sona doğru arka 
plan belirgin biçimde daha yoğun 
dolar — daire içindeki yüzde gös­
terimine ek olarak hoş bir gör­
sel gösterge. Animasyon seni ra­
hatsız ediyorsa (ör. arka planda 
yanında çalışmak istediğin için), 
onun düştüğü Expert moda geçe­
bilirsin.
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C-19 Büyük ilerleme dairesi

N E R E D E

İşleme ekranının ortasında, 220 × 220 piksel.

T E K N İ K

Üst üste render edilen iki halka: dışta sönük bir 
track halkası, içte vurgu veya kırmızı stroke ile dolu 
bir ilerleme halkası (hatada kırmızı). Daire içinde 
bir aşama simgesi (Eğitim için beyin, SfM için kame
ra, video kare çıkarma için film, Frame-Quality için 
sparkles), aşama başlığı ve 32 puntoluk yuvarlatıl
mış yazı tipinde canlı animasyonlu yüzde sayısı. İşle
me aktif olduğu sürece simge nazikçe titrer. Göste
rim 30 Hz zamanlayıcıda mevcut gerçek ilerlemeye 
doğru yumuşakça enterpole eder — sabit sürünme 
(kare başına 0.0003) artı orantısal pay (boşluğun 
%4′ü) ve bir sonraki beklenen kilometre taşının 
%80′ini hedefleyen yumuşak bir tavanla (SfM için 
sert kodlanmış kilometre taşı tablosundan). Böylece 
gerçek SfM güncellemeleri yalnızca her birkaç sani
yede bir gelse bile ilerleme akıcı görünür.

K I S ACA

Ortadaki büyük daire uygulama 
hesaplarken ana göstergendir. 
Gerçek hesaplama güncellemele­
ri yalnızca her birkaç saniyede 
bir gelse bile yumuşakça dolar 
— bu sana dakikalarca dondu­
rulmuş bir yüzdeye bakmak ye­
rine bir şeyler olduğu hissini 
verir. Ortadaki sembol şu anda 
karelerin çıkarılıp çıkarılmadığı­
na (film simgesi), kameraların hi­
zalanıp hizalanmadığına (kamera 
simgesi) veya Gaussian’ların eği­
tilip eğitilmediğine (beyin sim­
gesi) göre değişir. Yüzde sayısı 
mevcut alt adıma atıfta bulunur 
— genel pipeline’ı en üstteki dar 
çubukta görürsün. Bir hata duru­
munda halka mavi yerine kırmızı 
renge döner ve simge artık titre­
mez, böylece bir şeyin yanlış git­
tiğini hemen anlarsın.

C-22 Info düğmesi (Metrikleri göster)

N E R E D E

İşleme ekranının üst solunda, 32 × 32 piksel.

T E K N İ K

Materyal arka planlı sade düğme. Bilgi panelini açar 
veya kapatır. Simge etkinse Info-Circle-Outline ile 
Info-Circle-Filled arasında değişir. Yumuşak görü
nüm animasyonu. Tooltip’te „Show detailed proces
sing metrics“.

K I S ACA

Standart olarak ekran bilinçli ola­
rak düzenlidir — yalnızca büyük 
ilerleme dairesi, ilk başta daha 
fazlasını görmezsin. Teknik ola­
rak ilgili bir kullanıcı olarak ne ol­
duğunu daha ayrıntılı bilmek isti­
yorsan (hangi iterasyon, kayıp ne 
kadar yüksek, kaç Gaussian), üst 
soldaki i simgesine tıkla. Altta 
küçük bir panel açılır ve tüm can­
lı değerleri gösterir. Yeniden bir 
tıklama yine gizler. Ayar kalıcı de­
ğildir — her yeni eğitim çalıştır­
masında panel ilk başta yine giz­
lidir, bu, başlangıç kullanıcılarını 
korkutmamak için bilinçli olarak 
öyledir.
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C-23 Info paneli (Canlı metrikler)

N E R E D E

İşleme ekranının sol altında, yalnızca 
showProcessingInfo == true ise görünür.

T E K N İ K

Ultra ince materyal arka planlı iki sütunlu panel. Sol 
sütun: aşamaya özgü bilgi satırları — SfM için durum 
metni ve yüzde; Training için iterasyon, kombine ka
yıp, L1 kaybı, D-SSIM kaybı, Gaussian sayısı (turun
cu renkli), hız (it/s), geçen süre, hesaplanan ETA, SH 
derecesi ve öğrenme hızı. Sağ sütun: durum metni, 
zaman bilgisi dizesi, satır içi kayıp grafiği (bkz. 
C-28) ve bir keşfedilebilirlik dürtmesi (bkz. C-32). 
Tüm değerler her eğitim tikinde güncellenen eğitim 
durumundan okunur.

K I S ACA

Info paneli Expert modunda sü­
rekli Inspector kenar çubuğunda 
duracak olan tüm canlı değerle­
ri gösterir: mevcut iterasyon, ka­
yıp değeri (daha küçük = daha 
iyi), Gaussian sayısı, hız, tahmi­
ni kalan süre, SH derecesi ve 
öğrenme hızı. Sağda ek olarak 
eğitimin doğru yönde gittiğini bir 
bakışta söyleyen küçük bir kayıp 
eğrisi çalışır. Eğitim ağır görünü­
yorsa, buraya bir bakış yardımcı 
olur — artık düşmeyen bir Loss 
veya artık azalmayan bir ETA so­
runlara işaret eder. Loss patlarsa 
(aniden devasa olursa) veya NaN 
gösterirse, eğitim istikrarsız hale 
gelmiştir ve Cancel + Retry veya 
başka bir önayara geçiş anlamlı­
dır.

C-25 Pause/Resume düğmesi

N E R E D E

Alttaki gezinme çubuğu, yalnızca eğitim aşaması sı
rasında (SfM SIRASINDA DEĞİL) ve işleme çalıştığı 
sürece görünür.

T E K N İ K

Çerçeveli düğme. Duruma göre Pause veya Re
sume çağırır. Etiket „Pause“ (Pause simgesiyle) 
ile „Resume” (Play simgesi) arasında değişir. SfM 
adımı sırasında düğme gösterilmez, çünkü Apple 
Photogrammetry’nin Pause semantiği yoktur. Pause 
durumu iterasyon, Gaussian durumunu ve optimizer 
momentumunu tamamen korur — Resume tam ola
rak daha önce durdurulduğu yerden devam eder.

K I S ACA

Eğitim çalışırken istediğin zaman 
durdurabilir ve sonradan sürdü­
rebilirsin. Bu arada Mac’te çok 
GPU gerektiren başka bir şey 
yapmak istediğinde anlamlıdır — 
ör. video düzenleme, oyun testi 
veya başka bir uygulamadan bir 
render dışa aktarması. Pause’a 
tıkla, işini yap, Resume’a tıkla, 
eğitim tam olarak nerede kal­
dıysa oradan devam eder. İte­
rasyon sayacı, Gaussian sayısı 
ve optimizer momentumu tama­
men korunur, Pause durumu ka­
liteye mal olmaz. SfM fazı sıra­
sında Pause kullanılamaz — App­
le Photogrammetry’nin durdur­
ma işlevi yoktur, orada acil du­
rumda Cancel ile çalışmak zorun­
dasın.
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C-26 Cancel düğmesi

N E R E D E

Alttaki gezinme çubuğu, işleme (SfM veya eğitim) 
çalıştığı sırada görünür.

T E K N İ K

Kırmızı çerçeveli düğme. Başlık „Stop and discard 
progress?“, düğmeler „Discard Progress” (yıkıcı) ve 
„Keep Running“ (Cancel) olan bir onay diyaloğu 
açar. Onayda Cancel bayrağı ayarlanır, eğitim görevi 
sonlandırılır, gerekirse SfM alt süreci sonlandırılır ve 
JSONL günlüğüne iptal durumlu bir özet satırı yazılır. 
Pause’un aksine eğitim buffer’ları ve durumu atılır.

K I S ACA

İptal düğmesi. Pause’un aksine 
kesindir — bundan sonra yeni­
den başlatmak istersen, işleme 
baştan çalışır, zaten eğitilmiş 
tüm iterasyonlar kayıptır. Öna­
yarda hata yaptıysan, eğitim çok 
yavaş çalışıyorsa veya uygulama 
açıkça çöp sonuçlar üretiyor ve 
beklemek istemiyorsan anlamlı­
dır. Gerçek iptalden önce uygu­
lama bir onay diyaloğu üzerin­
den tekrar sorar, böylece yanlış­
lıkla saatlerce hesaplama süresi­
ni kaybetmezsin. Yalnızca kısa 
süreliğine durdurmak istiyorsan, 
daha çok Pause al.

C-27 Retry düğmesi

N E R E D E

Alttaki gezinme çubuğu, pipeline başarısız olduğun
da görünür (SfM durumu „SfM failed“ ile başlar veya 
eğitim hata durumunda).

T E K N İ K

Vurgu düğmesi. Tüm pipeline’ı yeniden başlatır. Baş
latmadan önce hâlâ içe aktarılan görüntüler/videolar 
olup olmadığı kontrol edilir. Önceki hata günlükleri 
JSONL dizininde korunur; yeni bir çalıştırma mevcut 
zaman damgalı yeni bir günlük dosyası yazar.

K I S ACA

SfM veya eğitim bir hata mesa­
jıyla iptal ederse, burada yeni­
den deneyebilirsin. Birçok adım­
da (RANSAC, Densification) rast­
gele bileşenler olduğu için bazen 
yardımcı olur ve ilk denemenin 
başarısız olduğu yerde ikinci de­
neme başarılı olabilir. Tüm pipe­
line sonra yeniden baştan, taze 
bir JSONL günlük dosyasında ça­
lışır. İkinci deneme de başarısız 
olursa, çoğunlukla giriş görüntü­
leri sorundur (çok az, çok az ör­
tüşme, hareket bulanıklığı, kötü 
ışık); o zaman Back ile geri dön 
ve materyali değiştir. İpucu: pa­
ralel olarak eğitim günlüklerine 
bak (Help → Open Training Logs), 
orada hangi noktada somut ola­
rak takıldığı daha ayrıntılı yazar.
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C-28 Inline Loss grafiği

N E R E D E

Info panelinde, sağ sütun, yalnızca eğitim sırasında 
boş olmayan geçmiş öyküsüyle görünür.

T E K N İ K

Kompakt çizim alanı (40 piksel yüksekliğinde), Loss 
geçmişini vurgu renginde 1 piksel çizgi olarak çizer. 
Veriler sonlu değerlere filtrelenir (istikrarsız eğitim
ler için NaN koruması). Min/Max tüm geçmişe göre 
hesaplanır — grafik yani değer aralığına otomatik 
yakınlaştırılır. Son Loss değeri grafiğin sağ üstünde 
durur. Geçmişin kendisi her eğitim tikinde uygulama 
durumunda oluşturulur (tipik olarak her 100 iteras
yonda).

K I S ACA

Küçük bir Loss eğrisi, eğitimin 
„yakınsadığını“ (çizgi sağa dü­
şer) veya takıldığını veya patladı­
ğını (çizgi düz veya yükselir) bir 
bakışta gösterir. Sağlıklı bir eği­
timde çizgi başlangıçta dik düşer 
ve sonra düzleşir — bu bekle­
nen seyirdir, yarıya bölme eğrisi­
ne benzer. Grafik otomatik olarak 
mevcut değer aralığına yakınlaş­
tırılır, böylece eğitim sonundaki 
küçük iyileşmeler de görünür ka­
lır. Çizgi aniden yukarı fırlarsa 
veya donarsa, bu bir şeylerin 
ters gittiğine dair iyi bir sinyal­
dir — ya materyal sorunludur ya 
da başka bir önayar daha uygun 
olurdu. Grafiği üst solda i sim­
gesiyle açtığın Info panelinde bu­
lursun.

C-32 Keşfedilebilirlik dürtmesi (Expert mod ipucu)

N E R E D E

Info panelinde, sağ sütunun altında, yalnızca eğitim 
sırasında VE Başlangıç modunda görünür.

T E K N İ K

Göz simgesi ve Caption metni „Switch to Expert Mo
de (⌘2) for live splat preview“ ile küçük satır, geride 
duran tonlama ve 10 puntoluk yazı tipi. Etkileşimli 
öge değil, yalnızca ipucu. Tıklamaya tepki vermez — 
kullanıcının gerçekten Cmd+2 basması ya da Mode 
→ Expert Mode menüsüne tıklaması gerekir.

K I S ACA

Expert modunda eğitim sırasında 
3D modelinin mevcut ara sürü­
münün canlı olarak görüntüleyi­
cide görünür olduğuna dair mü­
tevazı bir ipucu. Başlangıç mo­
dunda yüzeyi sakin tutmak için 
bilinçli olarak gizlenir — ama bir­
çok kullanıcı bu işlevin olduğunu 
bilmez, bu yüzden burada nazik­
çe işaret ederiz. Cmd+2′ye bas ve 
eğitim arka planda çalışmaya de­
vam ederken modelinin gözünün 
önünde nasıl bir araya geldiği­
ni izleyebilirsin. Bu, sonucun ne 
olacağını birkaç bin iterasyondan 
sonra zaten değerlendirmek veya 
iptal edip yeniden başlamayı ter­
cih etmek için de iyi bir araçtır. 
Cmd+1 seni istediğin zaman Baş­
langıç görünümüne geri getirir.
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Bir sonraki aşamaya ne zaman?

Uygulama, eğitim başarıyla tamamlandığında otomatik olarak Z3′e (önizleme) geçer — 
bir şey tıklaman gerekmez. Alttaki gezinme çubuğu sonra Pause/Cancel’dan Back düğ
mesine (içe aktarmaya geri) ve Export düğmesine (dışa aktarmaya ileri) geçer. Hata 
durumunda (kırmızı hata mesajı, aşama simgesi X) bunun yerine Retry görünür ve yeni
den başlatıp başlatmayacağına ya da görüntü materyalini değiştirmek için Back ile içe 
aktarmaya geri dönüp dönmeyeceğine karar vermelisin.

Z3 — Önizleme (3D modeli döndür)

Şekil 38:  3D görüntüleyicili Simple modu önizleme adımı

Şekil 39:  Eğitim tamamlandıktan sonra Z3 önizleme — yeniden yapılandırılmış Blender çiçek 
demeti, başlık „Training complete — 3,022 Gaussians in 13s“ gösterir, altta Back ve Export 

düğmeleri
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RESIMDE NE GÖRÜNDÜĞÜ  Ekmek kırıntısı aktif aşama olarak „Preview“i işaretler. Tam alanlı 
3D görüntüleyici eğitilmiş çiçek demeti sahnesini render eder (sentetik Blender test seti, 
960 yarımküresel cam’den 60 kare alt küme). Başlık durum çubuğu: „Training complete 
— 3 022 Gaussians in 13 s” — son Gaussian sayısını ve eğitim süresini verir. Görüntü
leyicide sürükleme kamerayı döndürür (Yaw/Pitch); kaydırma tekerleği bakış yönünde 
yakınlaştırır. „Back“ düğmesi (sol altta) Resume veya yeniden çalıştırma için Z2′ye 
döner; „Export” düğmesi (sağ altta, birincil) Z4′e devam eder.

Eğitim tamamlandıktan sonra uygulama otomatik olarak önizlemeye düşer. Burada 
bitmiş Gaussian Splatting modelini tam ekran Metal görünümünde görür ve fareyle 
ve trackpad ile döndürür, yakınlaştırır ve kaydırırsın. Görüntüleyicinin üstünde kamera 
kontrolü ve bilgi ile küçük bir bindirme bulunur — otomatik döndürme, eğitim istatis
tiği, sıfırlama düğmesi. Bir sonraki adıma (Dışa aktarma) geçmeden önce, yeniden 
yapılandırmanın temiz olduğundan emin olmak için modeli farklı açılardan kontrol etmek 
mantıklıdır.

C-36 SplatViewportView (3D ana görünüm)

N E R E D E

Önizleme adımının tam ekran arka planı.

T E K N İ K

Bitmiş nokta bulutunu render eden Metal tabanlı 3D 
görüntüleyici. Render’cı, RadianceKit’in KENDİ For
wardPass rasterizer’ıdır — eğitim sırasında splat’ları 
zaten render eden aynı render’cı — bu yüzden 
gerçek WYSIWYG’dir (eğitilen şey aynen gösterilir 
ve dışa aktarılır). Order-Independent Transparency 
ile karo tabanlı render pipeline’ı. Render’cı başlatıla
mazsa (ör. Metal sistemde mevcut olmadığı için), 
bunun yerine „Metal not available“ metniyle siyah bir 
arka plan görünür. Görünüm güvenli alanı yok sayar, 
böylece model pencere kenarına kadar uzanır.

K I S ACA

Ana görüntüleyici. Burada fo­
toğraflarından yeniden yapılan­
dırılmış 3D modelini görürsün, 
GPU’da gerçek zamanlı render 
edilir. Döndürmek için sol fare 
düğmesiyle tıkla ve sürükle. Ya­
kınlaştırmak için kaydırma teker­
leği veya iki parmaklı trackpad 
hareketi. Kaydırmak için sağ fa­
re düğmesi veya Cmd+sürükle­
me. Model sahneni fotorealistik 
olarak yeniden yapılandıran on 
binlerce yarı saydam 3D elipso­
idden („Gaussian’lar“) oluşur — 
her birinin eğitimin öğrendiği bir 
konumu, yönelimi, biçimi ve ren­
gi vardır. Mac’inin Metal destek­
lemediği nadir durumda, bunun 
yerine bir uyarı mesajıyla siyah 
bir arka plan görürsün — Radi­
anceKit kesinlikle Metal yetenekli 
bir GPU’ya ihtiyaç duyar.
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C-37 CameraControlsOverlay (Kontrol bindirmesi)

N E R E D E

Görüntüleyicinin üstünde yüzen.

T E K N İ K

Otomatik döndürme (Turntable), Reset Camera, ar
ka plan seçimi (Gri/Siyah/Beyaz), Save Screenshot, 
Toggle Info Panel için düğmelerle kompakt UI bin
dirmesi. Kamera parametrelerine (mesafe, azimut, 
yükseklik, hedef, FOV) bağlanır ve Auto-Turntable’ı 
kontrol eder. Eğitim sırasında (kullanıcı Expert mo
dunda görüntüleyicinin birlikte çalıştığını görmek is
tediğinde) bindirme ek olarak kompakt bir eğitim 
durumu satırı gösterir.

K I S ACA

Modelin üstünde küçük yüzen 
çubuk. Burada otomatik döndür­
meyi başlatırsın (model kendili­
ğinden döner, ekran görüntüleri 
ve kısa demolar için iyi), ka­
merayı (kaybolduysan) başlangıç 
konumuna sıfırlarsın, arka planı 
değiştirirsin (nötr için gri, mak­
simum kontrast için siyah, açık 
modeller için beyaz) ve doğru­
dan  /Pictures altında kaydedilen 
ekran görüntüleri çekersin. Tüm 
modeli dışa aktarmak zorunda 
kalmadan belirli bir detayı belir­
li bir açıdan göstermek istediğin­
de pratiktir. Otomatik döndürme, 
modelin her taraftan eşit dere­
cede iyi görünüp görünmediğini 
veya eksik çekimlerden kaynak­
lanan bir „pis taraf“ olup olmadı­
ğını test etmek için de iyi bir 
testtir.

C-38 Export düğmesi (gezinme çubuğu)

N E R E D E

Z3′te altta gezinme çubuğu.

T E K N İ K

„Export“ etiketli ve paylaşım simgeli vurgu düğmesi. 
Tıklama Z4′e geçişi tetikler. Önceden ana görünüm 
tam sürümün etkinleştirilip etkinleştirilmediğini kont
rol eder — değilse, dışa aktarma aşaması yerine kilit 
görünümü gösterilir (bkz. U-06).

K I S ACA

Sonuçtan memnunsan, Export’a 
tıkla ve son adıma düşersin, bu­
rada biçimi seçer ve kaydedersin. 
Satın alınmamış tam sürüm ol­
madan, bunun yerine kilit açma 
ipucu ve satın alma düğmesiyle 
bir ekran kilidine düşersin — uy­
gulama sana zorla tam sürümü 
itmek istemez, ama dışa aktar­
ma premium özelliklerden biridir. 
Satın almayı tamamlar tamam­
lamaz uygulama doğrudan et­
kinleştirilmiş durumda çalışmaya 
devam eder ve alışılmış dışa ak­
tarma aşamasına düşersin. Yine 
de fikrini değiştirirsen, Back düğ­
mesi üzerinden önizlemeye geri 
gelir ve modeli döndürmeye de­
vam edebilirsin.
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Bir sonraki aşamaya ne zaman?

Dışa aktarmadan önce modeli bir kez tamamen döndür ve kontrol et: Giriş görüntüle
rinde kapsadığın tüm alanlar var mı? Yüzen „floater“lar (havada serbest yüzen Gauss 
splat bulutları) var mı? Arka plan/gök temiz mi yoksa lekeli mi görünüyor? Ciddi sorunlar 
yalnızca yeniden eğitimle düzeltilebilir — ya daha fazla görüntüyle, başka önayarla veya 
Expert modunda Floater Reduction ayarlarıyla.

Z4 — Dışa Aktarma (Biçim seç ve kaydet)

Şekil 40:  Biçim kartlarıyla Simple modu dışa aktarma adımı

Şekil 41:  Z4 dışa aktarma kartları — 6 biçim (PLY 742 KB seçili, SPZ 74 KB, glTF 708 
KB, .splat 96 KB, Orbit Video, Web Viewer 133 KB), sağda zaten dışa aktarılmış PLY ile dışa 

aktarma geçmiş kenar çubuğu
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RESIMDE NE GÖRÜNDÜĞÜ  Ekmek kırıntısı aktif aşama olarak „Export“u işaretler. Sol kart ız
garası „Choose Export Format” altı seçenekle: PLY (standart 3DGS, tam SH katsayılarıy
la 742 KB — burada mavi onayla önceden seçili), SPZ (sıkıştırılmış 3DGS biçimi, PLY’den 
~%90 daha küçük, 74 KB), glTF (KHR_​gaussian_​splatting uzantısıyla, 708 KB), .splat 
(antimatter15 üzerinden web görüntüleyici uyumlu, 96 KB), Orbit Video (sahnenin 360° 
MP4′ü, canlı boyut hesabı), Web Viewer (gömülü 3D görüntüleyiciyle bağımsız HTML, 
133 KB). Boyut bilgileri mevcut Gaussian sayısı ve biçim ek yükünden canlı hesaplanır. 
Sağda „Export History“ zaten tamamlanmış dışa aktarmaları biçim hapı, dosya adı ve 
zaman damgasıyla listeler — tıklama Finder’da gösterir. Sol altta birincil CTA: „Export 
PLY (3DGS Standard)” Gaussian alt başlığı „2,991 Gaussians · SH degree 3″ ile.

Son adımda 6 dışa aktarma biçiminden (PLY, SPZ, glTF, .splat, Orbit Video, Web Viewer) 
2 sütunlu kart ızgarası ile seçersin, Export’a tıklarsın ve macOS diyaloğunda kayıt 
konumu seçersin. Sağda tüm önceki dışa aktarmaların geçmişi çalışır — kart seçiminde 
her kartın altında hemen tahmini dosya boyutu gösterilir, böylece örneğin web’e gitmek 
istiyorsan SPZ’yi (küçük) tercih edersin ve başka bir yazılıma (SuperSplat, Postshot, 
Blender eklentisi aracılığıyla) içe aktarmak istiyorsan PLY (büyük ve eksiksiz).

C-39 2 sütunlu biçim ızgarası

N E R E D E

Dışa aktarma adımının sol ana sayfası.

T E K N İ K

İki esnek sütunla ve 12 punto aralıkla kart ızgarası. 
Başlangıç modunda sunulan biçimleri yineler — yal
nızca 6 en önemli biçimi içeren tüm biçim listesinin 
filtrelenmiş bir alt kümesi: PLY, SPZ, glTF, .splat, 
Orbit Video, Web Viewer. Compressed-PLY ve SOG 
YALNIZCA Expert modunda sunulur.

K I S ACA

Başlangıç modunda ilgili 6 biçim­
le bir kart ızgarası: PLY (diğer 
3D araçları için standart biçim), 
SPZ (web için sıkıştırılmış var­
yant), glTF (resmi Web3D stan­
dardı), .splat (antimatter15 web 
görüntüleyicisi için), Orbit Video 
(göstermek için hazır MP4) ve 
Web Viewer (gömülü 3D oynatıcı­
lı bağımsız HTML dosyası). Böyle­
ce kullanım durumlarının %90′ını 
kapsarsın. Daha az yaygın biçim­
lerden birine ihtiyacın varsa (aşı­
rı sıkıştırma için Compressed-
PLY veya SOG), Expert moda geç, 
orada 8 biçimin tümü kullanı­
labilir. Buradaki kompakt seçim, 
başlangıç kullanıcılarının çeşitli­
likten bunalmaması için bilinçli­
dir.
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C-40 Biçim kartı düğmesi

N E R E D E

Izgaradaki her kart.

T E K N İ K

Kart düzeniyle sade düğme: üstte simge (ör. PLY 
için belge fermuarı, SPZ için arşiv kutusu, Orbit 
Video için video simgesi), Headline olarak biçim adı, 
açıklama Caption (2 satır kırpılmış), altında tahmini 
dosya boyutu (biçim, Gaussian sayısı ve SH derece
sinden canlı hesaplanmış ve KB/MB olarak biçimlen
dirilmiş). Tıklamada biçim seçilir. Seçilen kart vurgu 
arka planı, vurgu kenarlığı ve sağ üstte onay simgesi 
alır. Tooltip biçim açıklamasıdır.

K I S ACA

Biçim başına bir kart. Birine tık­
la, vurgu rengi ve onay işaretiy­
le vurgulanır ve altındaki Export 
düğmesi metnini ona göre ayar­
lar („Export PLY“, „Export SPZ” 
vb.). Her kart uygun bir sembol, 
ad, iki satırlı kısa bir açıklama 
ve mevcut eğitim sonucundaki 
tahmini dosya boyutunu göste­
rir. Boyut anlamlı seçim yapma­
na yardımcı olur — sonucu e-
postayla göndermek istiyorsan 
en küçük varyantı al (çoğunlukla 
SPZ veya .splat); başka bir 3D 
yazılımında çalışmaya devam et­
mek istiyorsan en iyi uyumlulukla 
olanı al (tipik olarak PLY). Bir kar­
tın üzerine geldiğinde, biçimler 
arasındaki farklar belirsiz görü­
nüyorsa, tooltip daha ayrıntılı bir 
açıklama gösterir.

C-41 Video Duration kaydırıcı

N E R E D E

Biçim ızgarasının altında, yalnızca bir video biçimi 
(Orbit Video veya Social Video) seçildiğinde görü
nür.

T E K N İ K

3–30 saniye arası 1 saniye adımlarında kaydırıcı, 
uygulama durumundaki video uzunluğuna bağlanır. 
Maksimum genişlik 300 piksel. Yalnızca bir video 
biçimi seçildiğinde gösterilir. Video olmayan biçim
lerde kaydırıcı görünümden tamamen kaldırılır — ölü 
alan yok.

K I S ACA

Bir Orbit Video dışa aktarması 
seçersen, burada uzunluğu belir­
leyebilirsin. 3 saniye = çok hızlı 
dönüş, 30 saniye = modelin etra­
fında yavaş, sakin dönüş. Sosyal 
medya reels’i (Instagram, TikTok) 
için çoğunlukla 6–10 saniye ide­
aldir — modeli göstermek için 
yeterince uzun, izleyicilerin atla­
mayacak kadar kısa. Sunumlarda 
veya portfolyo videolarında ra­
hatlıkla 15–20 saniye alabilirsin. 
Kaydırıcı yalnızca bir video biçi­
mi seçildiğinde belirir; PLY veya 
SPZ gibi dosya biçimlerinde an­
lamsız olurdu ve gizlenir.
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C-42 Export düğmesi

N E R E D E

Biçim ızgarasının altında (ve video seçilmişse Dura
tion kaydırıcısının altında).

T E K N İ K

Büyük vurgu düğmesi. Etiket: „Export {Biçim adı}“, 
paylaşım simgesi. Tıklamada biçime uygun uzantı ve 
varsayılan dosya adı „scene.{ext}” ile macOS kaydet 
diyaloğu açılır; onayda dışa aktarma seçilen URL’ye 
yazılır. Eğitim sonucu yoksa veya bir dışa aktarma 
zaten çalışıyorsa devre dışıdır.

K I S ACA

Tıkla, macOS diyaloğunda ka­
yıt konumunu seç, hazır — uy­
gulama dosyayı seçilen biçim­
de seçilen yere yazar. Varsayı­
lan ad „scene.{uzantı}“dır (ör. 
„scene.ply” veya „scene.spz“), 
bunu kaydetmeden önce diyalog­
da istediğin gibi değiştirebilirsin. 
Henüz bir eğitim sonucu yoksa 
(burada hiç olmamalı, aksi tak­
dirde dışa aktarma adımında ola­
mazdın) veya başka bir dışa ak­
tarma zaten çalışıyorsa düğme 
gridir. Dışa aktarma çalışır çalış­
maz altında bir ilerleme göster­
gesi görünür; uygulama kullanı­
labilir kalır, yani zaten bir sonraki 
dışa aktarmayı hazırlayabilirsin.

C-43 Export ilerleme çubuğu

N E R E D E

Export düğmesinin altında, yalnızca bir dışa aktarma 
çalışıyorsa görünür.

T E K N İ K

Maksimum genişliği 300 piksel olan ilerleme göster
gesi, altında Caption „Exporting… N %“. Değer 0′dan 
1′e gider ve yazma sırasında güncellenir — PLY’de 10 
000 Gaussian parçalarında, SPZ’de kuantizasyondan 
sonra bir kez, Orbit Video’da kare aralıklarında.

K I S ACA

Dışa aktarma çalışırken burada 
ilerlemeyi dar bir çubuk artı yüz­
de gösterimi olarak görürsün. 
PLY çoğunlukla saniyeler içinde 
biter, çünkü dosya basitçe iki­
li olarak yazılır. SPZ biraz daha 
uzun sürer, çünkü veriler bu sıra­
da kuantize edilir ve sıkıştırılır. 
Orbit Video en zaman alıcı dı­
şa aktarmadır — burada her tek 
kare yeniden render edilir; çözü­
nürlüğe ve uzunluğa göre bu bir 
dakika veya daha uzun sürebilir. 
Dışa aktarma sırasında uygulama 
kullanılabilir kalır, yani zaten bir 
sonraki biçimi hazırlayabilir veya 
görüntüleyicide tıklamaya devam 
edebilirsin.
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C-44 Export hata gösterimi

N E R E D E

İlerleme çubuğunun altında, yalnızca son dışa aktar
mada bir hata oluştuğunda görünür.

T E K N İ K

Uyarı simgesi ve hata metniyle kırmızı satır. Kırmızı 
%8 arka plan opaklığı, yuvarlatılmış köşeler. Maksi
mum genişlik 400 piksel. Sık hata nedenleri: SOG 
sistem PATH’inde cwebp  bekler (App Store uyumlu 
değil); dolu disk alanında yazma hatası; izin verilen 
alan dışındaki kayıt hedeflerinde sandbox hatası.

K I S ACA

Dışa aktarma ters giderse, bu­
rada kırmızı renkte sorunun kı­
sa düz metin açıklaması görü­
nür. Çoğunlukla neden bellidir — 
diskte yer yok, hedef klasör için 
yazma izni yok veya sandbox-
izinli alanlar dışında bir hedef. 
Özellikle SOG biçiminde sistem­
de cwebp ’nin eksik olduğu gö­
rülür; bu durumda SOG kullanıla­
maz ve SPZ’ye geçmek zorunda­
sın. Hata mesajı belirsizse, gün­
lük dizinine bak (Help → Open 
Training Logs), orada neyin ters 
gittiği daha ayrıntılı yazılır. Şüp­
hede başka bir kayıt konumu 
seçmek yardımcı olur — ör. ma­
saüstü.

C-46 Export Geçmiş listesi

N E R E D E

Dışa aktarma adımının sağ tarafı.

T E K N İ K

Dışa aktarma geçmişi üzerinde liste (UserDefaults’ta 
JSON olarak kalıcı kayıtlı, her başarılı dışa aktarma
dan sonra korunur). Her satır biçim rozeti (küçük, 
vurgu renkli), zaman damgası (HH:mm), dosya adı (1 
satıra kırpılmış) ve biçimlendirilmiş dosya boyutunu 
gösterir. Bir satıra tıklama Finder’ı seçili dosyayla 
açar. Boş durum: „No exports yet“.

K I S ACA

Önceki dışa aktarmalarının bir 
listesi — biçim, saat, dosya adı, 
boyut, kronolojik sırada. Bir satı­
ra tıkla ve dosya Finder’da vurgu­
lanmış olarak gösterilir, klasör­
lerden kendin gezmek zorunda 
kalmadan. Bir saat sonra son dı­
şa aktarmaya yeniden ihtiyacın 
olduğunda ve nereye kaydettiği­
ni artık bilmediğinde pratiktir — 
geçmiş bunu hatırlar. Hiç bir şey 
dışa aktarmadıysan, burada „No 
exports yet“ diye dostça bir ipu­
cu yazar. Liste, UserDefaults’ta 
saklandığı için uygulama yeniden 
başlatmalarından sağ çıkar.
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C-48 Geçmiş bağlam menüsü (Sağ tıklama)

N E R E D E

Bir geçmiş satırına sağ tıklama.

T E K N İ K

Her liste girdisinde iki eylemli bağlam menüsü: „Re
veal in Finder“ (Finder’ı seçili dosyayla açar, basit 
tıklama gibi) ve „Copy Path” (tam dosya yolunu 
metin olarak panoya koyar). İkincisi, başka uygula
malara sürükle bırak veya komut satırına aktarım için 
yararlıdır.

K I S ACA

Bir geçmiş girdisine sağ tıkla­
ma iki eylemli küçük bir menü 
açar. „Reveal in Finder“ normal 
bir tıklamayla aynı şeyi yapar — 
seçili dosyayla Finder’ı açar, böy­
lece onu hemen görürsün. „Copy 
Path” tam dosya yolunu panoya 
koyar, böylece onu örneğin Ter­
minal komutlarında, başka uygu­
lamalarda veya bir nota yapıştı­
rabilirsin. Özellikle dışa aktarma­
yı birine vermek istediğinde veya 
onu yol girişiyle çalışan başka 
bir programda açmak istediğin­
de pratiktir. İşlevsel olarak Mac 
tipik kullanım desenlerine daya­
nan küçük ama yardımcı bir de­
tay.

İş akışı ne zaman tamamlanır?

Başarılı bir dışa aktarmadan sonra diskte dosya olarak 3D modelin vardır ve geçmiş yeni 
bir girdi gösterir. „Done“ düğmesi yoktur — yeniden eğitime gerek olmadan istediğin 
kadar dışa aktarmayı farklı biçimlerde ekleyebilirsin. Önizlemeye geri dönmek istersen 
(ör. bir kamera perspektifini yeniden kontrol etmek için), alt gezinme çubuğundaki Back 
düğmesini kullan. Tamamen yeni bir sahne başlatmak istersen, Back ile Z1′e gider ve 
orada Clear All kullanırsın ya da File → New Project (Cmd+⇧+N) kullanırsın.

Expert moduna geçiş

İstediğin zaman Cmd+2 bas ya da Mode → Expert Mode ( M8 ) seç. Tüm durum korunur: 
içe aktarılan görüntüler, seçilen önayar, çalışan veya bitmiş eğitim, bitmiş nokta bulutu, 
dışa aktarma geçmişi, hatta mevcut aşama. Expert modunda dört adımlı aşama yerine 
~150 kontrol alanının tamamıyla tam Inspector kenar çubuğu gösterilir. Özellikle: Project 
Navigator (bkz. Bölüm 2) gelişmiş görüntü işlemlerini (eksi düğmesi, Backspace silme, 
Cmd-Z geri alma, Quick Look önizleme), eğitim sırasında görüntüleyicide Canlı Önizle
me ve tüm Loss, MCMC, Densification ve Mip-Splatting parametrelerini sunar. Cmd+1 
Başlangıç moduna geri çevirir — bu da durum kaybetmez.

Sık sorular

Start Processing düğmem neden gri kalıyor?
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Henüz görüntü veya video içe aktarmadın. Bırakma bölgesine en az bir dosya çek veya 
„Browse Files“ kullan. Sağdaki görüntü listesi en az bir girdi içerir içermez düğme etkin 
olur. (Yalnızca 1–2 görüntüde başlatır, ama SfM doğrudan hatayla iptal eder — kırmızı 
doğrulama banner’ına bak.)

Export düğmem neden kilitli?

Başlangıç modunda iki kademe vardır: (a) Eğitim pipeline’ı henüz bitmediyse ve yokken, 
düğme devre dışıdır — önce Z2′yi tamamlaman gerekir. (b) Tam sürümü henüz satın 
almadıysan (PurchaseManager.hasAccess == false), dışa aktarma aşaması yerine kilit 
simgeli ve „Unlock Full Version“ düğmeli bir kilit görünümü görürsün; bu, satın alma 
sheet’ini açar. Quick ve Preview önayarları eğitimi ücretsiz olarak izin verir, ama dışa 
aktarma Premium’dur.

Neden önayar seçemiyorum?

Seçebilirsin — ama satın alınmamış tam sürüm olmadan bir Premium önayara (Balanced, 
Quality, MCMC varyantları) dokunduğunda, seçici otomatik olarak Preview’a geri sıçrar 
ve satın alma sheet’i açılır. Quick ve Preview, ücretsiz kullanılabilir tek önayarlardır.

Görüntüleri içine çekmeme rağmen bırakma bölgem neden boş ve kesik gri?

Muhtemelen UTI türü uyumsuzluğu. Uygulama JPG, PNG, TIFF, HEIC, MP4, MOV artı 
uygulamaya özgü Splat biçimlerini kabul eder. Diğer görüntü biçimleri (BMP, GIF, WebP, 
RAW biçimleri) ALGILANMAZ. Görüntü tipinin dahil olması gerektiğinden eminsen, dosya 
adı uzantısını kontrol et — uygulama öncelikle uzantıya göre gider, dosya içeriğine göre 
değil.

Neden yalnızca 30 görüntüm olmasına rağmen SfM bu kadar uzun sürüyor?

Apple Photogrammetry doğrusal ölçeklenmez — bazı görüntü takımyıldızlarında (karma
şık dokulu iç mekânlar, hareket bulanıklığı, kötü ışık) görüntü sayısının ima ettiğinden 
belirgin biçimde daha uzun sürer. SfM 30 görüntüde 10+ dakika sonra hâlâ takılıyorsa, 
iptal et ve daha iyi materyalle tekrar dene ya da Expert moda geç ve COLMAP/Native-
SfM’yi dene (Cmd+2 → Inspector → Camera Alignment).

Eğitim günlüklerimi nerede bulurum?

Help → Open Training Logs (Cmd+⇧+L). Bu ~/​Documents/​RadianceKit/​Logs/​ açar. Her 
eğitim oturumu dosya adında zaman damgalı kendi JSONL dosyasını yazar — ilk satır 
yapılandırmadır, ardından her 100 iterasyonda bir ilerleme satırı gelir, son satır son kayıp 
ve başarı bayraklı özettir.
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